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Allowable Pressure

At this time, there is no provision in CAEPIPE to specify the type of pipe manufacturing
process, i.e., whether the pipe is a seamless or longitudinal welded or spiral welded.
Accordingly, irrespective of the type of pipe manufacturing process, for straight pipes and
bends, CAEPIPE calculates allowable pressure using Eq. (9) of para.104.1.2 and Eqs. (3) &
(5) of para. 102.4.5 (b).
𝑃𝑎 =

2𝑆𝐸𝑡𝑎
𝑊
.( )
(𝐷𝑜 − 2𝑌𝑡𝑎 ) 𝐼

where
Pa= allowable pressure
SE = maximum allowable stress for the material inclusive of weld joint efficiency factor E
(or casting quality factor F) at the design temperature (i.e., at T design input into CAEPIPE).
The values of SE/SF are given in Mandatory Appendix A of B31.1 (2020) Code.
ta= available thickness for pressure design = tn × (1 - mill tolerance/100) - corrosion
allowance
(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be
included in corrosion allowance in CAEPIPE)
tn= nominal pipe thickness
Do= outside diameter of pipe
d = inside diameter of pipe
I = 1.0 for straight pipes and at the side wall on the bend / elbow centerline
Values for coefficient Y are as per Table 104.1.2-1. Refer to the Table listed at the end of this
section for details on coefficient ‘Y’ implemented in CAEPIPE.
W = weld strength reduction factor as per Table 102.4.7-1. Refer to the Table listed at the
end of this section for details on weld strength reduction factors implemented in CAEPIPE.
ASME B31.1 Code does not provide any explicit equation to compute Allowable Pressure
for closely spaced and widely spaced miter bends. Hence, for ASME B31.1 Code, CAEPIPE
computes the allowable pressure for miter bends using the explicit equations given in ASME
B31.3 (2018) [see para. 304.2.3], as listed below.
For closely spaced miter bends, the allowable pressure is calculated in CAEPIPE as

Pa 

SEWta ( R  r )
r ( R  r / 2)

For widely spaced miter bends with  <= 22.5 deg, the allowable pressure is calculated in
CAEPIPE as

1
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Pa 

SEWta2
r (ta  0.643 tan rta )

For widely spaced miter bends with  > 22.5 deg, the allowable pressure is calculated in
CAEPIPE as
Pa 

SEWta2
r (ta  1.25 tan rta )

where
r = mean radius of pipe = (Do - tn)/2
R = equivalent bend radius of the miter (an input in CAEPIPE for Miter)




1
.
0
1 

 = miter half angle = tan
  2R

 1.0  


 r
Sustained Stress

The stress (SL) due to sustained loads (pressure, weight and other sustained mechanical loads)
is calculated from Eq. 15 of para.104.8.1
2

𝑃𝐷𝑜 𝐼𝑎 𝐹𝑎
𝐼𝑡 𝑀𝑡𝐴 2
√(𝐼𝑖 𝑀𝑖𝐴 )2 + (𝐼𝑜 𝑀𝑜𝐴 )2
|+
] +(
𝑆𝐿 = √[|
+
) ≤ 𝑆ℎ
4𝑡𝑛
𝐴𝑝
𝑍
𝑍
where
P = internal design pressure that shall be not less than the maximum sustained operating
pressure (MSOP) within the piping system, including the effects of static head = maximum
of CAEPIPE pressures P1 through P10
Do = nominal outside diameter
tn= nominal wall thickness
Fa= longitudinal force due to weight and other sustained mechanical loads (excluding
pressure)
Ia= sustained longitudinal force index = 1.00
Ii = sustained in-plane moment index. Ii is taken as the greater of 0.75ii and 1.00. ii is taken
from ASME B31J, Table 1-1.
Io = sustained out-of-plane moment index. Io is taken as the greater of 0.75io and 1.00. io is
taken from ASME B31J, Table 1-1.
2
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It = sustained torsional moment index. I t is taken as the greater of 0.75it and 1.00. it is taken
from ASME B31J, Table 1-1.
MiA, MoA, MtA = in-plane, out-of-plane and torsional moment respectively due to weight and
other sustained mechanical loads
Z = nominal section modulus = un-corroded section modulus
Ap= un-corroded nominal cross sectional area
Sh = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 through
T10)]
SL = stress due to pressure, weight and other sustained mechanical loads
Occasional Stress

The stress (SO) due to sustained and occasional loads is calculated from Eq. 16 of para.
104.8.2 as the combined stress due to (a) sustained loads such as pressure, weight and other
sustained mechanical loads and (b) occasional loads such as earthquake or wind. Wind and
earthquake are not considered to act concurrently as per para. 101.5.2 and para. 101.5.3.
2

𝑃𝑜 𝐷𝑜 𝐼𝑎 𝐹𝑏
𝐼𝑡 𝑀𝑡𝐵 2
√(𝐼𝑖 𝑀𝑖𝐵 )2 + (𝐼𝑜 𝑀𝑜𝐵 )2
|+
] +(
𝑆𝑂 = √[|
+
) ≤ 𝑘𝑆ℎ
4𝑡𝑛
𝐴𝑝
𝑍
𝑍
where
Fb = longitudinal force due to weight, other sustained mechanical loads (excluding pressure),
and occasional loads such as thrusts from pressure/safety relief valve loads, from pressure
and flow transients, earthquake, wind, etc.
Ia= occasional longitudinal force index = 1.00
Ii = occasional in-plane moment index. Ii is taken as the greater of 0.75ii and 1.00. ii is taken
from ASME B31J, Table 1-1.
Io = occasional out-of-plane moment index. Io is taken as the greater of 0.75io and 1.00. io is
taken from ASME B31J, Table 1-1.
It = occasional torsional moment index. I t is taken as the greater of 0.75it and 1.00. it is taken
from ASME B31J, Table 1-1.
MiB, MoB, MtB = in-plane, out-of-plane and torsional moment respectively due to weight,
other sustained mechanical loads (excluding pressure), and occasional loads such as thrusts
from pressure/safety relief valve loads, from pressure and flow transients, earthquake, wind,
etc.
Po = peak pressure = (peak pressure factor in CAEPIPE) x P
SO = stress due to pressure, weight, other sustained mechanical loads and occasional loads
such as thrusts from relief / safety valve loads, from pressure and flow transients,
earthquake, wind etc.
3
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k = 1.2 for occasional loads acting for no more than 1 hr at any one time and no more than
80 hr/yr.
All other terms such as P, Ap, Z, etc. are as defined under Sustained Stress.
For Unsigned occasional load cases such as Earthquake, etc. the forces and moments are
combined as given below.
𝑃 𝐷

𝑜 𝑜
| 4𝑡
+
𝑛

𝐼𝑎 𝐹𝑏
𝐴𝑝

𝑃 𝐷

𝑜 𝑜
| = 𝑚𝑎𝑥 [| 4𝑡
+

𝐼𝑎 𝐹𝑏(𝑠𝑢𝑠𝑡)

𝑛

𝐴𝑝

𝐼𝑎 𝐹𝑏(𝑜𝑐𝑐𝑎)

|+|

𝐴𝑝

(𝐼𝑖 𝑀𝑖𝐵 )2 = (𝐼𝑖 )2 . [|𝑀𝑖𝐵(𝑠𝑢𝑠𝑡) | + |𝑀𝑖𝐵(𝑜𝑐𝑐𝑎) |]

𝑃 𝐷

𝑜 𝑜
| , | 4𝑡
+
𝑛

𝐼𝑎 𝐹𝑏(𝑠𝑢𝑠𝑡)
𝐴𝑝

𝐼𝑎 𝐹𝑏(𝑜𝑐𝑐𝑎)

|−|

𝐴𝑝

|]

2

(𝐼𝑜 𝑀𝑜𝐵 )2 = (𝐼𝑜 )2 . [|𝑀𝑜𝐵(𝑠𝑢𝑠𝑡) | + |𝑀𝑜𝐵(𝑜𝑐𝑐𝑎) |]
(𝐼𝑡 𝑀𝑡𝐵 )2 = (𝐼𝑡 )2 . [|𝑀𝑡𝐵(𝑠𝑢𝑠𝑡) | + |𝑀𝑡𝐵(𝑜𝑐𝑐𝑎) |]

2

2

For Signed occasional load cases such as Wind, etc. the forces and moments are combined as
given below.
𝑃 𝐷

𝑜 𝑜
| 4𝑡
+
𝑛

𝐼𝑎 𝐹𝑏
𝐴𝑝

𝑃 𝐷

𝑜 𝑜
| = | 4𝑡
+
𝑛

𝐼𝑎 𝐹𝑏(𝑠𝑢𝑠𝑡)
𝐴𝑝

+

𝐼𝑎 𝐹𝑏(𝑜𝑐𝑐𝑎)
𝐴𝑝

(𝐼𝑖 𝑀𝑖𝐵 )2 = (𝐼𝑖 )2 . [|𝑀𝑖𝐵(𝑠𝑢𝑠𝑡) + 𝑀𝑖𝐵(𝑜𝑐𝑐𝑎) |]

|

2

(𝐼𝑜 𝑀𝑜𝐵 )2 = (𝐼𝑜 )2 . [|𝑀𝑜𝐵(𝑠𝑢𝑠𝑡) + 𝑀𝑜𝐵(𝑜𝑐𝑐𝑎) |]
(𝐼𝑡 𝑀𝑡𝐵 )2 = (𝐼𝑡 )2 . [|𝑀𝑡𝐵(𝑠𝑢𝑠𝑡) + 𝑀𝑡𝐵(𝑜𝑐𝑐𝑎) |]

2

2

where
MiB(sust), MoB(sust), MtB(sust) = in-plane, out-of-plane and torsional moment respectively due to
weight and other sustained mechanical loads (excluding pressure).
MiB(occa), MoB(occa), MtB(occa) = in-plane, out-of-plane and torsional moment respectively due to
occasional loads such as thrusts from pressure/safety relief valve loads, from pressure and
flow transients, earthquake, wind, etc.
Fb(sust) = longitudinal force due to weight, other sustained mechanical loads (excluding
pressure)
Fb(occa) = longitudinal force due to occasional loads such as thrusts from pressure/safety relief
valve loads, from pressure and flow transients, earthquake, wind, etc.
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Expansion Stress Range (i.e., Stress due to Displacement Load Range)

The stress range (SE) due to thermal expansion is calculated from Eq. 17 of para.104.8.3.
2

𝑖𝑎 𝐹𝑐
𝑖𝑡 𝑀𝑡𝐶 2
√(𝑖𝑖 𝑀𝑖𝐶 )2 + (𝑖𝑜 𝑀𝑜𝐶 )2
√
|+
] +(
𝑆𝐸 = [|
) ≤ 𝑆𝐴
𝐴𝑝
𝑍
𝑍
where
Fc = axial force range due to reference displacement load range
Ap= un-corroded nominal cross sectional area
ia= axial force stress intensification factor = 1.0 for elbows, pipe bends and miter bends
(single, closely spaced and widely spaced), and ia = io(or i when listed) in ASME B31J for
other components
MiC, MoC, MtC = in-plane, out-of-plane and torsional moment range respectively due to the
reference displacement load range
ii, io, it = in-plane, out-of-plane and torsional stress intensification factors respectively as
defined in ASME B31J, Table 1-1
Z = nominal section modulus = un-corroded section modulus

S A  f (1.25SC  0.25Sh ) , from Eq. (1A) of para. 102.3.2 (b)

f  cyclic stress range reduction factor from Eq. (1C) of para. 102.3.2 (b),
f  6/N0.2 <= 1.0 and f >= 0.15 with N being the total number of equivalent reference
displacement stress range cycles expected during the service life of the piping
SC = basic allowable stress at minimum metal temperature expected during the displacement
stress range under analysis
Sh = basic allowable stress at maximum metal temperature expected during the displacement
stress range under analysis
When Sh is greater than SL, the allowable stress range may be calculated as

S A  f [1.25(SC  Sh )  S L ] , from Eq. (1B) of para. 102.3.2 (b).
This equation can be re-written as
𝑆𝐴 = 𝑓 (1.25𝑆𝐶 + 0.25𝑆ℎ ) + 𝑓(𝑆ℎ − 𝑆𝐿 ) (see Note 2 below)

This is specified as an analysis option: “Use liberal allowable stresses”, in the menu Options>Analysis on the Code tab of CAEPIPE.

5
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Note:
1. Refer end of this appendix for the details of “Thickness and Section Modulus used
for weight, pressure and stress calculations”.
2. As per Note 2 of para. 102.3.2 (b) (1) of ASME B31.1 (2020), “For materials with a
minimum tensile strength of over 70 ksi (480 MPa), eqs. (1A) and (1B) shall be
calculated using Sc or Sh values no greater than 20 ksi (140 MPa), unless otherwise
justified.”
Compliance to this criterion is checked using the value entered under Tensile
Strength field of CAEPIPE Material property input. If this field is NOT entered or
left BLANK, then CAEPIPE will compute the Tensile Strength of the material by
multiplying the Allowable Stress at the minimum temperature (at which the material
properties are entered in CAEPIPE stress model) with a factor of 3.5. This is
because, the allowable stress for material below creep is generally 1/3.5 of Tensile
Strength as stated in Section 1-100 of Mandatory Appendix 1 of ASME Section II,
Part D.
For example, if the allowable stress is 22,000 psi for a high strength material at the
minimum temperature of -20 deg. F, then the Tensile Strength would be 22,000 x 3.5
= 77,000 psi. So, in this case, CAEPIPE will internally set the values of both Sc and
Sh as 20,000 psi as Tensile Strength is greater than 70,000 psi.
In addition, if the option “Use Liberal allowable stresses” is turned ON through
Layout Window > Options > Analysis > Code, then if the left over Sustained stress
(= Sh - SL) is positive, CAEPIPE will multiply this positive left over Sustained stress
by the Stress range reduction factor (f) and add that resulting value to the Expansion
allowable stress computed using the above equation (1A).
Settlement Stress

The stress range (𝑆𝑆 ) due to single, noncyclicdisplacement stress range (e.g., predicted
settlement or uplift or movement of pipe support structures such as buildings, pipe racks,
anchors, etc.) is calculated from Eq. 17 of Figure 104.8-1 as given below in accordance with
para. 102.3.2 (b)(2).
2

𝑖𝑎 𝐹𝐷
√(𝑖𝑖 𝑀𝑖𝐷 )2 + (𝑖𝑜 𝑀𝑜𝐷 )2
𝑖𝑡 𝑀𝑡𝐷 2
√
|+
] +(
𝑆𝑆 = [|
) ≤ 3𝑆𝐶
𝐴𝑝
𝑍
𝑍

where
ia= axial force stress intensification factor = 1.0 for elbows, pipe bends and miter bends
(single, closely spaced and widely spaced), and ia = io(or i when listed) in ASME B31J for
other components
ii, io, it = in-plane, out-of-plane and torsional stress intensification factors respectively as
defined in ASME B31J, Table 1-1

6
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FD = axial force range due to any single noncyclic anchor movement (e.g., predicted building
settlement)
Ap= un-corroded nominal cross sectional area
MiD, MoD, MtD = in-plane, out-of-plane and torsional moment range respectively due to any
single noncyclic anchor movement (e.g., predicted building settlement)
Z = nominal section modulus = un-corroded section modulus
𝑆𝑐 = allowable stress at the Reference Temperature in CAEPIPE
ASME B31.1 (2020) – Non-metallic piping as per Chapter N-II

The Chapter N-II titled “Design” of ASME B31.1 (2020) provides methods to evaluate
Non-metallic piping such as PVC, CPVC etc. This Chapter presents equations and
references for
1. Pressure Design (Allowable Pressure calculation) of Non-metallic Pipe and Pipe Fittings,
and
2. Code Compliance checks (such as Sustained Stress, Expansion Stress and Occasional
Stress) for Non-Metallic piping .
From ASME B31.1 (2020) Chapter N-II, it was observed that the equations for Allowable
Pressure for Non-metallic piping and pipe fittings are different from those provided for
Metallic piping and pipe fittings. On the other hand, equations provided for Code
Compliance checks for Metallic piping are also applicable for Non-metallic piping. Refer to
Code Compliance equations for Metallic piping as per ASME B31.1 (2020) given above.
In view of the above, CAEPIPE can be used for analyzing Plastic Piping (such as PVC,
CPVC etc.) using ASME B31.1 (2020) code to obtain results for displacements, element
forces and moments, stresses, support loads and support load summary; however, the
Allowable Pressure results given in Column 2 of Code Compliance Results should be
ignored. Allowable pressures for Plastic Pipe and Pipe Fittings have to be computed
manually as per Chapter N-II of ASME B31.1 (2020) outside of CAEPIPE.
Material Properties for PVC, CPVC, etc. are provided in “Chapter N-II” titled “Design” of
ASME B31.1 (2020). These properties are already included in the material library for Plastics
starting CAEPIPE Version 11.00.

7
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Coefficient ‘Y’ used in CAEPIPE to compute Allowable Design Pressure of
components (extracted from Table 104.1.2-1 of ASME B31.1 – 2020)

S.
No.
1.
2.
3.
4.
5.
6.

Material Type
Ferritic Steels (FS)
Austenitic Steel (AS)
Nickel Alloy UNS No.
N06690 (NA)
Other Nickel Alloys
(NA)
Cast Iron
Material Types other
than those stated from
Sl. Nos. 1 to 5.

900
(482)
and
below
0.4
0.4
0.4

Values of ‘Y’ for Temperature, Deg F (Deg C)
950
1000
1050
1100
1150
1200
(510) (538)
(566)
(593)
(621)
(649)

0.5
0.4
0.4

0.7
0.4
0.4

0.7
0.4
0.4

0.7
0.5
0.5

0.7
0.7
0.7

0.7
0.7
0.7

1250
(677)
and
above
0.7
0.7
0.7

0.4

0.4

0.4

0.4

0.4

0.4

0.5

0.7

0.0
0.4

0.0
0.4

0.0
0.4

0.0
0.4

0.0
0.4

0.0
0.4

0.0
0.4

0.0
0.4

Notes:
1. If Do/ta< 6, for ferritic and austenitic steels designed for temperatures of 900oF
(480oC) and below, CAEPIPE calculates Y as
Y

d
d  Do
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Weld Strength Reduction Factors (W) used in CAEPIPE to calculate the
Allowable Design Pressure of components (extracted from Table 102.4.7-1 of ASME
B31.1-2020)
Material
Sl.
Type/Material
No. Description
1
Carbon Steel
(CS)
[see Note (a)]
2
Ferritic Steels
(FS)
3
Austenitic
Steel (AS)
4
Material
Description
that contains a
string “CrMo”
5
Material Types
other
than
those stated in
Sl. Nos. 1 to 3

Weld Strength Reduction Factor for Temperature, Deg F (Deg C)
700
750
800
850
900
950
1000 1050
(371) (399) (427) (454) (482) (510) (538) (566)
1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00

1100
(593)
1.00

1150
(621)
1.00

1200
(649)
1.00

1.00

1.00

1.00

1.00

1.00

1.00

0.95

0.91

0.86

0.82

0.77

1.00

1.00

1.00

1.00

1.00

1.00

0.95

0.91

0.86

0.82

0.77

1.00

1.00

1.00

0.95

0.91

0.86

0.82

0.77

0.73

0.68

0.64

1.00

1.00

1.00

1.00

1.00

1.00

1.00

1.00

1.00

1.00

1.00

Notes:
(a) Based on Note 7 of Table 102.4.7-1 of ASME B31.1 (2020) code, W = 1.0 for Carbon
Steel (CS).
(b) For Austenitic Steels (including 800H and 800 HT), values up to 1500 deg F are as
follows:
Temperature, deg F
Temperature, deg C Weld Strength Reduction Factor
1250
677
0.73
1300
704
0.68
1350
732
0.64
1400
760
0.59
1450
788
0.55
1500
816
0.50
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Power Piping
ASME B31.1 (2018)
[Superseded by ASME B31.1 (2020)]

Allowable Pressure

At this time, there is no provision in CAEPIPE to specify the type of pipe construction, i.e.,
whether the pipe is a seamless or longitudinal welded or spiral welded. Accordingly,
irrespective of the type of pipe construction, CAEPIPE calculates allowable pressure as
follows.
For straight pipes and bends with seamless construction or designed for sustained operation
below the creep range, Eq. (9) of para.104.1.2 is used as given below to compute allowable
pressure.
Pa 

2SEWta
Do  2Yt a

where
Pa= allowable pressure
SE = maximum allowable stress in material due to internal pressure and joint efficiency (or
casting quality factor) at the design temperature. The values of SE are given in Mandatory
Appendix A of B31.1 (2018) Code
ta= available thickness for pressure design = tn × (1 - mill tolerance/100) - corrosion
allowance
(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be
included in corrosion allowance in CAEPIPE)
tn= nominal pipe thickness
Do= outside diameter of pipe
d = inside diameter of pipe
The coefficient Y is implemented as per Table 104.1.2-1. Refer to the Table listed at the end
of this section for details on ‘Y’ factor implemented in CAEPIPE.
W = weld strength reduction factor as per Table 102.4.7-1. Refer to the Table listed at the
end of this section for details on Weld strength reduction factor implemented in CAEPIPE.
ASME B31.1 Code does not provide any explicit equation to compute Allowable Pressure
for closely spaced and widely spaced miter bends. Hence, for ASME B31.1 Code, CAEPIPE
computes the allowable pressure for miter bends using the explicit equations given in ASME
B31.3 (2018) [see para. 304.2.3] as listed below.
For closely spaced miter bends, the allowable pressure is calculated in CAEPIPE as

Pa 

SEWta ( R  r )
r ( R  r / 2)

10
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ASME B31.1 (2018)
[Superseded by ASME B31.1 (2020)]

For widely spaced miter bends with  <= 22.5 deg, the allowable pressure is calculated in
CAEPIPE as
Pa 

SEWta2
r (ta  0.643 tan rta )

For widely spaced miter bends with  > 22.5 deg, the allowable pressure is calculated in
CAEPIPE as
Pa 

SEWta2
r (ta  1.25 tan rta )

where
r = mean radius of pipe = (Do - tn)/2
R = equivalent bend radius of the miter (an input in CAEPIPE for Miter)




1
.
0
1 

 = miter half angle = tan
  2R

 1.0  


 r
Sustained Stress

The stress (SL) due to sustained loads (pressure, weight and other sustained mechanical loads)
is calculated from Eq. 15 of para.104.8.1
SL 

PDo 0.75iM A

 Sh
4t n
Z

where
P = maximum of CAEPIPE pressures P1 through P10
Do = outside diameter
tn= nominal wall thickness
i = stress intensification factor. The product 0.75i shall not be less than 1.0.
MA = resultant bending moment due to weight and other sustained loads
Z = un-corroded section modulus; for reduced outlets, effective section modulus as per para.
104.8.4
Sh = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 through
T10)]
11
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ASME B31.1 (2018)
[Superseded by ASME B31.1 (2020)]

Occasional Stress

The stress (SLO) due to occasional loads is calculated from Eq. 16 of para.104.8.2 as the sum
of stress due to sustained loads (SL) and stress due to occasional loads (So) such as earthquake
or wind. Wind and earthquake are not considered concurrently.

S Lo 

Ppeak Do
4t n



0.75iM A 0.75iM B

 1.2S h
Z
Z

where
MB = resultant bending moment on the cross-section due to occasional loads such as thrusts
from relief / safety valve loads, from pressure and flow transients, earthquake, wind etc.
Ppeak = peak pressure = (peak pressure factor in CAEPIPE) x P
Expansion Stress Range (i.e., Stress due to Displacement Load Range)

The stress (SE) due to thermal expansion is calculated from Eq. 17 of para.104.8.3.
SE 

iM C
 SA
Z

where
MC = resultant moment due to thermal expansion

S A  f (1.25SC  0.25Sh ) , from Eq. (1A) of para. 102.3.2 (b)

f  cyclic stress range reduction factor from Eq.(1C) of para. 102.3.2(b),
f  6/N0.2 <= 1.0 and f >= 0.15 with N being the total number of equivalent reference
displacement stress range cycles expected during the service life of the piping
SC = basic allowable stress at minimum metal temperature expected during the displacement
cycle under analysis
Sh = basic allowable stress at maximum metal temperature expected during the displacement
cycle under analysis
When Sh is greater than SL, the allowable stress range may be calculated as

S A  f [1.25(SC  Sh )  S L ] , from Eq. (1B) of para. 102.3.2 (b)
This is specified as an analysis option: “Use liberal allowable stresses”, in the menu Options>Analysis on the Code tab of CAEPIPE.
Note:
Refer end of this appendix for the details of “Thickness and Section Modulus used for
weight, pressure and stress calculations”.
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Coefficient ‘Y’ used in CAEPIPE to compute Allowable Design Pressure of
components (extracted from Table 104.1.2-1 of ASME B31.1 – 2018)

Sl.
No.
1.
2.
3.
4.
5.
6.

Material Type
Ferritic Steels
(FS)
Austenitic Steel
(AS)
Nickel Alloy UNS
No. N06690 (NA)
Other Nickel
Alloys (NA)
Cast Iron
Material Types
other than those
stated from Sl.
Nos. 1 to 5.

Values of ‘Y’ for Temperature, Deg F (Deg C)
950
1000
1050
1100
1150
1200
(510) (538)
(566)
(593)
(621)
(649)

900
(482)
and
below
0.4

0.5

0.7

0.7

0.7

0.7

0.7

1250
(677)
and
above
0.7

0.4

0.4

0.4

0.4

0.5

0.7

0.7

0.7

0.4

0.4

0.4

0.4

0.5

0.7

0.7

0.7

0.4

0.4

0.4

0.4

0.4

0.4

0.5

0.7

0.0
0.4

0.0
0.4

0.0
0.4

0.0
0.4

0.0
0.4

0.0
0.4

0.0
0.4

0.0
0.4

Notes:
2. If Do/ta< 6, for ferritic and austenitic steels designed for temperatures of 900oF
(480oC) and below, CAEPIPE calculates Y as
Y

d
d  Do

Weld Strength Reduction Factors used in CAEPIPE to calculate the Allowable
Design Pressure of components (extracted from Table 102.4.7-1 of ASME B31.1-2018)
Sl.
No.
1
2
3
4

5

Material
Type/Material
Description
Carbon Steel
(CS)
Ferritic Steels
(FS)
Austenitic
Steel (AS)
Material
Description
that contains a
string “CrMo”
Material Types
other
than
those stated in
Sl. Nos. 1 to 3

Weld Strength Reduction Factor for Temperature, Deg F (Deg C)
700
750
800
850
900
950
1000 1050
(371) (399) (427) (454) (482) (510) (538) (566)
1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00

1100
(593)
1.00

1150
(621)
1.00

1200
(649)
1.00

1.00

1.00

1.00

1.00

1.00

1.00

0.95

0.91

0.86

0.82

0.77

1.00

1.00

1.00

1.00

1.00

1.00

0.95

0.91

0.86

0.82

0.77

1.00

1.00

1.00

0.95

0.91

0.86

0.82

0.77

0.73

0.68

0.64

1.00

1.00

1.00

1.00

1.00

1.00

1.00

1.00

1.00

1.00

1.00
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Notes:
For Austenitic Steels (including 800H and 800 HT) the values upto 1500 deg F are as
follows:
Temperature, deg F
Temperature, deg C Weld Strength Reduction Factor
1250
677
0.73
1300
704
0.68
1350
732
0.64
1400
760
0.59
1450
788
0.55
1500
816
0.50
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Power Piping
ASME B31.1 (2016)
[Superseded by ASME B31.1 (2018)]

Allowable Pressure

At this time, there is no provision in CAEPIPE to specify the type of pipe construction, i.e.,
whether the pipe is a seamless or longitudinal welded or spiral welded. Accordingly,
irrespective of the type of pipe construction, CAEPIPE calculates allowable pressure as
follows.
For straight pipes and bends with seamless construction or designed for sustained operation
below the creep range, Eq. (9) of para.104.1.2 is used as given below to compute allowable
pressure.

Pa 

2SEt a
Do  2Yt a

For straight pipes and bends designed for sustained operation within the creep range, Eq.
(11) of para.104.1.4 is used as given below to calculate allowable pressure.

Pa 

2SEWta
Do  2Yt a

where
Pa= allowable pressure
SE = allowable stress as given in Appendix A of B31.1 (2016) Code, where
E = weld joint efficiency factor or casting quality factor as given in Table 102.4.3
ta= available thickness for pressure design = tn × (1 - mill tolerance/100) - corrosion
allowance
(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be
included in corrosion allowance in CAEPIPE)
tn= nominal pipe thickness
Do= outside diameter of pipe
d = inside diameter of pipe
The Pressure coefficient Y is implemented as per Table 104.1.2 (A). Refer to the Table listed
at the end of this section for details on ‘Y’ factor implemented in CAEPIPE
W = weld strength reduction factor as per Table 102.4.7. Refer to the Table listed at the end
of this section for details on Weld strength reduction factor implemented in CAEPIPE.
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For closely spaced miter bends, the allowable pressure is calculated from Eq. (C.3.1) of
para.104.3.3.

Pa 

SEta ( R  r )
r ( R  r / 2)

where
r = mean radius of pipe = (Do - tn)/2
R = equivalent bend radius of the miter
For widely spaced miter bends, the allowable pressure is calculated from Eq. (C.3.2) of para.
104.3.3.
Pa 

SEt a2
r (t a  1.25 tan  rt a )

Where,  = miter half angle
Sustained Stress

The stress (SL) due to sustained loads (pressure, weight and other sustained mechanical
loads) is calculated from Eq. 15 of para.104.8.1

SL 

PDo 0.75iM A

 Sh
4t n
Z

where
P = maximum of CAEPIPE pressures P1 through P10
Do = outside diameter
tn= nominal wall thickness
i = stress intensification factor. The product 0.75i shall not be less than 1.0.
MA = resultant bending moment due to weight and other sustained loads
Z = un-corroded section modulus; for reduced outlets, effective section modulus as per para.
104.8.4
Sh = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 through
T10)]
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Occasional Stress

The stress (SLo) due to occasional loads is calculated from Eq. 16 of para.104.8.2 as the sum
of stress due to sustained loads (SL) and stress due to occasional loads (So) such as
earthquake or wind. Wind and earthquake are not considered concurrently.

S Lo 

Ppeak Do
4t n



0.75iM A 0.75iM B

 1.2S h
Z
Z

where
MB = resultant bending moment on the cross-section due to occasional loads such as thrusts
from relief / safety valve loads, from pressure and flow transients, earthquake, wind etc.
Ppeak = peak pressure = (peak pressure factor in CAEPIPE) x P
Expansion Stress Range (i.e., Stress due to Displacement Load Range)

The stress (SE) due to thermal expansion is calculated from Eq. 17 of para.104.8.3.
SE 

iM C
 SA
Z

where
MC = resultant moment due to thermal expansion

S A  f (1.25S C  0.25S h ) , from Eq. (1A) of para. 102.3.2 (B)

f  cyclicstress range reduction factor from Eq.(1C) of para. 102.3.2(B),
f  6/N0.2 <= 1.0 and f >= 0.15 with N being the total number of equivalent reference

displacement stress range cycles expected during the service life of the piping

SC = basic allowable stress as minimum metal temperature expected during the displacement
cycle under analysis
Sh = basic allowable stress as maximum metal temperature expected during the displacement
cycle under analysis
When Sh is greater than SL, the allowable stress range may be calculated as

S A  f [1.25(S C  S h )  S L ] , from Eq. (1B) of para. 102.3.2 (B)
This is specified as an analysis option: “Use liberal allowable stresses”, in the menu Options>Analysis on the Code tab of CAEPIPE.
Note:
Refer end of this appendix for the details of “Thickness and Section Modulus used for
weight, pressure and stress calculations”.
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ASME B31.1 (2016)
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Pressure coefficient ‘Y’ used in Allowable Design Pressure of components
(extracted from Table 104.1.2(A) of ASME B31.1 – 2016).

Sl.
No.
1.
2.
3.
4.
5.
6.

Material Type
Ferritic Steels
(FS)
Austenitic Steel
(AS)
Nickel Alloy UNS
No. N06690 (NA)
Other Nickel
Alloys (NA)
Cast Iron
Material Types
other than those
stated from Sl.
Nos. 1 to 5.

950
(510)

Values of ‘Y’ for Temperature, Deg F (Deg C)
1000
1050
1100
1150
1200
(538)
(566)
(593)
(621)
(649)

900
(482)
and
below
0.4

0.5

0.7

0.7

0.7

0.7

0.7

1250
(677)
and
above
0.7

0.4

0.4

0.4

0.4

0.5

0.7

0.7

0.7

0.4

0.4

0.4

0.4

0.5

0.7

0.7

0.7

0.4

0.4

0.4

0.4

0.4

0.4

0.5

0.7

0.0
0.4

0.0
0.4

0.0
0.4

0.0
0.4

0.0
0.4

0.0
0.4

0.0
0.4

0.0
0.4

Notes:
3. If Do/ta< 6, for ferritic and austenitic steels designed for temperatures of 900oF
(480oC) and below then

Y

d
d  Do
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Weld Strength Reduction Factors applied for calculating the Allowable Design
Pressure of components (extracted from Table 102.4.7 of ASME B31.1-2016).
Sl.
No.
1
2
3
4

Material Type
Carbon Steel
(CS)
Ferritic Steels
(FS)
Austenitic
Steel (AS)
Material Types
other
than
those stated in
Sl. Nos. 1 to 3

Weld Strength Reduction Factor for Temperature, Deg F (Deg C)
700
750
800
850
900
950
1000 1050
(371) (399) (427) (454) (482) (510) (538) (566)
1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00

1100
(593)
1.00

1150
(621)
1.00

1200
(649)
1.00

1.00

1.00

1.00

1.00

1.00

1.00

0.95

0.91

0.86

0.82

0.77

1.00

1.00

1.00

1.00

1.00

1.00

0.95

0.91

0.86

0.82

0.77

1.00

1.00

1.00

1.00

1.00

1.00

1.00

1.00

1.00

1.00

1.00

Notes:
For Austenitic Steels (including 800H and 800 HT) the values upto 1500 deg F are as
follows:
Temperature, deg F
Temperature, deg C Weld Strength Reduction Factor
1250
677
0.73
1300
704
0.68
1350
732
0.64
1400
760
0.59
1450
788
0.55
1500
816
0.50
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ANSI B31.1 (1967)
Allowable Pressure

The allowable pressure for straight pipes and bends is calculated from 104.1.2.
𝑃=
where
𝑃 =
𝑆 =
𝐸 =
𝑡𝑚 =
𝑡𝑛
𝐷
𝑑
𝑌

=
=
=
=
=

2𝑆𝐸𝑡𝑚
𝐷 − 2𝑌𝑡𝑚

allowable pressure
allowable stress
joint factor (input as material property)
minimum required thickness, including mechanical, corrosion, and erosion
allowances
𝑡𝑛 ×(1 – mill tolerance/100) – corrosion allowance
nominal pipe thickness
nominal outside diameter
nominal inside diameter
pressure coefficient from Table 104.1.2(a)2

Sustained Stress

The stress 𝑆𝐿 due to sustained loads (pressure, weight and other sustained mechanical loads)
is calculated from 102.3.2(d)
𝑆𝐿 = |

𝑃𝐷 𝐹𝐴
√(𝑖𝑖 𝑀𝑖𝐴 )2 + (𝑖𝑜 𝑀𝑜𝐴 )2
+ |+
≤ 𝑆ℎ
4𝑡𝑚 𝐴
𝑍

where
𝑃 = maximum of CAEPIPE input pressures P1 through P10
𝐷 = nominal outside diameter
𝑡𝑚 = minimum wall thickness as given above
𝑖𝑖 = in-plane stress intensification factor
𝑖𝑜 = out-of-plane stress intensification factor
𝐹𝐴 = axial force due to weight and other sustained mechanical loads excluding pressure
A = nominal metal area
𝑀𝑖𝐴 = in-plane bending moment due to weight and other sustained loads
𝑀𝑜𝐴 = out-of-plane bending moment due to weight and other sustained loads
𝑍 = nominal section modulus = un-corroded section modulus
𝑆ℎ = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (T ref, T1
through T10)]
Note:
1. When the option “Include axial force in stress calculations” is tuned OFF, then
𝐹
CAEPIPE will exclude the term 𝐴𝐴 in the equation above.
2. When the option “Pressure stress” is selected as “Pd^2/(D^2-d^2)”; then CAEPIPE
𝑃𝐷

𝑃𝑑2

will replace the term 4𝑡 with 𝐷2 −𝑑2 , where, d = nominal inside diameter
𝑚
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Occasional Stress

The stress 𝑆𝐿𝑂 is calculated as the sum of stress due to sustained loads 𝑆𝐿 and stress due to
occasional loads 𝑆𝑂 such as earthquake or wind. Wind and earthquake are not considered
concurrently (102.3.1).

where

(𝑃𝑜 − 𝑃)𝐷 𝐹𝐵
√(𝑖𝑖 𝑀𝑖𝐵 )2 + (𝑖𝑜 𝑀𝑜𝐵 )2
𝑆𝐿𝑂 = 𝑆𝐿 + |
+ |+
≤ 1.2𝑆ℎ
4𝑡𝑚
𝐴
𝑍

Po = peak pressure = (peak pressure factor in CAEPIPE) x P
P = maximum of CAEPIPE input pressures P1 through P10
𝐷 = nominal outside diameter
𝑖𝑖 = in-plane stress intensification factor
𝑖𝑜 = out-of-plane stress intensification factor
𝐹𝐵 = axial force due to occasional loads
A = nominal metal area
𝑀𝑖𝐵 = in-plane bending moment only due to occasional loads
𝑀𝑜𝐵 = out-of-plane bending moment only due to occasional loads
𝑍 = nominal section modulus = un-corroded section modulus
𝑆ℎ = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (T ref, T1 through T10)]
Note:
1. When the option “Include axial force in stress calculations” is tuned OFF, then
𝐹
CAEPIPE will exclude the term 𝐴𝐵 in the equation above.
2. When the option “Pressure stress” is selected as “Pd^2/(D^2-d^2)” then CAEPIPE
will replace the term

(𝑃𝑜−𝑃)𝐷
4𝑡𝑚

with

(𝑃𝑂 −𝑃)𝑑2
𝐷2 −𝑑2

, where, d = nominal inside diameter

Expansion Stress

The stress (𝑆𝐸 ) due to thermal expansion is calculated from (119.6.4).
𝑆𝐸 = √𝑆𝑏2 + 4𝑆𝑡2 ≤ 𝑆𝐴

where
𝑆𝑏 =
𝑆𝑡 =
𝑍 =
𝑀𝑖𝐶 =
𝑀𝑜𝐶 =
𝑀𝑡𝐶 =
𝑆𝐴 =

resultant bending stress = √(𝑖𝑖 𝑀𝑖𝐶 )2 + (𝑖𝑜 𝑀𝑜𝐶 )2 /𝑍
torsional stress = 𝑀𝑡𝐶 /2Z
un-corroded section modulus; for a branch, effective section modulus
in-plane bending moment only due to thermal loads
out-of-plane bending moment only due to thermal loads
torsional moment only due to thermal loads
𝑓 (1.25𝑆𝑐 + 0.25𝑆ℎ ) as per eq. (1) in para. 102.3.2 (c).

SC = basic allowable stress at minimum metal temperature expected during the displacement
stress range under analysis
Sh = basic allowable stress at maximum metal temperature expected during the displacement
stress range under analysis
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f = stress range reduction factor from Table 102.3.2(c).
When 𝑆ℎ is greater than 𝑆𝐿 , the allowable stress range may be calculated as
𝑆𝐴 = 𝑓[1.25(𝑆𝑐 + 𝑆ℎ ) − 𝑆𝐿 ]

This is specified as an option (Use liberal allowable stresses) in the menu Options > Analysis
on the Code tab.
Note:
When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE
will compute SE as given below.
𝐹𝐶
𝑆𝐸 = | | + √𝑆𝑏2 + 4𝑆𝑡2 ≤ 𝑆𝐴
𝐴
where
𝐹𝐶 = axial force due to thermal loads only.
A = nominal metal area
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ANSI B31.1 (1973)
Allowable Pressure

The allowable pressure for straight pipes and bends is calculated using eq. (4) in para.
104.1.2A.
𝑃𝑎 =

2𝑆𝐸𝑡𝑎
(𝐷𝑜 − 2𝑌𝑡𝑎 )

where
𝑃𝑎 = allowable pressure
SE = maximum allowable stress for the material inclusive of weld joint efficiency factor E
(or casting quality factor F) at the design temperature (i.e., at T design input into CAEPIPE).
The values of SE/SF are given in Appendix A of B31.1 (1973) Code.
ta= available thickness for pressure design = tn × (1 - mill tolerance/100) - corrosion
allowance
(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be
included in corrosion allowance in CAEPIPE)
tn= nominal pipe thickness
Do= nominal outside diameter of pipe
𝑑 = nominal inside diameter
𝑌 = coefficient from Table 104.1.2, A

S.
No.
1.
2.
3.
4.
5.

Material Type
Ferritic Steels (FS)
Austenitic Steel (AS)
Nonferrous Steels
Cast Iron
Material Types other
than those stated from
Sl. Nos. 1 to 4.

Values of ‘Y’ for Temperature, Deg F (Deg C)
900
950
1000
1050
1100
1150
(482) (510) (538)
(566)
(593)
(621)
and
and
below
above
0.4
0.5
0.7
0.7
0.7
0.7
0.4
0.4
0.4
0.4
0.5
0.7
0.4
0.4
0.4
0.4
0.4
0.4
0.4
0.4
0.4
0.4
0.4
0.4
0.4
0.4
0.4
0.4
0.4
0.4

Notes:
1. If Do/ta< 6, for ferritic and austenitic steels designed for temperatures of 900oF
(480oC) and below, CAEPIPE calculates Y using eq. (5) in para. 104.1.2.
Y

d
d  Do
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Sustained Stress

The stress 𝑆𝐿 due to sustained loads (pressure, weight and other sustained mechanical loads) is
calculated from para. 102.3.2 D.
𝑃𝑑2
√(𝑖𝑖 𝑀𝑖𝐴 )2 + (𝑖𝑜 𝑀𝑜𝐴 )2
|
𝑆𝐿 = | 2
+
≤ 𝑆ℎ
𝐷 − 𝑑2
𝑍

where
𝑃 = internal design pressure that shall be not less than the maximum sustained operating pressure
(MSOP) within the piping system, including the effects of static head = maximum of
CAEPIPE input pressures P1 through P10
𝐷 = nominal outside diameter
d = nominal inside diameter
𝑖𝑖 = in-plane stress intensification factor from Appendix D
𝑖𝑜 = out-of-plane stress intensification factor from Appendix D
𝑀𝑖𝐴 = in-plane bending moment due to weight and other sustained mechanical loads (excluding
pressure)
𝑀𝑜𝐴 = out-of-plane bending moment due to weight and other sustained mechanical loads
(excluding pressure)
𝑍 = un-corroded section modulus; for a branch, effective section modulus as per para. 119.7.3.
𝑆ℎ = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (T ref, T1 through T10)]
Note:
When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE will
𝑃𝑑2

𝑃𝑑2

replace the term |𝐷2 −𝑑2 | with |𝐷2 −𝑑2 +

𝐹𝐴
𝐴

|

where
𝐹𝐴 = axial force due to weight and other sustained mechanical loads excluding pressure
A = nominal metal area
Occasional Stress

The stress 𝑆𝐿𝑂 , calculated as the sum of stress due to sustained loads 𝑆𝐿 and stress due to
occasional loads 𝑆𝑂 such as earthquake or wind, shall meet the following conditions as per para.
102.3.3A. Wind and earthquake are not considered concurrently as per para. 101.5.3.
𝑆𝐿𝑂 = 𝑆𝐿 + |

(𝑃𝑜 − 𝑃)𝑑2
𝐷2 − 𝑑 2

|+

√(𝑖𝑖 𝑀𝑖𝐵 )2 + (𝑖𝑜 𝑀𝑜𝐵 )2
𝑍

≤ 𝑘. 𝑆ℎ

Po = peak pressure = (peak pressure factor in CAEPIPE) x P
P = Maximum of CAEPIPE input pressures P1 through P10
𝑍 = un-corroded section modulus; for a branch, effective section modulus as per para. 119.7.3.
𝑀𝑖𝐵 = in-plane bending moment due to occasional loads such as thrusts from pressure/safety
relief valve loads, from pressure and flow transients, earthquake/wind, etc.
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𝑀𝑜𝐵 = out-of-plane bending moment due to occasional loads such as thrusts from pressure/safety
relief valve loads, from pressure and flow transients, earthquake/wind, etc.
𝑆ℎ = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (T ref, T1 through T10)]
k = 1.2 for Level B
k = 1.8 for Level C
k = 2.40 for Level D
𝑖𝑖 = in-plane stress intensification factor from Appendix D
𝑖𝑜 = out-of-plane stress intensification factor from Appendix D
Note:
When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE will
replace the term |

(𝑃𝑜−𝑃)𝑑2
𝐷2 −𝑑2

(𝑃𝑜−𝑃)𝑑2

| with |

𝐷2 −𝑑2

+

𝐹𝐵
𝐴

|

where
𝐹𝐵 = axial force due to occasional loads such as thrusts from pressure/safety relief valve loads,
from pressure and flow transients, earthquake/wind, etc.
A = nominal metal Area
Expansion Stress Range

The stress range (𝑆𝐸 ) due to thermal expansion is calculated using eq. (8) in para. 119.6.4A.
𝑆𝐸 = √𝑆𝑏2 + 4𝑆𝑡2 ≤ 𝑆𝐴

where
𝑆𝑏 = resultant bending stress = √(𝑖𝑖 𝑀𝑖𝐶 )2 + (𝑖𝑜 𝑀𝑜𝐶 )2 /𝑍
𝑆𝑡 = torsional stress = 𝑀𝑡𝐶 /2Z
𝑖𝑖 = in-plane stress intensification factor from Appendix D
𝑖𝑜 = out-of-plane stress intensification factor from Appendix D
𝑀𝑖𝐶 = in-plane bending moment due to the reference thermal load range
𝑀𝑜𝐶 = out of plane bending moment due to the reference thermal load range
𝑍 = un-corroded section modulus; for a branch, effective section modulus as per para. 119.7.3.
𝑆𝐴 = 𝑓 (1.25𝑆𝑐 + 0.25𝑆ℎ ) as per eq. (1) in para. 102.3.2 (c).
SC = basic allowable stress at minimum metal temperature expected during the thermal stress
range under analysis
Sh = basic allowable stress at maximum metal temperature expected during the thermal stress
range under analysis
f = stress range reduction factor from Table 102.3.2, C
When 𝑆ℎ is greater than 𝑆𝐿 , the allowable stress range may be calculated as follows, in
accordance with para. 102.3.2 D.
𝑆𝐴 = 𝑓[1.25(𝑆𝑐 + 𝑆ℎ ) − 𝑆𝐿 ]
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This is specified as an option (Use liberal allowable stresses) in the menu Options > Analysis
on the Code tab.
Note:
When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE
will compute SE as given below.
𝐹𝐶
𝑆𝐸 = | | + √𝑆𝑏2 + 4𝑆𝑡2 ≤ 𝑆𝐴
𝐴
where
𝐹𝐶 = axial force due to reference displacement load range.
A = nominal metal area
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Allowable Internal Pressure

For straight pipes and bends, the allowable pressure is calculated using Eq. (3a) for straight pipes
and Eq. (3c) for bends from paras. 304.1.2. and 304.2.1 respectively.
𝑃𝑎 =

2𝑆𝐸𝑡𝑎
𝑊
.( )
(𝐷𝑜 − 2𝑌𝑡𝑎 ) 𝐼

where
Pa= allowable internal pressure
S = allowable stress at Design Temperature (i.e., at T design input into CAEPIPE) as provided in para.
302.3.1 (a) and as per Table A-1
E = joint factor (input as material property) from Table A-1A as per para. 302.3.3 (b) or Table A-1B
as per para. 302.3.4 9 (a).
W = Weld Joint Strength Reduction Factor at Design Temperature (i.e., at T design input into
CAEPIPE) from para. 302.3.5 (e) and as per Table 302.3.5. Refer to the Table listed at the end of
this section for details on Weld Strength Reduction Factor implemented in CAEPIPE.
ta= available thickness for pressure design
= tn × (1 - mill tolerance/100) - corrosion allowance “c”
(Any additional thickness required for threading, grooving, erosion, corrosion, etc. should be
included in corrosion allowance “c” in CAEPIPE)
tn= nominal pipe thickness
D = outside diameter
𝑌 = coefficient from Table 304.1.1, valid for 𝑡𝑎 < 𝐷/6. Refer to the Table listed at the end of this
Section for details on ‘Y’ used in CAEPIPE.
I = 1.0 for straight pipes and at the side wall on the bend / elbow centerline
For closely spaced miter bends, the allowable pressure is calculated in CAEPIPE using Eq. (4a) and
Eq. (4b) from para. 304.2.3 (a) as
𝑆𝐸𝑊𝑡𝑎2
𝑆𝐸𝑊𝑡𝑎 (𝑅 − 𝑟)
]
𝑃𝑎 = 𝑚𝑖𝑛 [
,
𝑟(𝑡𝑎 + 0.643 tan 𝜃 √𝑟𝑡𝑎 ) 𝑟 (𝑅 − 𝑟/2)
For widely spaced miter bends with 𝜃<= 22.5 deg, the allowable pressure is calculated in CAEPIPE
using Eq. (4a) from para. 304.2.3 (b) (1) as
𝑆𝐸𝑊𝑡𝑎2
𝑃𝑎 =
𝑟(𝑡𝑎 + 0.643 tan 𝜃 √𝑟𝑡𝑎 )
For widely spaced miter bends with 𝜃> 22.5 deg, the allowable pressure is calculated in CAEPIPE
using Eq. (4c) from para. 304.2.3 (b) (2) as
𝑆𝐸𝑊𝑡𝑎2
𝑃𝑎 =
𝑟(𝑡𝑎 + 1.25 tan 𝜃 √𝑟𝑡𝑎 )
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where
𝑟 = mean radius of pipe using nominal wall thickness = (D- tn)/2
𝑅 = effective bend radius of the miter (see para. 304.2.3 (d) of code for definition) [an input in
CAEPIPE for miters]




1
.
0
1 

 = miter half angle = tan
  2R

 1.0  


 r
Note:

As per para. 304.1.2 (a), Eq. 3(a) used above to compute allowable internal pressure is valid only
when ta < D/6. Hence, CAEPIPE will issue a warning message and will leave the Allowable
Pressure row BLANK for elements where t a >= D/6 in Code Compliance Results.
Sustained Stress

The stress (𝑆𝐿 ) due to sustained loads (pressure, weight and other sustained mechanical loads) is
calculated using Eqs. (23a), (23b), (23c) and (23d) from para. 320.2 and para. 302.3.5 (c).
𝑆𝐿 = √(|𝑆𝑎 | + 𝑆𝑏 )2 + (2𝑆𝑡 )2 ≤ 𝑆ℎ
where
𝐼𝑎 𝐹𝑎
𝑃𝜋𝑑 2 /4 𝑅
]
𝑆𝑎 = [
= 𝐼𝑎 [
+ ]
𝐴𝑝 𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑
𝐴𝑝
𝐴𝑝 𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑
√(𝐼𝑖 𝑀𝑖 )2 + (𝐼𝑜 𝑀𝑜 )2
]
𝑍𝑚
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑
𝐼𝑡 𝑀𝑡
𝑆𝑡 = [
]
2𝑍𝑚 𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑
𝑆𝑏 = [

= maximum of CAEPIPE input pressures P1 through P10
= outside diameter
= wall thickness used for sustained stress calculation after deducting corrosion allowance from
the nominal thickness
𝑡𝑆 = nominal thickness – corrosion allowance in CAEPIPE, as per para. 320.1
𝐴𝑝 = sustained corroded cross-sectional area of the pipe computed using ts as per para. 320.2.
𝐼𝑎 = longitudinal force index = 1.0
𝐹𝑎 = longitudinal force due to sustained loads (pressure and weight)
𝑅 = axial force due to weight alone, where weight is computed using nominal thickness.
𝐼𝑖 = sustained in-plane moment index = 0.75𝑖𝑖 or 1.0, whichever is greater.
𝐼𝑜 = sustained out-of-plane moment index = 0.75𝑖𝑜 or 1.0, whichever is greater.
𝐼𝑡 = sustained torsional moment index = 1.0
𝑀𝑖 = in-plane bending moment due to sustained loads, e.g., pressure and weight
𝑀𝑜 = out-of-plane bending moment due to sustained loads, e.g., pressure and weight
𝑀𝑡 = torsional moment due to sustained loads, e.g., pressure and weight
𝑍𝑚 = corroded section modulus as per para. 320.1
𝑃
𝐷
𝑡𝑆
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𝑆ℎ = basic allowable stress at maximum temperature, i.e., max (Tref, T1 through T10)
ii and io = in-plane and out-of-plane index from ASME B31J (2017) respectively.
Sustained plus Occasional Stress

The stress (𝑆𝐿𝑜 ) due to sustained and occasional loads is calculated as the sum of stress (𝑆𝐿 ) due to
sustained loads such as pressure and weight and stress (𝑆𝑜 ) due to occasional loads such as
earthquake or wind. Wind and earthquake are not considered as acting concurrently. See para.
302.3.6 (a).
For temp ≤ 4270 C or 8000 F

𝑆𝐿𝑂 ≤ 1.33𝑆ℎ as per para. 302.3.6 (a)(1)
For temp > 4270 C or 8000 F

𝑆𝐿𝑂 ≤ min(0.9𝑊𝑆𝑦 , 4𝑆ℎ )as per para. 302.3.6 (a)(2) [only 302.3.6 (a)(2)(-a) and 302.3.6 (a)(2)(-b)
considered]
where
𝑆𝐿𝑂 = 𝑆𝐿 + 𝑆𝑂 , where 𝑆𝐿 is computed as above, and 𝑆𝑜 is calculated using Eqs. (23a), (23b), (23c)
and (23d) with applicable loads as per para. 302.3.6 (a).
𝑆𝑂 = √(|𝑆𝑎𝑜 | + 𝑆𝑏𝑜 )2 + (2𝑆𝑡𝑜 )2
(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝜋𝑑 2 /4 𝑅
𝐼𝑎 𝐹𝑎
]
𝑆𝑎𝑜 = [
= 𝐼𝑎 [
+ ]
𝐴𝑝 𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙
𝐴𝑝
𝐴𝑝 𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙
𝑆𝑏𝑜

√(𝐼𝑖 𝑀𝑖 )2 + (𝐼𝑜 𝑀𝑜 )2
]
=[
𝑍𝑚

𝑆𝑡𝑜 = [

𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

𝐼𝑡 𝑀𝑡
]
2𝑍𝑚 𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

= peak pressure = (peak pressure factor in CAEPIPE) x P
= axial force due to occasional loads such as earthquake or wind
= in-plane bending moment due to occasional loads such as earthquake or wind
= out-of-plane bending moment due to occasional loads such as earthquake or wind
= torsional moment due to occasional loads such as earthquake or wind
= yield strength at maximum temperature, i.e., max (T ref, T1 through T10)
= 1.0 for Austenetic stainless steel and 0.8 for other materials as per para. 302.3.6(a)(2)
= corroded section modulus as per para. 320.1

𝑃𝑝𝑒𝑎𝑘

𝑅
𝑀𝑖
𝑀𝑜
𝑀𝑡
𝑆𝑦
𝑊
𝑍𝑚

Note: When the field Yield strength is left BLANK or NOT input, then CAEPIPE will compute
the Yield Strength of the material by multiplying the Allowable Stress at the minimum temperature
(at which the material properties are entered in CAEPIPE stress model) with a factor of 1.5 (=3/2).
This is because; the allowable stress for material below creep is generally 2/3 of Yield Strength.
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Expansion Stress

The stress (𝑆𝐸 ) due to thermal expansion is calculated using Eq. 17 from para. 319.4.4 and shall not
exceed (SA) as per para.302.3.5 (d).
𝑆𝐸 = √(|𝑆𝑎 | + 𝑆𝑏 )2 + (2𝑆𝑡 )2 ≤ 𝑆𝐴
where
𝑆𝑎 = [

𝑖𝑎 𝐹𝑎
]
𝐴 𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

√(𝑖𝑖 𝑀𝑖 )2 + (𝑖𝑜 𝑀𝑜 )2
]
𝑆𝑏 = [
𝑍

𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

𝑆𝑡 = [

𝑖𝑡 𝑀𝑡
]
2𝑍 𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

𝐴 = un-corroded cross-sectional area of the pipe/fitting computed using nominal thickness 𝑡𝑛 and
outer diameter D, as per para. 319.3.5.
𝑖𝑎 = axial stress intensification factor = 1.0 for elbows, pipe bends and miter bends and 𝑖𝑎 = 𝑖𝑜 for
other components as per ASME B31J (2017)
𝐹𝑎 = range of axial force between any two thermal conditions being evaluated
𝑖𝑖 = in-plane stress intensification factor (SIF) as per ASME B31J (2017); shall not be < 1.0
𝑖𝑜 = out-of-plane SIF as per ASME B31J (2017); shall not be < 1.0
𝑖𝑡 = torsional SIF as per ASME B31J (2017); shall not be < 1.0
𝑀𝑖 = in-plane bending moment range between any two conditions being evaluated
𝑀𝑜 = out-of-plane bending moment range between any two conditions being evaluated
𝑀𝑡 = torsional moment range between any two conditions being evaluated
𝑍 = un-corroded section modulus as per para. 319.3.5 and para. 319.4.4 (a)
𝑆𝐴 = 𝑓 (1.25𝑆𝐶 + 0.25𝑆ℎ ), Eq. (1a) of para. 302.3.5(d)
𝑓 = stress range reduction factor from Eq. (1c) of para. 302.3.5 (d) = 6N -0.2 where f ≥ 0.15 and f ≤
1.0 (see Note 1 below)
𝑁= equivalent number of full displacement cycles during expected service of piping (= Number of
Thermal Cycles input into CAEPIPE through Options > Analysis > Temperature)
𝑆𝐶 = basic allowable stress at minimum metal temperature expected during the displacement cycle
under analysis
𝑆ℎ = basic allowable stress at maximum metal temperature expected during the displacement cycle
under analysis
when 𝑆ℎ is greater than 𝑆𝐿 , the allowable stress range may be calculated as
𝑆𝐴 = 𝑓 [1.25(𝑆𝐶 + 𝑆ℎ ) − 𝑆𝐿 ], Eq. (1b) of para. 302.3.5(d). This equation can be re-written as
𝑆𝐴 = 𝑓 (1.25𝑆𝐶 + 0.25𝑆ℎ ) + 𝑓(𝑆ℎ − 𝑆𝐿 ) (see Note 3 below)

This is specified as an analysis option “Use liberal allowable stresses”, in the menu Layout >
Options > Analysis > Code tab.
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Notes:

1. Young’s modulus of elasticity corresponding to reference temperature (T ref) is used to form the
stiffness matrix in accordance with para. 319.4.4 (a).
2. Refer to the end of this appendix for the details of “Thickness and Section Modulus used for
weight, allowable pressure and stress calculations”.
3. Para. 302.3.5 provides maximum value of Sc and Sh as 138 MPa (20 ksi). The reason for this
criterion is explicitly stated in Note 2 of para. 102.3.5 (b) (1) of ASME B31.1 (2020) as “For
materials with a minimum tensile strength of over 70 ksi (480 MPa), eqs. (1a) and (1b) shall be
calculated using Sc or Sh values no greater than 20 ksi (140 MPa), unless otherwise justified.”
Compliance to this criterion is checked using the value entered under Tensile Strength field of
CAEPIPE Material property input. If this field is NOT entered or left BLANK, then CAEPIPE
will compute the Tensile Strength of the material by multiplying the Allowable Stress at the
minimum temperature (at which the material properties are entered in CAEPIPE stress model)
with a factor of 3.5. This is because, the allowable stress for material below creep is generally
1/3.5 of Tensile Strength as stated in Section 1-100 of Mandatory Appendix 1 of ASME Section
II, Part D.
For example, if the allowable stress is 22,000 psi for a high strength material at the minimum
temperature of -20 deg. F, then the Tensile Strength would be 22,000 x 3.5 = 77,000 psi. So, in
this case, CAEPIPE will internally set the values of both Sc and Sh as 20,000 psi as Tensile
Strength is greater than 70,000 psi.
In addition, if the option “Use Liberal allowable stresses” is turned ON through Layout Window
> Options > Analysis > Code, then if the left over Sustained stress (= Sh - SL) is positive,
CAEPIPE will multiply this positive left over Sustained stress by the Stress range reduction
factor (f) and add that resulting value to the Expansion allowable stress computed using the
above equation (1a).
4. As per para. 319.2.1 (c), wind sway should be input into appropriate thermal load displacement.
Notes on Material Library for B313-2020.mat supplied with CAEPIPE:
Material library for ASME B31.3 (2020) [B313-2020.mat] supplied with CAEPIPE has been created
by referring to the values provided in Appendix A and Appendix C of ASME B31.3 (2020).
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Coefficient ‘Y’ used in CAEPIPE to compute Allowable Design Pressure of components
(extracted from Table 304.1.1 of ASME B31.3 – 2020)

Sl. No.
1.
2.
3.
4.
5.

Material Type
Ferritic Steels
(FS)
Austenitic
Steel (AS)
Nickel Alloys
(NA)
Gray Iron /
Cast Iron (CI)
Material
Types other
than
those
stated from
Sl. Nos. 1 to
4.

950
(510)

Values of ‘Y’ for Temperature, Deg F (Deg C)
1000
1050
1100
1150
1200
(538)
(566)
(593)
(621)
(649)

900
(482)
and
below
0.4

0.5

0.7

0.7

0.7

0.7

0.7

1250
(677)
and
above
0.7

0.4

0.4

0.4

0.4

0.5

0.7

0.7

0.7

0.4

0.4

0.4

0.4

0.4

0.4

0.5

0.7

0.0

0.0

0.0

0.0

0.0

0.0

0.0

0.0

0.4

0.4

0.4

0.4

0.4

0.4

0.4

0.4
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Weld Joint Strength Reduction Factors used in CAEPIPE to calculate the Allowable Internal Pressure of components (extracted from

Table 302.3.5 of ASME B31.3-2020)
Sl.
No.
1
2

3

4
5
6
7

Material
Type/Material
Description
Carbon Steel (CS)
Material
Description that
contains a string
“CrMo”
Ferritic
Steels
(FS) [CSEF & CSEF
(N+T)]
Austenitic Steel
(AS)
Nickel Alloy (NA)
Stainless
Steel
(SS)
Material Types
other than those
stated in Sl. Nos.
1 to 6

<=800
(427)
1.00
1.00

850
(454)
1.00
0.95

900
(482)
1.00
0.91

Weld Joint Strength Reduction Factor W for Temperature, Deg F (Deg C)
950
1000
1050
1100
1150
1200
1250
1300
1350
(510)
(538)
(566)
(593)
(621)
(649)
(677)
(704)
(732)
1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00
0.86
0.82
0.77
0.73
0.68
0.64
0.64
0.64
0.64

1.00

1.00

1.00

1.00

0.95

0.91

0.86

0.82

0.77

0.77

0.77

0.77

0.77

0.77

0.77

1.00

1.00

1.00

1.00

0.95

0.91

0.86

0.82

0.77

0.73

0.68

0.64

0.59

0.55

0.5

1.00
1.00

1.00
1.00

1.00
1.00

1.00
1.00

0.95
1.00

0.91
1.00

0.86
1.00

0.82
1.00

0.77
1.00

0.73
1.00

0.68
1.00

0.64
1.00

0.59
1.00

0.55
1.00

0.5
1.00

1.00

1400
(760)
1.00
0.64

1450
(788)
1.00
0.64

1500
(816)
1.00
0.64

W = 1 – 0.000909 (Tmax – Tcr) for Tmax> 800 deg. F (or 427 deg. C) and <= 1500 deg. F (or 816 deg. C),
where, Tcr is taken as 800 deg. F
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Allowable Internal Pressure

For straight pipes and bends, the allowable pressure is calculated using Eq. (3a) for straight
pipes and Eq. (3c) with I = 1.0 for bends from paras. 304.1.2. and 304.2.1. respectively.
Pa 

2SEWta
D  2Yta

where
Pa= allowable pressure
S = allowable stress as provided in para. 302.3.1 (a) and as per Table A-1
E = joint factor (input as material property) from Table A-1A as per para. 302.3.3. or Table
A-1B as per para. 302.3.4.
W = Weld Joint Strength Reduction Factor from para. 302.3.5 (e) and as per Table
302.3.5.Refer to the Table listed at the end of this section for details on Weld strength
reduction factor implemented in CAEPIPE.
ta= available thickness for pressure design
= tn × (1 - mill tolerance/100) - corrosion allowance “c”
(Any additional thickness required for threading, grooving, erosion, corrosion, etc. should be
included in corrosion allowance “c” in CAEPIPE)
tn= nominal pipe thickness
D = outside diameter
𝑑= inside diameter
𝑌 = coefficient from Table 304.1.1, valid for 𝑡𝑎 < 𝐷/6. Refer to the Table listed at the end
of this Section for details on ‘Y’ used in CAEPIPE.
𝑌=

𝑑+2𝑐
𝐷+𝑑+2𝑐

, valid for 𝑡𝑎 ≥ 𝐷/6 for all material types.

For closely spaced miter bends, the allowable pressure is calculated in CAEPIPE using Eq.
(4b) from para. 304.2.3.
𝑆𝐸𝑊𝑡𝑎 (𝑅 − 𝑟)
𝑃𝑎 =
𝑟(𝑅 − 𝑟/2)
For widely spaced miter bends with 𝜃<= 22.5 deg, the allowable pressure is calculated in
CAEPIPE using Eq. (4a) from para. 304.2.3 as
𝑆𝐸𝑊𝑡𝑎2
𝑃𝑎 =
𝑟(𝑡𝑎 + 0.643 tan 𝜃 √𝑟𝑡𝑎 )
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For widely spaced miter bends with 𝜃> 22.5 deg, the allowable pressure is calculated in
CAEPIPE using Eq. (4c) from para. 304.2.3 as
𝑆𝐸𝑊𝑡𝑎2
𝑃𝑎 =
𝑟(𝑡𝑎 + 1.25 tan 𝜃 √𝑟𝑡𝑎 )
where
𝑟 = mean radius of pipe = (D- tn)/2
𝑅 = effective bend radius of the miter (see para. 304.2.3 of code for definition) [an input
in CAEPIPE for miters]




1
.
0
1 

 = miter half angle = tan
  2R

 1.0  


 r
Sustained Stress

The stress (𝑆𝐿 ) due to sustained loads (pressure, weight and other sustained mechanical
loads) is calculated using Eqs. (23a), (23b1), (23b2), (23c) and (23d) from para. 320.2 and
para. 302.3.5 (c).
𝑆𝐿 = √(|𝑆𝑎 | + 𝑆𝑏 )2 + (2𝑆𝑡 )2 ≤ 𝑆ℎ
where
𝑆𝑎 = [

𝐼𝑎 𝐹𝑎
𝑃𝐷 𝑅
]
=[
+ ]
𝐴𝑝 𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑
4𝑡𝑠 𝐴𝑝 𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

𝑆𝑏 = [

√(𝐼𝑖 𝑀𝑖 )2 + (𝐼𝑜 𝑀𝑜 )2
]
𝑍𝑚

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

For branch (Leg 3 in Fig. 319.4.4B),
√(𝐼𝑖 𝑀𝑖 )2 + (𝐼𝑜 𝑀𝑜 )2
]
𝑆𝑏 = [
𝑍3
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

𝑆𝑡 = [
𝑃
𝐷
𝑡𝑆
𝑡𝑆
𝐴𝑝
𝐼𝑎
𝐹𝑎
𝑅

𝐼𝑡 𝑀𝑡
]
2𝑍𝑚 𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

= maximum of CAEPIPE input pressures P1 through P10
= outside diameter
= wall thickness used for sustained stress calculation after deducting corrosion
allowance from the nominal thickness
= nominal thickness – corrosion allowance in CAEPIPE, as per para. 320.1
= corroded cross-sectional area of the pipe computed using ts as per para. 320.1.
= longitudinal force index = 1.0
= longitudinal force due to sustained loads (pressure and weight)
= axial force due to weight alone, where weight is computed using nominal thickness.
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𝐼𝑖 =
𝐼𝑜 =
𝐼𝑡 =
𝑀𝑖 =
𝑀𝑜 =
𝑀𝑡 =
𝑍𝑚 =
𝑍3 =

𝑆ℎ

sustained in-plane moment index = 0.75𝑖𝑖 or 1.0, whichever is greater.
sustained out-of-plane moment index = 0.75𝑖𝑜 or 1.0, whichever is greater.
torsional moment index = 1.0
in-plane bending moment due to sustained loads e.g., pressure and weight
out-of-plane bending moment due to sustained loads e.g., pressure and weight
torsional moment due to sustained loads e.g., pressure and weight
corroded section modulus as per para. 320.1
effective corroded section modulus (Ze) when Appendix D of B31.3 is used to
compute ii and io (or) corroded section modulus (Zm) when B31J is used to compute
ii and io
= basic allowable stress at maximum temperature, i.e., max (Tref, T1 through T10)

Note:
ii andio are taken from Appendix D of B31.3 (2018) or ASME B31J (2017), when the
Analysis option “Use B31J for SIFs and Flexibility Factors” is Turned ON in CAEPIPE.
Sustained plus Occasional Stress

The stress (𝑆𝐿𝑜 ) due to sustained and occasional loads is calculated as the sum of stress (𝑆𝐿 )
due to sustained loads such as pressure and weight and stress (𝑆𝑜 ) due to occasional loads
such as earthquake or wind. Wind and earthquake are not considered as acting concurrently
(see para. 302.3.6(a)).
For temp ≤ 4270 C or 8000 F

𝑆𝐿𝑂 ≤ 1.33𝑆ℎ as per para. 302.3.6 (a)(1)
For temp > 4270 C or 8000 F

𝑆𝐿𝑂 ≤ min(0.9𝑊𝑆𝑦 , 4𝑆ℎ )as per para. 302.3.6 (a)(2) [only 302.3.6 (a)(2)(-a) and 302.3.6
(a)(2)(-b) considered]
where
𝑆𝐿𝑂 = 𝑆𝐿 + 𝑆𝑂 , where 𝑆𝐿 is computed as above, and 𝑆𝑜 is calculated using Eqs. (23a), (23b1),
(23b2), (23c) and (23d) with applicable loads as per para. 302.3.6 (a).
𝑆𝑂 = √(|𝑆𝑎𝑜 | + 𝑆𝑏𝑜 )2 + (2𝑆𝑡𝑜 )2
(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷 𝑅
𝐼𝑎 𝐹𝑎
]
𝑆𝑎𝑜 = [
=[
+ ]
𝐴𝑝 𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙
4𝑡𝑠
𝐴𝑝 𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙
𝑆𝑏𝑜 = [

√(𝐼𝑖 𝑀𝑖 )2 + (𝐼𝑜 𝑀𝑜 )2
]
𝑍𝑚

𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙
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For branch (Leg 3 in Fig. 319.4.4B)
𝑆𝑏𝑜

√(𝐼𝑖 𝑀𝑖 )2 + (𝐼𝑜 𝑀𝑜 )2
]
=[
𝑍3

𝑆𝑡𝑜 = [

𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

𝐼𝑡 𝑀𝑡
]
2𝑍𝑚 𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

= peak pressure = (peak pressure factor in CAEPIPE) x P
𝑅
= axial force due to occasional loads such as earthquake or wind
𝑀𝑖
= in-plane bending moment due to occasional loads such as earthquake or wind
𝑀𝑜
= out-of-plane bending moment due to occasional loads such as earthquake or wind
𝑀𝑡
= torsional moment due to occasional loads such as earthquake or wind
𝑆𝑦
= yield strength at maximum temperature, i.e., max (T ref, T1 through T10)
𝑊
= 1.0 for Austenetic stainless steel and 0.8 for all other materials as per para.
302.3.6(a)
𝑍𝑚 = corroded section modulus as per para. 320.1
𝑍3 = effective corroded section modulus (Ze) when Appendix D of B31.3 is used to
compute ii and io (or) corroded section modulus (Zm) when B31J is used to compute
ii and io
𝑃𝑝𝑒𝑎𝑘

Expansion Stress

The stress (𝑆𝐸 ) due to thermal expansion is calculated using Eq. 17 from para. 319.4.4
𝑆𝐸 = √(|𝑆𝑎 | + 𝑆𝑏 )2 + (2𝑆𝑡 )2
where
𝑆𝑎 = [

𝑖𝑎 𝐹𝑎
]
𝐴 𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

√(𝑖𝑖 𝑀𝑖 )2 + (𝑖𝑜 𝑀𝑜 )2
]
𝑆𝑏 = [
𝑍

𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

For branch (Leg 3 in Fig. 319.4.4B)
√(𝑖𝑖 𝑀𝑖 )2 + (𝑖𝑜 𝑀𝑜 )2
]
𝑆𝑏 = [
𝑍3

𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

𝑆𝑡 = [

𝐴

𝑖𝑡 𝑀𝑡
]
2𝑍 𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

= un-corroded cross-sectional area of the pipe/fitting computed using nominal
thickness 𝑡𝑛 and outer diameter D, as per para. 319.3.5.
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𝑖𝑎 = axial stress intensification factor = 1.0 for elbows, pipe bends and miter bends and
𝑖𝑎 = 𝑖𝑜 𝑜𝑟 𝑖 for other components as listed in Appendix D of B31.3 or as per B31J
𝐹𝑎 = range of axial force due to displacement strains between any two thermal conditions

being evaluated
𝑖𝑖 = in-plane stress intensification factor; shall not be less than 1.0
𝑖𝑜 = out-of-plane stress intensification factor; shall not be less than 1.0
𝑖𝑡 = torsional stress intensification factor as listed in Appendix D of B31.3or as per B31J
𝑀𝑖 = in-plane bending moment
𝑀𝑜 = out-of-plane bending moment
𝑀𝑡 = torsional moment
𝑍 = un-corroded section modulus as per para. 319.3.5 and para. 319.4.4 (a)
𝑍3 = effective un-corrodedsection modulus (Ze) when Appendix D of B31.3 is used to
compute ii and io (or) un-corrodedsection modulus (Z) when B31J is used to
compute ii and io
𝑆𝐴 = 𝑓 (1.25𝑆𝐶 + 0.25𝑆ℎ ), Eq. (1a) of para. 302.3.5(d)
𝑓 = stress range reduction factor from Eq. (1c) of para. 302.3.5 (d) = 6N -0.2
where f ≥ 0.15 and f ≤ 1.0 (see Note 1 below)
𝑁=
equivalent number of full displacement cycles during expected service of piping (=
Number of Thermal Cycles input into CAEPIPE through Options > Analysis >
Temperature)
𝑆𝐶 = basic allowable stress at minimum metal temperature expected during the
displacement cycle under analysis
𝑆ℎ = basic allowable stress at maximum metal temperature expected during the
displacement cycle under analysis
When 𝑆ℎ is greater than𝑆𝐿 , the allowable stress range may be calculated as
𝑆𝐴 = 𝑓 [1.25(𝑆𝐶 + 𝑆ℎ ) − 𝑆𝐿 ], Eq. (1b) of para. 302.3.5(d).
This is specified as an analysis option “Use liberal allowable stresses”, in the menu Layout >
Options > Analysis > Code tab.
Notes:

1. As per para. 302.3.5 (d), f = maximum value of stress range factor; 1.2 for ferrous
materials with specified minimum tensile strengths ≤ 517 MPa (75 ksi) and at Metal
temperatures ≤ 371°C (700°F). This criterion is not implemented in CAEPIPE as the
provision for entering the minimum tensile strength in material property is not available
at this time. Hence f ≤ 1.0 for all materials including Ferrous materials.
2. Young’s modulus of elasticity corresponding to reference temperature (Tref) is used to
form the stiffness matrix in accordance with para. 319.4.4 (a).
3. Refer end of this appendix for the details of “Thickness and Section Modulus used for
weight, pressure and stress calculations”.
4. 𝑖𝑖 and𝑖𝑜 are taken from Appendix D of B31.3 (2018) or ASME B31J (2017), when the
Analysis option “Use B31J for SIFs and Flexibility Factors” is Turned ON in CAEPIPE.
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Notes on Material Library for B313-2018.mat supplied with CAEPIPE:
Material library for ASME B31.3 (2018) [B313-2018.mat] supplied with CAEPIPE has been
created by referring to the values provided in Appendix A and Appendix C of ASME B31.3
(2018).
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Coefficient ‘Y’ used in CAEPIPE to compute Allowable Design Pressure of
components (extracted from Table 304.1.1 of ASME B31.3 – 2018)

Sl.
No.
1.
2.
3.
4.
5.

Material Type
Ferritic
Steels
(FS)
Austenitic Steel
(AS)
Nickel
Alloys
(NA)
Gray Iron / Cast
Iron (CI)
Material Types
other than those
stated from Sl.
Nos. 1 to 4.

Values of ‘Y’ for Temperature, Deg F (Deg C)
950
1000
1050
1100
1150
1200
(510)
(538)
(566)
(593)
(621)
(649)

900
(482)
and
below
0.4

0.5

0.7

0.7

0.7

0.7

0.7

1250
(677)
and
above
0.7

0.4

0.4

0.4

0.4

0.5

0.7

0.7

0.7

0.4

0.4

0.4

0.4

0.4

0.4

0.5

0.7

0.0

0.0

0.0

0.0

0.0

0.0

0.0

0.0

0.4

0.4

0.4

0.4

0.4

0.4

0.4

0.4
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Weld Strength Reduction Factors used in CAEPIPE to calculate the Allowable Design Pressure of components (extracted from Table 302.3.5
of ASME B31.3-2018)

Sl.
No.
1
2

3
4
5
6
7

Material Type/Material
Description
Carbon Steel (CS)
Material Description
that contains a string
“CrMo”
Ferritic Steels (FS)
[CSEF & CSEF (N+T)]
Austenitic Steel (AS)
Nickel Alloy (NA)
Stainless Steel (SS)
Material Types other
than those stated in Sl.
Nos. 1 to 6

<=80
0
(427)
1.00
1.00

850

900

950

Weld Strength Reduction Factor for Temperature, Deg F (Deg C)
1000
1050
1100
1150
1200
1250
1300
1350

1400

1450

1500

(454)
1.00
0.95

(482)
1.00
0.91

(510)
1.00
0.86

(538)
1.00
0.82

(566)
1.00
0.77

(593)
1.00
0.73

(621)
1.00
0.68

(649)
1.00
0.64

(677)
1.00
0.64

(704)
1.00
0.64

(732)
1.00
0.64

(760)
1.00
0.64

(788)
1.00
0.64

(816)
1.00
0.64

1.00

1.00

1.00

1.00

0.95

0.91

0.86

0.82

0.77

0.77

0.77

0.77

0.77

0.77

0.77

1.00
1.00
1.00
1.00

1.00
1.00
1.00

1.00
1.00
1.00

1.00
0.95
0.91
0.86
0.82
0.77
0.73
0.68
0.64
0.59
0.55
1.00
0.95
0.91
0.86
0.82
0.77
0.73
0.68
0.64
0.59
0.55
1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00
W = 1 – 0.000909 (Tmax – Tcr) for Tmax> 800 deg. F (or 427 deg. C) and <= 1500 deg. F (or 816 deg. C),
where, Tcr is taken as 800 deg. F

0.5
0.5
1.00
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Allowable Internal Pressure

For straight pipes and bends, the allowable pressure is calculated using Eq. (3a) for straight
pipes and Eq. (3c) with I = 1.0 for bends from paras. 304.1.2. and 304.2.1. respectively.
Pa 

2SEWta
D  2Yta

where
Pa= allowable pressure
S = allowable stress as provided in para. 302.3.1 (a) and as per Table A-1
E = joint factor (input as material property) from Table A-1A as per para. 302.3.3. or Table
A-1B as per para. 302.3.4.
W = Weld Joint Strength Reduction Factor from para. 302.3.5 (e) and as per Table 302.3.5 is
implemented in CAEPIPE as follows.
Tmax below denotes maximum operating temperature (i.e., max of T1 through T10 and Tref
in CAEPIPE).
With Material Type in CAEPIPE = CS [CrMo]

W = 1.0 with Tmax<= 8000 F (or 4270 C)
W = 0.64 with Tmax> 12000 F (or 6490 C) and
For Tmax> 8000 F (or 4270 C) and <= 12000 F (or 6490 C), the values of W are taken from
Table 302.3.5.
W for intermediate temperatures is linearly interpolated.
With Material Type in CAEPIPE = FS [CSEF (Subcritical)]

W = 1.0 with Tmax<= 9000 F (or 4820 C)
W = 0.5 with Tmax> 9000 F (or 4820C)
With Material Type in CAEPIPE = AS or NA

W = 1.0 with Tmax<= 9500 F (or 5100 C)
For Tmax> 9500 F (or 5100 C), the values of W are taken as per Table 302.3.5.
W for intermediate temperatures is linearly interpolated.
With Material Type in CAEPIPE = SS

W = 1.0 with Tmax<= 15000 F (or 8160 C)
For Other Material Types in CAEPIPE

W = 1.0 with Tmax<= 8000 F (or 4270 C)
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W = 1 – 0.000909 (Tmax – Tcr) for Tmax> 8000 F (or 4270 C) and<= 15000F (or 8100C)
where, Tcr is taken as 8000 F
ta= available thickness for pressure design
= tn × (1 - mill tolerance/100) - corrosion allowance “c”
(Any additional thickness required for threading, grooving, erosion, corrosion, etc. should be
included in corrosion allowance in CAEPIPE)
tn= nominal pipe thickness
D = outside diameter
𝑑
𝑌

= inside diameter
= coefficient from Table 304.1.1, valid for 𝑡𝑎 < 𝐷/6. Refer to the Table listed at the
end of this Section for details on ‘Y’ used in CAEPIPE.

𝑌

=

𝑑+2𝑐
𝐷+𝑑+2𝑐

, valid for 𝑡𝑎 ≥ 𝐷/6 for all material types.

For closely spaced miter bends, the allowable pressure is calculated in CAEPIPE using Eq.
(4b) from para. 304.2.3.
𝑆𝐸𝑊𝑡𝑎 (𝑅 − 𝑟)
𝑃𝑎 =
𝑟(𝑅 − 𝑟/2)
For widely spaced miter bends with 𝜃<= 22.5 deg, the allowable pressure is calculated in
CAEPIPE using Eq. (4a) from para. 304.2.3 as
𝑆𝐸𝑊𝑡𝑎2
𝑃𝑎 =
𝑟(𝑡𝑎 + 0.643 tan 𝜃 √𝑟𝑡𝑎 )
For widely spaced miter bends with 𝜃> 22.5 deg, the allowable pressure is calculated in
CAEPIPE using Eq. (4c) from para. 304.2.3 as
𝑆𝐸𝑊𝑡𝑎2
𝑃𝑎 =
𝑟(𝑡𝑎 + 1.25 tan 𝜃 √𝑟𝑡𝑎 )
where
𝑟 = mean radius of pipe = (D- tn)/2
𝑅 = effective bend radius of the miter (see para. 304.2.3 of code for definition) [an input
in CAEPIPE for miters]




1.0

 = miter half angle = tan 1 
  2R

 1.0  


 r
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Sustained Stress

The stress (𝑆𝐿 ) due to sustained loads (pressure, weight and other sustained mechanical
loads) is calculated using Eqs. (23a), (23b1), (23b2), (23c) and (23d) from para. 320.2 and
para. 302.3.5 (c).
𝑆𝐿 = √(|𝑆𝑎 | + 𝑆𝑏 )2 + (2𝑆𝑡 )2 ≤ 𝑆ℎ
where
𝑆𝑎 = [

𝐼𝑎 𝐹𝑎
𝑃𝐷 𝑅
]
=[
+ ]
𝐴𝑝 𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑
4𝑡𝑠 𝐴𝑝 𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

𝑆𝑏 = [

√(𝐼𝑖 𝑀𝑖 )2 + (𝐼𝑜 𝑀𝑜 )2
]
𝑍𝑚

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

For branch (Leg 3 in Fig. 319.4.4B),
√(𝐼𝑖 𝑀𝑖 )2 + (𝐼𝑜 𝑀𝑜 )2
]
𝑆𝑏 = [
𝑍𝑒
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

𝑆𝑡 = [

𝐼𝑡 𝑀𝑡
]
2𝑍𝑚 𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

= maximum of CAEPIPE input pressures P1 through P10
= outside diameter
= wall thickness used for sustained stress calculation after deducting corrosion
allowance from the nominal thickness
𝑡𝑆 = nominal thickness – corrosion allowance in CAEPIPE, as per para. 320.1
𝐴𝑝 = corroded cross-sectional area of the pipe computed using ts as per para. 320.1.
𝐼𝑎 = longitudinal force index = 1.0
𝐹𝑎 = longitudinal force due to sustained loads (pressure and weight)
𝑅 = axial force due to weight alone, where weight is computed using nominal thickness.
𝐼𝑖 = sustained in-plane moment index = 0.75𝑖𝑖 or 1.0, whichever is greater.
𝐼𝑜 = sustained out-of-plane moment index = 0.75𝑖𝑜 or 1.0, whichever is greater.
where𝑖𝑖 and 𝑖𝑜 are taken from Appendix D of B31.3 (2016).
𝐼𝑡 = torsional moment index = 1.0
𝑀𝑖 = in-plane bending moment due to sustained loads e.g., pressure and weight
𝑀𝑜 = out-of-plane bending moment due to sustained loads e.g., pressure and weight
𝑀𝑡 = torsional moment due to sustained loads e.g., pressure and weight
𝑍𝑚 = corroded section modulus as per para. 320.1
𝑍𝑒 = effective corroded section modulus for branch as per para. 320.2
𝑃
𝐷
𝑡𝑆
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Sustained plus Occasional Stress

The stress (𝑆𝐿𝑜 ) due to sustained and occasional loads is calculated as the sum of stress (𝑆𝐿 )
due to sustained loads such as pressure and weight and stress (𝑆𝑜 ) due to occasional loads
such as earthquake or wind. Wind and earthquake are not considered as acting concurrently
(see para. 302.3.6(a)).
For temp ≤ 4270 C or 8000 F

𝑆𝐿𝑂 ≤ 1.33𝑆ℎ
For temp > 4270 C or 8000 F

𝑆𝐿𝑂 ≤ 0.9𝑊𝑆𝑦
where
𝑆𝐿𝑂 = 𝑆𝐿 + 𝑆𝑂 , where 𝑆𝐿 is computed as above, and 𝑆𝑜 is calculated using Eqs. (23a), (23b1),
(23b2), (23c) and (23d) with applicable loads.
𝑆𝑂 = √(|𝑆𝑎𝑜 | + 𝑆𝑏𝑜 )2 + (2𝑆𝑡𝑜 )2
(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷 𝑅
𝐼𝑎 𝐹𝑎
]
𝑆𝑎𝑜 = [
=[
+ ]
𝐴𝑝 𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙
4𝑡𝑠
𝐴𝑝 𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙
𝑆𝑏𝑜 = [

√(𝐼𝑖 𝑀𝑖 )2 + (𝐼𝑜 𝑀𝑜 )2
]
𝑍𝑚

𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

For branch (Leg 3 in Fig. 319.4.4B)
𝑆𝑏𝑜 = [
𝑆𝑡𝑜 = [

√(𝐼𝑖 𝑀𝑖 )2 + (𝐼𝑜 𝑀𝑜 )2
]
𝑍𝑒

𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

𝐼𝑡 𝑀𝑡
]
2𝑍𝑚 𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

= peak pressure = (peak pressure factor in CAEPIPE) x P
= axial force due to occasional loads such as earthquake or wind
= in-plane bending moment due to occasional loads such as earthquake or wind
= out-of-plane bending moment due to occasional loads such as earthquake or wind
= torsional moment due to occasional loads such as earthquake or wind
= yield strength at maximum temperature, i.e., max (T ref, T1 through T10)
= 1.0 for Austenetic stainless steel and 0.8 for all other materials as per para.
302.3.6(a)
= corroded section modulus as per para. 320.1
= effective corroded section modulus for branch as per para. 320.2

𝑃𝑝𝑒𝑎𝑘

𝑅
𝑀𝑖
𝑀𝑜
𝑀𝑡
𝑆𝑦
𝑊
𝑍𝑚
𝑍𝑒
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Expansion Stress

The stress (𝑆𝐸 ) due to thermal expansion is calculated using Eq. 17 from para. 319.4.4
𝑆𝐸 = √(|𝑆𝑎 | + 𝑆𝑏 )2 + (2𝑆𝑡 )2
where
𝑆𝑎 = [

𝑖𝑎 𝐹𝑎
]
𝐴 𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

√(𝑖𝑖 𝑀𝑖 )2 + (𝑖𝑜 𝑀𝑜 )2
]
𝑆𝑏 = [
𝑍

𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

For branch (Leg 3 in Fig. 319.4.4B)
√(𝑖𝑖 𝑀𝑖 )2 + (𝑖𝑜 𝑀𝑜 )2
]
𝑆𝑏 = [
𝑍𝑒

𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

𝑆𝑡 = [

𝑖𝑡 𝑀𝑡
]
2𝑍 𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

= un-corroded cross-sectional area of the pipe/fitting computed using nominal
thickness 𝑡𝑛 and outer diameter D, as per para. 319.3.5.
𝑖𝑎 = axial stress intensification factor = 1.0 for elbows, pipe bends and miter bends and
𝑖𝑎 = 𝑖𝑜 𝑜𝑟 𝑖 for other components as listed in Appendix D of B31.3 (2016)
𝐹𝑎 = range of axial force due to displacement strains between any two thermal conditions
being evaluated
𝑖𝑖 = in-plane stress intensification factor; shall not be less than 1.0
𝑖𝑜 = out-of-plane stress intensification factor; shall not be less than 1.0
𝑖𝑡 = torsional stress intensification factor = 1.0
𝑀𝑖 = in-plane bending moment
𝑀𝑜 = out-of-plane bending moment
𝑀𝑡 = torsional moment
𝑍 = un-corroded section modulus as per para. 319.3.5 and para. 319.4.4 (a)
𝑍𝑒 = un-corroded effective section modulus as per para. 319.3.5 and para. 319.4.4 (c)
𝐴

= 𝑓 (1.25𝑆𝐶 + 0.25𝑆ℎ ), Eq. (1a) of para. 302.3.5(d)
= stress range reduction factor from Eq. (1c) of para. 302.3.5 (d) = 6N -0.2
where f ≥ 0.15 and f ≤ 1.0 (see Note 1 below)
𝑆𝐶 = basic allowable stress at minimum metal temperature expected during the
displacement cycle under analysis
𝑆ℎ = basic allowable stress at maximum metal temperature expected during the
displacement cycle under analysis
When 𝑆ℎ is greater than𝑆𝐿 , the allowable stress range may be calculated as
𝑆𝐴 = 𝑓 [1.25(𝑆𝐶 + 𝑆ℎ ) − 𝑆𝐿 ], Eq. (1b) of para. 302.3.5(d).
𝑆𝐴
𝑓
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This is specified as an analysis option “Use liberal allowable stresses”, in the menu Layout >
Options > Analysis > Code tab.
Notes:

1. As per para. 302.3.5 (d), f = maximum value of stress range factor; 1.2 for ferrous
materials with specified minimum tensile strengths ≤ 517 MPa (75 ksi) and at Metal
temperatures ≤ 371°C (700°F). This criterion is not implemented in CAEPIPE as the
provision for entering the minimum tensile strength in material property is not available
at this time. Hence f ≤ 1.0 for all materials including Ferrous materials.
2. Young’s modulus of elasticity corresponding to reference temperature (Tref) is used to
form the stiffness matrix in accordance with para. 319.4.4 (a).
3. Refer end of this appendix for the details of “Thickness and Section Modulus used for
weight, pressure and stress calculations”.
Notes on Material Library for B313-2016.mat supplied with CAEPIPE:
Material library for ASME B31.3 (2016) [B313-2016.mat]supplied with CAEPIPE has been
created by referring to the values provided in Appendix A and Appendix C of ASME B31.3
(2016).
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Coefficient ‘Y’ used in CAEPIPE to compute Allowable Design Pressure of
components (extracted from Table 304.1.1 of ASME B31.3 – 2016)

Sl.
No.
1.
2.
3.
4.
5.

Material Type
Ferritic
Steels
(FS)
Austenitic Steel
(AS)
Nickel
Alloys
(NA)
Gray Iron / Cast
Iron (CI)
Material Types
other than those
stated from Sl.
Nos. 1 to 4.

Values of ‘Y’ for Temperature, Deg F (Deg C)
950
1000
1050
1100
1150
1200
(510)
(538)
(566)
(593)
(621)
(649)

900
(482)
and
below
0.4

0.5

0.7

0.7

0.7

0.7

0.7

1250
(677)
and
above
0.7

0.4

0.4

0.4

0.4

0.5

0.7

0.7

0.7

0.4

0.4

0.4

0.4

0.4

0.4

0.5

0.7

0.0

0.0

0.0

0.0

0.0

0.0

0.0

0.0

0.4

0.4

0.4

0.4

0.4

0.4

0.4

0.4
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Allowable Internal Pressure

For straight pipes and bends, the allowable pressure is calculated using Eq. (3a) for straight
pipes and Eq. (3c) with I = 1.0 for bends from paras. 304.1.2. and 304.2.1. respectively.

Pa 

2SEWta
D  2Yt a

where
Pa= allowable pressure
S = allowable stress as provided in para. 302.3.1 (a) and as per Table A-1
E = joint factor (input as material property) from Table A-1A or A-1B from para. 302.3.3.
and para. 302.3.4.
W = Weld Joint Strength Reduction Factor from para. 302.3.5 (e) and as per Table 302.3.5 is
implemented in CAEPIPE as follows. Tmax below denotes maximum operating temperature
(i.e., max of T1 through T10 and Tref in CAEPIPE).
With Material Type in CAEPIPE = CS [CrMo]

W = 1.0 with Tmax<= 8000 F (or 4270 C)
W = 0.64 with Tmax> 12000 F (or 6490 C) and
For Tmax> 8000 F (or 4270 C) and <= 12000 F (or 6490 C), the values of W are taken from
Table 302.3.5.
W for intermediate temperatures is linearly interpolated.
With Material Type in CAEPIPE = FS [CSEF (Subcritical)]

W = 1.0 with Tmax<= 9000 F (or 4820 C)
W = 0.5 with Tmax> 9000 F (or 4820C)
With Material Type in CAEPIPE = AS or NA

W = 1.0 with Tmax<= 9500 F (or 5100 C)
For Tmax> 9500 F (or 5100 C), the values of W are taken as per Table 302.3.5.
W for intermediate temperatures is linearly interpolated.
With Material Type in CAEPIPE = SS

W = 1.0 with Tmax<= 15000 F (or 8160 C)
For Other Material Types in CAEPIPE

W = 1.0 with Tmax<= 8000 F (or 4270 C)
W = 1 – 0.000909 (Tmax – Tcr) for Tmax> 8000 F (or 4270 C) and<= 15000F (or 8100C)
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where, Tcr is taken as 8000 F
ta= available thickness for pressure design
= tn × (1 - mill tolerance/100) - corrosion allowance “c”
(Any additional thickness required for threading, grooving, erosion, corrosion, etc. should be
included in corrosion allowance in CAEPIPE)
tn= nominal pipe thickness
D = outside diameter
𝑑
𝑌

= inside diameter
= Pressure coefficient from Table 304.1.1, valid for 𝑡𝑎 < 𝐷/6, and

𝑌

=

𝑑+2𝑐

𝐷+𝑑+2𝑐

, valid for 𝑡𝑎 ≥ 𝐷/6

For closely spaced miter bends, the allowable pressure is calculated using Eq. (4b) from para.
304.2.3.
𝑆𝐸𝑊𝑡𝑎 (𝑅 − 𝑟)
𝑃𝑎 =
𝑟(𝑅 − 𝑟/2)
where
𝑟 = mean radius of pipe = (D- tn)/2
𝑅 = effective bend radius of the miter (see para. 304.2.3 of code for definition)
For widely spaced miter bends, the allowable pressure is calculated using Eq. (4c) from para.
304.2.3 as
𝑆𝐸𝑊𝑡𝑎2
𝑃𝑎 =
𝑟(𝑡𝑎 + 1.25 tan 𝜃 √𝑟𝑡𝑎 )
where
𝜃 = miter half angle
Sustained Stress

The stress (𝑆𝐿 ) due to sustained loads (pressure, weight and other sustained mechanical
loads) is calculated using Eq. (23a) and (23b) from para. 320.2 and para. 302.3.5 (c).
𝑆𝐿 = √(|𝑆𝑎 | + 𝑆𝑏 )2 + (2𝑆𝑡 )2 ≤ 𝑆ℎ
where
𝑆𝑎 = [

𝐼𝑎 𝐹𝑎
]
𝐴𝑝

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

𝑃𝐷 𝑅
=[
+ ]
4𝑡𝑠 𝐴𝑝

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

√(𝐼𝑖 𝑀𝑖 )2 + (𝐼𝑜 𝑀𝑜 )2
]
𝑆𝑏 = [
𝑍𝑚
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑
𝐼𝑡 𝑀𝑡
𝑆𝑡 = [
]
2𝑍𝑚 𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑
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= maximum of CAEPIPE input pressures P1 through P10
= outside diameter
= wall thickness used for sustained stress calculation after deducting corrosion
allowance from the nominal thickness
𝑡𝑆 = nominal thickness – corrosion allowance in CAEPIPE, as per para. 320.1
𝐴𝑝 = corroded cross-sectional area of the pipe computed using ts as per para. 320.1.
𝐼𝑎 = longitudinal force index = 1.0
𝐹𝑎 = longitudinal force due to sustained loads (pressure and weight)
𝑅 = axial force due to weight
𝐼𝑖 = in-plane stress intensification factor; the product of0.75𝑖𝑖 shall not be less than 1.0
𝐼𝑜 = out-of-plane stress intensification factor; the product of 0.75𝑖𝑜 shall not be less than
1.0
𝐼𝑡 = torsional moment index = 1.0
𝑀𝑖 = in-plane bending moment due to sustained loads e.g., pressure and weight
𝑀𝑜 = out-of-plane bending moment due to sustained loads e.g., pressure and weight
𝑀𝑡 = torsional moment due to sustained loads e.g., pressure and weight
𝑍𝑚 = corroded section modulus as per para. 320.1; for reduced outlets / branch
connections, effective section modulus
𝑍𝑚 = hot allowable stress at maximum temperature [i.e., at Max(Tref, T1 through T10)]
𝑃
𝐷
𝑡𝑆

Sustained plus Occasional Stress

The stress (𝑆𝐿𝑜 ) due to sustained and occasional loads is calculated as the sum of stress due
to sustained loads such as due to pressure and weight (𝑆𝐿 ) and stress due to occasional loads
(𝑆𝑜 ) such as due to earthquake or wind. Wind and earthquake are not considered
concurrently (see para. 302.3.6(a)).
For temp ≤ 4270 C or 8000 F

𝑆𝐿𝑂 ≤ 1.33𝑆ℎ
For temp > 4270 C or 8000 F

𝑆𝐿𝑂 ≤ 0.9𝑊𝑆𝑦
where
𝑆𝐿𝑂 = 𝑆𝐿 + 𝑆𝑂 , where 𝑆𝐿 is computed as above, and
𝑆𝑂 = √(|𝑆𝑎𝑜 | + 𝑆𝑏𝑜 )2 + (2𝑆𝑡𝑜 )2
(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷 𝑅
𝐼𝑎 𝐹𝑎
]
𝑆𝑎𝑜 = [
=[
+ ]
𝐴𝑝 𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙
4𝑡𝑠
𝐴𝑝 𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙
𝑆𝑏𝑜 = [

√(𝐼𝑖 𝑀𝑖 )2 + (𝐼𝑜 𝑀𝑜 )2
]
𝑍𝑚

𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙
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𝑆𝑡𝑜 = [

𝐼𝑡 𝑀𝑡
]
2𝑍𝑚 𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙
=
=
=
=
=
=
=

𝑃𝑝𝑒𝑎𝑘

𝑅
𝑀𝑖
𝑀𝑜
𝑀𝑡
𝑆𝑦
𝑊

peak pressure = (peak pressure factor in CAEPIPE) x P
axial force due to occasional loads such as earthquake or wind
in-plane bending moment due to occasional loads such as earthquake or wind
out-of-plane bending moment due to occasional loads such as earthquake or wind
torsional moment due to occasional loads such as earthquake or wind
yield strength at maximum temperature, i.e., max(Tref, T1 through T10)
1.0 for Austeniticstainless steel and 0.8 for all other materials as per para.302.3.6(a)

Expansion Stress

The stress (𝑆𝐸 ) due to thermal expansion is calculated using Eq. 17 from para. 319.4.4
𝑆𝐸 = √(|𝑆𝑎 | + 𝑆𝑏 )2 + (2𝑆𝑡 )2
where
𝑆𝑎 = [

𝑖𝑎 𝐹𝑎
]
𝐴 𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

√(𝑖𝑖 𝑀𝑖 )2 + (𝑖𝑜 𝑀𝑜 )2
]
𝑆𝑏 = [
𝑍

𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

𝑆𝑡 = [

𝑖𝑡 𝑀𝑡
]
2𝑍 𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

= un-corroded cross-sectional area of the pipe/fitting computed using nominal
thickness 𝑡𝑛 and outer diameter D, as per para. 319.3.5.
𝑖𝑎 = axial stress intensification factor = 1.0 for elbows, pipe bends and miter bends and
𝑖𝑎 = 𝑖𝑜 for other components as listed in Appendix D of B31.3 (2014)
𝐹𝑎 = range of axial force due to displacement strains between any two thermal conditions
being evaluated
𝑖𝑖 = in-plane stress intensification factor; shall not be less than 1.0
𝑖𝑜 = out-of-plane stress intensification factor; shall not be less than 1.0
𝑖𝑡 = torsional stress intensification factor = 1.0
𝑀𝑖 = in-plane bending moment
𝑀𝑜 = out-of-plane bending moment
𝑀𝑡 = torsional moment
𝑍 = un-corroded section modulus as per para. 319.3.5; for reduced outlets/branch
connections, effective section modulus as per para. 319.4.4 (a)
𝑆𝐴 = 𝑓 (1.25𝑆𝐶 + 0.25𝑆ℎ ), Eq. (1a) of para. 302.3.5(d)
𝑓 = stress range reduction factor from Eq. (1c) of para. 302.3.5 (d) = 6N -0.2
where f ≥ 0.15 and f ≤ 1.0 (see Note 1 below)
𝑆𝐶 = basic allowable stress at minimum metal temperature expected during the
displacement cycle under analysis
𝐴
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= basic allowable stress at maximum metal temperature expected during the
displacement cycle under analysis
When 𝑆ℎ is greater than𝑆𝐿 , the allowable stress range may be calculated as
𝑆𝐴 = 𝑓 [1.25(𝑆𝐶 + 𝑆ℎ ) − 𝑆𝐿 ], Eq. (1b) of para. 302.3.5(d).
𝑆ℎ

This is specified as an analysis option “Use liberal allowable stresses”, in the menu Layout
>Options>Analysis >Code tab.
Notes:

1. As per para. 302.3.5 (d), f = maximum value of stress range factor; 1.2 for ferrous
materials with specified minimum tensile strengths ≤ 517 MPa (75 ksi) and at Metal
temperatures ≤ 371°C (700°F). This criterion is not implemented in CAEPIPE as the
provision for entering the minimum tensile strength in material property is not available
at this time. Hence f ≤ 1.0 for all materials including Ferrous materials.
2. Refer end of this appendix for the details of “Thickness and Section Modulus used for
weight, pressure and stress calculations”.
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Allowable Pressure

For straight pipes and bends (including closely spaced and widely spaced miter bends), the
allowable pressure is calculated from para. 403.2.1.
𝑃𝑖 =
where
𝑃𝑖 =
𝑆 =
𝐹 =
𝑆𝑦 =
𝐸 =
𝑡𝑎 =
=
𝐷

2𝑆𝑡𝑎
𝐷

allowable pressure
allowable stress = F x E x Sy
Design Factor = 0.72 as specified in para 403.2.1
specified minimum yield strength of pipe at Design Temperature input in CAEPIPE
weld joint factor as defined in Table 403.2.1-1
available thickness for pressure design
𝑡𝑛 ×(1 – mill tolerance/100) – sum of allowances, as per para. 403.2.1, for
corrosion, threading, grooving and erosion.
= outside diameter

Stress due to Sustained Loads (Unrestrained Piping)

For Pipes (as per para. 402.6.2)
𝑆𝐿 = |

𝑃𝐷 𝐹𝑎
√(𝑖𝑖 𝑀𝑖 )2 + (𝑖𝑜 𝑀𝑜 )2 + (𝑀𝑡 )2
]
+ |
+[
4𝑡𝑛 𝐴 𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑
𝑍

≤ 0.75𝑆𝑦

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

as per Table 403.3.1-1
where
𝑖𝑖
𝑖𝑜

= in-plane stress intensification factor; for straight pipes, 𝑖𝑖 = 1.0
= out-of-plane stress intensification factor; for straight pipes, 𝑖𝑜 = 1.0

For Fittings & Components.(as per para. 402.6.2)
𝑆𝐿(𝑓𝑐) = |

𝑃𝐷 𝐹𝑎
√(0.75𝑖𝑖 𝑀𝑖 )2 + (0.75𝑖𝑜 𝑀𝑜 )2 + (𝑀𝑡 )2
]
+ |
+[
4𝑡𝑛 𝐴 𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑
𝑍

≤ 0.75𝑆𝑦

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

as per Table 403.3.1-1
where
𝑃 = maximum operating pressure = max. of CAEPIPE input pressures P1 through P10
Due considerations shall be given as per para. 401.2.2.2 while inputting pressure
values in CAEPIPE.
𝐷 = outside diameter
𝑡𝑛 = nominal thickness as per para. 402.1
𝑖𝑖 = in-plane stress intensification factor; the product 0.75𝑖𝑖 shall not be less than 1.0
𝑖𝑜 = out-of-plane stress intensification factor; the product 0.75𝑖𝑜 shall not be less than 1.0
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𝑀𝑖 = in-plane bending moment
𝑀𝑜 = out-of-plane bending moment
𝑀𝑡 = torsional moment
𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus
𝐹𝑎 = axial force component for external loads
𝐴= nominal cross-section area
𝑆𝑦 =specified minimum yield strength of pipe at maximum CAEPIPE temperature [i.e., at
max (Tref, T1 through T10)]
Stress due to Sustained Loads + Occasional Loads (Unrestrained Piping)

For Pipes (as per para. 402.6.2)
𝑆𝐿𝑂 = SL + |

(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷 𝐹𝑎
√(𝑖𝑖 𝑀𝑖 )2 + (𝑖𝑜 𝑀𝑜 )2 + (𝑀𝑡 )2
+ |
+[
]
4𝑡𝑛
𝐴 𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙
𝑍

≤ 0.8𝑆𝑦

𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

as per Table 403.3.1-1
For Fittings & Components (as per para. 402.6.2)
𝑆𝐿𝑂 = 𝑆𝐿(𝑓𝑐) + |

(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷 𝐹𝑎
√(0.75𝑖𝑖 𝑀𝑖 )2 + (0.75𝑖𝑜 𝑀𝑜 )2 + (𝑀𝑡 )2
+ |
+[
]
4𝑡𝑛
𝐴 𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙
𝑍

≤ 0.8𝑆𝑦

𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

as per Table 403.3.1-1
where
𝑃𝑝𝑒𝑎𝑘 = peak pressure = (peak pressure factor x P) where P = maximum operating
pressure, as defined above with 1.0 ≤ peak pressure factor ≥ 1.1 as per para.
403.3.4
Expansion Stress (Unrestrained Piping)

The stress (𝑆𝐸 ) due to thermal expansion is calculated from para.402.5.2
𝑆𝐸 = √𝑆𝑏2 + 4𝑆𝑡2 ≤ 𝑆𝐴 as per Table 403.3.1-1 and para. 403.3.2

where
𝑆𝑏 = resultant bending stress =
Mt

√(𝑖𝑖 𝑀𝑖 )2+(𝑖𝑜 𝑀𝑜 )2
Z

𝑆𝑡 = torsional stress = 2Z
𝑀𝑡 = torsional moment
𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus
Please note, “Liberal allowable” option is always turned ON for ANSI B31.4
𝑆𝐴 = 𝑓[1.25(𝑆𝐶 + 𝑆ℎ ) − 𝑆𝐿 ]
𝑓 = stress range reduction factor = 6/N0.2 , where N = number of equivalent full range
Cycles, where𝑓 ≤ 1.2 (from para. 403.3.2).
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𝑆𝑐 = 0.67𝑆𝑦 at the lower of the installed temperature or minimum operating temperature
𝑆ℎ = 0.67𝑆𝑦 at the higher of the installed temperature or maximum operating temperature
𝑆𝑦 = specified minimum yield strength of pipe at maximum operating temperature [i.e., at
max (Tref, T1 through T10)]
Stress due to Sustained, Thermal and Occasional Loads (Restrained Piping)

The Net longitudinal stress (SL) due to sustained, thermal expansion and occasional loads for
restrained piping is calculated from para. 402.6.1

𝑆𝐿𝑝 = 𝑆𝐸 + 𝜐𝑆𝐻 +
𝑆𝐿𝑛 = 𝑆𝐸 + 𝜐𝑆𝐻 +

𝐹𝑎
𝐴
𝐹𝑎
𝐴

+
−

𝑀
𝑍
𝑀
𝑍

As per para. 402.6.1, both positive and negative values of M/Z shall be considered for
analysis.
Where
𝑆𝐸 = Thermal expansion stress = 𝐸𝛼 (𝑇𝑖 − 𝑇𝑜 ), which can either be positive or negative
𝑆𝐻 = circumferential (hoop) stress =

𝑃𝐷
2𝑡𝑛

𝜐 = Poission’s ratio = 0.3 as per para. 402.2.3

As per para. 402.6.1, 𝑆𝐻 can be either positive or negative.
𝐹𝑎 = axial force, such as weight on a riser. As per para. 402.6.1, 𝐹𝑎 can be positive or negative.

M = bending moment from Weight and other Sustained and Occasional loads
For Pipes
M = √(𝑖𝑖 𝑀𝑖 )2 + (𝑖𝑜 𝑀𝑜 )2
For Fittings & Components
𝑀 = √(0.75𝑖𝑖 𝑀𝑖 )2 + (0.75𝑖𝑜 𝑀𝑜 )2
where
𝑃 = PFO x max. pressure (P1 through P10) entered in CAEPIPE.
𝑃𝐹𝑂 = Peak Pressure Factor input. PFO = 1.0, if occasional loads are not present.
𝐷 = outside diameter
𝑡𝑛 = nominal thickness
𝑖𝑖 = in-plane stress intensification factor; the product 0.75ii shall not be less than 1.0
𝑖𝑜 = out-of-plane stress intensification factor; the product 0.75ioshall not be less than 1.0
𝑀𝑖 = in-plane bending moment from Weight and other Sustained and Occasional loads
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𝑀𝑜 = out-of-plane bending moment from Weight and other Sustained and Occasional loads
𝐹𝑎 = axial force component for Weight and other Sustained and Occasional loads
𝐴= nominal cross-section area
𝑍= un-corroded section modulus; for reduced outlets, effective section modulus
𝑆𝑦 = specified minimum yield strength of pipe at maximum operating temperature [i.e., at
max (Tref, T1 through T10)]
𝑇𝑖 = installation temperature = Tref in CAEPIPE
𝑇𝑜 = warmest or coldest operating temperature
𝛼 = coefficient of thermal expansion at To defined above
𝐸= young’s modulus at ambient (reference) temperature
Combining of Stresses (Restrained Piping)

The longitudinal and circumferential stresses are combined in accordance with the maximum
shear stress theory as follows (by default in CAEPIPE).
2

S𝑒𝑞1 = 2√[(𝑆𝐿𝑝 − 𝑆𝐻 )/2] + (𝑆𝑡 )2

S𝑒𝑞2 = 2√[(𝑆𝐿𝑛 − 𝑆𝐻 )/2]2 + (𝑆𝑡 )2

whereSLp and SLn are calculated as given above.
Alternatively, the stresses may be combined in accordance with the maximum distortion
energy theory as follows (see Note 4 below):
2

S𝑒𝑞1 =√(𝑆𝐻 )2 − 𝑆𝐻 𝑆𝐿𝑝 + (𝑆𝐿𝑝 ) + 3(𝑆𝑡 )2

S𝑒𝑞2 = √(𝑆𝐻 )2 − 𝑆𝐻 𝑆𝐿𝑛 + (𝑆𝐿𝑛 )2 + 3(𝑆𝑡 )2

S𝑒𝑞 = 𝑚𝑎𝑥{𝑆𝑒𝑞1 , 𝑆𝑒𝑞2 } ≤ 0.9𝑆𝑦
where
S𝑒𝑞 = equivalent combined stress
M

S𝑡 = torsional stress = 2Zt
𝑀𝑡 = torsional moment from Weight and other Sustained and Occasional loads
Notes:
1. Para. 402.6.2 of B31.4 (2019) states that “Longitudinal stress from pressure in an
unrestrained line should include consideration of bending stress or axial stress that may
be caused by elongation of the pipe due to internal pressure and result in stress at bends
and at connections and produce additional loads on equipment and on supports”.
The above statement seems to imply that “elongation due to Bourdon effect” is to be
included in the Sustained load case (and hence in Operating case and Sustained plus
Occasional load case).
On the other hand, since the deformation due to Bourdon effect is being constrained by
piping supports, CAEPIPE includes the Bourdon effect as part of the results for
Thermal Expansion (when “Solve Thermal Case” is opted) or as part of the Operating
Case (when “Thermal = Operating – Sustained is opted).
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2. Young’s modulus of elasticity corresponding to reference temperature (Tref) is used to
form the stiffness matrix in accordance with para. 402.2.2.
3. Refer end of this appendix for the details of “Thickness and Section Modulus used for
weight, pressure and stress calculations”.
4. By default, CAEPIPE combines the stresses for restrained piping using the maximum
shear stress theory as stated above. To combine stresses in accordance with the
maximum distortion energy theory as stated above, set an environmental variable with
name “DET_314” with its value as “YES”.
5. Stress Intensification Factors (SIFs) and Flexibility Factors (FFs) are computed using
ASME B31.4 (2019) by default. When the option “Use B31J for SIFs and Flexibility
Factors” is Turned ON, then CAEPIPE computes SIFs and FFs as per B31J (2017).
Notes on Material Library for B314-2019.mat supplied with CAEPIPE:
Material library for ASME B31.4 (2019) [B314-2019.mat] has been created and supplied with
CAEPIPE as mentioned below.
1. Coefficient of Thermal Expansion: As stated in para. 402.2.1 of B31.4 (2019),
Coefficient of Thermal Expansion for Carbon and low alloy high tensile steel are entered
as 6.5E-6 in./in./0F for temperatures up to 250 0F.
2. Modulus of Elasticity: Modulus of Elasticity for Carbon and low alloy high tensile steel
for temperatures up to 250 0F are entered by referring to the values provided in Table
832.5-1 of ASME B31.8 (2018).
3. Yield Strength: Yield Strength for Carbon and low alloy high tensile steel for
temperatures up to 250 0F are entered by referring to the values specified in Mandatory
Appendix D titled “Specified Minimum Yield Strength for Steel Pipe Commonly Used in
Piping Systems” of ASME B31.8 (2018).
4. Density and Poisson’s ratio: Density and Poisson’s ratio for Carbon and low alloy high
tensile steel are entered as 0.283 lb/in3 and 0.3 respectively.
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Allowable Pressure

For straight pipes and bends (including closely spaced and widely spaced miter bends), the
allowable pressure is calculated from para. 403.2.1.
𝑃𝑖 =
where
𝑃𝑖 =
𝑆 =
𝐸 =
𝑡𝑎 =
=
𝐷

2𝑆𝐸𝑡𝑎
𝐷

allowable pressure
allowable stress = 0.72 Sy, where 𝑆𝑦 is specified minimum yield strength of pipe
weld joint factor as defined in Table 403.2.1-1
available thickness for pressure design
𝑡𝑛 ×(1 – mill tolerance/100) – sum of allowances, as per para. 403.2.1, for
corrosion, threading, grooving and erosion.
= outside diameter

Stress due to Sustained Loads (Unrestrained Piping)

For Pipes (as per para. 402.6.2)
𝑆𝐿 = |

𝑃𝐷 𝐹𝑎
√(𝑖𝑖 𝑀𝑖 )2 + (𝑖𝑜 𝑀𝑜 )2 + (𝑀𝑡 )2
]
+ |
+[
4𝑡𝑛 𝐴 𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑
𝑍

≤ 0.75𝑆𝑦

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

as per Table 403.3.1-1
where
𝑖𝑖
𝑖𝑜

= in-plane stress intensification factor = 1.0 for pipes
= out-of-plane stress intensification factor = 1.0 for pipes

For Fittings & Components.(as per para. 402.6.2)
𝑆𝐿(𝑓𝑐) = |

𝑃𝐷 𝐹𝑎
√(0.75𝑖𝑖 𝑀𝑖 )2 + (0.75𝑖𝑜 𝑀𝑜 )2 + (𝑀𝑡 )2
]
+ |
+[
4𝑡𝑛 𝐴 𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑
𝑍

≤ 0.75𝑆𝑦

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

as per Table 403.3.1-1
where
𝑃 = maximum operating pressure = max of CAEPIPE input pressures (P1 through P10).
Due considerations shall be given as per para. 401.2.2.2 while inputting pressure
values in CAEPIPE.
𝐷 = outside diameter
𝑡𝑛 = nominal thickness as per para. 402.1
𝑖𝑖 = in-plane stress intensification factor; the product 0.75𝑖𝑖 shall not be less than 1.0
𝑖𝑜 = out-of-plane stress intensification factor; the product 0.75𝑖𝑜 shall not be less than 1.0
𝑀𝑖 = in-plane bending moment
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𝑀𝑜
𝑀𝑡
𝑍
𝐹𝑎
𝐴
𝑆𝑦

= out-of-plane bending moment
= torsional moment
= un-corroded section modulus; for reduced outlets, effective section modulus
= axial force component for external loads
= nominal cross-section area
= specified minimum yield strength of pipe

Stress due to Sustained Loads + Occasional Loads (Unrestrained Piping)

For Pipes (as per para. 402.6.2)
𝑆𝐿𝑂 = SL + |

(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷 𝐹𝑎
√(𝑖𝑖 𝑀𝑖 )2 + (𝑖𝑜 𝑀𝑜 )2 + (𝑀𝑡 )2
+ |
+[
]
4𝑡𝑛
𝐴 𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙
𝑍

≤ 0.8𝑆𝑦

𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

as per Table 403.3.1-1
For Fittings & Components (as per para. 402.6.2)
𝑆𝐿𝑂 = 𝑆𝐿(𝑓𝑐) + |

(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷 𝐹𝑎
√(0.75𝑖𝑖 𝑀𝑖 )2 + (0.75𝑖𝑜 𝑀𝑜 )2 + (𝑀𝑡 )2
+ |
+[
]
4𝑡𝑛
𝐴 𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙
𝑍

≤ 0.8𝑆𝑦

𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

as per Table 403.3.1-1
where
𝑃𝑝𝑒𝑎𝑘 = peak pressure = (peak pressure factor x P) where P = maximum operating
pressure, as defined above with 1.0 ≤ peak pressure factor ≥ 1.1 as per para.
403.3.4
Expansion Stress (Unrestrained Piping)

The stress (𝑆𝐸 ) due to thermal expansion is calculated from para.402.5.2
𝑆𝐸 = √𝑆𝑏2 + 4𝑆𝑡2 ≤ 𝑆𝐴 as per Table 403.3.1-1 and para. 403.3.2

where
𝑆𝑏 =
𝑆𝑡 =
𝑀𝑡 =
𝑍 =

)2

)2

resultant bending stress = √(𝑖𝑖𝑀𝑖 Z+(𝑖𝑜𝑀𝑜
torsional stress = M2Zt
torsional moment
un-corroded section modulus; for reduced outlets, effective section modulus

Please note, “Liberal allowable” option is always turned ON for ANSI B31.4
𝑆𝐴 = 𝑓 [1.25(𝑆𝐶 + 𝑆ℎ ) − 𝑆𝐿 ]
𝑓 = stress range reduction factor = 6/N0.2 , where N = number of equivalent full range
cycles
where𝑓 ≤ 1.2 (from para. 403.3.2).
𝑆𝑐 = 0.67𝑆𝑦 at the lower of the installed temperature or minimum operating temperature
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𝑆ℎ = 0.67𝑆𝑦 at the higher of the installed temperature or maximum operating temperature
where
𝑆𝑦 = specified minimum yield strength of pipe
Stress due to Sustained, Thermal and Occasional Loads (Restrained Piping)

The Net longitudinal stress (SL) due to sustained, thermal expansion and occasional loads for
restrained piping is calculated from para. 402.6.1

𝑆𝐿𝑝 = 𝑆𝐸 + 𝜐𝑆𝐻 +
𝑆𝐿𝑛 = 𝑆𝐸 + 𝜐𝑆𝐻 +

𝐹𝑎
𝐴
𝐹𝑎
𝐴

+
−

𝑀
𝑍
𝑀
𝑍

As per para. 402.6.1, both positive and negative values of M/Z shall be considered for
analysis.
where
𝑆𝐻 = circumferential (hoop) stress =

𝑃𝐷
2𝑡𝑛

𝜐 = Poission’s ratio = 0.3 as per para. 402.2.3

As per para. 402.6.1, 𝑆𝐻 can be either positive or negative.
𝐹𝑎 = axial force, such as weight on a riser. As per para. 402.6.1, 𝐹𝑎 can be positive or negative.

M = bending moment from Weight and other External loads
For Pipes
M = √(𝑖𝑖 𝑀𝑖 )2 + (𝑖𝑜 𝑀𝑜 )2
For Fittings & Components
𝑀 = √(0.75𝑖𝑖 𝑀𝑖 )2 + (0.75𝑖𝑜 𝑀𝑜 )2
𝑆𝐸 = Thermal expansion stress = 𝐸𝛼 (𝑇𝑖 − 𝑇𝑜 ), which can either be positive or negative

where
𝑃 = PFO x maximum pressure (P1 through P10) entered in CAEPIPE.
𝑃𝐹𝑂 = Peak Pressure Factor input. PFO = 1.0, if occasional loads are not present.
𝐷 = outside diameter
𝑡𝑛 = nominal thickness
𝑖𝑖 = in-plane stress intensification factor; the product 0.75ii shall not be less than 1.0
𝑖𝑜 = out-of-plane stress intensification factor; the product 0.75ioshall not be less than 1.0
𝑀𝑖 = in-plane bending moment from Weight and other External loads
𝑀𝑜 = out-of-plane bending moment from Weight and other External loads
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𝐹𝑎
𝐴
𝑍
𝑆𝑦
𝑇𝑖
𝑇𝑜
𝛼
𝐸

= axial force component for Weight and other External loads
= nominal cross-section area
= un-corroded section modulus; for reduced outlets, effective section modulus
= specified minimum yield strength of pipe
= installation temperature = Tref in CAEPIPE
= warmest or coldest operating temperature
= coefficient of thermal expansion at To defined above

= young’s modulus at ambient (reference) temperature

Combining of Stresses

In restrained pipe, the longitudinal and circumferential stresses are combined in accordance
with the maximum shear stress theory as follows (by default in CAEPIPE).
2

S𝑒𝑞1 = 2√[(𝑆𝐿𝑝 − 𝑆𝐻 )/2] + (𝑆𝑡 )2

S𝑒𝑞2 = 2√[(𝑆𝐿𝑛 − 𝑆𝐻 )/2]2 + (𝑆𝑡 )2

Where SLp and SLn are calculated as given above.
Alternatively, the stresses may be combined in accordance with the maximum distortion
energy theory as follows (see Note 4 below):
2

S𝑒𝑞1 =√(𝑆𝐻 )2 − 𝑆𝐻 𝑆𝐿𝑝 + (𝑆𝐿𝑝 ) + 3(𝑆𝑡 )2

S𝑒𝑞2 = √(𝑆𝐻 )2 − 𝑆𝐻 𝑆𝐿𝑛 + (𝑆𝐿𝑛 )2 + 3(𝑆𝑡 )2

S𝑒𝑞 = 𝑚𝑎𝑥{𝑆𝑒𝑞1 , 𝑆𝑒𝑞2 } ≤ 0.9𝑆𝑦
where
S𝑒𝑞 = equivalent combined stress
S𝑡 = torsional stress
Notes:
5. Para. 402.6.2 of B31.4 (2016) states that “Longitudinal stress from pressure in an
unrestrained line should include consideration of bending stress or axial stress that may
be caused by elongation of the pipe due to internal pressure and result in stress at bends
and at connections and produce additional loads on equipment and on supports”.
The above statement seems to imply that “elongation due to Bourdon effect” is to be
included in the Sustained load case (and hence in Operating case and Sustained plus
Occasional load case).
On the other hand, since the deformation due to Bourdon effect is being constrained by
piping supports, CAEPIPE includes the Bourdon effect as part of the results for
Thermal Expansion (when “Solve Thermal Case” is opted) or as part of the Operating
Case (when “Thermal = Operating – Sustained is opted).
6. Young’s modulus of elasticity corresponding to reference temperature (Tref) is used to
form the stiffness matrix in accordance with para. 402.2.2.
7. Refer end of this appendix for the details of “Thickness and Section Modulus used for
weight, pressure and stress calculations”.
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8. By default, CAEPIPE combines the stresses for restrained piping using the maximum
shear stress theory as stated above. To combine stresses in accordance with the
maximum distortion energy theory as stated above, set an environmental variable with
name “DET_314” with its value as “YES”.
Notes on Material Library for B314-2016.mat supplied with CAEPIPE:
Material library for ASME B31.4 (2016) [B314-2016.mat] has been created and supplied with
CAEPIPE as mentioned below.
9. Coefficient of Thermal Expansion: As stated in para. 402.2.1 of B31.4 (2016),
Coefficient of Thermal Expansion for Carbon and low alloy high tensile steel are entered
as 6.5E-6 in./in./0F for temperatures up to 250 0F.
10. Modulus of Elasticity: Modulus of Elasticity for Carbon and low alloy high tensile steel
for temperatures up to 250 0F are entered by referring to the values provided in Table
832.5-1 of ASME B31.8 (2016).
11. Yield Strength: Yield Strength for Carbon and low alloy high tensile steel for
temperatures up to 250 0F are entered by referring to the values specified in Mandatory
Appendix D titled “Specified Minimum Yield Strength for Steel Pipe Commonly Used in
Piping Systems” of ASME B31.8 (2016).
12. Density and Poisson’s ratio: Density and Poisson’s ratio for Carbon and low alloy high
tensile steel are entered as 0.283 lb/in3 and 0.3 respectively.
13. Longitudinal Joint Factor: Longitudinal Joint Factor for Carbon and low alloy high
tensile steel are entered by referring to the values specified in Table 841.1.7-1 of ASME
B31.8 (2016).
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Allowable Pressure

For straight pipes and bends (including closely spaced and widely spaced miter bends), the
allowable pressure is calculated from para. 403.2.1.
𝑃𝑖 =
where
𝑃𝑖 =
𝑆 =
𝑆𝑦 =
𝐸 =
𝑡𝑎 =
=
𝐷

2𝑆𝐸𝑡𝑎
𝐷

allowable pressure
allowable stress = 0.72 Sy
specified minimum yield strength of pipe
weld joint factor as defined in Table 403.2.1-1
available thickness for pressure design
𝑡𝑛 ×(1 – mill tolerance/100) – sum of allowances, as per para. 403.2.1, for
corrosion, threading, grooving and erosion.
= outside diameter

Stress due to Sustained Loads (Unrestrained Piping)

For Pipes (as per para. 402.6.2)
𝑃𝐷 𝐹𝑎
√(𝑖𝑖 𝑀𝑖 )2 + (𝑖𝑜 𝑀𝑜 )2 + (𝑀𝑡 )2
]
𝑆𝐿 = |
+ |
+[
4𝑡𝑛 𝐴 𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑
𝑍

≤ 0.75𝑆𝑦

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

as per Table 403.3.1-1
where
𝑖𝑖
𝑖𝑜

= in-plane stress intensification factor = 1.0 for pipes
= out-of-plane stress intensification factor = 1.0 for pipes

For Fittings & Components.(as per para. 402.6.2)
𝑆𝐿(𝑓𝑐)

𝑃𝐷 𝐹𝑎
√(0.75𝑖𝑖 𝑀𝑖 )2 + (0.75𝑖𝑜 𝑀𝑜 )2 + (𝑀𝑡 )2
]
=|
+ |
+[
4𝑡𝑛 𝐴 𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑
𝑍

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

≤ 0.75𝑆𝑦
as per Table 403.3.1-1
where
𝑃 = maximum operating pressure = max of CAEPIPE input pressures (P1 through P10).
Due considerations shall be given as per para. 401.2.2.2 while inputting pressure
values in CAEPIPE.
𝐷 = outside diameter
𝑡𝑛 = nominal thickness as per para. 402.1
𝑖𝑖 = in-plane stress intensification factor; the product 0.75𝑖𝑖 shall not be less than 1.0
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𝑖𝑜
𝑀𝑖
𝑀𝑜
𝑀𝑡
𝑍
𝐹𝑎
𝐴
𝑆𝑦

= out-of-plane stress intensification factor; the product 0.75𝑖𝑜 shall not be less than 1.0
= in-plane bending moment
= out-of-plane bending moment
= torsional moment
= un-corroded section modulus; for reduced outlets, effective section modulus
= axial force component for external loads
= nominal cross-section area
= specified minimum yield strength of pipe

Stress due to Sustained Loads + Occasional Loads (Unrestrained Piping)

For Pipes (as per para. 402.6.2)
𝑆𝐿𝑂 = SL + |

(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷 𝐹𝑎
√(𝑖𝑖 𝑀𝑖 )2 + (𝑖𝑜 𝑀𝑜 )2 + (𝑀𝑡 )2
+ |
+[
]
4𝑡𝑛
𝐴 𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙
𝑍

≤ 0.8𝑆𝑦

𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

as per Table 403.3.1-1
For Fittings & Components (as per para. 402.6.2)
𝑆𝐿𝑂 = 𝑆𝐿(𝑓𝑐) + |

(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷 𝐹𝑎
√(0.75𝑖𝑖 𝑀𝑖 )2 + (0.75𝑖𝑜 𝑀𝑜 )2 + (𝑀𝑡 )2
+ |
+[
]
4𝑡𝑛
𝐴 𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙
𝑍

≤ 0.8𝑆𝑦

𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

as per Table 403.3.1-1
where
𝑃𝑝𝑒𝑎𝑘 = peak pressure = (peak pressure factor x P) where P = maximum operating
pressure, as defined above with 1.0 ≤ peak pressure factor ≥ 1.1 as per para.
403.3.4
Expansion Stress (Unrestrained Piping)

The stress (𝑆𝐸 ) due to thermal expansion is calculated from para.402.5.2
𝑆𝐸 = √𝑆𝑏2 + 4𝑆𝑡2 ≤ 𝑆𝐴 as per Table 403.3.1-1 and para. 403.3.2

where
𝑆𝑏 =
𝑆𝑡 =
𝑀𝑡 =
𝑍 =

)2

)2

resultant bending stress = √(𝑖𝑖𝑀𝑖 Z+(𝑖𝑜𝑀𝑜
torsional stress = M2Zt
torsional moment
un-corroded section modulus; for reduced outlets, effective section modulus

Please note, “Liberal allowable” option is always turned ON for ANSI B31.4
𝑆𝐴 = 𝑓 [1.25(𝑆𝐶 + 𝑆ℎ ) − 𝑆𝐿 ]
𝑓 = stress range reduction factor = 6/N0.2 , where N = number of equivalent full range
cycles
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where𝑓 ≤ 1.2 (from para. 403.3.2).
𝑆𝑐 = 0.67𝑆𝑦 at the lower of the installed temperature or minimum operating temperature
= 0.67𝑆𝑦 at the higher of the installed temperature or maximum operating temperature
where
𝑆𝑐 = specified minimum yield strength of pipe
Stress due to Sustained, Thermal and Occasional Loads (Restrained Piping)

The Net longitudinal stress (SL) due to sustained, thermal expansion and occasional loads for
restrained piping is calculated from para. 402.6.1
𝑆𝐿 = max(|𝑆𝑝 + 𝑆𝑥 + 𝑆𝐵 |, |𝑆𝑝 + 𝑆𝑥 − 𝑆𝐵 |)𝑠𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑 +
max(|𝑆𝑝 + 𝑆𝑥 + 𝑆𝐵 |, |𝑆𝑝 + 𝑆𝑥 − 𝑆𝐵 |)𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙 +
max(|𝑆𝑇 |𝑤𝑎𝑟𝑚𝑒𝑠𝑡 , |𝑆𝑇 |𝑐𝑜𝑙𝑑𝑒𝑠𝑡 ) ≤ 0.9𝑆𝑦
where
𝑃𝐷

Pressure stress = 𝑆𝑝 = 𝜐 2𝑡 = where 𝜐 = 0.3 as per para. 402.2.3 and can be either positive or
𝑛
negative
Stress due to axial loading (other than temperature and pressure)= 𝑆𝑥 =

𝐹𝑎
𝐴

and can be positive or negative.
Nominal bending stress SB from Weight and / or other External loads for
For Pipes
𝑆𝐵 =

√(𝑖𝑖 𝑀𝑖 )2 +(𝑖𝑜 𝑀𝑜 )2+(𝑀𝑡 )2
Z

For Fittings & Components
√(0.75𝑖 𝑀 )2 +(0.75𝑖 𝑀 )2 +(𝑀 )2

𝑜 𝑜
𝑡
𝑖 𝑖
𝑆𝐵 =
𝑍
Thermal expansionstress 𝑆𝑇 = 𝐸𝛼(𝑇𝑖 − 𝑇𝑜 ), which can either be positive or negative

where
𝑃 = maximum operating pressure = max (P1 through P10)
𝐷 = outside diameter
𝑡𝑛 = nominal thickness
𝑖𝑖 = in-plane stress intensification factor; the product 0.75ii shall not be less than 1.0
𝑖𝑜
𝑀𝑖
𝑀𝑜
𝑀𝑡

= out-of-plane stress intensification factor; the product 0.75io shall not be less than 1.0
= in-plane bending moment
= out-of-plane bending moment
= torsional moment
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𝐹𝑎
𝐴
𝑍
𝑆𝑦
𝑇𝑖
𝑇𝑜
𝛼
𝐸

=
=
=
=
=
=

axial force component for external loads
nominal cross-section area
un-corroded section modulus; for reduced outlets, effective section modulus
specified minimum yield strength of pipe
installation temperature = Tref in CAEPIPE
warmest or coldest operating temperature

= coefficient of thermal expansion at To defined above

= young’s modulus at ambient (reference) temperature

Note:

1. Para. 402.6.2 of B31.4 (2012) states that “Longitudinal stress from pressure in an
unrestrained line should include consideration of bending stress or axial stress that may
be caused by elongation of the pipe due to internal pressure and result in stress at bends
and at connections and produce additional loads on equipment and on supports”.
The above statement seems to imply that “elongation of pipe and opening of bends due
to Bourdon effect” are to be included in the Sustained load case (and hence in Operating
case and Sustained plus Occasional load case).
On the other hand, since the deformation due to Bourdon effect is being constrained by
piping supports, CAEPIPE includes the Bourdon effect as part of the results for
Thermal Expansion (when “Solve Thermal Case” is opted) or as part of the Operating
Case (when “Thermal = Operating – Sustained is opted).
2. Young’s modulus of elasticity corresponding to reference temperature (Tref) is used to
form the stiffness matrix in accordance with para. 402.2.2.
3. Refer end of this appendix for the details of “Thickness and Section Modulus used for
weight, pressure and stress calculations”.
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Allowable Pressure

For straight pipes and bends (including closely spaced and widely spaced miter bends), the
allowable pressure is calculated from para. 504.1.2.
𝑃=

2𝑆𝐸𝑡𝑎
𝐷 − 2𝑌𝑡𝑎

where
𝑃 = allowable pressure
𝑆 = basic allowable stress at maximum of CAEPIPE input temperatures T1 through T10
𝐸 = longitudinal or spiral joint factor (input as material property) from para. 502.3.1 and
Table 502.3.1-1
Table 502.3.1-1 provides maximum allowable hoop stress values (𝑆𝐸 ) as a function of
metal temperature and includes Longitudinal or Spiral Joint Factor (𝐸 ) for various
materials. Divide 𝑆𝐸 value by 𝐸 value provided in Table 502.3.1-1 to obtain basic
allowable stress 𝑆. For materials where 𝐸 is not given explicitly in Table 502.3.1-1, use
𝐸 = 1.0.
𝑆𝐸 in the above formula for allowable pressure 𝑃 is the allowable hoop stress per para.
502.3.1 and Table 502.3.1-1.
𝑡𝑎 = available thickness for pressure design (as per para. 504.1.1)
= 𝑡𝑛 × (1 - mill tolerance/100) - corrosion allowance
(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be
included in corrosion allowance)
𝑡𝑛 = nominal pipe thickness
𝐷 = outside diameter
𝑑 = inside diameter
𝑌 = pressure coefficient
For ductile non-ferrous materials and ferritic and austenitic steels from para. 504.1.1,
𝑑

𝑌 = 0.4 and 𝑌 = 𝑑+𝐷, for 4 ≤ 𝐷/𝑡𝑎 < 6
Y = 0.0 for Cast Iron
Sustained Stress (in corroded condition)

The stress (𝑆𝐿 ) due to sustained loads (pressure, weight and other sustained mechanical
loads) is calculated from para. 502.3.2(d). Also, refer to Note 1 below.
𝑆𝐿 =
where
𝑃 =
𝐷 =
𝑡𝑐 =
𝑖𝑖 =
𝑖𝑜 =

𝑃𝐷 √(𝑖𝑖 𝑀𝑖 )2 + (𝑖𝑜 𝑀𝑜 )2
+
≤ 𝑆ℎ
4𝑡𝑐
𝑍𝑐

maximum of CAEPIPE input pressures P1 through P10
outside diameter
nominal thickness – corrosion allowance, as per para. 502.3.2 (d)
in-plane stress intensification factor from Table 519.3.6-1
out-of-plane stress intensification factor from Table 519.3.6-1
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𝑀𝑖
𝑀𝑜
𝑍𝑐
𝑆ℎ

=
=
=
=

in-plane bending moment
out-of-plane bending moment
corroded section modulus as per para. 502.3.2 (d)
basic allowable stress at maximum of CAEPIPE input temperatures T1 through T10

Occasional Stress (in corroded condition)

The stress (𝑆𝐿𝑜 ) due to occasional loads is calculated as the sum of stress due to sustained
loads (𝑆𝐿 ) and stress due to occasional loads (𝑆𝑜 ) such as earthquake or wind. Wind and
earthquake are not considered concurrently (see para. 502.3.3 (a)). Also, refer to Note 1
below.
𝑆𝐿𝑂 =

𝑃𝑝𝑒𝑎𝑘 𝐷
√(𝑖𝑖 𝑀𝑖 )2 + (𝑖𝑜 𝑀𝑜 )2
]
+[
4𝑡𝑐
𝑍𝑐

𝑠𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

√(𝑖𝑖 𝑀𝑖 )2 + (𝑖𝑜 𝑀𝑜 )2
]
+[
𝑍𝑐

≤ 1.33𝑆ℎ

𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

where
𝑃𝑝𝑒𝑎𝑘 = peak pressure = (peak pressure factor) x P, where P is defined above
Expansion Stress (in un-corroded condition)

The stress (𝑆𝐸 ) due to thermal expansion is calculated from para. 519.4.5 and para. 519.3.
𝑆𝐸 = √𝑆𝑏2 + 4𝑆𝑡2 ≤ 𝑆𝐴
where
√(𝑖𝑖 𝑀𝑖 )2 +(𝑖𝑜 𝑀𝑜 )2

𝑆𝑏

= resultant bending stress =

𝑆𝑡
𝑀𝑡
𝑍
𝑖𝑖
𝑖𝑜
𝑆𝐴
𝑓
𝑆𝑐𝑜𝑙𝑑

= torsional stress =2𝑍𝑡
= torsional moment
= un-corroded section modulus; for reduced outlets, effective section modulus
= in-plane stress intensification factor from Table 519.3.6-1
= out-of-plane stress intensification factor from Table 519.3.6-1
= 𝑓 (1.25𝑆𝑐𝑜𝑙𝑑 + 0.25𝑆ℎ𝑜𝑡 )(see para. 502.3.2 (c))
= stress range reduction factor from Figure 502.3.2-1. f >= 0.5 and f <= 1.0
= basic allowable stress at minimum metal temperature expected during the
displacement cycle under analysis
= basic allowable stress at maximum metal temperature expected during the
displacement cycle under analysis

𝑆ℎ𝑜𝑡

𝑀

𝑍

When 𝑆ℎ is greater than 𝑆𝐿 , the allowable stress range may be calculated as
𝑆𝐴 = 𝑆𝐴 + 𝑓 (𝑆ℎ − 𝑆𝐿 )
where, 𝑆ℎ = basic allowable stress at maximum of CAEPIPE input temperatures T 1 through
T10
This is specified as an analysis option: “Use liberal allowable stresses”, in the CAEPIPE
menu Options->Analysis on the Code tab.
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Notes:
1. As per para. 502.3.2 (d), the pressure stress should be calculated using the formula
𝑃𝑑 2 /(𝐷2 − 𝑑 2 ), where d is the internal diameter = 𝐷 − 2𝑡𝑐 . Hence, "𝑃𝑑 2 /(𝐷2 − 𝑑 2 )"
(available through CAEPIPE Layout > Options > Analysis > Pressure) is set as "default"
and is disabled for user to modify.
2. As per para. 519.4.5(a), Bending and torsional stress shall be computed using the asinstalled modulus of elasticity, i.e., Ec at installation temperature. Hence, "Use modulus at
reference temperature" (available through CAEPIPE Layout > Options > Analysis >
Temperature) is set as "default" and is disabled for user to modify.
3. As per para. 519.2.2, wind sway should be input into the appropriate Thermal Load
Displacement.
4. Refer to Section titled “Operating Stress for NDE/Impact Test” in this manual for
details regarding the requirements and implementation of Impact Test in CAEPIPE for
this code.
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Allowable Pressure

For straight pipes and bends (including closely spaced and widely spaced miter bends), the
allowable pressure is calculated from para. 504.1.2.
𝑃=

2𝑆𝐸𝑡𝑎
𝐷 − 2𝑌𝑡𝑎

where
𝑃 = allowable pressure
𝑆 = basic allowable stress at maximum of CAEPIPE input temperatures T1 through T10
𝐸 = longitudinal or spiral joint factor (input as material property) from para. 502.3.1 and
Table 502.3.1
Table 502.3.1 provides maximum allowable hoop stress values (𝑆𝐸 ) as a function of metal
temperature and includes Longitudinal or Spiral Joint Factor (𝐸 ) for various materials.
Divide 𝑆𝐸 value by 𝐸 value provided in Table 502.3.1 to obtain basic allowable stress 𝑆. For
materials where 𝐸 is not given explicitly in Table 502.3.1, use 𝐸 = 1.0.
Hence, 𝑆𝐸 in the above formula for allowable pressure 𝑃 is the allowable hoop stress per
para. 502.3.1 and Table 502.3.1.
𝑡𝑎 = available thickness for pressure design (as per para. 504.1.1)
= 𝑡𝑛 × (1 - mill tolerance/100) - corrosion allowance
(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be
included in corrosion allowance)
𝑡𝑛 = nominal pipe thickness
𝐷 = outside diameter
𝑑 = inside diameter
𝑌 = pressure coefficient
For ductile non-ferrous materials and ferritic and austenitic steels,
𝑑

𝑌 = 0.4for𝐷/𝑡𝑎 ≥ 6 and 𝑌 = 𝑑+𝐷, for 4 ≤ 𝐷/𝑡𝑎 < 6
Y = 0.0 for Cast Iron
Sustained Stress (in corroded condition)

The stress (𝑆𝐿 ) due to sustained loads (pressure, weight and other sustained mechanical
loads) is calculated from para. 502.3.2(d). Also, refer to Note 1 below.
𝑃𝐷 √(𝑖𝑖 𝑀𝑖 )2 + (𝑖𝑜 𝑀𝑜 )2
𝑆𝐿 =
+
≤ 𝑆ℎ
4𝑡𝑐
𝑍𝑐
where
𝑃 =
𝐷 =
𝑡𝑐 =
𝑖𝑖 =
𝑖𝑜 =
𝑀𝑖 =

maximum of CAEPIPE input pressures P1 through P10
outside diameter
nominal thickness – corrosion allowance, as per para. 502.3.2 (d)
in-plane stress intensification factor
out-of-plane stress intensification factor
in-plane bending moment
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𝑀𝑜 = out-of-plane bending moment
𝑍𝑐 = corroded section modulus as per para. 502.3.2 (d)
𝑆ℎ = basic allowable stress at maximum of CAEPIPE input temperatures T1 through T10
Occasional Stress (in corroded condition)

The stress (𝑆𝐿𝑜 ) due to occasional loads is calculated as the sum of stress due to sustained
loads (𝑆𝐿 ) and stress due to occasional loads (𝑆𝑜 ) such as earthquake or wind. Wind and
earthquake are not considered concurrently (see para. 502.3.3 (a)). Also, refer to Note 1
below.
𝑆𝐿𝑂 =

𝑃𝑝𝑒𝑎𝑘 𝐷
√(𝑖𝑖 𝑀𝑖 )2 + (𝑖𝑜 𝑀𝑜 )2
]
+[
4𝑡𝑐
𝑍𝑐

𝑠𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

√(𝑖𝑖 𝑀𝑖 )2 + (𝑖𝑜 𝑀𝑜 )2
]
+[
𝑍𝑐

≤ 1.33𝑆ℎ

𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

where
𝑃𝑝𝑒𝑎𝑘 = peak pressure = (peak pressure factor) x P, where P is defined above
Expansion Stress (in un-corroded condition)

The stress (𝑆𝐸 ) due to thermal expansion is calculated from para. 519.4.5 and para. 519.3.5.
𝑆𝐸 = √𝑆𝑏2 + 4𝑆𝑡2 ≤ 𝑆𝐴
where
𝑆𝑏

= resultant bending stress =

𝑆𝑡
𝑀𝑡
𝑍
𝑆𝐴
𝑓
𝑆𝑐𝑜𝑙𝑑

=
=
=
=
=
=

𝑆ℎ𝑜𝑡

𝑀

√(𝑖𝑖 𝑀𝑖 )2 +(𝑖𝑜 𝑀𝑜 )2
𝑍

torsional stress =2𝑍𝑡
torsional moment
un-corroded section modulus; for reduced outlets, effective section modulus
𝑓 (1.25𝑆𝑐𝑜𝑙𝑑 + 0.25𝑆ℎ𝑜𝑡 )(see para. 502.3.2 (c))
stress range reduction factor from Figure 502.3.2
basic allowable stress as minimum metal temperature expected during the
displacement cycle under analysis
= basic allowable stress as maximum metal temperature expected during the
displacement cycle under analysis

When 𝑆ℎ is greater than 𝑆𝐿 , the allowable stress range may be calculated as
𝑆𝐴 = 𝑆𝐴 + 𝑓 (𝑆ℎ − 𝑆𝐿 )
where, 𝑆ℎ = basic allowable stress at maximum of CAEPIPE input temperatures T 1 through
T10
This is specified as an analysis option: “Use liberal allowable stresses”, in the CAEPIPE
menu Options->Analysis on the Code tab.

107

Refrigeration Piping and Heat Transfer Components
ASME B31.5 (2016)
Notes:
1. As per para. 502.3.2 (d), the pressure stress should be calculated using the formula
𝑃𝑑 2 /(𝐷2 − 𝑑 2 ), where d is the internal diameter = 𝐷 − 2𝑡𝑐 . This can be selected
through Options > Analysis > Pressure.
2. As per para. 519.4.5(a), Bending and torsional stress shall be computed using the asinstalled modulus of elasticity, i.e., Ec at installation temperature. Hence, "Use modulus at
reference temperature" (available through CAEPIPE Layout > Options > Analysis >
Temperature) is set as "default" and is disabled for user to modify.
3. Refer end of this appendix for the details of “Thickness and Section Modulus used for
weight, pressure and stress calculations”.
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Allowable Pressure

For straight pipes and bends (including closely spaced and widely spaced miter bends), the
allowable pressure is calculated from para. 841.1.1.
𝑃=

2𝑆𝐸𝑡𝑛 𝐹𝑇
𝐷

𝑃=

2𝑆𝐸𝑡𝑛 𝐹𝑇
𝐷 − 𝑡𝑛

When D/tn< 30, then

where
𝑃 = allowable pressure
𝑆 = specified minimum yield strength from para. 841.1.1 (a)
𝐸 = longitudinal joint factor (input as material property), obtained from Table 841.1.7-1
and para. 817.1.3 (d)
𝑡𝑛 = nominal pipe thickness
𝐷 = outside diameter
𝐹 = construction type design factor, obtained from Table 841.1.6-1
𝑇 = temperature derating factor, obtained from Table 841.1.8-1 and para. 841.1.8
Stress due to Sustained and Occasional Loads (Unrestrained Piping)

The sum of longitudinal pressure stress due to axial loading (other than thermal expansion
and pressure) and the bending stress due to external loads, such as weight of the pipe and
contents, seismic or wind, etc. is calculated according to paras. 833.6 (a) and 833.6 (b) along
with paras. 805.2.3, 833.2 (b), 833.2 (d), 833.2 (e) and 833.2 (f).
Please note, the “include axial force in stress calculations” option is turned ON by default for
ANSI B31.8 in CAEPIPE.
Sustained Stress𝑺𝑳 :

For Pipes and Long Radius Bends
𝑃𝐷 𝑅
√(𝑀𝑖 )2 + (𝑀𝑜 )2 + (𝑀𝑡 )2
𝑆𝐿 = |
+ |
+[
]
4𝑡𝑛 𝐴 𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑
𝑍

≤ 0.75ST

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

For other Fittings and Components.
PD R
√(0.75ii Mi )2 + (0.75ioMo )2 + (Mt )2
SL(fc) = |
+ |
+[
]
4t n A Sustained
Z

≤ 0.75ST

Sustained

Sustained + Occasional Stress 𝑺𝑳𝑶 :

For Pipes and Long Radius Bends
𝐒𝐋𝐎 = 𝐒𝐋 + |

(𝐏𝐩𝐞𝐚𝐤 − 𝐏)𝐃 𝐑
√(𝑴𝒊)𝟐 + (𝑴𝒐 )𝟐 +(𝑴𝒕 )𝟐
+ |
+[
]
𝟒𝐭𝐧
𝐀 𝐨𝐜𝐜𝐚𝐬𝐢𝐨𝐧𝐚𝐥
𝐙

𝐨𝐜𝐜𝐚𝐬𝐢𝐨𝐧𝐚𝐥
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For Fittings and Components
𝑆𝐿𝑂 = 𝑆𝐿(𝑓𝑐) + |

(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷 𝑅
√(0.75𝑖𝑖 𝑀𝑖 )2 + (0.75𝑖𝑜 𝑀𝑜 )2 + (𝑀𝑡 )2
+ |
+[
]
4𝑡𝑛
𝐴 𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙
𝑍

≤ 0.75𝑆𝑇

𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

where
𝑃 = maximum operating pressure = max (P1 through P10)
𝑃𝑝𝑒𝑎𝑘 = Peak pressure factor x P
𝐷 = outside diameter
𝑡𝑛 = nominal thickness
𝑖𝑖 = in-plane stress intensification factor; the product 0.75ii shall not be less than 1.0
𝑖𝑜 = out-of-plane stress intensification factor; the product 0.75ioshall not be less than 1.0
𝑀𝑖 = in-plane bending moment
𝑀𝑜 = out-of-plane bending moment
𝑀𝑡 = torsional moment
𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus
𝑅 = axial force component for external loads (other than thermal expansion and pressure)
𝐴 = un-corroded pipe metal cross-section area
𝑆 = specified minimum yield strength from para. 841.1.1(a)
𝑇= temperature derating factor, obtained from para. 841.1.8 and Table 841.1.8-1
Note:
Young’s modulus of elasticity corresponding to the lowest operating temperature [=min (T 1
through T10, Tref)] is used to form the stiffness matrix for Sustained and Occasional load
calculations in accordance with para. 832.3(g).
Expansion Stress (Unrestrained Piping)

The stress (𝑆𝐸 ) due to thermal expansion is calculated from para.833.8.
𝑆𝐸 = √𝑆𝑏2 + 4𝑆𝑡2 ≤ 𝑆𝐴
where
𝑆𝑏 = resultant bending stress =
𝑀

√(𝑖𝑖 𝑀𝑖 )2 +(𝑖𝑜 𝑀𝑜 )2
𝑍

𝑆𝑡 = torsional stress = 2𝑍𝑡
𝑀𝑡 = torsional moment
𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus
Please note, “Liberal allowable” option is always turned ON for ANSI B31.8.
𝑆𝐴 = 𝑓 [1.25(𝑆𝐶 + 𝑆ℎ ) − 𝑆𝐿 ]
𝑓 = stress range reduction factor = 6/N0.2, where N = number of equivalent full range
cycles
where𝑓 ≤ 1.0 (from para. 833.8 (b)).
𝑆𝐿 = sustained stress computed as per equation given above
𝑆𝐶 = 0.33SuT at the minimum installed or operating temperature
𝑆ℎ = 0.33SuT at the maximum installed or operating temperature
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where
𝑆𝑢 = specified minimum ultimate tensile strength = 1.5 𝑆𝑦 (assumed), and
𝑆𝑦 = specified minimum yield strength as per para. 841.1.1(a)
𝑇 = temperature derating factor, obtained from para. 841.1.8 and Table 841.1.8-1
Note:
Young’s modulus of elasticity corresponding to the lowest operating temperature [=min(T 1
through T10,Tref)] is used to form the stiffness matrix for Expansion load calculations in
accordance with para. 832.4 (g).
Stress due to Sustained, Thermal and Occasional Loads (Restrained Piping)

The Net longitudinal stress (𝑆𝐿 ) due to sustained, thermal expansion and occasional loads
for restrained piping is calculated from paras. 833.3 (a), 833.3 (b) along with paras. 805.2.3,
833.2 (a), 833.2 (c), 833.2 (d), 833.2 (e) and 833.2 (f)
𝑆𝐿𝑝 = 𝑆𝑝 + 𝑆𝑇 + 𝑆𝑋 + 𝑆𝐵
𝑆𝐿𝑛 = 𝑆𝑝 + 𝑆𝑇 + 𝑆𝑋 − 𝑆𝐵
As per 833.4 (d), both the tensile and compressive values of S B shall be considered in
analysis.
where
𝑃𝐷
𝑆𝑝 = 0.3𝑆𝐻 = 0.3 2𝑡 = longitudinal stress due to internal pressure in restrained pipeline
𝑛

𝑃𝐷

𝑆𝐻 = hoop stress = 2𝑡 as per para. 805.2.3
𝑛

𝑆𝑇 = longitudinal stress due to thermal expansion in restrained pipeline = 𝐸𝛼 (𝑇𝑖 − 𝑇𝑜 ) (see
Note 1 below)
𝑅

𝑆𝑋 = stress due to axial loading (other than thermal expansion and pressure) = 𝐴
𝑆𝐵 = nominal bending stress due to weight and other external loads (other than thermal
expansion)
For Pipes and Long Radius Bends
𝑆𝐵 =

√(𝑀𝑖 )2 + (𝑀𝑜 )2 + (𝑀𝑡 )2
𝑍

For other Fittings and Components.
√(0.75𝑖𝑖 𝑀𝑖 )2 + (0.75𝑖𝑜 𝑀𝑜 )2 + (𝑀𝑡 )2
𝑍
As per para 833.3(a), note that 𝑆𝐵 ,𝑆𝐿 , 𝑆𝑇 𝑜𝑟 𝑆𝑋 can be positive or negative
where
𝑃 = maximum operating pressure = max(P1 through P10)
𝐷 = outside diameter
𝑆𝐵 =
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𝑡𝑛
𝑖𝑖
𝑖𝑜
𝑀𝑖
𝑀𝑜
𝑀𝑡
𝑅
𝐴
𝑍
𝑆
𝑇
𝐸
𝑇𝑖
𝑇𝑜
𝛼

=
=
=
=
=
=
=
=
=
=
=
=
=
=
=

nominal thickness
in-plane stress intensification factor; the product 0.75ii shall not be less than 1.0
out-of-plane stress intensification factor; the product 0.75io shall not be less than 1.0
in-plane bending moment
out-of-plane bending moment
torsional moment
axial force component for external loads (other than thermal expansion and pressure)
un-corroded pipe metal cross-sectional area (i.e., before deducting for corrosion)
un-corroded section modulus; for reduced outlets, effective section modulus
Specified Minimum Yield Strength (SMYS) from para. 841.1.1 (a)
Temperature derating factor from para. 841.1.8 and Table 841.1.8-1
Young’s modulus at ambient temperature from para. 833.2 (c) = Tref in CAEPIPE
installation temperature = Tref in CAEPIPE
warmest or coldest operating temperature
coefficient of thermal expansion at T0 in CAEPIPE

Note 1:
If there are more than one thermal load, for example T1 and T2, then CAEPIPE calculates
longitudinal stress due to thermal expansion as follows.
𝐸𝛼1 (𝑇1 − 𝑇𝑟𝑒𝑓 ) for T1, 𝐸𝛼2 (𝑇2 − 𝑇𝑟𝑒𝑓 ) for T2 and for
(𝑇2 − 𝑇1 ) = 𝐸𝛼𝑛 (𝑇𝑛 − 𝑇𝑟𝑒𝑓 ) − 𝐸𝛼𝑚 (𝑇𝑚 − 𝑇𝑟𝑒𝑓 ), where n = 1 and m = 2
Combined Stress for Restrained Pipe

The combined biaxial stress state of the pipeline in the operating mode is evaluated using the
calculation given below by default in CAEPIPE as per para. 833.4.
S𝑒𝑞 = max{𝑆𝑒𝑞1, 𝑆𝑒𝑞2 } ≤ 0.9𝑆𝑇
where
S𝑒𝑞 = equivalent combined stress
S𝑒𝑞1 = max{|𝑆𝐻 − 𝑆𝐿𝑝 |, |𝑆𝐻 |, |𝑆𝐿𝑝 |}
S𝑒𝑞2 = max{|𝑆𝐻 − 𝑆𝐿𝑛 |, |𝑆𝐻 |, |𝑆𝐿𝑛 |}
Alternatively, the stresses may be combined in accordance with the maximum distortion
energy theory as follows (see Note 3 below):
2

S𝑒𝑞1 = √(𝑆𝐿𝑝 ) − 𝑆𝐻 𝑆𝐿𝑝 + (𝑆𝐻 )2
S𝑒𝑞2 = √(𝑆𝐿𝑛 )2 − 𝑆𝐻 𝑆𝐿𝑛 + (𝑆𝐻 )2
Notes:
114

Gas Transmission and Distribution Piping Systems
ASME B31.8 (2020)
1. Young’s modulus of elasticity corresponding to the lowest operating temperature
[=min(T1 through T10,Tref)] is used to form the stiffness matrix in accordance with para.
832.3 (g).
2. Refer end of this appendix for the details of “Thickness and Section Modulus used for
weight, pressure and stress calculations”.
3. To combine stresses in accordance with the maximum distortion energy theory as stated
above, set an environmental variable with name “DET_318” with its value as “YES”.
Notes on Material Library for B318-2020.mat supplied with CAEPIPE:
Material library for ASME B31.8 (2020) [B318-2020.mat] has been created and supplied with
CAEPIPE as mentioned below.
1. Coefficient of Thermal Expansion: As stated in para. 832.2 of B31.8 (2020),
Coefficient of Thermal Expansion for Carbon and low alloy steel are entered by referring
to the values given in Table 832.2-1 of ASME B31.8 (2020).
2. Modulus of Elasticity: Modulus of Elasticity for Carbon and low alloy steel are entered
by referring to the values given in Table 832.5-1 of ASME B31.8 (2020).
3. Yield Strength: Yield Strength for Carbon and low alloy steel are entered by referring to
the values specified in Mandatory Appendix D titled “Specified Minimum Yield Strength
for Steel Pipe Commonly Used in Piping Systems” of ASME B31.8 (2020).
4. Density and Poisson’s ratio: Density and Poisson’s ratio for Carbon and low alloy high
tensile steel are entered as 0.283 lb/in3 and 0.3 respectively.
5. Longitudinal Joint Factor: Longitudinal Joint Factor for Carbon and low alloy steel are
entered by referring to the values specified in Table 841.1.7-1 of ASME B31.8 (2020).
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Allowable Pressure

For straight pipes and bends (including closely spaced and widely spaced miter bends), the
allowable pressure is calculated from para. 841.1.1.
𝑃=

2𝑆𝐸𝑡𝑛 𝐹𝑇
𝐷

𝑃=

2𝑆𝐸𝑡𝑛 𝐹𝑇
𝐷 − 𝑡𝑛

When D/tn< 30, then

where
𝑃 = allowable pressure
𝑆 = specified minimum yield strength from para. 841.1.1 (a) and para. 817.1.3 (h)
𝐸 = longitudinal joint factor (input as material property), obtained from Table 841.1.7-1
and para. 817.1.3 (d)
𝑡𝑛 = nominal pipe thickness
𝐷 = outside diameter
𝐹 = construction type design factor, obtained from Table 841.1.6-1
𝑇 = temperature derating factor, obtained from Table 841.1.8-1 and para. 841.1.8
Stress due to Sustained and Occasional Loads (Unrestrained Piping)

The sum of longitudinal pressure stress due to axial loading (other than thermal expansion
and pressure) and the bending stress due to external loads, such as weight of the pipe and
contents, seismic or wind, etc. is calculated according to paras. 833.6 (a) and 833.6 (b) along
with paras. 805.2.3, 833.2 (b), 833.2 (d), 833.2 (e) and 833.2 (f).
Please note, the “include axial force in stress calculations” option is turned ON by default for
ANSI B31.8 in CAEPIPE.
Sustained Stress𝑺𝑳 :

For Pipes and Long Radius Bends
𝑃𝐷 𝑅
√(𝑀𝑖 )2 + (𝑀𝑜 )2 + (𝑀𝑡 )2
𝑆𝐿 = |
+ |
+[
]
4𝑡𝑛 𝐴 𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑
𝑍

≤ 0.75ST

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

For other Fittings and Components.
PD R
√(0.75ii Mi )2 + (0.75ioMo )2 + (Mt )2
SL(fc) = |
+ |
+[
]
4t n A Sustained
Z

≤ 0.75ST

Sustained

Sustained + Occasional Stress 𝑺𝑳𝑶 :

For Pipes and Long Radius Bends
𝐒𝐋𝐎 = 𝐒𝐋 + |

(𝐏𝐩𝐞𝐚𝐤 − 𝐏)𝐃 𝐑
√(𝑴𝒊)𝟐 + (𝑴𝒐 )𝟐 +(𝑴𝒕 )𝟐
+ |
+[
]
𝟒𝐭𝐧
𝐀 𝐨𝐜𝐜𝐚𝐬𝐢𝐨𝐧𝐚𝐥
𝐙

𝐨𝐜𝐜𝐚𝐬𝐢𝐨𝐧𝐚𝐥

121

≤ 𝟎. 𝟕𝟓𝐒𝐓

Gas Transmission and Distribution Piping Systems
ASME B31.8 (2018)
[Superseded by ASME B31.8 (2020)]

For Fittings and Components
𝑆𝐿𝑂 = 𝑆𝐿(𝑓𝑐) + |

(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷 𝑅
√(0.75𝑖𝑖 𝑀𝑖 )2 + (0.75𝑖𝑜 𝑀𝑜 )2 + (𝑀𝑡 )2
+ |
+[
]
4𝑡𝑛
𝐴 𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙
𝑍

≤ 0.75𝑆𝑇

𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

where
𝑃 = maximum operating pressure = max (P1 through P10)
𝑃𝑝𝑒𝑎𝑘 = Peak pressure factor x P
𝐷 = outside diameter
𝑡𝑛 = nominal thickness
𝑖𝑖 = in-plane stress intensification factor; the product 0.75ii shall not be less than 1.0
𝑖𝑜 = out-of-plane stress intensification factor; the product 0.75ioshall not be less than 1.0
𝑀𝑖 = in-plane bending moment
𝑀𝑜 = out-of-plane bending moment
𝑀𝑡 = torsional moment
𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus
𝑅 = axial force component for external loads (other than thermal expansion and pressure)
𝐴 = un-corroded cross-section area
𝑆 = specified minimum yield strength from para. 841.1.1(a)
𝑇= temperature derating factor, obtained from para. 841.1.8 and Table 841.1.8-1
Note:
Young’s modulus of elasticity corresponding to the lowest operating temperature [=min (T 1
through T10, Tref)] is used to form the stiffness matrix for Sustained and Occasional load
calculations in accordance with para. 832.3(g).
Expansion Stress (Unrestrained Piping)

The stress (𝑆𝐸 ) due to thermal expansion is calculated from para.833.8.
𝑆𝐸 = √𝑆𝑏2 + 4𝑆𝑡2 ≤ 𝑆𝐴
where
𝑆𝑏 = resultant bending stress =
𝑀

√(𝑖𝑖 𝑀𝑖 )2 +(𝑖𝑜 𝑀𝑜 )2
𝑍

𝑆𝑡 = torsional stress = 2𝑍𝑡
𝑀𝑡 = torsional moment
𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus
Please note, “Liberal allowable” option is always turned ON for ANSI B31.8.
𝑆𝐴 = 𝑓 [1.25(𝑆𝐶 + 𝑆ℎ ) − 𝑆𝐿 ]
𝑓 = stress range reduction factor = 6/N0.2, where N = number of equivalent full range
cycles
where𝑓 ≤ 1.0 (from para. 833.8 (b)).
𝑆𝐿 = sustained stress computed as per equation given above
𝑆𝐶 = 0.33SuT at the minimum installed or operating temperature
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𝑆ℎ =
where
𝑆𝑢 =
𝑆𝑦 =
𝑇 =

0.33SuT at the maximum installed or operating temperature
specified minimum ultimate tensile strength = 1.5 𝑆𝑦 (assumed), and
specified minimum yield strength as per para. 841.1.1(a)
temperature derating factor, obtained from para. 841.1.8 and Table 841.1.8-1

Note:
Young’s modulus of elasticity corresponding to the lowest operating temperature [=min(T 1
through T10,Tref)] is used to form the stiffness matrix for Expansion load calculations in
accordance with para. 832.4(b).
Stress due to Sustained, Thermal and Occasional Loads (Restrained Piping)

The Net longitudinal stress (𝑆𝐿 ) due to sustained, thermal expansion and occasional loads
for restrained piping is calculated from paras. 833.3 (a), 833.3 (b) along with paras. 805.2.3,
833.2 (a), 833.2 (c), 833.2 (d), 833.2 (e) and 833.2 (f)
𝑆𝐿𝑝 = 𝑆𝑝 + 𝑆𝑇 + 𝑆𝑋 + 𝑆𝐵
𝑆𝐿𝑛 = 𝑆𝑝 + 𝑆𝑇 + 𝑆𝑋 − 𝑆𝐵
As per 833.4 (d), both the tensile and compressive values of S B shall be considered in
analysis.
where
𝑃𝐷
𝑆𝑝 = 0.3𝑆𝐻 = 0.3 2𝑡 = longitudinal stress due to internal pressure in restrained pipeline
𝑛

𝑆𝐻 = hoop stress
𝑆𝑇 = longitudinal stress due to thermal expansion in restrained pipeline = 𝐸𝛼 (𝑇𝑖 − 𝑇𝑜 ) (see
Note 1 below)
𝑅

𝑆𝑋 = stress due to axial loading (other than thermal expansion and pressure) = 𝐴
𝑆𝐵 = nominal bending stress due to weight and other external loads(other than thermal
expansion)
For Pipes and Long Radius Bends
√(𝑀𝑖 )2 + (𝑀𝑜 )2 + (𝑀𝑡 )2
𝑆𝐵 =
𝑍
For other Fittings and Components.
√(0.75𝑖𝑖 𝑀𝑖 )2 + (0.75𝑖𝑜 𝑀𝑜 )2 + (𝑀𝑡 )2
𝑍
As per para 833.3(a), note that 𝑆𝐵 ,𝑆𝐿 , 𝑆𝑇 𝑜𝑟 𝑆𝑋 can be positive or negative
where
𝑃 = maximum operating pressure = max(P1 through P10)
𝑆𝐵 =
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𝐷
𝑡𝑛
𝑖𝑖
𝑖𝑜
𝑀𝑖
𝑀𝑜
𝑀𝑡
𝑅
𝐴
𝑍
𝑆
𝑇
𝐸
𝑇𝑖
𝑇𝑜
𝛼

=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=

outside diameter
nominal thickness
in-plane stress intensification factor; the product 0.75ii shall not be less than 1.0
out-of-plane stress intensification factor; the product 0.75io shall not be less than 1.0
in-plane bending moment
out-of-plane bending moment
torsional moment
axial force component for external loads (other than thermal expansion and pressure)
un-corroded cross-sectional area (i.e., before deducting for corrosion)
un-corroded section modulus; for reduced outlets, effective section modulus
Specified Minimum Yield Strength (SMYS) from para. 841.1.1 (a)
Temperature derating factor from para. 841.1.8 and Table 841.1.8-1
Young’s modulus at ambient temperature= Tref in CAEPIPE
installation temperature = Tref in CAEPIPE
warmest or coldest operating temperature
coefficient of thermal expansion at T0 in CAEPIPE

Note 1:
If there are more than one thermal load, for example T1 and T2, then CAEPIPE calculates
longitudinal stress due to thermal expansion from T1 to T2 in restrained pipeline as follows.
𝐸𝛼 (𝑇𝑛 − 𝑇𝑚 ) = 𝐸𝛼𝑛 (𝑇𝑛 − 𝑇𝑟𝑒𝑓 ) − 𝐸𝛼𝑚 (𝑇𝑚 − 𝑇𝑟𝑒𝑓 ), where n = 1 and m = 2
Combined Stress for Restrained Pipe

The combined biaxial stress state of the pipeline in the operating mode is evaluated using the
calculation given below by default in CAEPIPE.
S𝑒𝑞1 = max{|𝑆𝐻 − 𝑆𝐿𝑝 |, |𝑆𝐻 |, |𝑆𝐿𝑝 |}
S𝑒𝑞2 = max{|𝑆𝐻 − 𝑆𝐿𝑛 |, |𝑆𝐻 |, |𝑆𝐿𝑛 |}
Alternatively, the stresses may be combined in accordance with the maximum distortion
energy theory as follows (see Note 3 below):
2

S𝑒𝑞1 = √(𝑆𝐿𝑝 ) − 𝑆𝐻 𝑆𝐿𝑝 + (𝑆𝐻 )2
S𝑒𝑞2 = √(𝑆𝐿𝑛 )2 − 𝑆𝐻 𝑆𝐿𝑛 + (𝑆𝐻 )2
S𝑒𝑞 = max{𝑆𝑒𝑞1, 𝑆𝑒𝑞2 } ≤ 0.9𝑆𝑇
where
S𝑒𝑞 = equivalent combined stress
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Notes:

6. Young’s modulus of elasticity corresponding to the lowest operating temperature
[=min(T1 through T10,Tref)] is used to form the stiffness matrix in accordance with para.
832.4(b).
7. Refer end of this appendix for the details of “Thickness and Section Modulus used for
weight, pressure and stress calculations”.
8. To combine stresses in accordance with the maximum distortion energy theory as stated
above, set an environmental variable with name “DET_318” with its value as “YES”.
Notes on Material Library for B318-2018.mat supplied with CAEPIPE:
Material library for ASME B31.8 (2018) [B318-2018.mat] has been created and supplied with
CAEPIPE as mentioned below.
9. Coefficient of Thermal Expansion: As stated in para. 832.2 of B31.8 (2018),
Coefficient of Thermal Expansion for Carbon and low alloy steel are entered by referring
to the values given in Table 832.2-1 of ASME B31.8 (2018).
10. Modulus of Elasticity: Modulus of Elasticity for Carbon and low alloy steel are entered
by referring to the values given in Table 832.5-1 of ASME B31.8 (2018).
11. Yield Strength: Yield Strength for Carbon and low alloy steel are entered by referring to
the values specified in Mandatory Appendix D titled “Specified Minimum Yield Strength
for Steel Pipe Commonly Used in Piping Systems” of ASME B31.8 (2018).
12. Density and Poisson’s ratio: Density and Poisson’s ratio for Carbon and low alloy high
tensile steel are entered as 0.283 lb/in3 and 0.3 respectively.
13. Longitudinal Joint Factor: Longitudinal Joint Factor for Carbon and low alloy steel are
entered by referring to the values specified in Table 841.1.7-1 of ASME B31.8 (2018).
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Allowable Pressure

For straight pipes and bends (including closely spaced and widely spaced miter bends), the
allowable pressure is calculated from para. 841.1.1.
𝑃=

2𝑆𝐸𝑡𝑛 𝐹𝑇
𝐷

where
𝑃 = allowable pressure
𝑆 = specified minimum yield strength from para. 817.1.3 (h) and para. 841.1.4 (a)
𝐸 = longitudinal joint factor (input as material property), obtained from Table 841.1.7-1
and para. 817.1.3 (d)
𝑡𝑛 = nominal pipe thickness
𝐷 = outside diameter
𝐹 = construction type design factor, obtained from Table 841.1.6-2
𝑇 = temperature derating factor, obtained from Table 841.1.8-1 and para. 841.1.8
Stress due to Sustained and Occasional Loads (Unrestrained Piping)

The sum of longitudinal pressure stress due to axial loading (other than thermal expansion
and pressure) and the bending stress due to external loads, such as weight of the pipe and
contents, seismic or wind, etc. is calculated according to paras. 833.6 (a) and 833.6 (b) along
with paras. 805.2.3, 833.2 (b), 833.2 (d), 833.2 (e) and 833.2 (f).
Please note, the “include axial force in stress calculations” option is turned ON by default for
ANSI B31.8 in CAEPIPE.
Sustained Stress 𝑺𝑳 :

For Pipes and Long Radius Bends
𝑃𝐷 𝑅
√(𝑀𝑖 )2 + (𝑀𝑜 )2 + (𝑀𝑡 )2
𝑆𝐿 = |
+ |
+[
]
4𝑡𝑛 𝐴 𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑
𝑍

≤ 0.75ST

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

For other Fittings or Components.
PD R
√(0.75ii Mi )2 + (0.75ioMo )2 + (Mt )2
SL(fc) = |
+ |
+[
]
4t n A Sustained
Z

≤ 0.75ST

Sustained

Sustained + Occasional Stress 𝑺𝑳𝑶 :

For Pipes and Long Radius Bends
𝐒𝐋𝐎 = 𝐒𝐋 + |

(𝐏𝐩𝐞𝐚𝐤 − 𝐏)𝐃 𝐑
√(𝑴𝒊)𝟐 + (𝑴𝒐 )𝟐 +(𝑴𝒕 )𝟐
+ |
+[
]
𝟒𝐭𝐧
𝐀 𝐨𝐜𝐜𝐚𝐬𝐢𝐨𝐧𝐚𝐥
𝐙

For Fittings or Components
𝑆𝐿𝑂 = 𝑆𝐿(𝑓𝑐) + |

≤ 𝟎. 𝟕𝟓𝐒𝐓

𝐨𝐜𝐜𝐚𝐬𝐢𝐨𝐧𝐚𝐥

(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷 𝑅
√(0.75𝑖𝑖 𝑀𝑖 )2 + (0.75𝑖𝑜 𝑀𝑜 )2 + (𝑀𝑡 )2
+ |
+[
]
4𝑡𝑛
𝐴 𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙
𝑍

𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙
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where
𝑃 = maximum operating pressure = max (P1 through P10)
𝑃𝑝𝑒𝑎𝑘 = Peak pressure factor x P
𝐷 = outside diameter
𝑡𝑛 = nominal thickness
𝑖𝑖 = in-plane stress intensification factor; the product 0.75ii shall not be less than 1.0
𝑖𝑜 = out-of-plane stress intensification factor; the product 0.75ioshall not be less than 1.0
𝑀𝑖 = in-plane bending moment
𝑀𝑜 = out-of-plane bending moment
𝑀𝑡 = torsional moment
𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus
𝑅 = axial force component for external loads (other than thermal expansion and pressure)
𝐴 = un-corroded cross-section area
𝑆 = specified minimum yield strength from para. 841.1.1(a)
𝑇= temperature derating factor, obtained from para. 841.1.8 and Table 841.1.8-1
Note:
Young’s modulus of elasticity corresponding to the lowest operating temperature [=min (T 1
through T10, Tref)] is used to form the stiffness matrix for Sustained and Occasional load
calculations in accordance with para. 832.4(b).
Expansion Stress (Unrestrained Piping)

The stress (𝑆𝐸 ) due to thermal expansion is calculated from para.833.8.
𝑆𝐸 = √𝑆𝑏2 + 4𝑆𝑡2 ≤ 𝑆𝐴
where
𝑆𝑏 = resultant bending stress =
𝑀

√(𝑖𝑖 𝑀𝑖 )2 +(𝑖𝑜 𝑀𝑜 )2
𝑍

𝑆𝑡 = torsional stress = 2𝑍𝑡
𝑀𝑡 = torsional moment
𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus
Please note, “Liberal allowable” option is always turned ON for ANSI B31.8.
𝑆𝐴 = 𝑓 [1.25(𝑆𝐶 + 𝑆ℎ ) − 𝑆𝐿 ]
𝑓 = stress range reduction factor = 6/N0.2, where N = number of equivalent full range
cycles
where𝑓 ≤ 1.0 (from para. 833.8 (b)).
𝑆𝐶 = 0.33SuT at the minimum installed or operating temperature
𝑆ℎ = 0.33SuT at the maximum installed or operating temperature
where
𝑆𝑢 = specified minimum ultimate tensile strength = 1.5 𝑆𝑦 (assumed), and
𝑆𝑦 = specified minimum yield strength as per para. 841.1.1(a)
𝑇 = temperature derating factor, obtained from para. 841.1.8 and Table 841.1.8-1
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Note:
Young’s modulus of elasticity corresponding to the lowest operating temperature [=min(T 1
through T10,Tref)] is used to form the stiffness matrix for Expansion load calculations in
accordance with para. 832.4(b).
Stress due to Sustained, Thermal and Occasional Loads (Restrained Piping)

The Net longitudinal stress (𝑆𝐿 ) due to sustained, thermal expansion and occasional loads
for restrained piping is calculated from paras. 833.3 (a), 833.3 (b) along with paras. 805.2.3,
833.2 (a), 833.2 (c), 833.2 (d), 833.2 (e) and 833.2 (f)
𝑆𝐿𝑝 = 𝑆𝑝 + 𝑆𝑇 + 𝑆𝑋 + 𝑆𝐵
𝑆𝐿𝑛 = 𝑆𝑝 + 𝑆𝑇 + 𝑆𝑋 − 𝑆𝐵
As per 833.4 (d), both the tensile and compressive values of SB shall be considered in
analysis.
where
𝑃𝐷
𝑆𝑝 = 0.3𝑆𝐻 = 0.3 2𝑡 = longitudinal stress due to internal pressure in restrained pipeline
𝑛

𝑆𝐻 = hoop stress
𝑆𝑇 = longitudinal stress due to thermal expansion in restrained pipeline = 𝐸𝛼 (𝑇𝑖 − 𝑇𝑜 )
𝑅

𝑆𝑋 = stress due to axial loading (other than thermal expansion and pressure) = 𝐴
𝑆𝐵 = nominal bending stress due to weight and other external loads(other than thermal
expansion)
For Pipes and Long Radius Bends
𝑆𝐵 =

√(𝑀𝑖 )2 + (𝑀𝑜 )2 + (𝑀𝑡 )2
𝑍

For other Fittings or Components.
√(0.75𝑖𝑖 𝑀𝑖 )2 + (0.75𝑖𝑜 𝑀𝑜 )2 + (𝑀𝑡 )2
𝑍
As per para 833.3(a), note that 𝑆𝐵 ,𝑆𝐿 , 𝑆𝑇 𝑜𝑟 𝑆𝑋 can have negative values.
where
𝑃 = maximum operating pressure = max(P1 through P10)
𝐷 = outside diameter
𝑡𝑛 = nominal thickness
𝑖𝑖 = in-plane stress intensification factor; the product 0.75ii shall not be less than 1.0
𝑖𝑜 = out-of-plane stress intensification factor; the product 0.75io shall not be less than 1.0
𝑀𝑖 = in-plane bending moment
𝑀𝑜 = out-of-plane bending moment
𝑀𝑡 = torsional moment
𝑆𝐵 =
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𝑅
𝐴
𝑍
𝑆
𝑇
𝐸
𝑇𝑖
𝑇𝑜
𝛼

=
=
=
=
=
=
=
=
=

axial force component for external loads (other than thermal expansion and pressure)
un-corroded cross-sectional area (i.e., after deducting for corrosion)
un-corroded section modulus; for reduced outlets, effective section modulus
Specified Minimum Yield Strength (SMYS) from para. 841.1.1 (a)
Temperature derating factor from para. 841.1.8 and Table 841.1.8-1
Young’s modulus at ambient (reference) temperature
installation temperature = Tref in CAEPIPE
warmest or coldest operating temperature
coefficient of thermal expansion at To defined above

Combined Stress for Restrained Pipe

The combined biaxial stress state of the pipeline in the operating mode is evaluated using the
calculation given below by default in CAEPIPE.
S𝑒𝑞1 = max{|𝑆𝐻 − 𝑆𝐿𝑝 |, |𝑆𝐻 |, |𝑆𝐿𝑝 |}
S𝑒𝑞2 = max{|𝑆𝐻 − 𝑆𝐿𝑛 |, |𝑆𝐻 |, |𝑆𝐿𝑛 |}
Alternatively, the stresses may be combined in accordance with the maximum distortion
energy theory as follows (see Note 3 below):
2

S𝑒𝑞1 = √(𝑆𝐿𝑝 ) − 𝑆𝐻 𝑆𝐿𝑝 + (𝑆𝐻 )2
S𝑒𝑞2 = √(𝑆𝐿𝑛 )2 − 𝑆𝐻 𝑆𝐿𝑛 + (𝑆𝐻 )2
S𝑒𝑞 = max{𝑆𝑒𝑞1, 𝑆𝑒𝑞2 } ≤ 0.9𝑆𝑇
where
S𝑒𝑞 = equivalent combined stress
Notes:

1. Young’s modulus of elasticity corresponding to the lowest operating temperature
[=min(T1 through T10,Tref)] is used to form the stiffness matrix in accordance with para.
832.4(b).
2. Refer end of this appendix for the details of “Thickness and Section Modulus used for
weight, pressure and stress calculations”.
3. To combine stresses in accordance with the maximum distortion energy theory as stated
above, set an environmental variable with name “DET_318” with its value as “YES”.
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Notes on Material Library for B318-2016.mat supplied with CAEPIPE:
Material library for ASME B31.8 (2016) [B318-2016.mat] has been created and supplied with
CAEPIPE as mentioned below.
1. Coefficient of Thermal Expansion: As stated in para. 832.2 of B31.8 (2016),
Coefficient of Thermal Expansion for Carbon and low alloy steel are entered by referring
to the values given in Table 832.2-1 of ASME B31.8 (2016).
2. Modulus of Elasticity: Modulus of Elasticity for Carbon and low alloy steel are entered
by referring to the values given in Table 832.5-1 of ASME B31.8 (2016).
3. Yield Strength: Yield Strength for Carbon and low alloy steel are entered by referring to
the values specified in Mandatory Appendix D titled “Specified Minimum Yield Strength
for Steel Pipe Commonly Used in Piping Systems” of ASME B31.8 (2016).
4. Density and Poisson’s ratio: Density and Poisson’s ratio for Carbon and low alloy high
tensile steel are entered as 0.283 lb/in3 and 0.3 respectively.
5. Longitudinal Joint Factor: Longitudinal Joint Factor for Carbon and low alloy steel are
entered by referring to the values specified in Table 841.1.7-1 of ASME B31.8 (2016).
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Allowable Pressure

For straight pipes and bends (including closely spaced and widely spaced miter bends), the
allowable pressure is calculated from para. 841.1.1.
𝑃=

2𝑆𝐸𝑡𝑛 𝐹𝑇
𝐷

where
𝑃 = allowable pressure
𝑆 = specified minimum yield strength from para. 817.1.3 (h) and para. 841.1.4 (a)
𝐸 = longitudinal joint factor (input as material property), obtained from Table 841.1.7-1
and para. 817.1.3 (d)
𝑡𝑛 = nominal pipe thickness
𝐷 = nominal outside diameter
𝐹 = construction type design factor, obtained from Table 841.1.6-1
𝑇 = temperature derating factor, obtained from Table 841.1.8-1 and para. 841.1.8
Stress due to Sustained and Occasional Loads (Unrestrained Piping)

The sum of longitudinal pressure stress and the bending stress due to external loads, such as
weight of the pipe and contents, seismic or wind, etc. is calculated according to paras. 833.6
(a) and 833.6 (b) along with paras. 805.2.3, 833.2 (b), 833.2 (d), 833.2 (e) and 833.2 (f).
Please note, the “include axial force in stress calculations” option is turned ON by default for
ANSI B31.8.
Sustained Stress 𝑺𝑳 :

For Pipes and Long Radius Bends
𝑃𝐷 𝑅
√(𝑖𝑖 𝑀𝑖 )2 + (𝑖𝑜 𝑀𝑜 )2
𝑆𝐿 = |
+ |
+[
]
4𝑡𝑛 𝐴 𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑
𝑍

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

For other Fittings or Components.
PD R
√(0.75ii Mi )2 + (0.75ioMo )2 + (Mt )2
SL(fc) = |
+ |
+[
]
4t n A Sustained
Z

Sustained

Sustained + Occasional Stress 𝑺𝑳𝑶 :

For Pipes and Long Radius Bends
𝐒𝐋𝐎 = 𝐒𝐋 + |

(𝐏𝐩𝐞𝐚𝐤 − 𝐏)𝐃 𝐑
√(𝐢𝐢𝐌𝐢)𝟐 + (𝐢𝐨 𝐌𝐨 )𝟐
+ |
+[
]
𝟒𝐭𝐧
𝐀 𝐨𝐜𝐜𝐚𝐬𝐢𝐨𝐧𝐚𝐥
𝐙

For Fittings or Components
𝑆𝐿𝑂 = 𝑆𝐿(𝑓𝑐) + |

≤ 𝟎. 𝟕𝟓𝐒𝐓

𝐨𝐜𝐜𝐚𝐬𝐢𝐨𝐧𝐚𝐥

(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷 𝑅
√(0.75𝑖𝑖 𝑀𝑖 )2 + (0.75𝑖𝑜 𝑀𝑜 )2 + (𝑀𝑡 )2
+ |
+[
]
4𝑡𝑛
𝐴 𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙
𝑍

𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙
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where
𝑃
𝑃𝑝𝑒𝑎𝑘
𝐷
𝑡𝑛
𝑖𝑖
𝑖𝑜

=
=
=
=
=
=

𝑀𝑖
𝑀𝑜
𝑀𝑡
𝑍
𝑅

=
=
=
=
=

𝐴
𝑆
𝑇

=
=
=

maximum operating pressure = max (P1 through P10)
Peak pressure factor x P
nominal outside diameter
nominal thickness
in-plane stress intensification factor; the product 0.75ii shall not be less than 1.0
out-of-plane stress intensification factor; the product 0.75ioshall not be less than
1.0
in-plane bending moment
out-of-plane bending moment
torsional moment
un-corroded section modulus; for reduced outlets, effective section modulus
axial force component for external loads (other than thermal expansion and
pressure)
corroded cross-section area (i.e., after deducting for corrosion)
specified minimum yield strength from para. 841.1.1(a)
temperature derating factor, obtained from para. 841.1.8 and Table 841.1.8-1

Note:
Young’s modulus of elasticity corresponding to the lowest operating temperature [=min (T 1
through T10, Tref)] is used to form the stiffness matrix for Sustained and Occasional load
calculations.
Expansion Stress (Unrestrained Piping)

The stress (𝑆𝐸 ) due to thermal expansion is calculated from para.833.8.
𝑆𝐸 = √𝑆𝑏2 + 4𝑆𝑡2 ≤ 𝑆𝐴
where
𝑆𝑏 = resultant bending stress =
𝑀

√(𝑖𝑖 𝑀𝑖 )2 +(𝑖𝑜 𝑀𝑜 )2
𝑍

𝑆𝑡 = torsional stress = 2𝑍𝑡
𝑀𝑡 = torsional moment
𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus
Please note, “Liberal allowable” option is always turned ON for ANSI B31.8.
𝑆𝐴 = 𝑓 [1.25(𝑆𝐶 + 𝑆ℎ ) − 𝑆𝐿 ]
𝑓 = stress range reduction factor = 6/N0.2, where N = number of equivalent full range
cycles
where𝑓 ≤ 1.0 (from para. 833.8 (b)).
𝑓 = 0.33SuT at the minimum installed or operating temperature
𝑆ℎ = 0.33SuT at the maximum installed or operating temperature
where
𝑆𝑢 = specified minimum ultimate tensile strength = 1.5 𝑆𝑦 (assumed), and
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𝑆𝑦 = specified minimum yield strength as per para. 841.1.1(a)
𝑇 = temperature derating factor, obtained from para. 841.1.8 and Table 841.1.8-1
Note:
Young’s modulus of elasticity corresponding to the lowest operating temperature [=min(T 1
through T10,Tref)] is used to form the stiffness matrix for Expansion load calculations.
Stress due to Sustained, Thermal and Occasional Loads (Restrained Piping)

The Net longitudinal stress (𝑆𝐿 ) due to sustained, thermal expansion and occasional loads
for restrained piping is calculated from paras. 833.3 (a), 833.3 (b) along with paras. 805.2.3,
833.2 (a), 833.2 (c), 833.2 (d), 833.2 (e) and 833.2 (f)
𝑆𝐿 = max(|𝑆𝑝 + 𝑆𝑥 + 𝑆𝐵 |, |𝑆𝑝 + 𝑆𝑥 − 𝑆𝐵 |)𝑠𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑 +
max(|𝑆𝑝 + 𝑆𝑥 + 𝑆𝐵 |, |𝑆𝑝 + 𝑆𝑥 − 𝑆𝐵 |)𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙 +
max(|𝑆𝑇 |𝑤𝑎𝑟𝑚𝑒𝑠𝑡 , |𝑆𝑇 |𝑐𝑜𝑙𝑑𝑒𝑠𝑡 ) ≤ 0.9𝑆𝑇
where
𝑃𝐷
Internal pressure stress =𝑆𝑝 = 0.3 2𝑡

𝑛

𝑅

Stress due to axial loading (other than thermal expansion and pressure) =𝑆𝑥 = 𝐴 , and may be
positive or negative
Nominal bending stress SB from Weight and / or other External loads for
For Pipes and Long Radius Bends
𝑆𝐵 =

√(𝑖𝑖 𝑀𝑖 )2 + (𝑖𝑜 𝑀𝑜 )2
𝑍

For other Fittings or Components.
√(0.75𝑖𝑖 𝑀𝑖 )2 + (0.75𝑖𝑜 𝑀𝑜 )2 + (𝑀𝑡 )2
𝑍
Thermal expansion stress = 𝑆𝑇 = 𝐸𝛼 (𝑇𝑖 − 𝑇𝑜 ) , and may be positive or negative
𝑆𝐵 =

Where
𝑃 =
𝐷 =
𝑡𝑛 =
𝑖𝑖 =
𝑖𝑜 =
𝑀𝑖 =
𝑀𝑜 =
𝑀𝑡 =
𝑅 =

maximum operating pressure = max(P1 through P10)
nominal outside diameter
nominal thickness
in-plane stress intensification factor; the product 0.75ii shall not be less than 1.0
out-of-plane stress intensification factor; the product 0.75ioshall not be less than 1.0
in-plane bending moment
out-of-plane bending moment
torsional moment
axial force component for external loads (other than thermal expansion and pressure)
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𝐴
𝑍
𝑆
𝑇
𝐸
𝑇𝑖
𝑇𝑜
𝛼

=
=
=
=
=
=
=
=

corroded cross-sectional area (i.e., after deducting for corrosion)
un-corroded section modulus; for reduced outlets, effective section modulus
Specified Minimum Yield Strength (SMYS) from para. 841.1.1 (a)
Temperature derating factor from para. 841.1.8 and Table 841.1.8-1
Young’s modulus at ambient (reference) temperature
installation temperature = Tref in CAEPIPE
warmest or coldest operating temperature
coefficient of thermal expansion at To defined above
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Allowable Pressure

For straight pipes and bends, the calculation of allowable pressure is based on Eq. (2) of
para. 904.1 and 904.2.1.
𝑃=

2𝑆𝐸 (𝑡𝑚 − 𝐴)
𝐷

where
𝑃 = allowable pressure
𝑆𝐸 = allowable hoop stress, given in Appendix I of B31.9 (2020) Code, where
𝐸= longitudinal or spiral weld joint efficiency factor as per Table I-1 of Appendix I of
ASME B31.9 (2020). For casting materials, factor E is replaced with Casting Qualify
Factor F from Table I-1 of Appendix I of ASME B31.9 (2020)
𝑡𝑚 =minimum required pipe thickness as per para. 904.1.1(a) =𝑡𝑛 × (1 – mill tolerance/100)
𝑡𝑛 =nominal pipe thickness
𝐴= corrosion allowance
(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be
included in “corrosion allowance” in CAEPIPE)
𝐷=outside diameter
For closely and widely spaced miter bends, the allowable pressure shall be the lower positive
value calculated from Eqs.(3A) and (3B) of para. 904.2.2(a)
𝑃=

𝑆𝐸𝑇

𝑃=

𝑆𝐸𝑇

𝑟

𝑟

where
𝑟 =
𝑇 =
𝑅 =
𝜃 =

𝑇

(𝑇+0.64 tan 𝜃
𝑅−𝑟

(𝑅−𝑟/2)

√𝑟𝑇

)

Eq. (3A)
Eq. (3B)

mean radius of pipe = (𝐷 − 𝑡𝑛 )/2
𝑡𝑚 − 𝐴, where 𝑡𝑚 and 𝐴 are defined above
effective bend radius of the miter
miter half angle, with 𝜃 ≤ 22.5 deg.

Note:

Equations (3A) and (3B) given above is applicable when R entered in CAEPIPE is at least as
great as the value calculated by eq. (4) of ASME B31.9 (2020).
Sustained Stress (in un-corroded condition)

The longitudinal sustained stress (𝑆𝐿 ) due to sustained loads (pressure, weight and other
sustained mechanical loads) is calculated as mentioned in para. 902.3.2(d)
2

𝑃𝐷𝑜 𝐼𝑎 𝐹𝑎
𝐼𝑡 𝑀𝑡𝐴 2
√(𝐼𝑖 𝑀𝑖𝐴 )2 + (𝐼𝑜 𝑀𝑜𝐴 )2
|+
] +(
𝑆𝐿 = √[|
+
) ≤ 𝑆ℎ
4𝑡𝑛
𝐴𝑝
𝑍
𝑍
where
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P = internal design pressure that shall be not less than the maximum sustained operating
pressure (MSOP) within the piping system, including the effects of static head = maximum
of CAEPIPE pressures P1 through P10
Do = nominal outside diameter
tn= nominal wall thickness
Fa= longitudinal force due to weight and other sustained mechanical loads (excluding
pressure)
Ia= sustained longitudinal force index = 1.00
Ii = sustained in-plane moment index. Ii is taken as the greater of 0.75ii and 1.00. ii is taken
from ASME B31J, Table 1-1.
Io = sustained out-of-plane moment index. Io is taken as the greater of 0.75io and 1.00. io is
taken from ASME B31J, Table 1-1.
It = sustained torsional moment index. I t is taken as the greater of 0.75it and 1.00. it is taken
from ASME B31J, Table 1-1.
MiA, MoA, MtA = in-plane, out-of-plane and torsional moment respectively due to weight and
other sustained mechanical loads
Z = nominal section modulus = un-corroded section modulus
Ap= un-corroded nominal cross sectional area
Sh = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 through
T10)]
SL = stress due to pressure, weight and other sustained mechanical loads
Occasional Stress (in un-corroded condition)

The stress (SO) due to sustained and occasional loads as mentioned in para.902.3.3 as the
combined stress due to (a) sustained loads such as pressure, weight and other sustained
mechanical loads and (b) occasional loads such as earthquake or wind. Wind and earthquake
are not considered to act concurrently.
2

𝑃𝑜 𝐷𝑜 𝐼𝑎 𝐹𝑏
𝐼𝑡 𝑀𝑡𝐵 2
√(𝐼𝑖 𝑀𝑖𝐵 )2 + (𝐼𝑜 𝑀𝑜𝐵 )2
√
|+
] +(
𝑆𝑂 = [|
+
) ≤ 𝑘𝑆ℎ
4𝑡𝑛
𝐴𝑝
𝑍
𝑍
where
Fb = longitudinal force due to weight, other sustained mechanical loads (excluding pressure),
and occasional loads such as thrusts from pressure/safety relief valve loads, from pressure
and flow transients, earthquake / wind, etc.
Ia= occasional longitudinal force index = 1.00
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Ii = occasional in-plane moment index. Ii is taken as the greater of 0.75ii and 1.00. ii is taken
from ASME B31J, Table 1-1.
Io = occasional out-of-plane moment index. Io is taken as the greater of 0.75io and 1.00. io is
taken from ASME B31J, Table 1-1.
It = occasional torsional moment index. It is taken as the greater of 0.75it and 1.00. it is taken
from ASME B31J, Table 1-1.
MiB, MoB, MtB = in-plane, out-of-plane and torsional moment respectively due to weight,
other sustained mechanical loads (excluding pressure), and occasional loads such as thrusts
from pressure/safety relief valve loads, from pressure and flow transients, earthquake /
wind, etc.
Po = peak pressure = (peak pressure factor in CAEPIPE) x P
SO = stress due to pressure, weight, other sustained mechanical loads and occasional loads
such as thrusts from relief / safety valve loads, from pressure and flow transients, earthquake
/ wind etc.
k = 1.33 for occasional loads as per para. 902.3.3 (a)
All other terms such as P, Ap, Z, etc. are as defined under Sustained Stress.
For Unsigned occasional load cases such as Earthquake, etc. the forces and moments are
combined as given below.
𝑃 𝐷

𝑜 𝑜
| 4𝑡
+
𝑛

𝐼𝑎 𝐹𝑏
𝐴𝑝

𝑃 𝐷

𝑜 𝑜
| = 𝑚𝑎𝑥 [| 4𝑡
+

𝐼𝑎 𝐹𝑏(𝑠𝑢𝑠𝑡)

𝑛

𝐴𝑝

𝐼𝑎 𝐹𝑏(𝑜𝑐𝑐𝑎)

|+|

𝐴𝑝

(𝐼𝑖 𝑀𝑖𝐵 )2 = (𝐼𝑖 )2 . [|𝑀𝑖𝐵(𝑠𝑢𝑠𝑡) | + |𝑀𝑖𝐵(𝑜𝑐𝑐𝑎) |]

𝑃 𝐷

𝑜 𝑜
| , | 4𝑡
+
𝑛

𝐼𝑎 𝐹𝑏(𝑠𝑢𝑠𝑡)
𝐴𝑝

𝐼𝑎 𝐹𝑏(𝑜𝑐𝑐𝑎)

|−|

𝐴𝑝

|]

2

(𝐼𝑜 𝑀𝑜𝐵 )2 = (𝐼𝑜 )2 . [|𝑀𝑜𝐵(𝑠𝑢𝑠𝑡) | + |𝑀𝑜𝐵(𝑜𝑐𝑐𝑎) |]
(𝐼𝑡 𝑀𝑡𝐵 )2 = (𝐼𝑡 )2 . [|𝑀𝑡𝐵(𝑠𝑢𝑠𝑡) | + |𝑀𝑡𝐵(𝑜𝑐𝑐𝑎) |]

2

2

For Signed occasional load cases such as Wind, etc. the forces and moments are combined as
given below.
𝑃 𝐷

𝑜 𝑜
| 4𝑡
+
𝑛

𝐼𝑎 𝐹𝑏
𝐴𝑝

𝑃 𝐷

𝑜 𝑜
| = | 4𝑡
+
𝑛

𝐼𝑎 𝐹𝑏(𝑠𝑢𝑠𝑡)
𝐴𝑝

+

𝐼𝑎 𝐹𝑏(𝑜𝑐𝑐𝑎)
𝐴𝑝

(𝐼𝑖 𝑀𝑖𝐵 )2 = (𝐼𝑖 )2 . [|𝑀𝑖𝐵(𝑠𝑢𝑠𝑡) + 𝑀𝑖𝐵(𝑜𝑐𝑐𝑎) |]

|

2

(𝐼𝑜 𝑀𝑜𝐵 )2 = (𝐼𝑜 )2 . [|𝑀𝑜𝐵(𝑠𝑢𝑠𝑡) + 𝑀𝑜𝐵(𝑜𝑐𝑐𝑎) |]
(𝐼𝑡 𝑀𝑡𝐵 )2 = (𝐼𝑡 )2 . [|𝑀𝑡𝐵(𝑠𝑢𝑠𝑡) + 𝑀𝑡𝐵(𝑜𝑐𝑐𝑎) |]

2

2
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where
MiB(sust), MoB(sust), MtB(sust) = in-plane, out-of-plane and torsional moment respectively due to
weight and other sustained mechanical loads (excluding pressure).
MiB(occa), MoB(occa), MtB(occa) = in-plane, out-of-plane and torsional moment respectively due to
occasional loads such as thrusts from pressure/safety relief valve loads, from pressure and
flow transients, earthquake / wind, etc.
Fb(sust) = longitudinal force due to weight, other sustained mechanical loads (excluding
pressure)
Fb(occa) = longitudinal force due to occasional loads such as thrusts from pressure/safety relief
valve loads, from pressure and flow transients, earthquake / wind, etc.
Expansion Stress Range (in un-corroded condition)

The stress range (𝑆𝐸 ) due to thermal expansion is calculated from para. 902.3.2(c), para.
919.2.1 and para. 919.4.1(b)
2

𝑖𝑎 𝐹𝑐
𝑖𝑡 𝑀𝑡𝐶 2
√(𝑖𝑖 𝑀𝑖𝐶 )2 + (𝑖𝑜 𝑀𝑜𝐶 )2
|+
] +(
𝑆𝐸 = √[|
) ≤ 𝑆𝐴
𝐴𝑝
𝑍
𝑍
where
Fc = axial force range due to reference displacement load range
Ap= un-corroded nominal cross sectional area
ia= axial force stress intensification factor = 1.0 for elbows, pipe bends and miter bends
(single, closely spaced and widely spaced), and ia = io(or i when listed) in ASME B31J for
other components
MiC, MoC, MtC = in-plane, out-of-plane and torsional moment range respectively due to the
reference displacement load range
ii, io, it = in-plane, out-of-plane and torsional stress intensification factors respectively as
defined in ASME B31J, Table 1-1
Z = nominal section modulus = un-corroded section modulus
𝑆𝐴 = 𝑓 (1.25𝑆𝐶 + 0.25𝑆ℎ ) (See Note 2 below)
𝑓 = stress range reduction factor 6/𝑁 0.2 , where 𝑁 being the total number of equivalent
reference displacement stress range cycles expected during the service life of the
piping. Also 0.15 ≤ 𝑓 ≤ 1.0
SC = basic allowable stress at minimum metal temperature expected during the displacement
stress range under analysis
Sh = basic allowable stress at maximum metal temperature expected during the displacement
stress range under analysis
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When 𝑆ℎ is greater than 𝑆𝐿 , the allowable stress range may be calculated as per para. 902.3.2
(d).
𝑆𝐴 = 𝑓 [1.25(𝑆𝐶 + 𝑆ℎ ) − 𝑆𝐿 ]. This equation can be re-written as
𝑆𝐴 = 𝑓 (1.25𝑆𝐶 + 0.25𝑆ℎ ) + 𝑓(𝑆ℎ − 𝑆𝐿 ) (see Note 2 below)

This is specified as an analysis option: “Use liberal allowable stresses”, in the CAEPIPE
menu Options>Analysis on the “Code” tab is Turned ON.
Notes:
1. Refer end of this appendix for the details of “Thickness and Section Modulus used
for weight, pressure and stress calculations” as per ASME B31.9 (2020).
2. Para.

902.3.2 (c) and (d) refers to para. 102.3.2 (b) of ASME B31.1 (2020) for Allowable
Stress. As per Note 2 of para. 102.3.2 (b) (1) of ASME B31.1 (2020), “For materials

with a minimum tensile strength of over 70 ksi (480 MPa), eqs. (1A) and (1B) shall be
calculated using Sc or Sh values no greater than 20 ksi (140 MPa), unless otherwise
justified.”
Compliance to this criterion is checked using the value entered under Tensile
Strength field of CAEPIPE Material property input. If this field is NOT entered or
left BLANK, then CAEPIPE will compute the Tensile Strength of the material by
multiplying the Allowable Stress at the minimum temperature (at which the material
properties are entered in CAEPIPE stress model) with a factor of 3.5. This is
because, the allowable stress for material below creep is generally 1/3.5 of Tensile
Strength as stated in Section 1-100 of Mandatory Appendix 1 of ASME Section II,
Part D.
For example, if the allowable stress is 22,000 psi for a high strength material at the
minimum temperature of -20 deg. F, then the Tensile Strength would be 22,000 x 3.5
= 77,000 psi. So, in this case, CAEPIPE will internally set the values of both Sc and
Sh as 20,000 psi as Tensile Strength is greater than 70,000 psi.
In addition, if the option “Use Liberal allowable stresses” is turned ON through
Layout Window > Options > Analysis > Code, then if the left over Sustained stress
(= Sh - SL) is positive, CAEPIPE will multiply this positive left over Sustained stress
by the Stress range reduction factor (f) and add that resulting value to the Expansion
allowable stress computed using the above equation (1A) to arrive at “Liberal
Thermal Allowable Sress”.
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Allowable Pressure

For straight pipes and bends, the calculation of allowable pressure is based on Eq. 2 of para.
904.1 and 904.2.1.
𝑃=

2𝑆𝐸 (𝑡𝑚 − 𝐴)
𝐷

where
𝑃 = allowable pressure
𝑆𝐸 = allowable hoop stress, given in Appendix I of B31.9 (2017) Code, where
𝐸= longitudinal or spiral weld joint efficiency factor as per Table I-1 of Appendix I of
ASME B31.9 (2017). For casting materials, factor E is replaced with Casting Qualify
Factor from Table I-1 of Appendix I of ASME B31.9 (2017)
𝑡𝑚 =minimum required pipe thickness as per para. 904.1.1(a)
=𝑡𝑛 × (1 – mill tolerance/100)
𝑡𝑛 =nominal pipe thickness
𝐴= corrosion allowance
(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be
included in “corrosion allowance” in CAEPIPE)
𝐷=outside diameter
For closely and widely spaced miter bends, the allowable pressure shall be the lower positive
value calculated from Eqs.(3A) and (3B) of para. 904.2.2(a)
𝑃=

𝑆𝐸𝑇

𝑃=

𝑆𝐸𝑇

𝑟

𝑟

where
𝑟 =
𝑇 =
𝑅 =
𝜃 =

𝑇

(𝑇+0.64 tan 𝜃
(

𝑅−𝑟
𝑅−𝑟/2

√𝑟𝑇

Eq. (3A)

)

Eq. (3B)

)

mean radius of pipe = (𝐷 − 𝑡𝑛 )/2
𝑡𝑚 − 𝐴, where 𝑡𝑚 and 𝐴 are defined above
effective bend radius of the miter
miter half angle

Sustained Stress (in un-corroded condition)

The longitudinal stress (𝑆𝐿 ) due to sustained loads (pressure, weight and other sustained
mechanical loads) is calculated as mentioned in para. 902.3.2(d)
𝑆𝐿 =

𝑃𝐷𝑜 0.75𝑖𝑀𝐴
+
≤ 𝑆ℎ
4𝑡𝑛
𝑍

where
𝑃= maximum of CAEPIPE input pressures P1 through P10
𝐷𝑜 = outside diameter
𝑡𝑛 =nominal wall thickness
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𝑖=stress intensification factor. The product 0.75𝑖 shall not be less than 1.0. See Note 1
below.
𝑀𝐴 = resultant bending moment due to weight and other sustained loads
𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus
𝑆ℎ = hot allowable stress at maximum of CAEPIPE input temperatures T1 through T10
Occasional Stress (in un-corroded condition)

The longitudinal stress (𝑆𝐿𝑂 )due to occasional loads is calculated as mentioned in
para.902.3.3 (a) as the sum of stresses due to pressure, live and dead loads and stress due to
occasional loads(𝑆𝑂 ) such as earthquake or wind. Wind and earthquake are not considered
to occur concurrently.
𝑆𝐿𝑂 =

𝑃𝑝𝑒𝑎𝑘 𝐷𝑜 0.75𝑖𝑀𝐴 0.75𝑖𝑀𝐵
+
+
≤ 1.33𝑆ℎ
4𝑡𝑛
𝑍
𝑍

where
𝑀𝐵
= resultant bending moment due to occasional loads
𝑃𝑝𝑒𝑎𝑘 = peak pressure = (peak pressure factor) x P
Expansion Stress (in un-corroded condition)

The stress (𝑆𝐸 ) due to thermal expansion is calculated from para. 902.3.2(c), para. 919.2.1
and para. 919.4.1(b)
𝑆𝐸 =

𝑖𝑀𝐶
≤ 𝑆𝐴
𝑍

where
𝑀𝐶 = resultant moment due to thermal expansion
𝑆𝐴 = 𝑓 (1.25𝑆𝐶 + 0.25𝑆ℎ )
𝑓 = stress range reduction factor 6/𝑁 0.2 , where 𝑁 being the total number of equivalent
reference displacement stress range cycles expected during the service life of the
piping. Also 0.15 ≤ 𝑓 ≤ 1.0
𝑆𝐶 = allowable stress at cold temperature, i.e. at minimum of CAEPIPE input
temperatures T1 through T10 and Tref
When 𝑆ℎ is greater than 𝑆𝐿 , the allowable stress range may be calculated as per para. 902.3.2
(d).
𝑆𝐴 = 𝑓 [1.25(𝑆𝐶 + 𝑆ℎ ) − 𝑆𝐿 ]
This is specified as an analysis option: “Use liberal allowable stresses”, in the CAEPIPE
menu Options>Analysis on the “Code” tab is Turned ON.
Notes:
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1. Stress Intensification Factors (SIFs) and Flexibility Factors (FFs) are computed using
ASME B31.1 (2016) by default as given below. When the option “Use B31J for SIFs
and Flexibility Factors” is Turned ON, then CAEPIPE computes SIFs and FFs as
per B31J (2017).
2. Refer end of this appendix for the details of “Thickness and Section Modulus used
for weight, pressure and stress calculations”.
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Allowable Pressure

For straight pipes and bends, the calculation of allowable pressure is based on Eq. 2 of para.
904.1 and 904.2.1.
𝑃=

2𝑆𝐸 (𝑡𝑚 − 𝐴)
𝐷

where
𝑃 = allowable pressure
𝑆𝐸 = allowable hoop stress, given in Appendix I of B31.9 (2014) Code, where
𝐸 = longitudinal or spiral weld joint efficiency factor or casting quality factor
𝑡𝑚 = minimum required pipe thickness as per para. 904.1.1(a)
= 𝑡𝑛 × (1 – mill tolerance/100)
𝑡𝑛 = nominal pipe thickness
𝐴 = corrosion allowance
(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be
included in “corrosion allowance” in CAEPIPE)
𝐷 = outside diameter
For closely and widely spaced miter bends, the allowable pressure shall be the lower positive
value calculated from Eqs.(3A) and (3B) of para. 904.2.2(a)
𝑃=

𝑆𝐸𝑇

𝑃=

𝑆𝐸𝑇

𝑟

𝑟

where
𝑟 =
𝑇 =
𝑅 =
𝜃 =

𝑇

(𝑇+0.64 tan 𝜃

√𝑟𝑇

Eq. (3A)

)

𝑅−𝑟

Eq. (3B)

(𝑅−𝑟/2)

mean radius of pipe = (𝐷 − 𝑡𝑛 )/2
𝑡𝑚 − 𝐴, where 𝑡𝑚 and 𝐴 are defined above
effective bend radius of the miter
miter half angle

Sustained Stress (in un-corroded condition)

The longitudinal stress (𝑆𝐿 ) due to sustained loads (pressure, weight and other sustained
mechanical loads) is calculated as mentioned in para. 902.3.2(d)
𝑆𝐿 =
where
𝑃 =
𝐷𝑜 =
𝑡𝑛 =
𝑖 =
𝑀𝐴 =
𝑍 =

𝑃𝐷𝑜 0.75𝑖𝑀𝐴
+
≤ 𝑆ℎ
4𝑡𝑛
𝑍

maximum of CAEPIPE pressures P1 through P10
outside diameter
nominal wall thickness
stress intensification factor. The product 0.75𝑖 shall not be less than 1.0.
resultant bending moment due to weight and other sustained loads
un-corroded section modulus; for reduced outlets, effective section modulus
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𝑆ℎ = hot allowable stress at maximum of CAEPIPE input temperatures T1 through T10
Occasional Stress (in un-corroded condition)

The longitudinal stress (𝑆𝐿𝑂 )due to occasional loads is calculated as mentioned in
para.902.3.3 (a) as the sum of stresses due to pressure, live and dead loads and stress due to
occasional loads(𝑆𝑂 ) such as earthquake or wind. Wind and earthquake are not considered
to occur concurrently.
𝑆𝐿𝑂 =

𝑃𝑝𝑒𝑎𝑘 𝐷𝑜 0.75𝑖𝑀𝐴 0.75𝑖𝑀𝐵
+
+
≤ 1.33𝑆ℎ
4𝑡𝑛
𝑍
𝑍

where
𝑀𝐵
= resultant bending moment due to occasional loads
𝑃𝑝𝑒𝑎𝑘 = peak pressure = (peak pressure factor) x P
Expansion Stress (in un-corroded condition)

The stress (𝑆𝐸 ) due to thermal expansion is calculated from para. 902.3.2(c), para. 919.2.1
and para. 919.4.1(b)
𝑆𝐸 =

𝑖𝑀𝐶
≤ 𝑆𝐴
𝑍

where
𝑀𝐶 = resultant moment due to thermal expansion
𝑆𝐴 = 𝑓 (1.25𝑆𝐶 + 0.25𝑆ℎ )
𝑓 = stress range reduction factor 6/𝑁 0.2 , where 𝑁 being the total number of equivalent
reference displacement stress range cycles expected during the service life of the
piping. Also 0.15 ≤ 𝑓 ≤ 1.0
𝑆𝐶 = allowable stress at cold temperature, i.e. at minimum of CAEPIPE input
temperaturesT1 through T10 and Tref
When 𝑆ℎ is greater than 𝑆𝐿 , the allowable stress range may be calculated as per para. 902.3.2
(d).
𝑆𝐴 = 𝑓 [1.25(𝑆𝐶 + 𝑆ℎ ) − 𝑆𝐿 ]
This is specified as an analysis option: “Use liberal allowable stresses”, in the CAEPIPE
menu Options>Analysis on the “Code” tab.
Note:
Refer end of this appendix for the details of “Thickness and Section Modulus used for
weight, pressure and stress calculations”.
Stress Intensification Factor (SIF) values for B31.9 (2014) are referred from Appendix D of
B31.1 (2012). The same is provided below for details.
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Allowable Internal Pressure

For straight pipes and bends, the allowable pressure is calculated using Eq. (3a) for straight
pipes and Eq. (3c) with I = 1.0 for bends from paras. IP-3.2.1 and IP-3.3.1.respectively.
Pa 

2SEM f ta
D  2Yta

where
Pa= allowable pressure
S = stress value for material from Table IX-1A
E = quality factor from Table IX-2 or Table IX-3A
Mf= material performance factor that addresses loss of material properties associated with
hydrogen gas service from Tables IX-5B and IX-5C from Appendix IX.
ta= available thickness for pressure design
= tn × (1 - mill tolerance/100) - corrosion allowance “c”
(Any additional thickness required for threading, grooving, erosion, corrosion, etc. should be
included in corrosion allowance in CAEPIPE)
tn= nominal pipe thickness
D = outside diameter
𝑑= inside diameter
𝑌= coefficient from Table IP-3.2.1, valid for 𝑡𝑎 < 𝐷/6 for Ferritic and Austenitic steels.
Refer to the Table listed at the end of this Section for details on ‘Y’ used in CAEPIPE
for all available materials.
𝑌=

𝑑+2𝑐
𝐷+𝑑+2𝑐

, valid for 𝑡𝑎 ≥ 𝐷/6 for all material types.

For closely spaced miter bends, the allowable pressure is calculated in CAEPIPE using Eq.
(4b) from para. IP-3.3.3.
𝑆𝐸𝑀𝑓 𝑡𝑎 (𝑅 − 𝑟)
𝑃𝑎 =
𝑟(𝑅 − 𝑟/2)
For widely spaced miter bends with 𝜃<= 22.5 deg, the allowable pressure is calculated in
CAEPIPE using Eq. (4a) from para. IP-3.3.3 as
𝑆𝐸𝑀𝑓 𝑡𝑎2
𝑃𝑎 =
𝑟(𝑡𝑎 + 0.643 tan 𝜃 √𝑟𝑡𝑎 )
For widely spaced miter bends with 𝜃> 22.5 deg, the allowable pressure is calculated in
CAEPIPE using Eq. (4c) from para. IP-3.3.3 as
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𝑃𝑎 =

𝑆𝐸𝑀𝑓 𝑡𝑎2
𝑟(𝑡𝑎 + 1.25 tan 𝜃 √𝑟𝑡𝑎 )

where
𝑟 = mean radius of pipe = (D- tn)/2
𝑅 = effective bend radius of the miter (see para. IP-3.3.3 (d) of code for definition) [an input
in CAEPIPE for miters]
 = angle of miter cut (see para. IP-3.3.3 of code for definition)
Sustained Stress

The stress (𝑆𝐿 ) due to sustained loads (pressure, weight and other sustained mechanical
loads) is calculated using Eqs. (23a), (23b1), (23b2), (23c) and (23d) from para. 320.2 of
ASME B31.3 (2018) and compared against the allowable provided in para. IP-2.2.10.
𝑆𝐿 = √(|𝑆𝑎 | + 𝑆𝑏 )2 + (2𝑆𝑡 )2 ≤ 𝑆ℎ 𝑀𝑓
where
𝑆𝑎 = [

𝐼𝑎 𝐹𝑎
𝑃𝐷 𝑅
]
=[
+ ]
𝐴𝑝 𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑
4𝑡𝑠 𝐴𝑝 𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

√(𝐼𝑖 𝑀𝑖 )2 + (𝐼𝑜 𝑀𝑜 )2
]
𝑆𝑏 = [
𝑍𝑚

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

For branch (Leg 3 in Fig. 319.4.4B) of ASME B31.3 (2018),
√(𝐼𝑖 𝑀𝑖 )2 + (𝐼𝑜 𝑀𝑜 )2
]
𝑆𝑏 = [
𝑍𝑒
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

𝑆𝑡 = [

𝐼𝑡 𝑀𝑡
]
2𝑍𝑚 𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

𝑃 = maximum of CAEPIPE input pressures P1 through P10
𝐷 = outside diameter
𝑡𝑆 = wall thickness used for sustained stress calculation obtained by deducting corrosion
allowance from the nominal thickness
𝑡𝑆 = nominal thickness - corrosion allowance in CAEPIPE, as per para. 320.1 of ASME
B31.3 (2018)
𝐴𝑝 = corroded cross-sectional area of the pipe computed using ts as per para. 320.1of ASME
B31.3 (2018)
𝐼𝑎 = longitudinal force index = 1.0
𝐹𝑎 = longitudinal force due to sustained loads such as pressure and weight
𝑅= axial force due to weight alone, where weight is computed using nominal thickness.
𝐼𝑖 = sustained in-plane moment index = 0.75𝑖𝑖 or 1.0, whichever is greater.
𝐼𝑜 = sustained out-of-plane moment index = 0.75𝑖𝑜 or 1.0, whichever is greater.
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where, 𝑖𝑖 and 𝑖𝑜 are taken from Appendix D of ASME B31.3 (2018) [reprinted at the
end of this Section] or from B31J (2017) when the option “Use B31J for SIFs and
Flexibility Factors” is Turned ON.
𝐼𝑡 = torsional moment index = 1.0
𝑀𝑖 = in-plane bending moment due to sustained loads such as pressure and weight
𝑀𝑜 = out-of-plane bending moment due to sustained loads such as pressure and weight
𝑀𝑡 = torsional moment due to sustained loads such as pressure and weight
𝑍𝑚 = corroded section modulus as per para. 320.1 of ASME B31.3 (2018)
𝑍𝑒 = effective corroded section modulus for branch as per para.320.2 of ASME B31.3 (2018)
when Appendix D of ASME B31.3 is used to compute Stress Intensification Factors
(SIFs) (or) corroded section modulus when B31J is used to compute to compute SIFs.
𝑀𝑓 = material performance factor that addresses loss of material properties associated
withhydrogen gas service from Tables IX-5B and IX-5C from Appendix IX.
𝑆ℎ = basic allowable stress at maximum temperature, i.e., max (Tref, T1 through T10)
Sustained plus Occasional Stress

The stress (𝑆𝐿𝑜 ) due to sustained and occasional loads is calculated as the sum of stress (𝑆𝐿 )
due to sustained loads such as pressure and weight and stress (𝑆𝑜 ) due to occasional loads
such as earthquake or wind. Wind and earthquake are not considered as acting concurrently
(see para. IP-2.2.11).
For temp ≤ 4270 C or 8000 F(see Note 1 below)

𝑆𝐿𝑂 ≤ 1.33𝑆ℎ 𝑀𝑓
For temp > 4270 C or 8000 F

𝑆𝐿𝑂 ≤ 0.9𝑊𝑆𝑦 𝑀𝑓
where
𝑆𝐿𝑂 = 𝑆𝐿 + 𝑆𝑂 , where 𝑆𝐿 is computed as above, and 𝑆𝑜 is calculated using Eqs. (23a), (23b1),
(23b2), (23c) and (23d) of ASME B31.3 (2018) with applicable loads.
𝑆𝑂 = √(|𝑆𝑎𝑜 | + 𝑆𝑏𝑜 )2 + (2𝑆𝑡𝑜 )2
(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷 𝑅
𝐼𝑎 𝐹𝑎
]
𝑆𝑎𝑜 = [
=[
+ ]
𝐴𝑝 𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙
4𝑡𝑠
𝐴𝑝 𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙
𝑆𝑏𝑜 = [

√(𝐼𝑖 𝑀𝑖 )2 + (𝐼𝑜 𝑀𝑜 )2
]
𝑍𝑚

𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

For branch (Leg 3 in Fig. 319.4.4B) of ASME B31.3 (2018)
𝑆𝑏𝑜

√(𝐼𝑖 𝑀𝑖 )2 + (𝐼𝑜 𝑀𝑜 )2
]
=[
𝑍𝑒

𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙
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𝑆𝑡𝑜 = [

𝐼𝑡 𝑀𝑡
]
2𝑍𝑚 𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙
= peak pressure = (peak pressure factor in CAEPIPE) x P
= maximum of CAEPIPE input pressures P1 through P10

𝑃𝑝𝑒𝑎𝑘

𝑃

𝑅
= axial force due to occasional loads such as earthquake or wind
𝑀𝑖
= in-plane bending moment due to occasional loads such as earthquake or wind
𝑀𝑜
= out-of-plane bending moment due to occasional loads such as earthquake or wind
𝑀𝑡 = torsional moment due to occasional loads such as earthquake or wind
𝑆𝑦 = yield strength at maximum temperature, i.e., max (T ref, T1 through T10)
𝑊 = 1.0 for Austenetic stainless steel and 0.8 for other materials as per para. IP-2.2.11(a)
𝑍𝑚 = corroded section modulus as per para. 320.1 of ASME B31.3 (2018)
𝑍𝑒 = effective corroded section modulus for branch as per para.320.2 of ASME B31.3 (2018)
when Appendix D of ASME B31.3 is used to compute Stress Intensification Factors
(SIFs) (or) corroded section modulus when B31J is used to compute to compute SIFs.
Note 1:

The allowable stress equations for (𝑆𝐿𝑂 )are taken from para. 302.3.6 of ASME B31.3 (2018),
as the sentence “At temperatures warmer than 427 deg. C (800 deg.F), use 1.33.Sh.M f” in
para. IP-2.2.11 of ASME B31.12 (2019) code seems to be incorrectly worded.
Expansion Stress

The stress (𝑆𝐸 ) due to thermal expansion is calculated using Eq. 17 from para. IP-6.1.5. The
Axial Stress term (𝑆𝑎 ) is included in Expansion Stress calculation as per Eq. 17 of para.
319.4.4 of ASME B31.3 (2018) code.
𝑆𝐸 = √(|𝑆𝑎 | + 𝑆𝑏 )2 + (2𝑆𝑡 )2
where
𝑆𝑎 = [

𝑖𝑎 𝐹𝑎
]
𝐴 𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

√(𝑖𝑖 𝑀𝑖 )2 + (𝑖𝑜 𝑀𝑜 )2
]
𝑆𝑏 = [
𝑍

𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

For branch (Leg 3 in Fig. IP-6.1.5-2)
√(𝑖𝑖 𝑀𝑖 )2 + (𝑖𝑜 𝑀𝑜 )2
]
𝑆𝑏 = [
𝑍𝑒

𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

𝑆𝑡 = [

𝑖𝑡 𝑀𝑡
]
2𝑍 𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛
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𝐴 =un-corroded cross-sectional area of the pipe/fitting computed using nominal thickness
𝑡𝑛 and outer diameter D as per IP-6.1.4 (e).
𝑖𝑎 =axial stress intensification factor = 1.0 for elbows, pipe bends and miter bends and
𝑖𝑎 = 𝑖𝑜 𝑜𝑟 𝑖 for other components as listed in Appendix D of B31.3 (2018)
𝐹𝑎 =range of axial force due to displacement strains between any two thermal conditions
being evaluated
𝑖𝑖 = in-plane stress intensification factor from Appendix D of ASME B31.3 (2018) or from
B31J (2017) when the option “Use B31J for SIFs and Flexibility Factors” is Turned ON.
𝑖𝑖 shallnot be less than 1.0.
𝑖𝑜 =out-of-plane stress intensification factor Appendix D of ASME B31.3 (2018) or from
B31J (2017) when the option “Use B31J for SIFs and Flexibility Factors” is Turned ON.
𝑖𝑜 shallnot be less than 1.0.
𝑖𝑡 =torsional stress intensification factor = 1.0
𝑀𝑖 =in-plane bending moment
𝑀𝑜 =out-of-plane bending moment
𝑀𝑡 =torsional moment
𝑍=un-corroded section modulus as per IP-6.1.4 (e)
𝑍𝑒 =un-corroded effective section modulus as per IP-6.1.4 (e)
𝑆𝐴 =𝑓 (1.25𝑆𝐶 + 0.25𝑆ℎ ), Eq. (1a) of para. IP-2.2.10 (d)
𝑓 =stress range reduction factor from Eq. (1c) of para. IP-2.2.10 (d) = 6N-0.2

where f ≥ 0.15 and f ≤ 1.0 (see Note 1 below)
𝑆𝐶 =basic allowable stress at minimum metal temperature expected during the displacement
cycle under analysis
𝑆ℎ =basic allowable stress at maximum metal temperature expected during the displacement
cycle under analysis
When 𝑆ℎ is greater than Sustained Stress 𝑆𝐿 , the allowable stress range may be calculated as
𝑆𝐴 = 𝑓 [1.25(𝑆𝐶 + 𝑆ℎ ) − 𝑆𝐿 ], Eq. (1b) of para. IP-2.2.10 (d).
This is specified as an analysis option “Use liberal allowable stresses”, in the menu Layout >
Options > Analysis > Code tab.
Notes:

1. As per para. IP-2.2.10 (d), f = maximum value of stress range factor; 1.2 for ferrous
materials with specified minimum tensile strengths ≤ 517 MPa (75 ksi) and at metal
temperatures ≤ 371°C (700°F). This criterion is not implemented in CAEPIPE as the
provision for entering the minimum tensile strength in material property is not available
at this time. Hence f ≤ 1.0 for all materials including Ferrous materials.
2. Young’s modulus of elasticity corresponding to reference temperature (Tref) is used to
form the stiffness matrix in accordance with para. IP-6.1.5 (d)(1).
3. Refer end of this appendix for the details of “Thickness and Section Modulus used for
weight, pressure and stress calculations”.
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Notes on Material Library for B3112-2019.mat supplied with CAEPIPE:
1. Material library for ASME B31.12 (2019) [B3112-2019.mat] supplied with CAEPIPE
has been created by referring to the values provided in Appendix IX of ASME
B31.12 (2019).
2. Coefficient of Thermal Expansion: Coefficient of Thermal Expansion data are
entered by referring to the values provided in Table C-1 of Appendix C of ASME
B31.3 (2018).
3. Modulus of Elasticity: Modulus of Elasticity data are entered by referring to the
values provided in Table C-6 of Appendix C of ASME B31.3 (2018).
4. Longitudinal Joint Factor: Longitudinal Joint Factor are entered by referring to the
values specified in Table IX-3A of ASME B31.12 (2019).
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Stress Intensification Factor (SIF) values for B31.12 (2019) are referred from Appendix D of
B31.3 (2018). The same is provided below for details.
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Coefficient ‘Y’ used in CAEPIPE to compute Allowable Design Pressure
[Sl. Nos. 1 & 2 below are from Table IP-3.2.1 and Sl. Nos. 3, 4 & 5 are from Table 304.1.1 of ASME
B31.3 (2018)]

Sl.
No.
1.
2.
3.
4.
5.

Material Type
Ferritic
Steels
(FS)
Austenitic Steel
(AS)
Nickel
Alloys
(NA)
Gray Iron / Cast
Iron (CI)
Material Types
other than those
stated from Sl.
Nos. 1 to 4.

950
(510)

Values of ‘Y’ for Temperature, Deg F (Deg C)
1000
1050
1100
1150
1200
(538)
(566)
(593)
(621)
(649)

900
(482)
and
below
0.4

0.5

0.7

0.7

0.7

0.7

0.7

1250
(677)
and
above
0.7

0.4

0.4

0.4

0.4

0.5

0.7

0.7

0.7

0.4

0.4

0.4

0.4

0.4

0.4

0.5

0.7

0.0

0.0

0.0

0.0

0.0

0.0

0.0

0.0

0.4

0.4

0.4

0.4

0.4

0.4

0.4

0.4

Carbon Steel Piping Materials Performance Factor (Mf) used in CAEPIPE for Material Type as
“CS” (from Table IX-5B)
Sl.
No.
1.
2.
3.
4.

Specified Min. Yield
Strength (ksi)
<= 52
<= 56
<= 65
<= 80

<=1000
1.000
0.930
0.839
0.715

2000
0.948
0.881
0.796
0.678

System Design Pressure, psig
3000
4000
5000
0.912
0.884
0.860
0.848
0.824
0.800
0.766
0.745
0.724
0.645
0.633
0.618

6000
0.839
0.778
0.706
0.600

Low and Intermediate Alloy Steel Piping Materials Performance Factor (Mf) used in CAEPIPE
for Material Type as “AS” (from Table IX-5C)
Sl.
No.
1.
2.
3.
4.

Specified Min. Tensile
Strength (ksi)
<= 35
<= 45
<= 60
<= 65

0.000
1.000
0.791
0.655
0.580

1000
0.918
0.724
0.601
0.532

System Design Pressure, psig
2000
3000
4000
0.881
0.875
0.836
0.696
0.675
0.660
0.577
0.561
0.547
0.511
0.497
0.485

5000
0.815
0.642
0.533
0.472

6000
0.800
0.630
0.524
0.464

Note:
For materials not covered by Tables given above, Material Performance Factor (Mf) is taken as 1.00.
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Allowable Internal Pressure

For straight pipes and bends, the allowable pressure is calculated using Eq. (3a) for straight
pipes and Eq. (3c) with I = 1.0 for bends from paras. IP-3.2.1 and IP-3.3.1.respectively.
Pa 

2SEM f ta
D  2Yta

where
Pa= allowable pressure
S = stress value for material from Table IX-1A
E = quality factor from Table IX-2 or Table IX-3A
Mf= material performance factor that addresses loss of material properties associated with
hydrogen gas service from Tables IX-5B and IX-5C from Appendix IX.
ta= available thickness for pressure design
= tn × (1 - mill tolerance/100) - corrosion allowance “c”
(Any additional thickness required for threading, grooving, erosion, corrosion, etc. should be
included in corrosion allowance in CAEPIPE)
tn= nominal pipe thickness
D = outside diameter
𝑑= inside diameter
𝑌= coefficient from Table IP-3.2.1, valid for 𝑡𝑎 < 𝐷/6 for Ferritic and Austenitic steels.
Refer to the Table listed at the end of this Section for details on ‘Y’ used in CAEPIPE
for all available material.
𝑌=

𝑑+2𝑐
𝐷+𝑑+2𝑐

, valid for 𝑡𝑎 ≥ 𝐷/6 for all material types.

For closely spaced miter bends, the allowable pressure is calculated in CAEPIPE using Eq.
(4b) from para. IP-3.3.3.
𝑆𝐸𝑀𝑓 𝑡𝑎 (𝑅 − 𝑟)
𝑃𝑎 =
𝑟(𝑅 − 𝑟/2)
For widely spaced miter bends with 𝜃<= 22.5 deg, the allowable pressure is calculated in
CAEPIPE using Eq. (4a) from para. IP-3.3.3 as
𝑆𝐸𝑀𝑓 𝑡𝑎2
𝑃𝑎 =
𝑟(𝑡𝑎 + 0.643 tan 𝜃 √𝑟𝑡𝑎 )
For widely spaced miter bends with 𝜃> 22.5 deg, the allowable pressure is calculated in
CAEPIPE using Eq. (4c) from para. IP-3.3.3 as
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𝑃𝑎 =

𝑆𝐸𝑀𝑓 𝑡𝑎2
𝑟(𝑡𝑎 + 1.25 tan 𝜃 √𝑟𝑡𝑎 )

where
𝑟= mean radius of pipe = (D- tn)/2
𝑅 = effective bend radius of the miter (see para. IP-3.3.3 (d) of code for definition) [an input
in CAEPIPE for miters]
 = angle of miter cut
Sustained Stress

The stress (𝑆𝐿 ) due to sustained loads (pressure, weight and other sustained mechanical
loads) is calculated using Eqs. (23a), (23b), (23c) and (23d) from para. 320.2 of ASME B31.3
(2014) and compared against the allowable provided in para. IP-2.2.10.
𝑆𝐿 = √(|𝑆𝑎 | + 𝑆𝑏 )2 + (2𝑆𝑡 )2 ≤ 𝑆ℎ 𝑀𝑓
where
𝑆𝑎 = [

𝐼𝑎 𝐹𝑎
𝑃𝐷 𝑅
]
=[
+ ]
𝐴𝑝 𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑
4𝑡𝑠 𝐴𝑝 𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

𝑆𝑏 = [

√(𝐼𝑖 𝑀𝑖 )2 + (𝐼𝑜 𝑀𝑜 )2
]
𝑍𝑚

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

For branch (Leg 3 in Fig. 319.4.4B)of ASME B31.3 (2014),
√(𝐼𝑖 𝑀𝑖 )2 + (𝐼𝑜 𝑀𝑜 )2
]
𝑆𝑏 = [
𝑍𝑒
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

𝑆𝑡 = [

𝐼𝑡 𝑀𝑡
]
2𝑍𝑚 𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

𝑃= maximum of CAEPIPE input pressures P1 through P10
𝐷 = outside diameter
𝑡𝑆 =wall thickness used for sustained stress calculation obtained by deducting corrosion
allowance from the nominal thickness
𝑡𝑆 = nominal thickness - corrosion allowance in CAEPIPE, as per para. 320.1ofASME B31.3
(2014)
𝐴𝑝 =corroded cross-sectional area of the pipe computed using ts as per para. 320.1ofASME
B31.3 (2014)
𝐼𝑎 = longitudinal force index = 1.0
𝐹𝑎 = longitudinal force due to sustained loads such as pressure and weight
𝑅= axial force due to weight alone, where weight is computed using nominal thickness.
𝐼𝑖 = sustained in-plane moment index = 0.75𝑖𝑖 or 1.0, whichever is greater.
𝐼𝑜 = sustained out-of-plane moment index = 0.75𝑖𝑜 or 1.0, whichever is greater.
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where, 𝑖𝑖 and 𝑖𝑜 are taken from Appendix D of ASME B31.3 (2014) [reprinted at the
end of this Section].
𝐼𝑡 = torsional moment index = 1.0
𝑀𝑖 =in-plane bending moment due to sustained loads such as pressure and weight
𝑀𝑜 =out-of-plane bending moment due to sustained loads such as pressure and weight
𝑀𝑡 =torsional moment due to sustained loads such as pressure and weight
𝑍𝑚 =corroded section modulus as per para. 320.1ofASME B31.3 (2014)
𝑍𝑒 =effective corroded section modulus for branch as per para.320.2 of ASME B31.3 (2014)
𝑀𝑓 =material performance factor that addresses loss of material properties associated with
hydrogen gas service from Tables IX-5B and IX-5C from Appendix IX.
Sustained plus Occasional Stress

The stress (𝑆𝐿𝑜 ) due to sustained and occasional loads is calculated as the sum of stress (𝑆𝐿 )
due to sustained loads such as pressure and weight and stress (𝑆𝑜 ) due to occasional loads
such as earthquake or wind. Wind and earthquake are not considered as acting concurrently
(see para. IP-2.2.11).
For temp ≤ 4270 C or 8000 F

𝑆𝐿𝑂 ≤ 1.33𝑆ℎ 𝑀𝑓
For temp > 4270 C or 8000 F

𝑆𝐿𝑂 ≤ 0.9𝑊𝑆𝑦 𝑀𝑓
where
𝑆𝐿𝑂 = 𝑆𝐿 + 𝑆𝑂 , where 𝑆𝐿 is computed as above, and 𝑆𝑜 is calculated using Eqs. (23a), (23b),
(23c) and (23d) of ASME B31.3 (2014) with applicable loads.
𝑆𝑂 = √(|𝑆𝑎𝑜 | + 𝑆𝑏𝑜 )2 + (2𝑆𝑡𝑜 )2
(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷 𝑅
𝐼𝑎 𝐹𝑎
]
𝑆𝑎𝑜 = [
=[
+ ]
𝐴𝑝 𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙
4𝑡𝑠
𝐴𝑝 𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙
𝑆𝑏𝑜 = [

√(𝐼𝑖 𝑀𝑖 )2 + (𝐼𝑜 𝑀𝑜 )2
]
𝑍𝑚

𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

For branch (Leg 3 in Fig. 319.4.4B)of ASME B31.3 (2014)
𝑆𝑏𝑜

√(𝐼𝑖 𝑀𝑖 )2 + (𝐼𝑜 𝑀𝑜 )2
]
=[
𝑍𝑒

𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

𝑆𝑡𝑜 = [

𝐼𝑡 𝑀𝑡
]
2𝑍𝑚 𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

𝑃𝑝𝑒𝑎𝑘

= peak pressure = (peak pressure factor in CAEPIPE) x P
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= axial force due to occasional loads such as earthquake or wind
= in-plane bending moment due to occasional loads such as earthquake or wind
= out-of-plane bending moment due to occasional loads such as earthquake or wind
torsional moment due to occasional loads such as earthquake or wind
yield strength at maximum temperature, i.e., max (T ref, T1 through T10)
1.0 for Austenetic stainless steel and 0.8 for other materials as per para. IP-2.2.11(a)
corroded section modulus as per para. 320.1ofASME B31.3 (2014)
effective corroded section modulus for branch as per para. 320.2ofASME B31.3 (2014)

𝑅
𝑀𝑖
𝑀𝑜
𝑀𝑡 =
𝑆𝑦 =
𝑊 =
𝑍𝑚 =
𝑍𝑒 =
Note 1:

The allowable stress equations for (𝑆𝐿𝑂 )are taken from para. 302.3.6 of ASME B31.3 (2014),
as the sentence “At temperatures warmer than 427 deg. C (800 deg.F), use 1.33.Sh.M f” in
para. IP-2.2.11 of ASME B31.12 (2014) code seems to be incorrectly worded.
Expansion Stress

The stress (𝑆𝐸 ) due to thermal expansion is calculated using Eq. 17 from para. IP-6.1.5
𝑆𝐸 = √(|𝑆𝑎 | + 𝑆𝑏 )2 + (2𝑆𝑡 )2
where
𝑆𝑎 = [

𝑖𝑎 𝐹𝑎
]
𝐴 𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

√(𝑖𝑖 𝑀𝑖 )2 + (𝑖𝑜 𝑀𝑜 )2
]
𝑆𝑏 = [
𝑍

𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

For branch (Leg 3 in Fig. IP-6.1.5-2)
√(𝑖𝑖 𝑀𝑖 )2 + (𝑖𝑜 𝑀𝑜 )2
]
𝑆𝑏 = [
𝑍𝑒

𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

𝑆𝑡 = [

𝐴
𝑖𝑎
𝐹𝑎

𝑖𝑖
𝑖𝑜

𝑖𝑡 𝑀𝑡
]
2𝑍 𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

= un-corroded cross-sectional area of the pipe/fitting computed using nominal
thickness 𝑡𝑛 and outer diameter D as per IP-6.1.4 (e).
= axial stress intensification factor = 1.0 for elbows, pipe bends and miter bends and
𝑖𝑎 = 𝑖𝑜 𝑜𝑟 𝑖 for other components as listed in Appendix D of B31.3 (2014)
= range of axial force due to displacement strains between any two thermal conditions
being evaluated
= in-plane stress intensification factor from Appendix D of ASME B31.3 (2014)
shallnot be less than 1.0
= out-of-plane stress intensification factor Appendix D of ASME B31.3 (2014)
shall not be less than 1.0
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𝑖𝑡
𝑀𝑖
𝑀𝑜
𝑀𝑡

𝑍
𝑍𝑒

= torsional stress intensification factor = 1.0
= in-plane bending moment

=
=
=
=

out-of-plane bending moment
torsional moment
un-corroded section modulus as per IP-6.1.4 (e)
un-corroded effective section modulus as per IP-6.1.4 (e)

= 𝑓 (1.25𝑆𝐶 + 0.25𝑆ℎ ), Eq. (1a) of para. IP-2.2.10 (d)
= stress range reduction factor from Eq. (1c) of para. IP-2.2.10 (d) = 6N-0.2
where f ≥ 0.15 and f ≤ 1.0 (see Note 1 below)
𝑆𝐶 = basic allowable stress at minimum metal temperature expected during the
displacement cycle under analysis
𝑆ℎ = basic allowable stress at maximum metal temperature expected during the
displacement cycle under analysis
When 𝑆ℎ is greater than Sustained Stress 𝑆𝐿 , the allowable stress range may be calculated as
𝑆𝐴 = 𝑓 [1.25(𝑆𝐶 + 𝑆ℎ ) − 𝑆𝐿 ], Eq. (1b) of para. IP-2.2.10 (d).
𝑆𝐴
𝑓

This is specified as an analysis option “Use liberal allowable stresses”, in the menu Layout >
Options > Analysis > Code tab.
Notes:

4. As per para. IP-2.2.10 (d), f = maximum value of stress range factor; 1.2 for ferrous
materials with specified minimum tensile strengths ≤ 517 MPa (75 ksi) and at metal
temperatures ≤ 371°C (700°F). This criterion is not implemented in CAEPIPE as the
provision for entering the minimum tensile strength in material property is not available
at this time. Hence f ≤ 1.0 for all materials including Ferrous materials.
5. Young’s modulus of elasticity corresponding to reference temperature (Tref) is used to
form the stiffness matrix in accordance with para. IP-6.1.5 (d)(1).
6. Refer end of this appendix for the details of “Thickness and Section Modulus used for
weight, pressure and stress calculations”.
Notes on Material Library for B3112-2014.mat supplied with CAEPIPE:
Material library for ASME B31.12 (2014) [B3112-2014.mat] supplied with CAEPIPE has
been created by referring to the values provided in Appendix IX of ASME B31.12 (2014).
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Coefficient ‘Y’ used in CAEPIPE to compute Allowable Design Pressure
[Sl. Nos. 1 & 2 below are from Table IP-3.2.1 and Sl. Nos. 3, 4 & 5 are from Table 304.1.1 of ASME
B31.3 (2014)]

Sl.
No.
1.
2.
3.
4.
5.

Material Type
Ferritic
Steels
(FS)
Austenitic Steel
(AS)
Nickel
Alloys
(NA)
Gray Iron / Cast
Iron (CI)
Material Types
other than those
stated from Sl.
Nos. 1 to 4.

950
(510)

Values of ‘Y’ for Temperature, Deg F (Deg C)
1000
1050
1100
1150
1200
(538)
(566)
(593)
(621)
(649)

900
(482)
and
below
0.4

0.5

0.7

0.7

0.7

0.7

0.7

1250
(677)
and
above
0.7

0.4

0.4

0.4

0.4

0.5

0.7

0.7

0.7

0.4

0.4

0.4

0.4

0.4

0.4

0.5

0.7

0.0

0.0

0.0

0.0

0.0

0.0

0.0

0.0

0.4

0.4

0.4

0.4

0.4

0.4

0.4

0.4

Carbon Steel Piping Materials Performance Factor (Mf) used in CAEPIPE for Material Type as
“CS” (from Table IX-5B)
Sl.
No.
1.
2.
3.
4.

Specified Min. Yield
Strength (ksi)
<= 52
<= 56
<= 65
<= 80

<=1000
1.000
0.930
0.839
0.715

2000
0.948
0.881
0.796
0.678

System Design Pressure, psig
3000
4000
5000
0.912
0.884
0.860
0.848
0.824
0.800
0.766
0.745
0.724
0.645
0.633
0.618

6000
0.839
0.778
0.706
0.600

Low and Intermediate Alloy Steel Piping Materials Performance Factor (Mf) used in CAEPIPE
for Material Type as “AS” (from Table IX-5C)
Sl.
No.
1.
2.
3.
4.

Specified Min. Tensile
Strength (ksi)
<= 35
<= 45
<= 60
<= 65

0.000
1.000
0.791
0.655
0.580

1000
0.918
0.724
0.601
0.532

System Design Pressure, psig
2000
3000
4000
0.881
0.875
0.836
0.696
0.675
0.660
0.577
0.561
0.547
0.511
0.497
0.485

5000
0.815
0.642
0.533
0.472

6000
0.800
0.630
0.524
0.464

Note:
For materials not covered by Tables given above, Material Performance Factor (Mf) is taken as 1.00.
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Implemented as an optional feature for B31.4, B31.5, B31.8 and B31.12 codes. This
feature can be turned ON or OFF through Layout Frame > Options > Analysis.



Turning on the Option B31J will allow users to select and specify among those
Branch SIF types defined in B31J for all the above codes.



When B31J is turned ON, CAEPIPE will calculate SIFs as per B31J and report
Torsional, In-plane and Out-of-plane SIFs in Element Forces and Moments results
irrespective of whether they are being used or not in Code Compliance as per the
Piping Code selected for Analysis. For Example, CAEPIPE will not include
Torsional Moment and Torsional SIF while calculating Sustained Stress as per ASME
B31.5 (2016).



For Equal TEEs, the Run and Branch should be differentiated in CAEPIPE model
by defining the Branch OD slightly less than the Run OD through CAEPIPE
Sections input. Otherwise, CAEPIPE will use the equations corresponding to Run
pipe even for Branch pipe.



ASME B31.3 (2020) includes the term Axial SIF in Stress Calculations. On the other
hand, B31J is silent about the Axial SIF for various components. Hence, CAEPIPE
will use the Axial SIF values as stated in the respective text portions of B31.3 (2016)
while computing stresses irrespective of whether the option B31J is turned ON or
OFF.



As per para 402.6.1 of ASME B31.4 (2019), Torsion moment is not included in the
equation for Sustained Stress for Restrained piping. In line with the code, CAEPIPE
will not use Torsion Moment and Torsion SIF while calculating Sustained Stress for
Restrained pipe even with the option B31J turned ON.



For ASME B31.5 (2019), paras. 502.3.2(d), 502.3.3 (a), 519.4.5 and 519.3.5 do not
include Torsional moment in computing Stresses. Accordingly, CAEPIPE will not
include Torsional Moment and Torsional SIF while calculating Stresses as per ASME
B31.5 (2016) even when the option B31J is turned ON.



For ASME B31.8 (2020), para. 833.2 (e) states that the nominal Bending Stress for
Fittings and Components as MR/Z, where MR is the resultant intensified moment
across the fittings or components with Stress Intensification Factor (SIF) as 0.75i.
On the other hand, for Pipe and Long Radius Bends, para.833.2 (d) of the Code
states that the nominal Bending Stress as M/Z, where M is the bending moment
across the pipe cross section without SIF being considered. In other words, the
moments are NOT intensified for Pipe and Long Radius Bends.



As ASME B31.8 (2020) does not include SIF for Pipe and Long Radius Bends in
Sustained Stress equation, SIF calculated as per B31J will NOT be included in
Sustained Stress calculation for Pipes and Long Radius bends at this time when the
option B31J is selected. On the other hand, the SIF calculated as per B31J will be
displayed in the Element Forces and Moments results.
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When B31J is turned ON, In-plane and Out-of-plane Flexibility Factors for Bends,
Miter bends and TEEs will be calculated as per B31J and included by CAEPIPE in
the corresponding element stiffness matrices. Similarly, CAEPIPE will calculate the
Torsion Flexibility Factors as per B31J and include them in the element stiffness
matrices irrespective of whether the code includes or excludes Torsional Moment
and Torsional SIF in Stress equations.



As it is not possible to identify the number of Flanges or Rigids at Run Pipe ends
located within 0.1D^1.4/T^0.4 from Branch intersection node using CAEPIPE
(required for applying the correction factor while computing Flexibility Factors as per
B31J), a provision is made in the Branch SIF definition to input the no. of Flanges or
Rigids that fall within the distance given by B31J.



When the bend angle is 90 degree and the thickness of the bend is equal to the
thickness of the matching pipe, the Ki and Ko should be calculated from 1.3/h. This
is not implemented in CAEPIPE software at this time.



Flexibility Factors computed for TEEs as per B31J are always applied to both ends
of the first elements belonging to Leg 1, Leg 2 and Leg 3 that are connected at the
Branch nodeas shown in Figure 1-1 of B31J.
CAEPIPE includes a feature “Layout Frame > Edit > Refine Branches for B31J” to
refine the elements connected to the Branch node to compute and apply Flexibility
Factors for Run (Leg 1 and Leg 2) and BranchPipe (Leg 3) as stated above.
When the above command is used, CAEPIPE will add the following.
a. Two (2) nodes on Run Pipe (one on either side of the Branch SIF node) at a
distance equal to Run Split Factor x Run Pipe OD, where the Run Split Factor
can be input by the user.
b. One (1) node on Branch Pipe at a distance equal to Branch Split Factor x Run
Pipe OD from the Branch SIF node, where the Branch Split Factor can be input
by the user.
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ASME Section III, Subsection NC - Class 2 (1980)
Allowable Pressure

The allowable pressure for straight pipes and bends is calculated from Equation 5 of NC3641.1.
𝑃=

where
𝑃 =
𝑆 =
𝐸 =
𝑡𝑚 =
=
𝑡 =
𝐷 =
𝑑 =
𝑌 =
=
=

2𝑆𝐸𝑡𝑚
𝐷 − 2𝑌𝑡𝑚

allowable pressure
allowable stress
joint factor (input as material property)
minimum required thickness, including mechanical and corrosion allowances
𝑡 × (1 – mill tolerance/100) – corrosion allowance
nominal pipe thickness
outside diameter
inside diameter
pressure coefficient
0.4 for 𝐷/𝑡𝑚 ≥ 6
𝑑/(𝐷 + 𝑑 ) for 𝐷/𝑡𝑚 < 6

Sustained Stress

The stress (𝑆𝐿 ) due to sustained loads (pressure, weight and other sustained mechanical
loads) is calculated from Equation 9 of NC-3652.
𝑆𝐿 =

where
𝑃 =
𝐷 =
𝑡 =
𝑖 =
𝑀𝐴 =
𝑍 =
𝑆ℎ =

𝑃𝐷 0.75𝑖𝑀𝐴
+
≤ 𝑆ℎ
4𝑡
𝑍

maximum pressure
outside diameter
nominal wall thickness
stress intensification factor. The product 0.75i, shall not be less than 1.0
resultant bending moment due to sustained loads = √𝑀𝑋2 + 𝑀𝑌2 + 𝑀𝑍2
section modulus, for reduced outlets, effective section modulus
hot allowable stress

Occasional Stress

The stress (𝑆𝐿𝑂 ) is calculated as the sum of stress due to sustained loads (𝑆𝐿 ) and stress due
to occasional loads (𝑆𝑂 ) such as earthquake or wind from Equation 10 of NC-3652.2. Wind
and earthquake are not considered concurrently.
𝑆𝐿𝑂 = 𝑆𝐿 +

0.75𝑖𝑀𝐵
≤ 1.2𝑆ℎ
𝑍

where
𝑀𝐵 = resultant moment due to occasional loads
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Expansion Stress

The stress (𝑆𝐸 ) due to thermal expansion is calculated from Equation 11 of NC-3652.3.
𝑆𝐸 =

𝑖𝑀𝐶
≤ 𝑆𝐴
𝑍

where
𝑀𝐶 = resultant moment due to thermal expansion
𝑆𝐴 = 𝑓 (1.25𝑆𝑐 + 0.25𝑆ℎ )
𝑆𝑐 = allowable stress at cold temperature
𝑓 = stress range reduction factor from Table NC-3611.2(e)-1
The stress due to pressure, weight, other sustained loads and thermal expansion is calculated
from Equation 13 of NC-3652.2.
𝑆𝑇𝐸 = 𝑆𝐿 + 𝑆𝐸 ≤ 𝑆ℎ + 𝑆𝐴
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ASME Section III, Subsection NC - Class 2(1986)
Allowable Pressure

The allowable pressure for straight pipes and bends is calculated from Equation 5 of NC3641.1.
𝑃=

where
𝑃 =
𝑆 =
𝐸 =
𝑡𝑚 =
=
𝑡 =
𝐷 =
𝑑 =
𝑌 =
=
=

2𝑆𝐸𝑡𝑚
𝐷 − 2𝑌𝑡𝑚

allowable pressure
allowable stress
joint factor (input as material property)
minimum required thickness, including mechanical and corrosion allowance
𝑡 ×(1 – mill tolerance/100) – corrosion allowance
nominal pipe thickness
outside diameter
inside diameter
pressure coefficient
0.4 for 𝐷/𝑡𝑚 ≥ 6
𝑑/(𝐷 + 𝑑 ) for 𝐷/𝑡𝑚 < 6

Sustained Stress

The stress (𝑆𝐿 ) due to sustained loads (pressure, weight and other sustained mechanical
loads) is calculated from Equation 8 of NC-3652.
𝑆𝐿 = 𝐵1

where
𝐵1, 𝐵2 =
𝑃
=
𝐷
=
𝑡
=
𝑀𝐴
=
𝑍
=
𝑆ℎ
=

𝑃𝐷
𝑀𝐴
+ 𝐵2
≤ 1.5𝑆ℎ
2𝑡
𝑍

primary stress indices from NB-3680
maximum pressure
outside diameter
nominal wall thickness
resultant bending moment due to sustained loads = √𝑀𝑋2 + 𝑀𝑌2 + 𝑀𝑍2
section modulus, for reduced outlets, effective section modulus
hot allowable stress

Occasional Stress

The stress (𝑆𝐿𝑂 ) is calculated as the sum of stress due to sustained loads (𝑆𝐿 ) and stress due
to occasional loads (𝑆𝑂 ) such as earthquake or wind from Equation 9 of NC-3653.1. Wind
and earthquake are not considered concurrently.
𝑆𝐿𝑂 = 𝑆𝐿 + 𝐵2

𝑀𝐵
≤ 1.8𝑆ℎ
𝑍

where
𝑀𝐵 = resultant moment due to occasional loads
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Expansion Stress

The stress (𝑆𝐸 ) due to thermal expansion is calculated from Equation 10 of NC-3653.2.
𝑆𝐸 =

where
𝑖 =
𝑀𝐶 =
𝑆𝐴 =
𝑆𝑐 =
𝑓 =

𝑖𝑀𝐶
≤ 𝑆𝐴
𝑍

stress intensification factor
resultant moment due to thermal expansion
𝑓 (1.25𝑆𝑐 + 0.25𝑆ℎ )
allowable stress at cold temperature
stress range reduction factor from Table NC-3611.2(e)-1

The stress due to pressure, weight, other sustained loads and thermal expansion is calculated
from Equation 11 of NC-3653.2(c).
𝑆𝑇𝐸 =

𝑃𝐷 0.75𝑖𝑀𝐴 𝑖𝑀𝐶
+
+
≤ 𝑆ℎ + 𝑆𝐴
4𝑡
𝑍
𝑍

0.75i shall not be less than 1.0.
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ASME Section III, Subsection NC - Class 2 (1992)
Allowable Pressure

The allowable pressure for straight pipes and bends is calculated from Equation 5 of NC3641.1.
𝑃=

where
𝑃 =
𝑆 =
𝐸 =
𝑡𝑚 =
=
𝑡 =
𝐷 =
𝑑 =
𝑌 =
=
=

2𝑆𝐸𝑡𝑚
𝐷 − 2𝑌𝑡𝑚

allowable pressure
allowable stress
joint factor (input as material property)
minimum required thickness, including mechanical and corrosion allowance
𝑡 ×(1 – mill tolerance/100) – corrosion allowance
nominal pipe thickness
outside diameter
inside diameter
pressure coefficient
0.4 for 𝐷/𝑡𝑚 ≥ 6
𝑑/(𝐷 + 𝑑 ) for 𝐷/𝑡𝑚 < 6

Sustained Stress

The stress (𝑆𝐿 ) due to sustained loads (pressure, weight and other sustained mechanical
loads) is calculated from Equation 8 of NC-3652 (in case the option “Include Axial force
in stress calculations” is turned OFF).
𝑆𝐿 = 2. 𝐵1. 𝐴𝐵𝑆 (

𝑃𝐷
𝑀𝐴
) + 𝐵2
≤ 1.5𝑆ℎ
4𝑡𝑛
𝑍

where
𝐵1, 𝐵2 = primary stress indices from NB-3680
𝑃
= internal Design Pressure = maximum of CAEPIPE Input pressures P1 through
P10
𝐷
= outside diameter
𝑡𝑛
= nominal wall thickness
𝑀𝐴
= resultant bending moment due to sustained loads = √𝑀𝑋2 + 𝑀𝑌2 + 𝑀𝑍2
𝑍
= section modulus; for reduced outlets, effective section modulus as per NC3653.3(d)
𝑆ℎ
= material allowable stress at Design Temperature = maximum of CAEPIPE Input
Temperatures T1 through T10
In case the option “Include Axial force in stress calculations” is turned ON, then
CAEPIPE evaluates Equation 8 of NC-3652 as follows.
𝑆𝐿 = 2. 𝐵1. 𝐴𝐵𝑆 [(

𝑃𝐷
𝐹
𝑀𝐴
)+( )
] + 𝐵2
≤ 1.5𝑆ℎ
4𝑡𝑛
𝐴 𝑠𝑢𝑠𝑡
𝑍
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𝑃𝐷

As an option, the pressure stress term (4𝑡 ) in the above equations for SL may be replaced
with the expression (

𝑃𝑑2
𝐷2 −𝑑2

𝑛

) using the CAEPIPE Options > Analysis > Pressure.

Occasional Stress

The stress (𝑆𝐿𝑂 ) is calculated as the sum of stress due to sustained loads (𝑆𝐿 ) and stress due
to occasional loads (𝑆𝑂 ) (such as earthquake or wind) from Equation 9 of NC-3653.1 (in
case the option “Include Axial force in stress calculations” is turned OFF).Wind and
earthquake are not considered concurrently.
𝑓𝑝 𝑃𝐷
𝑀𝐴 + 𝑀𝐵
𝑆𝐿𝑂 = 2. 𝐵1. 𝐴𝐵𝑆 (
) + 𝐵2 (
) ≤ 𝑆𝐿𝑂(𝐴𝑙𝑙)
4𝑡𝑛
𝑍

In case the option “Include Axial force in stress calculations” is turned ON, then
CAEPIPE evaluates Equation 9a as follows.
𝑓𝑝 𝑃𝐷
𝐹
𝐹
𝑀𝐴 + 𝑀𝐵
] + 𝐵2 (
𝑆𝐿𝑂 = 2. 𝐵1. 𝐴𝐵𝑆 [(
)+( )
+( )
) ≤ 𝑆𝐿𝑂(𝐴𝑙𝑙)
4𝑡𝑛
𝐴 𝑠𝑢𝑠𝑡
𝐴 𝑜𝑐𝑐𝑎
𝑍

where
𝑀𝐴
= resultant bending moment due to sustained loads = √𝑀𝑋2 + 𝑀𝑌2 + 𝑀𝑍2
𝑀𝐵
= resultant moment due to occasional loads, inclusive of seismic anchor movements
= √𝑀𝑋2 + 𝑀𝑌2 + 𝑀𝑍2
𝑓𝑝
= peak pressure factor input into CAEPIPE
𝑃
𝐷
𝑡𝑛
𝑍

=
=
=
=

internal Design Pressure defined above
outside diameter
nominal wall thickness
section modulus; for reduced outlets, effective section modulus as per NC3653.3(d)
𝑆𝐿𝑂(All) = minimum (1.80Sh, 1.5Sy) for Level B Service Limits as per NC-3653.1
=minimum (2.25Sh, 1.8Sy) for Level C Service Limits as per NC-3654.2 (a)
= minimum (3.0Sh, 2.0Sy) for Level D Service Limits as per NC-3655 (a)(2)
𝑆ℎ
= material allowable stress at Design Temperature defined above
𝑆𝑦

= material yield strength at Design Temperature
𝑃𝐷

As an option, the pressure stress term (4𝑡 ) in the above equations for SLO may be replaced
with the expression (

𝑃𝑑2
𝐷2 −𝑑2

𝑛

) using the CAEPIPE Options > Analysis > Pressure.
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Expansion Stress

The stress (𝑆𝐸 ) due to thermal expansion is calculated from Equation (10a) of NC-3653.2.
𝑆𝐸 =

𝑖𝑀𝐶
≤ 𝑆𝐴
𝑍

where
𝑖 = stress intensification factor from NB-3680
𝑀𝐶 = range of resultant moments due to displacement cycle between two thermal states
inclusive of moment ONLY due to thermal anchor movements = √𝑀𝑋2 + 𝑀𝑌2 + 𝑀𝑍2
𝑍 = section modulus; for reduced outlets, effective section modulus as per NC-3653.3(d)
𝑆𝐴 = allowable stress range for expansion stress = 𝑓 (1.25𝑆𝑐 + 0.25𝑆ℎ ) as per NC3611.2(e)
𝑆𝑐 = basic allowable stress at minimum metal temperature expected during the
displacement cycle under analysis
𝑆ℎ = basic allowable stress at maximum metal temperature expected during the
displacement cycle under analysis
f =

stress range reduction factor from Table NC-3611.2(e)-1

Sustained + Expansion Stress

The stress due to pressure, weight, other sustained loads and thermal expansion is calculated
from Equation 11 of NC-3653.2(c) (in case the option “Include Axial force in stress
calculations” is turned OFF)..
𝑆𝑇𝐸 = 𝐴𝐵𝑆 (

𝑃𝐷
0.75𝑖𝑀𝐴 𝑖𝑀𝐶
)+
+
≤ 𝑆𝐻 + 𝑆𝐴
4𝑡𝑛
𝑍
𝑍

In case the option “Include Axial force in stress calculations” is turned ON, then
CAEPIPE evaluates Equation 11 as follows.
𝑆𝑇𝐸 = 𝐴𝐵𝑆 [(

𝑃𝐷
𝐹
0.75𝑖𝑀𝐴 𝑖𝑀𝐶
]+
)+( )
+
≤ 𝑆𝐻 + 𝑆𝐴
4𝑡𝑛
𝐴 𝑠𝑢𝑠𝑡
𝑍
𝑍

0.75i shall not be less than 1.0.
where
𝑃 =
𝐷 =
𝑡𝑛 =
𝑀𝐴 =
𝑀𝐶 =
𝑍
𝑆𝐴

internal Design Pressure = maximum of CAEPIPE Input pressures P1 through P10
outside diameter
nominal wall thickness
resultant bending moment due to sustained loads = √𝑀𝑋2 + 𝑀𝑌2 + 𝑀𝑍2
range of resultant moments due to displacement cycle between two thermal states
inclusive of moment ONLY due to thermal anchor movements = √𝑀𝑋2 + 𝑀𝑌2 + 𝑀𝑍2
= section modulus; for reduced outlets, effective section modulus as per NC-3653.3(d)
= allowable stress range for expansion stress = 𝑓 (1.25𝑆𝑐 + 0.25𝑆ℎ ) as per NC3611.2(e)
222

ASME Section III, Subsection NC - Class 2 (1992)
𝑆𝑐 = basic allowable stress at minimum metal temperature expected during the
displacement cycle under analysis
𝑆ℎ = basic allowable stress at maximum metal temperature expected during the
displacement cycle under analysis
𝑆𝐻 = material allowable stress at Design Temperature defined above
𝑓

= stress range reduction factor from Table NC-3611.2(e)-1

Settlement Stress

The stress (𝑆𝑆 ) due to single nonrepeated anchor movement (e.g., predicted building
settlement) is calculated from Equation (10b) of NC-3653.2.
𝑆𝑆 =

𝑖𝑀𝐷
≤ 3𝑆𝐶
𝑍

where
𝑖 = stress intensification factor from Table NC-3673.2(b)-1
𝑀𝐷 = resultant moment due to any single nonrepeated anchor movement (e.g., predicted
building settlement)
𝑆𝑐 = allowable stress at the Reference Temperature in CAEPIPE
𝑍 = section modulus; for reduced outlets, effective section modulus as per NC-3653.3(d)
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Allowable Pressure

The allowable pressure for straight pipes and bends is calculated from Equation 5 of NC3641.1.
𝑃𝑎 =

where
𝑃𝑎 =
𝑆 =
𝐸 =
𝑡𝑚 =
=
𝑡 =
𝐷 =
𝑑 =
𝑌 =
=
=

2𝑆𝐸𝑡𝑚
𝐷 − 2𝑌𝑡𝑚

allowable pressure
allowable stress for the material at the Design Temperature
joint factor (input as material property)
minimum required thickness, including mechanical and corrosion allowance
𝑡 ×(1 – mill tolerance/100) – corrosion allowance
nominal pipe thickness
outside diameter
inside diameter
pressure coefficient
0.4 for 𝐷/𝑡𝑚 ≥ 6
𝑑/(𝐷 + 𝑑 ) for 𝐷/𝑡𝑚 < 6

Sustained Stress

The stress (𝑆𝐿 ) due to sustained loads (pressure, weight and other sustained mechanical
loads) is calculated from Equation 8 of NC-3652 (in case the option “Include Axial force
in stress calculations” is turned OFF).
𝑆𝐿 = 2. 𝐵1. 𝐴𝐵𝑆 (

where
𝐵1, 𝐵2 =
𝑃
=
𝐷
=
𝑡𝑛
=
𝑀𝐴
=
𝑍
=
𝑆ℎ =

𝑃𝐷
𝑀𝐴
) + 𝐵2
≤ 1.5𝑆ℎ
4𝑡𝑛
𝑍

primary stress indices from Table NC-3673.2(b)-1
maximum of CAEPIPE Input pressures P1 through P10
outside diameter
nominal wall thickness
resultant bending moment due to sustained loads = √𝑀𝑋2 + 𝑀𝑌2 + 𝑀𝑍2
section modulus; for reduced outlets, effective section modulus as per NC3653.3(d)
material allowable stress at maximum of CAEPIPE Inputtemperatures T1 through
T10

In case the option “Include Axial force in stress calculations” is turned ON, then
CAEPIPE evaluates Equation 8 of NC-3652 as follows.
𝑆𝐿 = 2. 𝐵1. 𝐴𝐵𝑆 [(

𝑃𝐷
𝐹
𝑀𝐴
)+( )
] + 𝐵2
≤ 1.5𝑆ℎ
4𝑡𝑛
𝐴 𝑠𝑢𝑠𝑡
𝑍
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𝑃𝐷

As an option, the pressure stress term (4𝑡 ) in the above equations for SL may be replaced
with the expression (

𝑃𝑑2
𝐷2 −𝑑2

𝑛

) using the CAEPIPE Options > Analysis > Pressure.

Occasional Stress

The stress (𝑆𝐿𝑂 ) is calculated as the sum of stress due to sustained loads (𝑆𝐿 ) and stress due
to occasional loads (𝑆𝑂 ) (such as thrusts from relief and safety valve loads from pressure and
flow transients, and reversing and nonreversing dynamic loads, if the Design Specification
requires calculation of moments due to reversing and non-reversing dynamic loads) from
Equation 9a of NC-3653.1 (in case the option “Include Axial force in stress
calculations” is turned OFF).
𝑆𝐿𝑂 = 2. 𝐵1. 𝐴𝐵𝑆 (

𝑓𝑝 𝑃𝐷
𝑀𝐴 + 𝑀𝐵
) + 𝐵2 (
) ≤ 𝑆𝐿𝑂(𝐴𝑙𝑙)
4𝑡𝑛
𝑍

In case the option “Include Axial force in stress calculations” is turned ON, then
CAEPIPE evaluates Equation 9aof NC-3653.1as follows.
𝑓𝑝 𝑃𝐷
𝐹
𝐹
𝑀𝐴 + 𝑀𝐵
] + 𝐵2 (
𝑆𝐿𝑂 = 2. 𝐵1. 𝐴𝐵𝑆 [(
)+( )
+( )
) ≤ 𝑆𝐿𝑂(𝐴𝑙𝑙)
4𝑡𝑛
𝐴 𝑠𝑢𝑠𝑡
𝐴 𝑜𝑐𝑐𝑎
𝑍

where
𝑀𝐴
= resultant bending moment due to sustained loads = √𝑀𝑋2 + 𝑀𝑌2 + 𝑀𝑍2
𝑀𝐵
= resultant moment due to occasional loads, inclusive of seismic anchor movements
and movements due to reversing and nonreversing dynamic loads
= √𝑀𝑋2 + 𝑀𝑌2 + 𝑀𝑍2
𝑓𝑝
= peak pressure factor input into CAEPIPE
maximum of CAEPIPE Input pressures P1 through P10
outside diameter
nominal wall thickness
section modulus; for reduced outlets, effective section modulus as per NC3653.3(d)
𝑆𝐿𝑂(All) = minimum (1.80Sh, 1.5Sy) for Level B Service Limits as per NC-3653.1
=minimum (2.25Sh, 1.8Sy) for Level C Service Limits as per NC-3654.2 (a)
= minimum (3.0Sh, 2.0Sy) for Level D Service Limits as per NC-3655 (a)(2)
𝑆ℎ =
material allowable stress at maximum of CAEPIPE Input temperatures T1
through T10
𝑃
𝐷
𝑡𝑛
𝑍

𝑆𝑦 =

=
=
=
=

material yield strength at maximum of CAEPIPE Input temperatures T1 through
T10
𝑃𝐷

As an option, the pressure stress term (4𝑡 ) in the above equations for SLO may be replaced
with the expression (

𝑃𝑑2
𝐷2 −𝑑2

𝑛

) using the CAEPIPE Options > Analysis > Pressure.
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Note:

Movements at anchors and nozzles due to seismic event and due to reversing and
nonreversing dynamic loads are to be input as “specified displacements” for seismic and they
will be included as a part of the Occasional Stress evaluation given above.
Expansion Stress

The stress (𝑆𝐸 ) due to thermal expansion is calculated from Equation (10a) of NC-3653.2.
𝑆𝐸 =

𝑖𝑀𝐶
≤ 𝑆𝐴
𝑍

where
𝑖 = stress intensification factor from Table NC-3673.2(b)-1
𝑀𝐶 = range of resultant moments due to displacement cycle between two thermal states
inclusive of moment ONLY due to thermal anchor movements = √𝑀𝑋2 + 𝑀𝑌2 + 𝑀𝑍2
𝑍 = section modulus; for reduced outlets, effective section modulus as per NC-3653.3(d)
𝑆𝐴 = allowable stress range for expansion stress = 𝑓 (1.25𝑆𝑐 + 0.25𝑆ℎ ) as per NC3611.2(e)
𝑆𝑐 = basic allowable stress at minimum metal temperature expected during the
displacement cycle under analysis
𝑆ℎ = basic allowable stress at maximum metal temperature expected during the
displacement cycle under analysis
f =

stress range reduction factor from Table NC-3611.2(e)-1

Sustained + Expansion Stress

The stress due to pressure, weight, other sustained loads and thermal expansion is calculated
from Equation 11 of NC-3653.2(c) (in case the option “Include Axial force in stress
calculations” is turned OFF)..
𝑆𝑇𝐸 = 𝐴𝐵𝑆 (

𝑃𝐷
0.75𝑖𝑀𝐴 𝑖𝑀𝐶
)+
+
≤ 𝑆𝐻 + 𝑆𝐴
4𝑡𝑛
𝑍
𝑍

In case the option “Include Axial force in stress calculations” is turned ON, then
CAEPIPE evaluates Equation 11of NC-3653.2(c)as follows.
𝑆𝑇𝐸 = 𝐴𝐵𝑆 [(

𝑃𝐷
𝐹
0.75𝑖𝑀𝐴 𝑖𝑀𝐶
]+
)+( )
+
≤ 𝑆𝐻 + 𝑆𝐴
4𝑡𝑛
𝐴 𝑠𝑢𝑠𝑡
𝑍
𝑍

0.75i shall not be less than 1.0.
where
𝑃 =
𝐷 =
𝑡𝑛 =
𝑀𝐴 =

maximum of CAEPIPE Input pressures P1 through P10
outside diameter
nominal wall thickness
resultant bending moment due to sustained loads = √𝑀𝑋2 + 𝑀𝑌2 + 𝑀𝑍2
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𝑀𝐶 = range of resultant moments due to displacement cycle between two thermal states
inclusive of moment ONLY due to thermal anchor movements = √𝑀𝑋2 + 𝑀𝑌2 + 𝑀𝑍2
𝑍 = section modulus; for reduced outlets, effective section modulus as per NC-3653.3(d)
𝑆𝐴 = allowable stress range for expansion stress = 𝑓 (1.25𝑆𝑐 + 0.25𝑆ℎ ) as per NC3611.2(e)
𝑆𝑐 = basic allowable stress at minimum metal temperature expected during the
displacement cycle under analysis
𝑆ℎ = basic allowable stress at maximum metal temperature expected during the
displacement cycle under analysis
𝑆𝐻 = material allowable stress at maximum of CAEPIPE Input temperatures T1 through
T10
𝑓

= stress range reduction factor from Table NC-3611.2(e)-1

Settlement Stress

The stress (𝑆𝑆 ) due to single nonrepeated anchor movement (e.g., predicted building
settlement) is calculated from Equation (10b) of NC-3653.2.
𝑆𝑆 =

𝑖𝑀𝐷
≤ 3𝑆𝐶
𝑍

where
𝑖 = stress intensification factor from Table NC-3673.2(b)-1
𝑀𝐷 = resultant moment due to any single nonrepeated anchor movement (e.g., predicted
building settlement)
𝑆𝑐 = allowable stress at the Reference Temperature in CAEPIPE
𝑍 = section modulus; for reduced outlets, effective section modulus as per NC-3653.3(d)
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Additional Note for Welding elbow or Pipe bend:
If the value of B1 = (0.4h – 0.1) < 0.0, then B1 is set to 0.0.

Additional Note for Reinforced fabricated tee:
For calculating the value of rps and t’e, the value of re is assumed to be equal to 2 x r’m, where
r’m is the mean radius of the branch leg.
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Additional Note for Circumferential fillet welded or socket welded joints:
Values of B1, B2 and Stress Intensification Factor (SIF) are taken as 0.75, 1.50 and 1.3
respectively in CAEPIPE for the following reasons.
1. There is no provision to input the value of Cx in CAEPIPE for fillet and socket welded
flanges.
2. The definition of Cx as per Note 11 of Table NC-3673.2(b)-1 contradicts with the definition
of Cx as defined in Notes (3) and (4) of Figure NC-4427-1.
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Allowable Pressure

The allowable pressure for straight pipes and bends is calculated from Equation 5 of NC3641.1.
𝑃𝑎 =

where
𝑃𝑎 =
𝑆 =
𝐸 =
𝑡𝑚 =
=
𝑡 =
𝐷 =
𝑑 =
𝑌 =
=
=

2𝑆𝐸𝑡𝑚
𝐷 − 2𝑌𝑡𝑚

allowable pressure
allowable stress for the material at the Design Temperature
joint factor (input as material property)
minimum required thickness, including mechanical and corrosion allowance
𝑡 ×(1 – mill tolerance/100) – corrosion allowance
nominal pipe thickness
outside diameter
inside diameter
pressure coefficient
0.4 for 𝐷/𝑡𝑚 ≥ 6
𝑑/(𝐷 + 𝑑 ) for 𝐷/𝑡𝑚 < 6

Sustained Stress

The stress (𝑆𝐿 ) due to sustained loads (pressure, weight and other sustained mechanical
loads) is calculated from Equation 8 of NC-3652 (in case the option “Include Axial force
in stress calculations” is turned OFF).
𝑆𝐿 = 2. 𝐵1. 𝐴𝐵𝑆 (

𝑃𝐷
𝑀𝐴
) + 𝐵2
≤ 1.5𝑆ℎ
4𝑡𝑛
𝑍

where
𝐵1, 𝐵2 =
𝑃
=
𝐷
=
𝑡𝑛
=
𝑀𝐴
=
𝑍
=
𝑆ℎ

primary stress indices from Table NC-3673.2(b)-1
maximum of CAEPIPE Input pressures P1 through P10
outside diameter
nominal wall thickness
resultant bending moment due to sustained loads = √𝑀𝑋2 + 𝑀𝑌2 + 𝑀𝑍2
section modulus; for reduced outlets, effective section modulus as per NC3653.3(d)
= material allowable stress at maximum of CAEPIPE Input temperatures T1
through T10

In case the option “Include Axial force in stress calculations” is turned ON, then
CAEPIPE evaluates Equation 8 of NC-3652 as follows.
𝑆𝐿 = 2. 𝐵1. 𝐴𝐵𝑆 [(

𝑃𝐷
𝐹
𝑀𝐴
)+( )
] + 𝐵2
≤ 1.5𝑆ℎ
4𝑡𝑛
𝐴 𝑠𝑢𝑠𝑡
𝑍
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𝑃𝐷

As an option, the pressure stress term (4𝑡 ) in the above equations for SL may be replaced
with the expression (

𝑃𝑑2
𝐷2 −𝑑2

𝑛

) using the CAEPIPE Options > Analysis > Pressure.

Occasional Stress

The stress (𝑆𝐿𝑂 ) is calculated as the sum of stress due to sustained loads (𝑆𝐿 ) and stress due
to occasional loads (𝑆𝑂 ) (such as thrusts from relief and safety valve loads from pressure and
flow transients, and reversing and nonreversing dynamic loads, if the Design Specification
requires calculation of moments due to reversing and nonreversing dynamic loads) from
Equation 9a of NC-3653.1 (in case the option “Include Axial force in stress
calculations” is turned OFF).
𝑆𝐿𝑂 = 2. 𝐵1. 𝐴𝐵𝑆 (

𝑓𝑝 𝑃𝐷
𝑀𝐴 + 𝑀𝐵
) + 𝐵2 (
) ≤ 𝑆𝐿𝑂(𝐴𝑙𝑙)
4𝑡𝑛
𝑍

In case the option “Include Axial force in stress calculations” is turned ON, then
CAEPIPE evaluates Equation 9aof NC-3653.1as follows.
𝑓𝑝 𝑃𝐷
𝐹
𝐹
𝑀𝐴 + 𝑀𝐵
] + 𝐵2 (
𝑆𝐿𝑂 = 2. 𝐵1. 𝐴𝐵𝑆 [(
)+( )
+( )
) ≤ 𝑆𝐿𝑂(𝐴𝑙𝑙)
4𝑡𝑛
𝐴 𝑠𝑢𝑠𝑡
𝐴 𝑜𝑐𝑐𝑎
𝑍

where
𝑀𝐴
= resultant bending moment due to sustained loads = √𝑀𝑋2 + 𝑀𝑌2 + 𝑀𝑍2
𝑀𝐵
= resultant moment due to occasional loads, inclusive of seismic anchor movements
and movements due to reversing and non-reversing dynamic loads
= √𝑀𝑋2 + 𝑀𝑌2 + 𝑀𝑍2
𝑓𝑝
= peak pressure factor input into CAEPIPE
𝑃
𝐷
𝑡𝑛
𝑍

=
=
=
=

maximum of CAEPIPE Input pressures P1 through P10
outside diameter
nominal wall thickness
section modulus; for reduced outlets, effective section modulus as per NC3653.3(d)
𝑆𝐿𝑂(All) = minimum (1.80Sh, 1.5Sy) for Level B Service Limits as per NC-3653.1
=minimum (2.25Sh, 1.8Sy) for Level C Service Limits as per NC-3654.2 (a)
= minimum (3.0Sh, 2.0Sy) for Level D Service Limits as per NC-3655 (a)(2)
𝑆ℎ
= material allowable stress at maximum of CAEPIPE Input temperatures T1
through T10
𝑆𝑦

= material yield strength at maximum of CAEPIPE Input temperatures T1 through
T10
𝑃𝐷

As an option, the pressure stress term (4𝑡 ) in the above equations for SLO may be replaced
with the expression (

𝑃𝑑2
𝐷2 −𝑑2

𝑛

) using the CAEPIPE Options > Analysis > Pressure.
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Note:

Movements at anchors and nozzles due to seismic event and due to reversing and
nonreversing dynamic loads are to be input as “specified displacements” for seismic and they
will be included as a part of the Occasional Stress evaluation given above.
Expansion Stress

The stress (𝑆𝐸 ) due to thermal expansion is calculated from Equation (10a) of NC-3653.2.
𝑆𝐸 =

𝑖𝑀𝐶
≤ 𝑆𝐴
𝑍

where
𝑖 = stress intensification factor from Table NC-3673.2(b)-1
𝑀𝐶 = range of resultant moments due to displacement cycle between two thermal states
inclusive of moment ONLY due to thermal anchor movements = √𝑀𝑋2 + 𝑀𝑌2 + 𝑀𝑍2
𝑍 = section modulus; for reduced outlets, effective section modulus as per NC-3653.3(d)
𝑆𝐴 = allowable stress range for expansion stress = 𝑓 (1.25𝑆𝑐 + 0.25𝑆ℎ ) as per NC3611.2(e)
𝑆𝑐 = basic allowable stress at minimum metal temperature expected during the
displacement cycle under analysis
𝑆ℎ = basic allowable stress at maximum metal temperature expected during the
displacement cycle under analysis
f =

stress range reduction factor from Table NC-3611.2(e)-1

Sustained + Expansion Stress

The stress due to pressure, weight, other sustained loads and thermal expansion is calculated
from Equation 11 of NC-3653.2(c) (in case the option “Include Axial force in stress
calculations” is turned OFF)..
𝑆𝑇𝐸 = 𝐴𝐵𝑆 (

𝑃𝐷
0.75𝑖𝑀𝐴 𝑖𝑀𝐶
)+
+
≤ 𝑆𝐻 + 𝑆𝐴
4𝑡𝑛
𝑍
𝑍

In case the option “Include Axial force in stress calculations” is turned ON, then
CAEPIPE evaluates Equation 11of NC-3653.2(c)as follows.
𝑆𝑇𝐸 = 𝐴𝐵𝑆 [(

𝑃𝐷
𝐹
0.75𝑖𝑀𝐴 𝑖𝑀𝐶
]+
)+( )
+
≤ 𝑆𝐻 + 𝑆𝐴
4𝑡𝑛
𝐴 𝑠𝑢𝑠𝑡
𝑍
𝑍

0.75i shall not be less than 1.0.
where
𝑃 =
𝐷 =
𝑡𝑛 =
𝑀𝐴 =

maximum of CAEPIPE Input pressures P1 through P10
outside diameter
nominal wall thickness
resultant bending moment due to sustained loads = √𝑀𝑋2 + 𝑀𝑌2 + 𝑀𝑍2
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𝑀𝐶 = range of resultant moments due to displacement cycle between two thermal states
inclusive of moment ONLY due to thermal anchor movements = √𝑀𝑋2 + 𝑀𝑌2 + 𝑀𝑍2
𝑍 = section modulus; for reduced outlets, effective section modulus as per NC-3653.3(d)
𝑆𝐴 = allowable stress range for expansion stress = 𝑓 (1.25𝑆𝑐 + 0.25𝑆ℎ ) as per NC3611.2(e)
𝑆𝑐 = basic allowable stress at minimum metal temperature expected during the
displacement cycle under analysis
𝑆ℎ = basic allowable stress at maximum metal temperature expected during the
displacement cycle under analysis
𝑆𝐻 = material allowable stress at maximum of CAEPIPE Input temperatures T1 through
T10
𝑓

= stress range reduction factor from Table NC-3611.2(e)-1

Settlement Stress

The stress (𝑆𝑆 ) due to single nonrepeated anchor movement (e.g., predicted building
settlement) is calculated from Equation (10b) of NC-3653.2.
𝑆𝑆 =

𝑖𝑀𝐷
≤ 3𝑆𝐶
𝑍

where
𝑖 = stress intensification factor from Table NC-3673.2(b)-1
𝑀𝐷 = resultant moment due to any single nonrepeated anchor movement (e.g., predicted
building settlement)
𝑆𝑐 = allowable stress at the Reference Temperature in CAEPIPE
𝑍 = section modulus; for reduced outlets, effective section modulus as per NC-3653.3(d)
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Additional Note for Welding elbow or Pipe bend:
If the value of B1 = (0.4h – 0.1) < 0.0, then B1 is set to 0.0.

Additional Note for Reinforced fabricated tee:
For calculating the value of rps and t’e, the value of re is assumed to be equal to 2 x r’m, where
r’m is the mean radius of the branch leg.
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Additional Note for Circumferential fillet welded or socket welded joints:
Values of B1, B2 and Stress Intensification Factor (SIF) are taken as 0.75, 1.50 and 1.3
respectively in CAEPIPE for the following reasons.
3. There is no provision to input the value of Cx in CAEPIPE for fillet and socket welded
flanges.
4. The definition of Cx as per Note 11 of Table NC-3673.2(b)-1 contradicts with the definition
of Cx as defined in Notes (3) and (4) of Figure NC-4427-1.
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Allowable Pressure

The allowable pressure for straight pipes and bends is calculated from Equation 5 of ND3641.1.
𝑃𝑎 =

where
𝑃𝑎 =
𝑆 =
𝐸 =
𝑡𝑚 =
=
𝑡 =
𝐷 =
𝑑 =
𝑌 =
=
=

2𝑆𝐸𝑡𝑚
𝐷 − 2𝑌𝑡𝑚

allowable pressure
allowable stress for the material at the Design Temperature
joint factor (input as material property)
minimum required thickness, including mechanical and corrosion allowance
𝑡 ×(1 – mill tolerance/100) – corrosion allowance
nominal pipe thickness
outside diameter
inside diameter
pressure coefficient
0.4 for 𝐷/𝑡𝑚 ≥ 6
𝑑/(𝐷 + 𝑑 ) for 𝐷/𝑡𝑚 < 6

Sustained Stress

The stress (𝑆𝐿 ) due to sustained loads (pressure, weight and other sustained mechanical
loads) is calculated from Equation 8 of ND-3652 (in case the option “Include Axial force
in stress calculations” is turned OFF).
𝑆𝐿 = 2. 𝐵1. 𝐴𝐵𝑆 (

𝑃𝐷
𝑀𝐴
) + 𝐵2
≤ 1.5𝑆ℎ
4𝑡𝑛
𝑍

where
𝐵1, 𝐵2 =
𝑃
=
𝐷
=
𝑡𝑛
=
𝑀𝐴
=
𝑍
=
𝑆ℎ

primary stress indices from Table ND-3673.2(b)-1
maximum of CAEPIPE Input pressures P1 through P10
outside diameter
nominal wall thickness
resultant bending moment due to sustained loads = √𝑀𝑋2 + 𝑀𝑌2 + 𝑀𝑍2
section modulus; for reduced outlets, effective section modulus as per ND3653.3(d)
= material allowable stress at maximum of CAEPIPE Input temperatures T1
through T10

In case the option “Include Axial force in stress calculations” is turned ON, then
CAEPIPE evaluates Equation 8 of ND-3652 as follows.
𝑆𝐿 = 2. 𝐵1. 𝐴𝐵𝑆 [(

𝑃𝐷
𝐹
𝑀𝐴
)+( )
] + 𝐵2
≤ 1.5𝑆ℎ
4𝑡𝑛
𝐴 𝑠𝑢𝑠𝑡
𝑍
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𝑃𝐷

As an option, the pressure stress term (4𝑡 ) in the above equations for SL may be replaced
with the expression (

𝑃𝑑2
𝐷2 −𝑑2

𝑛

) using the CAEPIPE Options > Analysis > Pressure.

Occasional Stress

The stress (𝑆𝐿𝑂 ) is calculated as the sum of stress due to sustained loads (𝑆𝐿 ) and stress due
to occasional loads (𝑆𝑂 ) (such as thrusts from relief and safety valve loads from pressure and
flow transients, and reversing and nonreversing dynamic loads, if the Design Specification
requires calculation of moments due to reversing and non-reversing dynamic loads) from
Equation 9a of ND-3653.1 (in case the option “Include Axial force in stress
calculations” is turned OFF).
𝑆𝐿𝑂 = 2. 𝐵1. 𝐴𝐵𝑆 (

𝑓𝑝 𝑃𝐷
𝑀𝐴 + 𝑀𝐵
) + 𝐵2 (
) ≤ 𝑆𝐿𝑂(𝐴𝑙𝑙)
4𝑡𝑛
𝑍

In case the option “Include Axial force in stress calculations” is turned ON, then
CAEPIPE evaluates Equation 9aof ND-3653.1as follows.
𝑓𝑝 𝑃𝐷
𝐹
𝐹
𝑀𝐴 + 𝑀𝐵
] + 𝐵2 (
𝑆𝐿𝑂 = 2. 𝐵1. 𝐴𝐵𝑆 [(
)+( )
+( )
) ≤ 𝑆𝐿𝑂(𝐴𝑙𝑙)
4𝑡𝑛
𝐴 𝑠𝑢𝑠𝑡
𝐴 𝑜𝑐𝑐𝑎
𝑍

where
𝑀𝐴
= resultant bending moment due to sustained loads = √𝑀𝑋2 + 𝑀𝑌2 + 𝑀𝑍2
𝑀𝐵
= resultant moment due to occasional loads, inclusive of seismic anchor movements
and movements due to reversing and non-reversing dynamic loads
= √𝑀𝑋2 + 𝑀𝑌2 + 𝑀𝑍2
𝑓𝑝

= peak pressure factor input into CAEPIPE

𝑃
𝐷
𝑡𝑛
𝑍

=
=
=
=

maximum of CAEPIPE Input pressures P1 through P10
outside diameter
nominal wall thickness
section modulus; for reduced outlets, effective section modulus as per ND3653.3(d)
𝑆𝐿𝑂(All) = minimum (1.80Sh, 1.5Sy) for Level B Service Limits as per ND-3653.1
=minimum (2.25Sh, 1.8Sy) for Level C Service Limits as per ND-3654.2 (a)
= minimum (3.0Sh, 2.0Sy) for Level D Service Limits as per ND-3655 (a)(2)
𝑆ℎ =
material allowable stress at maximum of CAEPIPE Input temperatures T1
through T10
𝑆𝑦

= material yield strength at maximum of CAEPIPE Input temperatures T1 through
T10
𝑃𝐷

As an option, the pressure stress term (4𝑡 ) in the above equations for SLO may be replaced
with the expression (

𝑃𝑑2
𝐷2 −𝑑2

𝑛

) using the CAEPIPE Options > Analysis > Pressure.
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Note:

Movements at anchors and nozzles due to seismic event and due to reversing and nonreversing dynamic loads are to be input as “specified displacements” for seismic and they will
be included as a part of the Occasional Stress evaluation given above.
Expansion Stress

The stress (𝑆𝐸 ) due to thermal expansion is calculated from Equation (10a) of ND-3653.2.
𝑆𝐸 =

𝑖𝑀𝐶
≤ 𝑆𝐴
𝑍

where
𝑖 = stress intensification factor from Table ND-3673.2(b)-1
𝑀𝐶 = range of resultant moments due to displacement cycle between two thermal states
inclusive of moment ONLY due to thermal anchor movements = √𝑀𝑋2 + 𝑀𝑌2 + 𝑀𝑍2
𝑍 = section modulus; for reduced outlets, effective section modulus as per ND-3653.3(d)
𝑆𝐴 = allowable stress range for expansion stress = 𝑓 (1.25𝑆𝑐 + 0.25𝑆ℎ ) as per ND3611.2(e)
𝑆𝑐 = basic allowable stress at minimum metal temperature expected during the
displacement cycle under analysis
𝑆ℎ = basic allowable stress at maximum metal temperature expected during the
displacement cycle under analysis
f =

stress range reduction factor from Table ND-3611.2(e)-1

Sustained + Expansion Stress

The stress due to pressure, weight, other sustained loads and thermal expansion is calculated
from Equation 11 of ND-3653.2(c) (in case the option “Include Axial force in stress
calculations” is turned OFF)..
𝑆𝑇𝐸 = 𝐴𝐵𝑆 (

𝑃𝐷
0.75𝑖𝑀𝐴 𝑖𝑀𝐶
)+
+
≤ 𝑆𝐻 + 𝑆𝐴
4𝑡𝑛
𝑍
𝑍

In case the option “Include Axial force in stress calculations” is turned ON, then
CAEPIPE evaluates Equation 11of ND-3653.2(c)as follows.
𝑆𝑇𝐸 = 𝐴𝐵𝑆 [(

𝑃𝐷
𝐹
0.75𝑖𝑀𝐴 𝑖𝑀𝐶
]+
)+( )
+
≤ 𝑆𝐻 + 𝑆𝐴
4𝑡𝑛
𝐴 𝑠𝑢𝑠𝑡
𝑍
𝑍

0.75i shall not be less than 1.0.
where
𝑃 =
𝐷 =
𝑡𝑛 =
𝑀𝐴 =

maximum of CAEPIPE Input pressures P1 through P10
outside diameter
nominal wall thickness
resultant bending moment due to sustained loads = √𝑀𝑋2 + 𝑀𝑌2 + 𝑀𝑍2
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𝑀𝐶 = range of resultant moments due to displacement cycle between two thermal states
inclusive of moment ONLY due to thermal anchor movements = √𝑀𝑋2 + 𝑀𝑌2 + 𝑀𝑍2
𝑍 = section modulus; for reduced outlets, effective section modulus as per ND-3653.3(d)
𝑆𝐴 = allowable stress range for expansion stress = 𝑓 (1.25𝑆𝑐 + 0.25𝑆ℎ ) as per ND3611.2(e)
𝑆𝑐 = basic allowable stress at minimum metal temperature expected during the
displacement cycle under analysis
𝑆ℎ = basic allowable stress at maximum metal temperature expected during the
displacement cycle under analysis
𝑆𝐻 = material allowable stress at maximum of CAEPIPE Input temperatures T1 through
T10
𝑓

= stress range reduction factor from Table ND-3611.2(e)-1

Settlement Stress

The stress (𝑆𝑆 ) due to single non-repeated anchor movement (e.g., predicted building
settlement) is calculated from Equation (10b) of ND-3653.2.
𝑆𝑆 =

𝑖𝑀𝐷
≤ 3𝑆𝐶
𝑍

where
𝑖 = stress intensification factor from Table ND-3673.2(b)-1
𝑀𝐷 = resultant moment due to any single nonrepeated anchor movement (e.g., predicted
building settlement)
𝑆𝑐 = allowable stress at the Reference Temperature in CAEPIPE
𝑍 = section modulus; for reduced outlets, effective section modulus as per ND-3653.3(d)

246

ASME Section III, Subsection ND - Class 3 (2017)

Additional Note for Welding elbow or Pipe bend:
If the value of B1 = (0.4h – 0.1) < 0.0, then B1 is set to 0.0.

Additional Note for Reinforced fabricated tee:
For calculating the value of rps and t’e, the value of re is assumed to be equal to 2 x r’m, where
r’m is the mean radius of the branch leg.
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Additional Note for Circumferential fillet welded or socket welded joints:
Values of B1, B2 and Stress Intensification Factor (SIF) are taken as 0.75, 1.50 and 1.3
respectively in CAEPIPE for the following reasons.
5. There is no provision to input the value of Cx in CAEPIPE for fillet and socket welded
flanges.
6. The definition of Cx as per Note 11 of Table ND-3673.2(b)-1 contradicts with the definition
of Cx as defined in Notes (3) and (4) of Figure ND-4427-1.
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Allowable Pressure

The allowable pressure for straight pipes and bends is calculated from Equation 5 of NCD3641.1.
𝑃𝑎 =

where
𝑃𝑎 =
𝑆 =
𝐸 =
𝑡𝑚 =
=
𝑡𝑛 =
𝐷 =
𝑑 =
𝑌 =
=
=

2𝑆𝐸𝑡𝑚
𝐷 − 2𝑌𝑡𝑚

allowable pressure
allowable stress for the material at the Design Temperature
joint factor (input as material property)
minimum required thickness, after deducting mechanical and corrosion allowance
𝑡𝑛 ×(1 – mill tolerance/100) – corrosion allowance
nominal pipe thickness
nominal outside diameter
nominal inside diameter
pressure coefficient
0.4 for 𝐷/𝑡𝑚 ≥ 6
𝑑/(𝐷 + 𝑑 ) for 𝐷/𝑡𝑚 < 6

Sustained Stress

The stress (𝑆𝐿 ) due to sustained loads (pressure, weight and other sustained mechanical
loads) is calculated from Equation 8 of NCD-3652 (in case the option “Include Axial
force in stress calculations” is turned OFF).
𝑆𝐿 = 2. 𝐵1. 𝐴𝐵𝑆 (

𝑃𝐷
𝑀𝐴
) + 𝐵2
≤ 1.5𝑆ℎ
4𝑡𝑛
𝑍

where
𝐵1, 𝐵2 =
𝑃
=
𝐷
=
𝑡𝑛
=
𝑀𝐴
=
𝑍
=
𝑆ℎ

primary stress indices from Table NCD-3673.2(b)-1
maximum of CAEPIPE Input pressures P1 through P10
nominal outside diameter
nominal wall thickness
resultant moment due to sustained loads = √𝑀𝑋2 + 𝑀𝑌2 + 𝑀𝑍2
section modulus; for reduced outlets, effective section modulus as per NCD3653.3(d)
= material allowable stress at maximum of CAEPIPE Input temperatures T1
through T10

In case the option “Include Axial force in stress calculations” is turned ON, then
CAEPIPE evaluates Equation 8 of NCD-3652 as follows.
𝑆𝐿 = 2. 𝐵1. 𝐴𝐵𝑆 [(

𝑃𝐷
𝐹𝑆
𝑀𝐴
)+( )
] + 𝐵2
≤ 1.5𝑆ℎ
4𝑡𝑛
𝐴 𝑠𝑢𝑠𝑡
𝑍
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where
𝐹𝑆
= axial force due to sustained loads
𝐴
= nominal metal area
𝑃𝐷
As an option, as suggested in NCD-3651 (a), the pressure stress term (4𝑡 ) in the above
equations for SL may be replaced with the expression (
Analysis > Pressure.

𝑃𝑑2
𝐷2 −𝑑2

𝑛

) using the CAEPIPE Options >

Occasional Stress

The occasional stress (𝑆𝐿𝑂 ) due to sustained loads (pressure, weight and other sustained
mechanical loads) and stress due to occasional loads (such as thrusts from relief and safety
valve loads, pressure and flow transients, and reversing and nonreversing dynamic loads, if
the Design Specification requires calculation of moments due to reversing and nonreversing
dynamic loads) is calculated from Equation 9a of NCD-3653.1 (in case the option
“Include Axial force in stress calculations” is turned OFF).
𝑆𝐿𝑂 = 2. 𝐵1. 𝐴𝐵𝑆 (

𝑓𝑝 𝑃𝐷
𝑀𝐴 + 𝑀𝐵
) + 𝐵2 (
) ≤ 𝑆𝐿𝑂(𝐴𝑙𝑙)
4𝑡𝑛
𝑍

In case the option “Include Axial force in stress calculations” is turned ON, then
CAEPIPE evaluates Equation 9a of NCD-3653.1as follows.
𝑓𝑝 𝑃𝐷
𝐹𝑆
𝐹𝑂
𝑀𝐴 + 𝑀𝐵
] + 𝐵2 (
𝑆𝐿𝑂 = 2. 𝐵1. 𝐴𝐵𝑆 [(
)+( )
+( )
) ≤ 𝑆𝐿𝑂(𝐴𝑙𝑙)
4𝑡𝑛
𝐴 𝑠𝑢𝑠𝑡
𝐴 𝑜𝑐𝑐𝑎
𝑍

where
𝑀𝐴
= resultant bending moment due to sustained loads = √𝑀𝑋2 + 𝑀𝑌2 + 𝑀𝑍2
𝑀𝐵
= resultant moment due to occasional loads, inclusive of seismic anchor movements
and movements due to reversing and non-reversing dynamic loads
= √𝑀𝑋2 + 𝑀𝑌2 + 𝑀𝑍2
𝑓𝑝
= peak pressure factor input into CAEPIPE
𝑃
𝐷
𝑡𝑛
𝑍

=
=
=
=

maximum of CAEPIPE Input pressures P1 through P10
nominal outside diameter
nominal wall thickness
section modulus; for reduced outlets, effective section modulus as per NCD3653.3(d)
𝑆𝐿𝑂(All) = minimum (1.80Sh, 1.5Sy) for Level B Service Limits as per NCD-3653.1
=minimum (2.25Sh, 1.8Sy) for Level C Service Limits as per NCD-3654.2 (a)
= minimum (3.0Sh, 2.0Sy) for Level D Service Limits as per NCD-3655 (a)(2)
𝑆ℎ
= material allowable stress at maximum of CAEPIPE Input temperatures T1
through T10
𝑆𝑦

= material yield strength at maximum of CAEPIPE Input temperatures T1 through
T10

𝐹𝑂

= axial force due to occasional loads
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𝐴
= nominal metal area
𝑃𝐷
As an option, as suggested in NCD-3651 (a), the pressure stress term (4𝑡 ) in the above
equations for SLO may be replaced with the expression (
Analysis > Pressure.

𝑃𝑑2
𝐷2−𝑑2

𝑛

) using the CAEPIPE Options >

Note:

Movements at anchors and nozzles due to seismic event and due to reversing and
nonreversing dynamic loads are to be input as “specified displacements” for seismic and they
will be included as a part of the Occasional Stress evaluation given above.
Expansion Stress

The stress (𝑆𝐸 ) due to thermal expansion is calculated from Equation (10a) of NCD-3653.2.
𝑆𝐸 =

𝑖𝑀𝐶
≤ 𝑆𝐴
𝑍

where
𝑖 = stress intensification factor from Table NCD-3673.2(b)-1
𝑀𝐶 = range of resultant moments due to displacement cycle between two thermal states
inclusive of moment ONLY due to thermal anchor movements = √𝑀𝑋2 + 𝑀𝑌2 + 𝑀𝑍2
𝑍 = section modulus; for reduced outlets, effective section modulus as per NCD3653.3(d)
𝑆𝐴 = allowable stress range for expansion stress = 𝑓(1.25𝑆𝑐 + 0.25𝑆ℎ ) as per NCD3611.2(e)
𝑆𝑐 = basic allowable stress at minimum metal temperature expected during the
displacement cycle under analysis
𝑆ℎ = basic allowable stress at maximum metal temperature expected during the
displacement cycle under analysis
f =

stress range reduction factor from Table NCD-3611.2(e)-1

Sustained + Expansion Stress

The stress due to pressure, weight, other sustained loads and thermal expansion is calculated
from Equation 11 of NCD-3653.2(c) (in case the option “Include Axial force in stress
calculations” is turned OFF)..
𝑆𝑇𝐸 = 𝐴𝐵𝑆 (

𝑃𝐷
0.75𝑖𝑀𝐴 𝑖𝑀𝐶
)+
+
≤ 𝑆𝐻 + 𝑆𝐴
4𝑡𝑛
𝑍
𝑍

In case the option “Include Axial force in stress calculations” is turned ON, then
CAEPIPE evaluates Equation 11 of NCD-3653.2(c) as follows.
𝑆𝑇𝐸 = 𝐴𝐵𝑆 [(

𝑃𝐷
𝐹
0.75𝑖𝑀𝐴 𝑖𝑀𝐶
]+
)+( )
+
≤ 𝑆𝐻 + 𝑆𝐴
4𝑡𝑛
𝐴 𝑠𝑢𝑠𝑡
𝑍
𝑍

0.75i shall not be less than 1.0.
where
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𝑃 =
𝐷 =
𝑡𝑛 =
𝑀𝐴 =
𝑀𝐶 =
𝑍

=

𝑆𝐴 =
𝑆𝑐 =
𝑆ℎ =

maximum of CAEPIPE Input pressures P1 through P10
nominal outside diameter
nominal wall thickness
resultant bending moment due to sustained loads = √𝑀𝑋2 + 𝑀𝑌2 + 𝑀𝑍2
range of resultant moments due to displacement cycle between two thermal states
inclusive of moment ONLY due to thermal anchor movements = √𝑀𝑋2 + 𝑀𝑌2 + 𝑀𝑍2
section modulus; for reduced outlets, effective section modulus as per NCD3653.3(d)
allowable stress range for expansion stress = 𝑓(1.25𝑆𝑐 + 0.25𝑆ℎ ) as per NCD3611.2(e)
basic allowable stress at minimum metal temperature expected during the
displacement cycle under analysis
basic allowable stress at maximum metal temperature expected during the
displacement cycle under analysis

𝑆𝐻 = material allowable stress at maximum of CAEPIPE Input temperatures T1 through
T10
𝑓

= stress range reduction factor from Table NCD-3611.2(e)-1

Settlement Stress

The stress (𝑆𝑆 ) due to single nonrepeated anchor movement (e.g., predicted building
settlement) is calculated from Equation (10b) of NCD-3653.2.
𝑆𝑆 =

𝑖𝑀𝐷
≤ 3𝑆𝐶
𝑍

where
𝑖 = stress intensification factor from Table NCD-3673.2(b)-1
𝑀𝐷 = resultant moment due to any single non-repeated anchor movement (e.g., predicted
building settlement)
𝑆𝑐 = allowable stress at the Reference Temperature in CAEPIPE
𝑍 = section modulus; for reduced outlets, effective section modulus as per NCD3653.3(d)
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Additional Note for Welding elbow or Pipe bend:
If the value of B1 = (0.4h – 0.1) < 0.0, then B1 is set to 0.0.

Additional Note for Reinforced fabricated tee:
For calculating the value of rps and t’e, the value of re is assumed to be equal to 2 x r’m, where
r’m is the mean radius of the branch leg.
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Additional Note for Circumferential fillet welded or socket welded joints:
Values of B1, B2 and Stress Intensification Factor (SIF) are taken as 0.75, 1.50 and 1.3
respectively in CAEPIPE for the following reasons.
1. There is no provision to input the value of Cx in CAEPIPE for fillet and socket welded
flanges.
2. The definition of Cx as per Note 11 of Table NCD-3673.2(b)-1 contradicts with the
definition of Cx as defined in Notes (3) and (4) of Figure NCD-4427-1.
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BS 806 (1986)
Allowable Pressure

The allowable pressure for straight pipes and bends is calculated from 4.2(4).
𝑃=

where
𝑃 =
𝑓 =
𝑒 =
𝑡𝑓 =
=
𝐷 =

2𝑓𝑒𝑡𝑓
𝐷 − 2𝑡𝑓

allowable pressure
allowable stress
joint factor (input as material property)
minimum required thickness, including mechanical and corrosion allowances
nominal pipe thickness × (1 – mill tolerance/100) – corrosion allowance
outside diameter
𝑃=

𝑓𝑒
𝑋(1 + 0.6427 𝑡𝑎𝑛 𝛼√𝑋)

where
𝛼 = miter angle
𝑋 = (𝐷 − 2𝑡𝑓 )/2𝑡𝑓
Stresses

Stresses are calculated according to 4.11.
Sustained stresses are due to pressure, weight and other sustained mechanical loads.
Maximum value is 0.8 × proof stress value or rupture stress value in hot condition.
Expansion stresses are due to thermal (including specified displacements) and pressure
loadings. Maximum value is lower of
1) 0.9 × proof stress at room temperature plus 0.9 × proof stress at design temperature.
2) 0.9 × proof stress at room temperature plus rupture stress at design temperature.
Hot stresses are due to pressure, deadweight, other sustained mechanical loads, thermal and
cold pull loadings. Maximum value is the rupture stress at design temperature.
Occasional stresses (which are due to seismic, dynamic or wind loadings) are not calculated.
If these are to be evaluated, ASME B31.1 code should be used according to Inquiry Case
806/2 : November 1986 to BS 806 : 1986.
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Stresses on Straight Pipes and Bends (4.11.4)

The combined stress 𝑓𝑐 on straight pipes and bends including miter bends is calculated from
(28).
𝐹𝐶 = 𝐹 2 + 4𝑓𝑆2

where
𝐹 =
𝑓𝑇 =
=
𝑓𝐿 =
=
𝑓𝑆 =

greater of 𝑓𝑇 or 𝑓𝐿
transverse stress (4.11.4.2)
transverse pressure stress + transverse bending stress
longitudinal stress (4.11.4.3)
longitudinal pressure stress + longitudinal bending stress
torsional stress (4.11.4.4)

Transverse Stress 𝒇𝑻 (4.11.4.2)

The transverse pressure stress on both straight pipes and bends excluding miter
bends is calculated from (29).
𝑝𝑑
+ 0.5𝑝
2𝑡

The transverse pressure stress on miter bends is calculated from (30)
(

𝑝𝑑
𝑑+𝑡
+ 0.5𝑝) (1 + 0.6427 𝑡𝑎𝑛 𝛼 √
)
2𝑡
2𝑡

The transverse bending stress on straight pipe is zero.
The transverse bending stress on bends including miter bends is calculated from (31)
𝑟
(𝑀 𝐹 )2 + (𝑀𝑜 𝐹𝑇𝑜 )2
𝐼 𝑖 𝑇𝑖

where
𝑑
𝑡
𝑝
𝑀𝑖
𝑀𝑜
𝐹𝑇𝑖
𝐹𝑇𝑜
𝑟
𝐼
𝐷
𝛼

=
=
=
=
=
=
=
=
=
=
=

inside diameter
thickness
pressure
in-plane bending moment
out-of-plane bending moment
in-plane transverse stress intensification factor
out-of-plane transverse stress intensification factor
mean radius of pipe
moment of inertia
outside diameter
miter angle
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Longitudinal Stress 𝒇𝑳 (4.11.4.3)

The longitudinal pressure stress on both straight pipes and bends including miter bends is
calculated form (32)
𝑝𝑑2
4𝑡(𝑑 + 𝑡)

The longitudinal bending stress on straight pipe is calculated from (33).
𝑑 + 2𝑡
√𝑀𝑖2 + 𝑀𝑜2
2𝐼

The longitudinal bending stress on bends including miter bends is calculated from (34).
𝑟
√(𝑀𝑖 𝐹𝐿𝑖 )2 + (𝑀𝑜 𝐹𝐿𝑜 )2
𝐼

where
𝐹𝐿𝑖 = in-plane longitudinal stress intensification factor
𝐹𝐿𝑜 = out-of-plane longitudinal stress intensification factor
Torsional Stress𝒇𝑺 (4.11.4.4)

The torsional stress for both straight pipes and bends including miter bends is
calculated from (35).
𝑓𝑆 = 𝑀𝑡

𝑑 + 2𝑡
4𝐼

where
𝑀𝑡 = torsional moment
Stress at Branch Junction (4.11.5)

The combined stress at a branch junction is calculated from (36)
2
𝑓𝐶𝐵 = 𝑓𝐵2 + 4𝑓𝑆𝐵

where
𝑓𝐵 = transverse pressure stress at the junction plus nondirectional bending stress
𝑓𝑆𝐵 = torsional stress at the junction
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Transverse Pressure Stress at Branch Junction (4.11.5.2)

The transverse pressure stress at branch junction is calculated from (37)
𝑝𝑚 (

where
𝑑1 =
𝑡𝑎 =
𝑝 =
𝑚 =

𝑑1 + 𝑡𝑎
)
2𝑡𝑎

mean radius of main pipe
minimum thickness of main pipe
design pressure
stress multiplier, or equal to:
(a) for branch junctions where both r2/r1 and t2/t1 are less than or equal to 0.3
𝑚 = 1.8 +

2.8𝑟2
𝑟1

𝑟1

√𝑡

1

(b) for branch junctions where either r2/r1 and t2/t1 are greater than 0.3
𝑚
= 2.5𝑍10.2042 for 𝑑2 /𝑑1 ≤ 0.7
𝑚
= 2.5𝑍10.2415 for 𝑑2 /𝑑1 > 0.7
𝑍1
= (𝑟2 /𝑡2 )2 𝑡1 /𝑟1
𝑟1
= mean radius of main pipe
𝑟2
= mean radius of branch pipe
𝑡1
= thickness of main pipe
𝑡2
= thickness of branch pipe
Non-directional Bending Stress at Branch Junction (4.11.5.3)

For the main pipe, the bending stress is calculated from (40)
𝑟1
√(𝑀𝑖 𝐵𝑖 )2 + (𝑀𝑜 𝐵𝑜 )2
𝐼
where
𝑟1 = mean radius of pipe
𝐼 = moment of inertia of main pipe
𝑀𝑖 = in-plane bending moment
𝑀𝑜 = out-of-plane bending moment
𝐵𝑖 = in-plane branch stress intensification factor (Fig.4.11.1(6))
𝐵𝑜 = out-of-plane branch stress intensification factor (Fig.4.11.1(6))
For the branch pipe, the bending stress is calculated from
𝑟2
√(𝑀𝑖 𝐵𝑖 )2 + (𝑀𝑜 𝐵𝑜 )2
𝐼
where
𝑟2 = mean radius of branch pipe
𝐼 = calculated from 𝜋𝑟23 𝐵𝑜 𝑡2

or

𝜋𝑟23 𝑡1
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Allowable Internal Pressure

For straight pipes and bends, the allowable pressure is calculated using the equation provided
in para. 5.2.1 for straight pipes and bends.
𝑃𝑎 =

2𝑓𝑆𝑦𝑡 𝑡𝑎
𝐷𝑋

where
Pa= allowable pressure
Syt = specified minimum yield strength
ta= available thickness for pressure design
= tn × (1 - mill tolerance/100) - corrosion allowance “c” (as per para. 8.3.3)
(Any additional thickness required for threading, grooving, erosion, corrosion, etc. should be
included in corrosion allowance in CAEPIPE)
tn= nominal pipe thickness
D = outside diameter
f = design factor from Table 2.
Stress from Normal Sustained Loads

The von Mises equivalent stress (𝑆𝐿 ) due to Normal Sustained Loads (pressure, weight and
other sustained loads inclusive of snow/ice loading) is calculated as per para. 6.3, para. 8.5.2
and Appendix 3 for all components in CAEPIPE and compared with the acceptance limit
given in para. 8.5.3, as given below.
𝑆𝐿 = √(𝑆ℎ − 𝑆𝑎 )2 + (𝑆ℎ 𝑆𝑎 ) + 3𝑆𝑞 2 ≤ 𝑆𝑠
where
For Bends, Miter Bends and Welding Elbows
𝑃𝐷𝑜
4𝐹
𝑖𝑡 32𝑀𝑏 𝐷0
]
𝑆𝑎 = 𝑖𝑡 [
+
±
4𝑡𝑠 𝜋[𝐷𝑜 2 − 𝐷𝑖 2 ]
𝜋[𝐷𝑜 4 − 𝐷𝑖 4 ]
𝑆ℎ = 𝑖𝑝 [

𝑃𝐷𝑜
𝑖𝑏 32𝑀𝑏 𝐷0
]±
2𝑡𝑠
𝜋[𝐷𝑜 4 − 𝐷𝑖 4 ]

16𝐷𝑜 𝑀𝑞
4𝑉𝑇
𝑆𝑞 = 𝑖𝑞 [
4
4 ] + 𝑖𝑠
𝜋[𝐷𝑜 − 𝐷𝑖 ]
𝜋[𝐷𝑜 2 − 𝐷𝑖 2 ]
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For Other components such as Straight Pipes, Reducers, Branch Pipes, Header Pipes, etc.
𝑃𝐷𝑜
4𝐹
𝑖𝑏 32𝑀𝑏 𝐷0
𝑆𝑎 = 𝑖𝑡 [
+
2
2 ]±
4𝑡𝑠 𝜋[𝐷𝑜 − 𝐷𝑖 ]
𝜋[𝐷𝑜 4 − 𝐷𝑖 4 ]
𝑆ℎ = 𝑖𝑝 [

𝑃𝐷𝑜
]
2𝑡𝑠

16𝐷𝑜 𝑀𝑞
4𝑉𝑇
]
𝑆𝑞 = 𝑖𝑞 [
+
𝑖
𝑠
𝜋[𝐷𝑜 4 − 𝐷𝑖 4 ]
𝜋[𝐷𝑜 2 − 𝐷𝑖 2 ]
𝑃 = maximum of CAEPIPE input pressures P1 through P10 (inclusive of any overpressure
as per para. 5.2.3)
𝐷𝑜 = outside diameter
𝐷𝑖 = inside diameter
𝑡𝑆 = nominal thickness – corrosion allowance in CAEPIPE, as per para. 8.3.3
𝑖𝑝 , 𝑖𝑏 , 𝑖𝑡 , 𝑖𝑞 , 𝑖𝑠 = sustained stress concentration factor (SCF) for pressure, bending, thrust,
torsion and shear computed as per Appendix 4.
𝑆ℎ = sustained hoop stress
𝑆𝑎 = sustained axial stress
𝑆𝑞 = sustained shear stress
F = axial force due to sustained loads
𝑀𝑏 = bending moment due to sustained loads = √𝑀𝑖 2 + 𝑀𝑜 2
𝑀𝑞 = torsional moment due to sustained loads
𝑉𝑇 = shear force due to sustained loads = √𝑉𝑖 2 + 𝑉𝑜 2
𝑀𝑖
𝑀𝑜
𝑉𝑖
𝑉𝑜
𝑆𝑠

=
=
=
=
=

in-plane bending moment due to sustained loads
out-of-plane bending moment due to sustained loads
in-plane shear force (local fy from CAEPIPE) due to sustained loads
out-of-plane shear force (local fz from CAEPIPE) due to sustained loads
allowable equivalent stress for Normal condition from Table 3 (given below).

Note:
In CAEPIPE, any wind load input is always considered as an “Abnormal” sustained load
(and NOT as a Normal sustained load).
In addition, CAEPIPE always considers snow/ice loading as a “Normal” sustained load (and
NOT as an Abnormal sustained load).
In CAEPIPE, the effect of cold-pull/cold spring is included only in support loads and not
included in stress calculations as many piping codes do not allow credit for any reduction in
stresses due to cold spring since the displacement range is unaffected.On the other hand,
piping codes allow reduction in support loads due to cold spring (which can be helpful at the
equipment).
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Stress from Abnormal Sustained Loads

The von Mises equivalent stress (𝑆𝐿𝑜 ) due to Abnormal Sustained Loads is calculated as per
para. 6.4, para. 8.5.2 and Appendix 3 for all components as the Sum of stress (𝑆𝐿 ) due to
Normal Sustained Loads (pressure, weight and other sustained loads) and stress (𝑆𝑜 ) due to
Abnormal Sustained Loads (i.e., occasional loads) such as earthquake or wind. Wind and
earthquake are not considered as acting concurrently. The resulting stress 𝑆𝐿𝑜 is compared
with the acceptance limit given in para. 8.5.3.
𝑆𝐿𝑜 ≤ 𝑆𝑠𝑎𝑏
where
𝑆𝐿𝑂 = 𝑆𝐿 + 𝑆𝑂 , where 𝑆𝐿 is computed as above.
𝑆𝑜 = √(𝑆ℎ𝑜 − 𝑆𝑎𝑜 )2 + (𝑆ℎ𝑜 𝑆𝑎𝑜 ) + 3𝑆𝑞𝑜 2
For Bends, Miter Bends and Welding Elbows
𝑃𝑝𝑒𝑎𝑘 𝐷𝑜
4𝐹𝑜
𝑖𝑡 32𝑀𝑏0 𝐷0
𝑆𝑎0 = 𝑖𝑡 [
+
2
2 ]±
4𝑡𝑠
𝜋[𝐷𝑜 − 𝐷𝑖 ]
𝜋[𝐷𝑜 4 − 𝐷𝑖 4 ]
𝑆ℎ𝑜 = 𝑖𝑝 [

𝑃𝑝𝑒𝑎𝑘 𝐷𝑜
𝑖𝑏 32𝑀𝑏0 𝐷0
]±
2𝑡𝑠
𝜋[𝐷𝑜 4 − 𝐷𝑖 4 ]

16𝐷𝑜 𝑀𝑞𝑜
4𝑉𝑇𝑜
𝑆𝑞𝑜 = 𝑖𝑞 [
4
4 ] + 𝑖𝑠
𝜋[𝐷𝑜 − 𝐷𝑖 ]
𝜋[𝐷𝑜 2 − 𝐷𝑖 2 ]
For Other components such as Straight Pipes, Reducers, Branch Pipes, Header Pipes, etc.,
𝑃𝑝𝑒𝑎𝑘 𝐷𝑜
4𝐹𝑜
𝑖𝑏 32𝑀𝑏0 𝐷0
]
𝑆𝑎0 = 𝑖𝑡 [
+
±
4𝑡𝑠
𝜋[𝐷𝑜 2 − 𝐷𝑖 2 ]
𝜋[𝐷𝑜 4 − 𝐷𝑖 4 ]
𝑆ℎ𝑜 = 𝑖𝑝 [

𝑃𝑝𝑒𝑎𝑘 𝐷𝑜
]
2𝑡𝑠

16𝐷𝑜 𝑀𝑞𝑜
4𝑉𝑇𝑜
𝑆𝑞𝑜 = 𝑖𝑞 [
4
4 ] + 𝑖𝑠
𝜋[𝐷𝑜 − 𝐷𝑖 ]
𝜋[𝐷𝑜 2 − 𝐷𝑖 2 ]
𝑃𝑝𝑒𝑎𝑘 = peak pressure = (peak pressure factor in CAEPIPE – 1.0) x P
𝑃 = maximum of CAEPIPE input pressures P1 through P10
𝐷𝑜 = outside diameter
𝐷𝑖 = inside diameter
𝑡𝑆 = nominal thickness – corrosion allowance in CAEPIPE, as per para. 8.3.3
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𝑖𝑝 , 𝑖𝑏 , 𝑖𝑡 , 𝑖𝑞 , 𝑖𝑠 = sustained stress concentration factor (SCF) for pressure, bending, thrust,
torsion and shear computed as per Appendix 4.
𝑆ℎ𝑜 = occasional hoop stress
𝑆𝑎𝑜 = occasional axial stress
𝑆𝑞𝑜 = occasional shear stress
𝐹𝑜 = axial force due to occasional loads
𝑀𝑏𝑜 = bending moment due to occasional loads = √𝑀𝑖𝑜 2 + 𝑀𝑜𝑜 2
𝑀𝑞𝑜 = torsional moment due to occasional loads
𝑉𝑇𝑜 = shear force due to occasional loads = √𝑉𝑖𝑜 2 + 𝑉𝑜𝑜 2
𝑀𝑖𝑜 =
𝑀𝑜𝑜 =
𝑉𝑖𝑜 =
𝑉𝑜𝑜 =
𝑆𝑠𝑎𝑏 =

in-plane bending moment due to occasional loads
out-of-plane bending moment due to occasional loads
in-plane shear force (local fy from CAEPIPE) due to occasional loads
out-of-plane shear force (local fz from CAEPIPE) due to occasional loads
allowable equivalent stress for Abnormal condition from Table 3 (given below).

Note:
In CAEPIPE, any ground settlement input is considered in computing “Shakedown Stress”
(which is covered next) and NOT as an Abnormal sustained load.
Table 3: Allowable Stress for Normal and Abnormal Sustained Loads

Expansion Stress (Shakedown Stress)

The von Mises equivalent stress (𝑆𝐸 ) range due to thermal expansion is calculated as per
para. 8.5.4 and Appendix 3 for all components in CAEPIPE and compared with the
acceptance limit given in para. 8.5.5, as given below.
𝑆𝐸 ≤ 0.5𝐾𝑆𝐷 (𝑆𝑦 + 𝑆𝑌𝑇 )
where
𝑆𝐸 = √(𝑆ℎ𝑒 − 𝑆𝑎𝑒 )2 + (𝑆ℎ𝑒 𝑆𝑎𝑒 ) + 3𝑆𝑞𝑒 2
For Bends, Miter Bends and Welding Elbows
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𝑃𝐷𝑜
4𝐹𝑒
𝑖𝑡 32𝑀𝑏𝑒 𝐷0
]
𝑆𝑎𝑒 = 𝑖𝑡 [
+
±
4𝑡𝑠 𝜋[𝐷𝑜 2 − 𝐷𝑖 2 ]
𝜋[𝐷𝑜 4 − 𝐷𝑖 4 ]
𝑆ℎ𝑒 = 𝑖𝑝 [

𝑆𝑞𝑒 = 𝑖𝑞 [

𝑃𝐷𝑜
𝑖𝑏 32𝑀𝑏𝑒 𝐷0
]±
2𝑡𝑠
𝜋[𝐷𝑜 4 − 𝐷𝑖 4 ]
16𝐷𝑜 𝑀𝑞𝑒
4

4

𝜋[𝐷𝑜 − 𝐷𝑖 ]

] + 𝑖𝑠

4𝑉𝑇𝑒
𝜋[𝐷𝑜 2 − 𝐷𝑖 2 ]

For Other components such as Straight Pipes, Reducers, Branch Pipes, Header Pipes, etc.,
𝑃𝐷𝑜
4𝐹𝑒
𝑖𝑏 32𝑀𝑏𝑒 𝐷0
𝑆𝑎𝑒 = 𝑖𝑡 [
+
2
2 ]±
4𝑡𝑠 𝜋[𝐷𝑜 − 𝐷𝑖 ]
𝜋[𝐷𝑜 4 − 𝐷𝑖 4 ]
𝑆ℎ𝑒 = 𝑖𝑝 [

𝑆𝑞𝑒 = 𝑖𝑞 [

𝑃𝐷𝑜
]
2𝑡𝑠
16𝐷𝑜 𝑀𝑞𝑒
4

4

𝜋[𝐷𝑜 − 𝐷𝑖 ]

] + 𝑖𝑠

4𝑉𝑇𝑒
𝜋[𝐷𝑜 2 − 𝐷𝑖 2 ]

𝑃 = operating pressure corresponding to the temperature considered for displacement cycle
under analysis. For example, P = P1 from CAEPIPE for Expansion T1.
𝐷𝑜 = outside diameter
𝐷𝑖 = inside diameter
𝑡𝑆 = nominal thickness – corrosion allowance in CAEPIPE, as per para. 8.3.3
𝑖𝑝 , 𝑖𝑏 , 𝑖𝑡 , 𝑖𝑞 , 𝑖𝑠 = cyclic stress concentration factor (SCF) for pressure, bending, thrust, torsion
and shear computed as per Appendix 4.
𝑆ℎ𝑒 = thermal expansion hoop stress
𝑆𝑎𝑒 = thermal expansion axial stress
𝑆𝑞𝑒 = thermal expansion shear stress
𝐹𝑒 = axial force due to thermal expansion
𝑀𝑏𝑒 = bending moment due to thermal expansion = √𝑀𝑖𝑒 2 + 𝑀𝑜𝑒 2
𝑀𝑞𝑒 = torsional moment due to thermal expansion
𝑉𝑇𝑒 = shear force due to thermal expansion = √𝑉𝑖𝑒 2 + 𝑉𝑜𝑒 2
𝑀𝑖𝑒 =
𝑀𝑜𝑒 =
𝑉𝑖𝑒 =
𝑉𝑜𝑒 =
𝐾𝑆𝐷 =

in-plane bending moment due to thermal expansion
out-of-plane bending moment due to thermal expansion
in-plane shear force (local fy from CAEPIPE) due to thermal expansion
out-of-plane shear force (local fz from CAEPIPE) due to thermal expansion
shakedown factor for the material from Table 4.
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KSD = 1.8 for Carbon Steel (CS) and 2.0 for Austenitic Steel (AS). For other materials, it is
assumed to be 1.8.
𝑆𝑦 = yield stress of material at room temperature (reference temperature in CAEPIPE).
𝑆𝑌𝑇 = yield stress of material at maximum of CAEPIPE input temperatures T1 through T10.
Fatigue Analysis

Fatigue compliance checks as described in para. 6.7, para. 8.5.6, para. 8.5.7 and Appendix 5
are not included in CAEPIPE analysis.
Stress Concentration Factors (SCF)
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Welding TEE
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Extruded TEE
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Reinforced Fabricated TEE
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Unreinforced Fabricated TEE
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Sustained and Cyclic SCF for Welds and Threaded Joints in CAEPIPE
Type

Buttweld

Tapered
Transition

Filletweld

Concave
Filletweld

Threaded
Joint

Ip
Pressure

Ib
Bending

1.00

1.00

2.00

1.30

1.00

1.00

1.80

2.10

1.00

1.00

2.00

1.30

1.00

1.00

2.00

1.30

1.00

1.00

1.00

2.30

It
Thrust
Sustained SCF
1.00
Cyclic SCF
1.30
Sustained SCF
1.00
Cyclic SCF
2.00
Sustained SCF
1.00
Cyclic SCF
1.30
Sustained SCF
1.00
Cyclic SCF
1.30
Sustained SCF
1.00
Cyclic SCF
2.30

Iq
Torsion

Is
Shear

1.00

1.00

1.00

2.00

1.00

1.00

1.00

2.00

1.00

1.00

1.00

2.00

1.00

1.00

1.00

2.00

1.00

1.00

1.00

1.00

Iq
Torsion

Is
Shear

1.00

1.00

1.00

1.00

1.00

1.00

1.00

1.00

1.00

1.00

1.00

1.00

1.00

1.00

1.00

1.00

1.00

1.00

1.00

1.00

Sustained and Cyclic SCF for Flanges in CAEPIPE
Type

Weldneck

Double
Welded
Single,
Fillet &
Socket
Welded
Lap Joint

Threaded

Ip
Pressure

Ib
Bending

1.00

1.00

1.00

1.00

1.00

1.00

1.00

1.20

1.00

1.00

2.00

1.30

1.00

1.00

2.00

1.60

1.00

1.00

2.00

2.30

It
Thrust
Sustained SCF
1.00
Cyclic SCF
1.00
Sustained SCF
1.00
Cyclic SCF
1.20
Sustained SCF
1.00
Cyclic SCF
1.30
Sustained SCF
1.00
Cyclic SCF
1.60
Sustained SCF
1.00
Cyclic SCF
2.30
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Allowable Pressure

A.2.1 Straight pipes: For straight pipes, the allowable internal pressure is calculated from
Equations (A.1) and (A.2):
2𝜎𝑑 𝑧𝑡𝑚𝑖𝑛
𝑃𝑎 =
(𝐴. 1)
𝑑𝑜
where,
𝑡𝑚𝑖𝑛 = 𝑡𝑛 − (𝑐1 + 𝑐2 )
(𝐴. 2)
𝑃𝑎 = allowable pressure
𝑑𝑜 = outside diameter of the pipe
𝑧 = joint efficiency factor
𝑡𝑛 = nominal wall thickness of the pipe.
𝑐1 = mill/fabrication tolerance (input as a % of thickness)
𝑐2 = corrosion allowance
𝜎𝑑 = allowable stress (i.e., design stress) = 𝑅𝑒 (𝑇), yield stress at design temperature (sec
5.2.3.1), where design temperature is a CAEPIPE input
Note: The above allowable pressure calculated by CAEPIPE is valid only for pipes and
components delivered with the required certificate as per sec. 5.2.2.
For pipes and components delivered without the required certificate, the allowable pressure
𝑃𝑎 computed by CAEPIPE should be manually divided by 𝛾𝑚,𝑦𝑖𝑒𝑙𝑑 = 1.2. (sec. 5.2.3.1)
A.2.2 Bends: The allowable internal pressure for bends is calculated as
2𝜎𝑑 𝑧 𝑡𝑚𝑖𝑛
𝑃𝑎 =
𝑑𝑜 𝐼
𝑅 − 0.25𝑑𝑖
𝐼=
𝑅 − 0.5𝑑𝑚
𝑑𝑖 = inside diameter of the pipe
𝑑𝑚 = mean diameter of the pipe

(𝐴. 3)

A.4 Reducers and extensions: shall withstand the same internal pressure as the connecting
pipes where the half angle 𝛼, at the apex of the component does not exceed 30 degrees,

The allowable internal pressure is calculated from
2𝜎𝑑 𝑧 cos 𝛼 𝑡𝑛1,𝑚𝑖𝑛 2𝜎𝑑 𝑧 cos 𝛼 𝑡𝑛2,𝑚𝑖𝑛
}
𝑃𝑎 = 𝑚𝑖𝑛 {
,
𝑑𝑜1
𝑑𝑜2
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where:
𝑡𝑛1,𝑚𝑖𝑛 = 𝑡𝑛1 − (𝑐1 + 𝑐2 )
𝑡𝑛2,𝑚𝑖𝑛 = 𝑡𝑛2 − (𝑐1 + 𝑐2 )
𝑡𝑛1 , 𝑎𝑛𝑑 𝑡𝑛2 is nominal wall thickness of pipe at inlet and outlet of reducer.
𝑑𝑜1 , 𝑎𝑛𝑑 𝑑𝑜2 is nominal outer diameter at inlet and outlet of reducer.
Note: CAEPIPE permits to model the reducers with α ≤ 30o . Reducers with α > 30o
cannot be modeled, because the stress concetration factors are not explcitly given in C.3.5
for reducers with α > 30o .
Evaluation of Stresses

Stress components and internal forces as per sec. 6.6.2 of the code are defined as:
Axial stress
(∆𝜎𝑎 )+ = 𝑖𝑎1
and

∆𝑁𝑥

(∆𝜎𝑎 )− = 𝑖𝑎1

𝐴

∆𝑁𝑥
𝐴

+ 𝑖𝑎2

√∆𝑀𝑦 2 +∆𝑀𝑧 2

− 𝑖𝑎2

𝑊
√∆𝑀𝑦2 +∆𝑀𝑧 2
𝑊

Shear Stress
(∆𝜏)+ = 𝑖𝑎3

∆𝑀𝑥

(∆𝜏)− = 𝑖𝑎3

∆𝑀𝑥

2𝑊

2𝑊

+ 𝑖𝑎4
− 𝑖𝑎4

2√∆𝑉𝑦 2 +∆𝑉𝑧 2
𝐴

and

2√∆𝑉𝑦 2 +∆𝑉𝑧 2
𝐴

Membrane Tangential Stress
𝑝∙𝑑
(∆𝜎𝑡 )𝑚 = 𝑖𝑎𝑝 2𝑡 𝑖
𝑚𝑖𝑛

(Membrane + Bending) Tangential Stress
𝑝∙𝑑𝑖

(∆𝜎𝑡 )𝑚𝑏 = 𝑖𝑎𝑝 2𝑡

𝑚𝑖𝑛

+ 𝑖𝑎5

√∆𝑀𝑦 2 +∆𝑀𝑧 2
𝑊

+ 𝜎𝑞

The equivalent stress as per sec. 6.6.3 is calculated from the axial and tangential stress
components (calculated with sign) by von Mises for either membrane stress or membrane +
bending stress (𝒎|𝒎𝒃)
𝑺𝒎|𝒎𝒃 = 𝒎𝒂𝒙 {S1𝑚|𝑚𝑏 , S2𝑚|𝑚𝑏 , S3𝑚|𝑚𝑏 , S4𝑚|𝑚𝑏 , |(∆𝜎𝑎 )+ |, |(∆𝜎𝑎 )− |}
where,
S1𝑚|𝑚𝑏 =√(∆𝜎𝑎 )2+ − (∆𝜎𝑎 )+ ∙ (∆𝜎𝑡 )𝒎|𝑚𝑏 + (∆𝜎𝑡 )2𝑚|𝑚𝑏 + 3(∆𝜏)2+
S2𝑚|𝑚𝑏 =√(∆𝜎𝑎 )2− − (∆𝜎𝑎 )− ∙ (∆𝜎𝑡 )𝒎|𝑚𝑏 + (∆𝜎𝑡 )2𝑚|𝑚𝑏 + 3(∆𝜏)2+
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S3𝑚|𝑚𝑏 =√(∆𝜎𝑎 )2+ − (∆𝜎𝑎 )+ ∙ (∆𝜎𝑡 )𝒎|𝑚𝑏 + (∆𝜎𝑡 )2𝑚|𝑚𝑏 + 3(∆𝜏)2−
S4𝑚|𝑚𝑏 =√(∆𝜎𝑎 )2− − (∆𝜎𝑎 )− ∙ (∆𝜎𝑡 )𝒎|𝑚𝑏 + (∆𝜎𝑡 )2𝑚|𝑚𝑏 + 3(∆𝜏)2−
𝑁𝑥 = Axial force (positive for tension), (pressure, temperature and soil reaction)
𝑀𝑥 = Torsional moment
𝑀𝑦 and 𝑀𝑧 = Bending moment
A = Metal area of pipe
W = Section modulus
𝑉𝑦 and 𝑉𝑧 = Shear force
p = Internal pressure
𝑑𝑖 = Inside diameter of the steel service pipe.
𝑡𝑚𝑖𝑛 = Minimum pipe wall thickness = 𝑡𝑛 − (𝑐1 + 𝑐2 )
𝑖𝑎1 = Stress concentration factor for axial stresses from normal force
𝑖𝑎2 = Stress concentration factor for axial stresses from bending moments
𝑖𝑎3 = Stress concentration factor for shear stresses from torsion
𝑖𝑎4 = Stress concentration factor for shear stresses from shear force
𝑖𝑎𝑝 = Stress concentration factor for hoop stresses from pressure
Area and section modulus are calculated, as per 6.6.2, as follows:
(45)

𝐴 = 𝜋 × (𝑑𝑜 − 𝑡𝑛 ) × 𝑡𝑛
𝜋

𝑊 = 32×𝑑 [𝑑𝑜4 − (𝑑𝑜 − 2𝑡𝑛 )4 ]
𝑜

(46)

𝑑𝑜 = Outer diameter of the steel service pipe
𝑡𝑛 = nominal pipe wall thickness
𝑐1 = Correction to wall thickness for fabrication tolerance
𝑐2 = Correction to wall thickness for corrosion allowance
𝑆𝑚 = Membrane stress
𝑆𝑚𝑏 = Resulting stress of membrane stress and bending stress
𝜎𝑎 = Axial (normal) stress
𝜎𝑡 = Tangential stress
𝜏 = Shear stress
𝜎𝑝 = Hoop stress from internal pressure
𝜎𝑞 = Ovalisation stress from soil pressure, traffic, etc. to be manually computed by the user
and input into soil model dialog of CAEPIPE at this time.
Forced Control Action LC2 (sec. 7.2.2.2);

In CAEPIPE, the LC2 case (both 𝑆𝑚 and 𝑆𝑟𝑒𝑠 ) is evaluated for sustained loads (W+P) which
include weight (of pipe, fluid, and insulation) at maximum operating pressure. The
displacements specified as settlement at anchor and nozzle locations are also included in
force-controlled action.
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1) 𝑺𝒎 = Membrane stress A1:
𝑆𝑚 ≤ 𝑆𝑚𝑎 (= 𝑅𝑒 (𝑇)/𝛾𝑚 )
𝑆𝑚 = is the equilibrium membrane stress
𝑆𝑚𝑎 = is the allowable membrane stress (= 𝑅𝑒 (𝑇)/𝛾𝑚 )
𝑅𝑒 (𝑇) = Specific minimum yield strength at maximum operating temperature
𝛾𝑚 = 1.25 is the partial safety factor for the base material, as per sec. 7.2.2.2.
2) 𝑺𝒓𝒆𝒔 = Membrane + Bending stress A1:
𝑆𝑟𝑒𝑠 (= 𝑆𝑚𝑏 ) ≤ 𝑆𝑟𝑒𝑠𝑎
𝑆𝑟𝑒𝑠 (= 𝑆𝑚𝑏 ) is the resulting stress of equilibrium membrane stress and equilibrium
bending stress
𝑆𝑟𝑒𝑠𝑎 = is the allowable resulting stress (including membrane + bending)
𝑅𝑒 (𝑇)
𝛾𝑚
=
𝑅𝑒 (𝑇)
2.5
− 1.5 𝑆𝑚
𝛾𝑚
{
1.5

𝑆𝑟𝑒𝑠𝑎

for
for

𝑅𝑒 (𝑇)
𝛾𝑚
𝑅𝑒 (𝑇)
𝑅𝑒 (𝑇)
0.67
≤ 𝑆𝑚 ≤
𝛾𝑚
𝛾𝑚
𝑆𝑚 ≤ 0.67

Note: The above stresses calculated by CAEPIPE is valid only for pipes and components
delivered with the required certificate as per sec. 5.2.2, where 𝛾𝑚 = 1.25.
For pipes and components delivered without the required certificate, the allowable stresses
should be calculated manually by the user with 𝛾𝑚 = (1.2 ∗ 1.25) as per sec.5.2.3.1
Stepwise plastic deformation LC3 (sec. 7.2.2.3);

In CAEPIPE, the LC3 case is evaluated for each operating load case (Weight of pipe, fluid &
insulation + Pressure + Temperature) and at each set of operating pressure and
temperature.
𝑆𝑝𝑑 = Force + Deformation stress A2
Limit state A2 concerns incremental collapse and stress ratcheting. The limit state for stress
ratcheting for fully restrained sections is obtained from:
𝑆𝑝𝑑 ≤ 𝑆𝑝𝑑𝑎
𝑆𝑝𝑑 is the maximum of axial stress due to plastic deformation.
𝑆𝑝𝑑 = 𝒎𝒂𝒙{(∆𝜎𝑎 )+ , (∆𝜎𝑎 )− }
The allowable/limit state for stress ratcheting for fully restrained sections is obtained from:
3 𝜎𝑝 2
3 𝜎𝑝 2
𝑆𝑝𝑑𝑎 = 𝑅𝑒 (𝑇) [√1 − (
) + √𝛾 2 − (
) ]
4 𝑅𝑒 (𝑇)
4 𝑅𝑒 (𝑇)
𝑅𝑒 (𝑇) = Specific minimum yield strength at operating temperature
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𝜎𝑝 (= 𝑃𝑑𝑜 ⁄2𝑧𝑡𝑚𝑖𝑛 ) = hoop stress at operating pressure. (eqn. 78)
𝛾 = 0.7, is a safety factor
Note: EN13941-1:2019 does not specify stress concentration factors for calculating 𝑆𝑝𝑑 . In
CAEPIPE, the stress concentration factors for 𝑆𝑝𝑑 calculations are considered the same as
those for resulting stresses for each component given in Tables C1, C3, C4, and C6.
TEES


In CAEPIPE,  and  are calculated separately
for run pipe and branch pipe with sectional forces
chosen as follows:
For stresses in the run pipe, the forces and
moments determined in the run at the
intersection between the centerlines of the pipes
are used.
For stresses in the branch pipe, the forces and
moments determined in the branch at a distance
of 0.5 𝑑𝑟𝑜 from the centreline of the run pipe are
used.
Note: CAEPIPE automatically refines the
elements connected to the node point with a
defined tee. Two (2) nodes on Run Pipe (one on
either side of the Branch SIF node) at a distance
equal to Run Pipe OD and one (1) node on
Branch Pipe at a distance equal to Run pipe OD/2 from the Branch SIF node are
internally added with appropriate node numbers.



As per sec. 6.6.7, the stresses at the intersection of run pipe are calculated after
combining the axial and shear stresses from the run pipe and branch element as follows.
(∆𝜎𝑎 )± (𝑟𝑢𝑛 𝑖𝑛𝑡𝑒𝑟𝑠𝑒𝑐𝑡𝑖𝑜𝑛 ) = (∆𝜎𝑎 )± (𝑟𝑢𝑛) + ∆𝜎𝑎 (𝑏𝑟𝑎𝑛𝑐ℎ)

(63)

(∆𝜏)± (𝑟𝑢𝑛 𝑖𝑛𝑡𝑒𝑟𝑠𝑒𝑐𝑡𝑖𝑜𝑛 ) = (∆𝜏)± (𝑟𝑢𝑛) + ∆𝜏 (𝑏𝑟𝑎𝑛𝑐ℎ)

(64)

In CAEPIPE,
∆𝜎𝑎 (𝑏𝑟𝑎𝑛𝑐ℎ) = {

(∆𝜎𝑎 )+ (𝑏𝑟𝑎𝑛𝑐ℎ) 𝑖𝑓
(∆𝜎𝑎 )− (𝑏𝑟𝑎𝑛𝑐ℎ) 𝑖𝑓

∆𝜏 (𝑏𝑟𝑎𝑛𝑐ℎ) = {

(∆𝜏)+ (𝑏𝑟𝑎𝑛𝑐ℎ) 𝑖𝑓
(∆𝜏)− (𝑏𝑟𝑎𝑛𝑐ℎ) 𝑖𝑓
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|(∆𝜎𝑎 )+ | > |(∆𝜎𝑎 )− |
|(∆𝜎𝑎 )− | ≥ |(∆𝜎𝑎 )+ |
|(∆𝜏)+ | > |(∆𝜏)− |
|(∆𝜏)− | ≥ |(∆𝜏)+ |
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Modeling buried pipe bilinear restraints

Longitudinal/Axial soil stiffness (sec. 6.5.3.1)
Cohesionless Soil
For sandy soils, the ultimate axial load per unit
length
𝐹𝑢 = 𝜇 (

1+𝐾𝑜
2

𝐷

Cohesive Soil
The ultimate axial/longitudinal load per unit length
𝐹𝑢 = 𝜋 𝐷𝑐 𝐶𝑓 ∙ 𝐶𝑠

2

(8)

𝜋𝐷𝑐 𝜎𝑣 + 𝐺 − 𝛾𝑠 ∙ 𝜋 ( 2𝑐 ) )

where
𝐹𝑢 - Ultimate axial soil load
𝐶𝑠 – Cohesion strength.
𝐶𝑓 - Cohesion factor

where,
𝐾𝑜 = coefficient of horizontal soil pressure at rest
𝐾𝑜 = 1 − sin 𝜑′
𝜑′ - the effective angle of Internal friction of soil
𝜎𝑣 - Effective (normal) intergranular soil stress at
pipe center level.
𝜇 = tan 𝛿

(12)

is the friction coefficient, sec.6.5.3.2
δ = Angle of interface friction between soil and
(casing) pipe.
For granular soils

𝜎𝑣 = 𝛾𝑠 𝐻𝑤 + 𝛾𝑠𝑤 (𝑍 − 𝐻𝑤 ) for 𝐻𝑤 < 𝑍
𝜎𝑣 = 𝛾𝑠 𝑍 for 𝐻𝑤 ≥ 𝑍
𝛾𝑠𝑤 = 𝛾′𝑠𝑤 − 𝛾𝑤

(9)
(10)
(11)

𝐷𝑐 = Outer diameter of the casing
G = Effective self-weight of the factory-made pipe assembly (including pipe fill) per meter of
pipe length
𝛾𝑠 = Effective weight of soil above ground water table
𝛾𝑠𝑤 = Effective weight of soil below ground water table = 𝛾′𝑠𝑤 − 𝛾𝑤
𝛾′𝑠𝑤 = Effective weight of saturated soil below ground water table
𝛾𝑤 = Effective weight of water
Z = Depth of burial (measured to centerline of pipe assembly)
𝐻𝑤 = Depth of ground water table below grade
For sandy soils, the relative displacement 𝑢𝑢 between the pipe and surrounding soil required
to reach the maximum friction resistance fu is approx. 𝑢𝑢 = 3 mm = 0.003m.
Axial soil stiffness = 𝐹𝑢 /𝑢𝑢
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Horizontal/Lateral soil stiffness (sec. 6.5.4.1)

The coefficient of horizontal/lateral soil reaction or horizontal/lateral bedding constant is
defined as the ratio between horizontal/lateral soil pressure and horizontal/lateral movement
of the pipe system.
The ultimate horizontal/lateral soil resistance 𝑃𝑢 is assessed using the equivalent equation for
side support:
Cohesionless Soil
For sandy soils, the ultimate horizontal/lateral load per
unit length
𝑃𝑢 = 𝛾 ∙ 𝑍 ∙ 𝐾𝑞 ∙ 𝐷𝑐

Cohesive Soil
The ultimate horizontal/lateral load per unit length
𝑃𝑢 = (𝐾𝑞 ∙ 𝛾 ∙ 𝑍 + 0.7 𝛼 ∙ 𝐾𝑐 ∙ 𝑐 ′ ) ∙ 𝐷𝑐

(16)

(17)

𝛼 = 0.6, in case of open excavation; and
𝛼 =1.0, in case of jacking methods;
𝑐 ′ = 𝐶𝑓 ∙ 𝐶𝑠 Effective cohesion of the soil
𝐾𝑐 = soil pressure coefficient for clay (Fig 10)

𝛾 = Soil density
Z = depth of the buried pipe
𝐾𝑞 = soil pressure coefficient for sand (Fig 10)

In Figure 10 the values on the right side (45°, 30°, etc.) represent the effective internal angle
of friction of the soil 𝜑′.
The ultimate horizontal/lateral displacement 𝑣𝑢 is not defined precisely. The results of a
number of tests with small diameter pipes are summarized in Table 12.
Table 12 – Ultimate horizontal/lateral displacement 𝑣𝑢
𝒗𝒖 /Z %
Casing Diameter Dc
Loose sand
Dense sand
75 mma
4.5
2.7
120 mm
3
2
≥ 300 mm
2
1.5
Values obtained by interpolation.
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For buried pipes without expansion cushions, a fair relationship between horizontal pipe
movement and corresponding soil restraint is given by
𝑝
𝑣 ⁄𝑣𝑢
=
(15)
𝑝𝑢 0.15 + 0.85 𝑣 ⁄𝑣𝑢
At 70% of ultimate horizontal load i.e., 𝑝⁄𝑝𝑢 = 0.7, the horizontal displacement is
calculated as
0.7(0.15 + 0.85 𝑣 ⁄𝑣𝑢 ) = 𝑣 ⁄𝑣𝑢
𝑣70% = 0.2593 𝑣𝑢
Vertical soil stiffnesses

To compute vertically upward and downward stiffnesses, the ultimate loads in vertical
direction are considered as the same as those for other piping codes in CAEPIPE. For
details, refer to the Section titled “Buried Piping” in the Technical Reference Manual. The
vertical yield displacement for the soil is assumed to be D/25, where D is the outside
diameter of the pipe.
Combined lateral stiffness of PUR, expansion cushions and soil (sec. 6.5.5)

PUR
𝑘ℎ,1 =

𝐸𝑝𝑢𝑟
𝑡𝑝𝑢𝑟

𝑘1 = 𝑘ℎ,1 𝑑𝑜
(19b)

(19a)

Cushion
𝐸
𝑘ℎ,2 = 𝑡 𝑐𝑢

(20a)

Soil
0.7 𝑝
𝑘ℎ,3 = 𝑣 𝑢

(21a)

𝑘2 = 𝑘ℎ,2 𝐷𝑐

(20b)

𝑘3 = 𝑘ℎ,3 𝐷𝑐𝑢

(21b)

𝑐𝑢

70%

Combined
1
1
=∑
𝑘

𝑘𝑖

(22)

where,
𝑑𝑜 = Outside diameter of steel service pipe
𝐷𝑐 = Outer diameter of casing
𝐷𝑐𝑢 = Equivalent outside diameter of expansion cushion.
Polyurethane foam thermal insulation (sec. 5.3)
In CAEPIPE, for EN13941-1 code, the insulation for pipe is considered as PUR, and the
elastic modulus for PUR is internally set as 𝐸𝑃𝑈𝑅 = 10.0 𝑀𝑃𝑎.
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The elastic modulus 𝐸𝑐𝑢 for expansion cushion shall be input in soil dialog as per section
5.6.3.
NOTE 1: The above methodology of combining stiffnesses of PUR, expansion
cushions and soil is also applied in the vertically downward and upward directions.
NOTE 2: Expansion Cushion is very flexible, whereas PUR is stiffer. Surrounding soil is
much stiffer than PUR. So, the line bedding constant ‘k2’ for Expansion Cushion is much
less than the line bedding constant ‘k1’ for PUR, which, in turn, is much less than the line
bedding constant ‘k3’ for the surrounding soil, where the line bedding constant is the same as
stiffness. In short, k2 << k1<<<k3.
The combined stiffness ‘k’ computed using Equation (22) will be less than the Expansion
Cushion stiffness, ‘k2’. Due to this low value of combined stiffness ‘k’, sometimes non-linear
iterative solution may not converge. In such case of non-convergence, re-perform the
analysis without including Expansion Cushion. If the solution still not converges, then reperform with just surrounding soil (i.e., without including stiffnesses of both PUR and
Expansion Cushion). In this case, the weight per unit length of insulation PUR shall be input
as “Additional weight” in CAEPIPE’s Loads dialog.
C.2 Flexibility factors for pipe components (see Annex C)

C.2.1 Bends
Flexibility Factor for bending
2
1.24 ∙ 𝑑𝑚
𝑘𝑏 =
≥1
4 ∙ 𝑡𝑛 ∙ 𝑅
2
2
1.24 ∙ 𝑑𝑚
1.65 ∙ 𝑑𝑚
≤ 𝑘𝑏 ≤
4 ∙ 𝑡𝑛 ∙ 𝑅
4 ∙ 𝑡𝑛 ∙ 𝑅
2
1.65 ∙ 𝑑𝑚
𝑘𝑏 =
4 ∙ 𝑡𝑛 ∙ 𝑅

Bend Radius
𝑅 ≤ 1.5 𝑑𝑜

Equation
(𝐶. 1)

1.5 𝑑𝑜 ≤ 𝑅 ≤ 2.5𝑑𝑜

(𝐶. 2)

𝑅 > 2.5𝑑𝑜

(𝐶. 3)

Intervening values are obtained by interpolation. The flexibility factor 𝑘𝑏 for bending is
reduced linearly for bend angles between 90° and 0. The flexibility factor for normal forces,
shear forces and torque equals 1.
For pipe bends, the internal pressure will counteract ovalization. This is considered by
dividing 𝑘𝑏 with
𝑝 𝑑𝑚 7/3 𝑑𝑚 −1/3
1+6 ( ) ( )
(𝐶. 4)
𝐸 2𝑡
2𝑅
For miter bends, the flexibility factors as given in ASME B31J (2017) are used, as they are
not provided in EN 13941-1 (2019).
2
𝑑𝑚
𝑘𝑏 = 1.52 (
)
4 ∙ 𝑡𝑛 ∙ 𝑅

5/6
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C.2.2 T-pieces
The flexibility factor for T pieces equals 1.
For 𝑑𝑏𝑜 ⁄𝑑𝑟𝑜 ≤ 0.8 the flexibility of the connection between the branch pipe and run pipe
may be taken into account by applying the following spring factor to the branch pipe at the
point where the axis of the branch intersects the outside of the run pipe.
For in-plane bending, 𝑀𝑏𝑦 ,
𝐸 ∙ 𝐼𝑏
𝑘𝑦 ∙ 𝑑𝑟𝑜
𝑑𝑟𝑜
𝑡𝑟 𝑑𝑏𝑜 0.5 𝑡𝑏
𝑘𝑦 = 0.2 ( ) ∙ ( ∙
) ∙
𝑡𝑟
𝑡𝑏 𝑑𝑟𝑜
𝑡𝑟
𝑐𝑦 =

(𝐶. 5)
(𝐶. 6)

For out-of-plane bending, 𝑀𝑏𝑧 ,
𝐸 ∙ 𝐼𝑏
𝑘𝑧 ∙ 𝑑𝑟𝑜
𝑑𝑟𝑜 1.5 𝑡𝑟 𝑑𝑏𝑜 0.5 𝑡𝑏
𝑘𝑧 = 0.1 ( ) ∙ ( ∙
) ∙
𝑡𝑟
𝑡𝑏 𝑑𝑟𝑜
𝑡𝑟
𝑐𝑧 =

(𝐶. 7)
(𝐶. 8)

Note: CAEPIPE automatically refines the elements connected to the node point with a
defined tee, by adding two (2) nodes on Run Pipe (one on either side of the Branch SIF
node) at a distance equal to Run Pipe OD and one (1) node on Branch Pipe at a distance
equal to Run pipe OD/2 from the Branch SIF node. Flexibility Factors for Branch Pipe (Leg
3), as stated above in equations (C.5) – (C-8), are applied to the branch pipe. For Equal
TEEs, the Run and Branch should be differentiated in the CAEPIPE model by
defining the Branch OD as slightly less than the Run OD through CAEPIPE
Sections input.
C.3 Stress concentration factors in pipe elements

Note: The stress concentration factors 𝒊𝒂𝟏 to 𝒊𝒂𝟓 and 𝒊𝒂𝒑 are either = 0 or >= 1 for all
types of stress evaluation. Stress concentration factors = 0, meaning “no contribution of the
term in computing stresses”.
C.3.2.1 Stress concentration factors for bends and miter bends: Simplified method
Table C.1 Stress concentration factors for bends
𝒊𝒂𝟏

𝑺𝒎

1

𝑺𝒓𝒆𝒔

1

𝒊𝒂𝟐

𝒊𝒂𝟑

0.9 ∙ (

2
𝑑𝑚
)
4𝑡𝑛 𝑅

2/3

2
𝑑𝑚
)
4𝑡𝑛 𝑅

2/3

0.9 ∙ (

𝒊𝒂𝟒

1

1

1

1

𝒊𝒂𝒑

𝒊𝒂𝟓

0

𝑅 − 0.25𝑑𝑖
𝑅 − 0.5𝑑𝑚
1.8 ∙ (

2
𝑑𝑚
)
4𝑡𝑛 𝑅

2/3

𝑅 − 0.25𝑑𝑖
𝑅 − 0.5𝑑𝑚

If the bracing effect of over pressure has been considered when calculating the flexibility of
the pipe bend,
𝒊𝒂𝟐 and 𝒊𝒂𝟓 shall be divided by f
289

EN13941-1:2019
𝑝 𝑑𝑚 5/2 𝑑𝑚 −2/3
𝑓 = 1 + 3.25 ( ) ( )
𝐸 2𝑡
2𝑅
With 𝒊𝒂𝟐 and 𝒊𝒂𝟓 valued at a minimum of 1.0 after the above division.

(𝐶. 9)

C.3.3 T-pieces
Table C.3 Stress concentration factors for membrane stresses in point B of T-pieces (all
types)
Membrane stresses
𝑺𝒎
Run pipe
Branch pipe

𝒊𝒂𝟏

𝒊𝒂𝟐

𝒊𝒂𝟑

𝒊𝒂𝟒

𝑟𝑟 ∙ 𝑘2
𝑟𝑏 ∙ 𝑘

𝑟𝑟 ∙ 𝑘1
𝑟𝑏 ∙ 𝑘

2𝑟𝑟 ∙ 𝑘1
𝑟𝑏 ∙ 𝑘

𝑟𝑟 ∙ 𝑘1
𝑟𝑏 ∙ 𝑘

Table C.4 – T-pieces: Stress concentration factors for resulting stresses in point B
Resulting stresses
𝑺𝒓𝒆𝒔
Directly welded T-piece
Run pipe
Branch pipe
Forged T-piece
Run pipe
Branch pipe
T-piece with drawn collar
Run pipe
Branch pipe

𝒊𝒂𝟏

𝒊𝒂𝟐

𝒊𝒂𝟑

CAEPIPE: Unreinforced fabricated Tee
1.2𝑘2
𝑘1
2𝑘1
𝑘
𝑘
𝑘
CAEPIPE: Welding Tee
0.7𝑘2
0.6𝑘1
1.2𝑘1
0.4𝑘
0.4𝑘
0.4𝑘
CAEPIPE: Extruded Tee
0.8𝑘2
0.7𝑘1
1.4𝑘1
0.7𝑘
0.7𝑘
0.7𝑘

1 1/3 1 2/3
𝑑𝑏𝑚 3/2
𝑘1 = 0.523 (
) ( ) 𝑑𝑏𝑚 + 2.5 (1 −
)
𝑑𝑟𝑚
𝑡𝑟
𝑑𝑟𝑚

𝒊𝒂𝟒

𝑘1
𝑘
0.6𝑘1
0.4𝑘
0.7𝑘1
0.7𝑘

(𝐶. 17)

1 5/6 1 2/3
𝑑𝑏𝑚 𝑡𝑏 9/5
3/2
𝑘2 = 0.65 (
) ( ) (𝑑𝑏𝑚 ) + 2.5 (1 −
)
𝑑𝑟𝑚
𝑡𝑟
𝑑𝑟𝑚 𝑡𝑟
𝑑𝑟𝑚 2/3
𝑘 = 0.567 (
)
𝑡𝑟
Reduction factors for membrane stresses:
𝑡𝑏
𝑑𝑏𝑚 5/3
𝑟𝑟 = 0.56
(2 −
)
𝑡𝑟
𝑑𝑟𝑚

(𝐶. 18)

𝑑𝑏𝑚
𝑟𝑏 = 0.83 √
𝑑𝑟𝑚

(𝐶. 19)
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Reducers
Reducers with defined radius of curvature r

𝑺𝒎
𝑺𝒓𝒆𝒔

Table C.6. Stress concentration factors for reducers
𝒊𝒂𝒑
𝒊𝒂𝟏
𝒊𝒂𝟐
𝒊𝒂𝟑
𝒊𝒂𝟒
𝒊𝒂𝟓
1
1
0
0
1
1/cos 
1
0
0
𝑘
𝑘
1/cos 

𝑑𝑜,𝑚𝑖𝑛
𝑘 = 0.5 + 0.01 ∙ 𝛼 √
𝑡1𝑛

(𝐶. 21)

𝛼 is inserted in degrees. The expression for k is only valid if the following requirements are
met:
the transitional part is concentric; 𝛼 ≤ 30𝑜 and 𝑑𝑜,𝑚𝑖𝑛 ⁄𝑡𝑙,𝑛 and 𝑑𝑜,𝑚𝑎𝑥 ⁄𝑡𝑛 are both smaller
than 100.
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Allowable Pressure

The allowable pressure for straight pipes is calculated from equation (6.1-1) or (6.1-3)
depending on the ratio between outer and inner diameters.
For 𝐷𝑜 /𝐷𝑖 ≤ 1.7
𝑃=

2𝑓𝑧𝑒
𝐷𝑜 − 𝑒

For 𝐷𝑜 /𝐷𝑖 > 1.7
𝑃 = 𝑓𝑧

(1 − 𝑎2 )
(1 + 𝑎2 )

where
𝑃 = allowable pressure
𝑓 = allowable stress at Design Temperature as input into CAEPIPE Material properties
𝑧 = joint factor (input as material property in CAEPIPE)
𝑒 = pipe wall thickness without allowances and tolerances
= nominal pipe thickness × (1 – mill tolerance/100 – corrosion allowance “c”)
(In the pipe section where higher nominal thickness is ordered in order to accommodate
either threading or grooving or erosion or any other thinning allowance, then such additional
thickness required for threading/grooving/erosion/thinning etc. should be included in
corrosion allowance “c” in CAEPIPE to compute allowable pressure for that pipe section.)
𝐷𝑜 = outer diameter
𝐷𝑖 = un-corroded inner diameter
2𝑒
𝑎 =1−𝐷
𝑜

For pipe bends
Clause 6.2.1 of the code explicitly states “These calculation rules take into account that upon
applying internal pressure to a pipe bend, higher stresses occur on the intrados of the bend
(and lower stresses on the extrados of the bend) than on a straight pipe with identical wall
thickness.”
So, for pipe bends the maximum allowable pressure is calculated using the equivalent pipe
wall thickness eequi

𝑒𝑒𝑞𝑢𝑖 =

𝑒
𝑡𝑓

where

𝑡𝑓 = [
𝑅

𝑅/𝐷𝑜 − 0.25
𝑅/𝐷𝑜 − 0.50

]

= radius of bend
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For closely spaced miter bends, the allowable pressure is calculated from equations (6.3.4-1)
and (6.3.4-2).
𝑃 = 𝑚𝑖𝑛 [

𝑓𝑧𝑒 2

𝑓𝑧𝑒(𝑅𝑠 − 𝑟)
] 𝑤𝑖𝑡ℎ 𝜃 ≤ 22.50
𝑟(𝑒 + 0.643 𝑡𝑎𝑛 𝜃 √𝑟𝑒) 𝑟(𝑅𝑠 − 𝑟/2)
,

For widely spaced miter bends, the allowable pressure is calculated from equations (6.3.4-1),
(6.3.4-2) and (6.3.5-1)
𝑃 = 𝑚𝑖𝑛 [

𝑓𝑧𝑒 2

𝑓𝑧𝑒(𝑅𝑠 − 𝑟)
] 𝑤𝑖𝑡ℎ 𝜃 ≤ 22.50
𝑟(𝑒 + 0.643 𝑡𝑎𝑛 𝜃 √𝑟𝑒) 𝑟(𝑅𝑠 − 𝑟/2)

𝑃=

,

𝑓𝑧𝑒 2
𝑟(𝑒 + 1.25 𝑡𝑎𝑛 𝜃 √𝑟𝑒)

𝑤𝑖𝑡ℎ 𝜃 > 22.50

where
𝑟 = mean radius of pipe = (𝐷𝑜 − e)/2
𝑅𝑆 = effective bend radius of the miter
θ = miter half angle
Sustained Stress

The primary stress (σ1) due to sustained loads (pressure, weight and other sustained
mechanical loads) is calculated from equation (12.3.2-2)
2

𝑖𝑄𝐴 𝑄𝑥𝐴 √(0.75𝑖𝑖 𝑀𝑖𝐴 )2 + (0.75𝑖𝑜 𝑀𝑜𝐴 )2
𝑖𝑡 𝑀𝑡𝐴 2
⌉ +[
𝜎1 = √⌈
+
] ≤ 𝑓𝑓
𝐴𝑐
𝑍𝑐
𝑍𝑐
where
2
𝑃𝑐 𝜋𝑑𝑖𝑐

QxA = max[|𝑄𝑥𝑆 |, |
2
𝑃𝑐 𝜋𝑑𝑖𝑐

4

4

+ 𝑄𝑥𝑆 |]

= internal pressure forces due to unrelieved axial expansion joints etc.

QxS = axial force from other sustained mechanical loads (such as pipe weight, fluid weight
etc.) [excluding that from pressure]
Pc = maximum of CAEPIPE input pressures [i.e., max(P1 through P10)]
dic = corroded inside diameter = do – (2.ec)
do = outside diameter
ec = corroded thickness = en – corrosion allowance
en = nominal pipe thickness
𝜋

2)
Ac = area of cross section of the corroded pipe = 4 (𝑑𝑜2 − 𝑑𝑖𝑐
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MiA = in-plane bending moment from the sustained mechanical loads [excluding that from
pressure]
MoA = out-of-plane bending moment from the sustained mechanical loads [excluding that
from pressure]
MtA = torsional moment from the sustained mechanical loads [excluding that from pressure]
iQA = stress intensification factor for axial forces for sustained mechanical loads = 1.0
ii = In-plane stress intensification factor from the Tables given at the end of this section
io = Out-of-plane stress intensification factor from the Tables given at the end of this section
it = stress intensification factor for torsional moments = 1.0
𝜋

4)
Zc = corroded section modulus for pipe = 32𝑑 (𝑑𝑜4 − 𝑑𝑖𝑐
;
𝑜

for branch connections/reduced outlets, as per Table H.3 of EN 13480-3:2017/A2:2020,
4

Zc = 𝑚𝑖𝑛 [𝑖

4

𝜋((𝑑𝑚,𝑏 +𝑒𝑛,𝑏 ) −(𝑑𝑚,𝑏 +𝑒𝑛,𝑏 −2𝑒𝑐,𝑏 ) ) 𝜋
32(𝑑𝑚,𝑏 +𝑒𝑛,𝑏 )

2

, 4 (𝑑𝑚,𝑏 + 𝑒𝑛,𝑏 ) 𝑒𝑐 ]

where i is taken as In-plane SIF ii
ff = min(f; fcr) = design stress for flexibility analysis at the maximum operating temperature
under consideration [i.e., max(T1 through T10)], where
f = min(Rp0.2t/1.5 ; Rm/2.4) at max(T1 through T10); f is input into CAEPIPE material
properties
fcr = design stress in creep range at max(T1 through T10); f cr is input into CAEPIPE material
properties
Rp0.2t = minimum 0.2% proof strength at max(T1 through T10)
Rm = Tensile Strength (= Tensile as shown in CAEPIPE material input)

Note: Starting Version 7.50 of CAEPIPE, the value of “ff” is no longer input in the material properties
table. Instead, the value of “f” which is calculated as min(Rp0.2t/1.5; Rm/2.4) is input for each
temperature.

If a stress model created using CAEPIPE version earlier than 7.50 is read into CAEPIPE Version 7.50
or later version, the material properties should be updated appropriately by the CAEPIPE User.
Sustained plus Occasional Stress

The primary stress (𝜎2 ) due to sustained and occasional loads is calculated from equation
(12.3.3-4) as the combined stress due to (a) sustained loads such as pressure, weight and
other sustained mechanical loads and (b) occasional loads such as earthquake or wind. Wind
and earthquake are not considered to act concurrently.

294

EN 13480-3:2017/A2:2020
2

𝑖𝑄𝐴 𝑄𝑥 √[0.75𝑖𝑖 (𝑀𝑖𝐴 + 𝑀𝑖𝐵 )]2 + [0.75𝑖𝑜 (𝑀𝑜𝐴 + 𝑀𝑜𝐵 )]2
𝑖𝑡 𝑀𝑡𝐴 + 𝑖𝑡 𝑀𝑡𝐵 2
⌉ +[
] ≤ 𝑘𝑓𝑓
𝜎2 = √⌈
+
𝐴𝑐
𝑍𝑐
𝑍𝑐

where
MiB = in-plane bending moment from occasional or exceptional loads
MoB = out-of-plane bending moment from occasional or exceptional loads
MtB = torsional moment from occasional or exceptional loads
For reversing loads (unsigned occasional load cases, e.g. earthquake)
2
𝑃𝑏 𝜋𝑑𝑖𝑐

Qx = max[|𝑄𝑥𝐴 | + |𝑄𝑥𝐵 |, |

4

+ 𝑄𝑥𝐴 | + |𝑄𝑥𝐵 |] as per equation (12.3.3-2)

Both signs of MiB and MoB are considered
For non-reversing loads (signed occasional load cases, e.g. wind)
2
𝑃𝑏 𝜋𝑑𝑖𝑐

Qx = max[|𝑄𝑥𝐴 |, |𝑄𝑥𝐴 + 𝑄𝑥𝐵 |, |
(12.3.3-3)

4

2
𝑃𝑏 𝜋𝑑𝑖𝑐

+ 𝑄𝑥𝐴 | , |

4

+ 𝑄𝑥𝐴 + 𝑄𝑥𝐵 |] as per equation

Pb = Peak pressure during occasional loading = Peak Pressure Factor x P c
Pc = maximum of CAEPIPE input pressures [i.e., max(P1 through P10)]
QxA = axial force due to sustained mechanical loads [excluding that from pressure]
QxB = axial force due to occasional loads [excluding that from pressure]
𝜋

2)
Ac = area of cross section of the corroded pipe = 4 (𝑑𝑜2 − 𝑑𝑖𝑐
𝜋

4)
Zc = corroded section modulus = 32𝑑 (𝑑𝑜4 − 𝑑𝑖𝑐
;
𝑜

for branch connections/reduced outlets, as per Table H.3 of EN 13480-3:2017/A2:2020,
4

Zc = 𝑚𝑖𝑛 [𝑖

4

𝜋((𝑑𝑚,𝑏 +𝑒𝑛,𝑏 ) −(𝑑𝑚,𝑏 +𝑒𝑛,𝑏 −2𝑒𝑐,𝑏 ) ) 𝜋
32(𝑑𝑚,𝑏 +𝑒𝑛,𝑏 )

2

, 4 (𝑑𝑚,𝑏 + 𝑒𝑛,𝑏 ) 𝑒𝑐 ]

where i is taken as In-plane SIF ii
ff = min(f; fcr) = design stress for flexibility analysis at the maximum operating temperature
under consideration [i.e., max(T1 through T10)], where
f = min(Rp0.2t/1.5 ; Rm/2.4) at max(T1 through T10); f is input into CAEPIPE material
properties
fcr = design stress in creep range at max(T1 through T10); f cr is input into CAEPIPE material
properties
Rp0.2t = minimum 0.2% proof strength at max(T1 through T10)
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Rm = Tensile Strength (= Tensile as shown in CAEPIPE material input)
𝑘=1.2 if the occasional load is acting less than 1% in any 24 hour operating period. In
CAEPIPE, the default value for 𝑘=1.2; user can change this default value through Layout
window > Options > Analysis > Code > EN13480.

Note: Starting Version 7.50 of CAEPIPE, the value of “ff” is no longer input in the material properties
table. Instead, the value of “f” which is calculated as min(Rp0.2t/1.5; Rm/2.4) is input for each
temperature.

If a stress model created using CAEPIPE version earlier than 7.50 is read into CAEPIPE Version 7.50
or later version, the material properties should be updated appropriately by the CAEPIPE User.
Expansion Stress

The secondary stress (𝜎3 ) due to thermal expansion is calculated from equation (12.3.4-3)
2

𝑖𝑄𝐶 𝑄𝑥𝐶 √(𝑖𝑖 𝑀𝑖𝐶 )2 + (𝑖𝑜 𝑀𝑜𝐶 )2
𝑖𝑡 𝑀𝑡𝐶 2
√
⌈
⌉
𝜎3 =
+
+[
] ≤ 𝑓𝑎
𝐴
𝑍
𝑍
where
𝑀𝑖𝐶 = in-plane moment range due to thermal expansion and alternating loads
𝑀𝑜𝐶 = out-of-plane moment range due to thermal expansion and alternating loads
𝑀𝑡𝐶 = torsional moment range due to thermal expansion and alternating loads
iQC = stress intensification factor for axial forces due to thermal expansion and alternating
loads = 1.0
QxC = range of axial force due to thermal expansion and alternating loads
en = nominal pipe thickness
do = outside diameter
di = inside diameter = do – 2 en
𝜋

A = un-corroded nominal area of cross-section = 4 (𝑑𝑜2 − 𝑑𝑖2 )
𝜋

Z = un-corroded section modulus for pipe = 32𝑑 (𝑑𝑜4 − 𝑑𝑖4 );
𝑜

for branch connections/reduced outlets, as per Table H.3 of EN 13480-3:2017/A2:2020,
4

Z = 𝑚𝑖𝑛 [𝑖

4

𝜋((𝑑𝑚,𝑏 +𝑒𝑛,𝑏 ) −(𝑑𝑚,𝑏 −𝑒𝑛,𝑏 ) ) 𝜋
32(𝑑𝑚,𝑏 +𝑒𝑛,𝑏 )

2

, 4 (𝑑𝑚,𝑏 + 𝑒𝑛,𝑏 ) 𝑒𝑛 ]

where i is taken as In-plane SIF ii
𝐸

𝑓𝑎 = 𝑈(1.25𝑓𝑐 + 0.25𝑓ℎ ) 𝐸ℎ as per equation (12.1.3-1)
𝑐

U = cyclic stress range reduction factor taken from Table 12.1.3-1
𝐸𝐶 = modulus of elasticity at the minimum metal temperature consistent with the loading
under consideration
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𝐸ℎ = modulus of elasticity at the maximum metal temperature consistent with the loading
under consideration
𝑓𝑐 = min(Rm/3; f), where f = min(Rp0.2t/1.5 ; Rm/2.4) at room temperature (Tref) as per
equation (12.1.3-2)
𝑓ℎ = basic allowable stress at maximum metal temperature consistent with the loading under
consideration = min(fc; f; fcr) as per equation (12.1.3-3), with fc determined at minimum
metal temperature consistent with the loading under consideration and f determined at
maximum metal temperature consistent with the loading under consideration.
fcr = design stress in creep range at max(T1 through T10); f cr is input into CAEPIPE material
properties
For example, for the thermal range (T1-T2), with T1 = 3000 C, T2 = 1000 C and Tref = 210C,
Ec is determined at T2 = 1000C and Eh is determined at T1 =3000C.
fc as per Equation (12.1.3-2) listed above is determined at Tref = 210C.
The value of fc used in calculating fh is determined at T2 = 1000C [= min(100, 300)]; the
value of f used in calculating fh is determined at T1 = 3000 C [= max(100, 300)] and the value
of fcr is taken at T1 = 3000C (if available)
If the above condition in equation (12.3.4-3) is not met, equation (12.3.4-2) as listed below
may be used.
𝜎4 = 𝜎1 + 𝜎3 ≤ 𝑓𝑓 + 𝑓𝑎
Additional Conditions for the Creep Range

For piping operating within the creep range, the stress, (𝜎5 ), due to sustained, thermal and
alternating loadings shall satisfy the equation (12.3.5-2) below.
2

𝑖𝑄𝐶 𝑄𝑥𝐶 √(0.75𝑖𝑖 𝑀𝑖𝐶 )2 + (0.75𝑖𝑜 𝑀𝑜𝐶 )2
𝑖𝑡 𝑀𝑡𝐶 2
√
] +[
𝜎5 = 𝜎1 + [
+
] ≤ 𝑓𝑐𝑟
3𝐴
3𝑍
3𝑍
where

f cr = design stress in creep range at max(T1 through T10); fcr is input into material
properties.
Stresses due to a single non-repeated Support Movement (settlement)

The stress (𝜎6 ) due to a single non-repeated support movement (settlement) is calculated
from equation (12.3.6-2)
2

𝑖𝑄𝐷 𝑄𝑥𝐷 √(𝑖𝑖 𝑀𝑖𝐷 )2 + (𝑖𝑜 𝑀𝑜𝐷 )2
𝑖𝑡 𝑀𝑡𝐷 2
⌉ +[
𝜎6 = √⌈
+
] ≤ 𝑓𝐷
𝐴
𝑍
𝑍
where
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𝑀𝑖𝐷 = in-plane moment due to non-repeated anchor/restraint movement
𝑀𝑜𝐷 = out-of-plane moment due to non-repeated anchor/restraint movement
𝑀𝑡𝐷 = torsional moment due to non-repeated anchor/restraint movement
iQD = stress intensification factor for axial forces due to non-repeated anchor/restraint
movement = 1.0
QxD = axial force due to non-repeated anchor/restraint movement
A and Z are the same as defined under Expansion Stress given above
𝑓𝐷 = allowable stress = min(2Rp0.2t; Rm)
Since only f and Rm are input into CAEPIPE, the above allowable stress criterion can be
rewritten as follows.
𝑓𝐷 = 3f, if [f < (Rm/2.4)]; otherwise
𝑓𝐷 = Rm ,if [f = (Rm/2.4)]
where
f = allowable stress @ Reference Temperature (Tref) entered in CAEPIPE.
Stresses on Buried Piping as per EN 13480-6 (2017)

The axial stress (𝑆𝐿 ) due to combined pressure and temperature change effects is calculated
from equation 1 of Clause 5.2.4 of EN 13480-6 (2017).
𝑆𝐿 = η𝑆𝑃 − Eα(∆ 𝑇 ) ≤ 0.9𝑆𝑦
where
𝑆𝑃 = circumferential stress due to maximum of CAEPIPE input pressures [i.e., max(P1
through P10)]
η= Poisson’s ratio
∆ 𝑇 = maximum temperature range
𝑆𝑦 = Yield Strength = 1.5 x f
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SIFs for Reducer and Welds are computed as per Table H.1 as given below.

See Notes given at the end of this Section
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SIFs for Flanges and Threaded Joints are computed as given below.
Sl.
No.
1
2
3
4
5
6
7
8

Designation

Flexibility
factor

Weld Neck Flange
Double Welded Slip on Flange
Single Welded Slip on Flange
Fillet Welded Flange
Socket Welded Flange
Lap Joint Flange
Threaded Flange
Threaded Joint

1
1
1
1
1
1
1
1

Stress
intensification
factor i
1.0
1.2
1.3
1.3
1.3
1.6
2.3
2.3

Note:
In-plane and out-of-plane SIF values are the same for Reducers, Welds, Flanges and
Threaded Joints (computed as per Table H.1 as well as the Table provided above).
CAEPIPE internally incorporates the SIF values and Flexibility factors as given by the above
three (3) Tables for any stress model.
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Allowable Pressure

The allowable pressure for straight pipes is calculated from equation 6.1-1 or 6.1-3
depending on the ratio between inner and outer diameter.
For 𝐷𝑜 /𝐷𝑖 ≤ 1.7
𝑃=

2𝑓𝑧𝑒
𝐷𝑜 − 𝑒

For 𝐷𝑜 /𝐷𝑖 > 1.7
𝑃 = 𝑓𝑧

(1 − 𝑎2 )
(1 + 𝑎2 )

where
𝑃 = allowable pressure
𝑓 = allowable stress
𝑧 = joint factor (input as material property in CAEPIPE)
𝑒 = nominal pipe thickness × (1 – mill tolerance %/100 – corrosion allowance)“c”
(Any additional thickness required for threading, grooving, erosion, corrosion, etc. should be
included in corrosion allowance in CAEPIPE)
𝐷𝑜 = outer diameter
𝐷𝑖 = inner diameter
2𝑒
𝑎 =1−𝐷
𝑜

For pipe bends the maximum allowable pressure is calculated using the equivalent pipe wall thickness

e𝑒𝑞𝑢𝑖−
𝑒𝑒𝑞𝑢𝑖 =

𝑒
𝑡𝑓

where
𝑅/𝐷−0.25

tf

= (

)

𝑅

= radius on bend

𝑅/𝐷−0.50

For closely spaced miter bends, the allowable pressure is calculated from equations 6.3.4-1
and 6.3.4-2.
𝑃 = 𝑚𝑖𝑛 [

𝑓𝑧𝑒 2

𝑓𝑧𝑒(𝑅𝑠 − 𝑟)
] 𝑤𝑖𝑡ℎ 𝜃 ≤ 22.5
𝑟(𝑒 + 0.643 𝑡𝑎𝑛 𝜃 √𝑟𝑒) 𝑟(𝑅𝑠 − 𝑟/2)
,
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For widely spaced miter bends, the allowable pressure is calculated from equations 6.3.4-1,
6.3.4-2 and 6.3.5-1
𝑃 = 𝑚𝑖𝑛 [

𝑓𝑧𝑒 2

𝑓𝑧𝑒(𝑅𝑠 − 𝑟)
] 𝑤𝑖𝑡ℎ 𝜃 ≤ 22.5
𝑟(𝑒 + 0.643 𝑡𝑎𝑛 𝜃 √𝑟𝑒) 𝑟(𝑅𝑠 − 𝑟/2)

𝑃=

,

𝑓𝑧𝑒 2
𝑟(𝑒 + 1.25 𝑡𝑎𝑛 𝜃 √𝑟𝑒)

𝑤𝑖𝑡ℎ𝜃 ≤ 22.5

where
𝑟 = mean radius of pipe = (𝐷 − t)/2
𝑅𝑆 = effective bend radius of the miter
θ = miter half angle
Sustained Stress

The stress (  1 ) due to sustained loads (pressure, weight and other sustained mechanical
loads) is calculated from Equation (12.3.2-1)

1 

PDo 0.75iM A

 ff
4en
Z

where
P = maximum of CAEPIPE input pressures [i.e., max(P1 through P10)]
Do = outside diameter
en = nominal pipe thickness

i  stress intensification factor; the product of 0.75ishall not be less than 1.0
M A  resulting bending moment due to sustained loads

Z = un-corroded section modulus; for reduced outlets / branch connections, effective
section modulus
ff = min(f; fcr) = design stress for flexibility analysis at the maximum operating temperature
under consideration [i.e., max(T1 through T10)], where
f = min(Rp0.2t/1.5 ; Rm/2.4)
fcr = design stress in creep range at max(T1 through T10)
Rp0.2t = minimum 0.2% proof strength at max(T1 through T10)
Rm = Tensile Strength (= Tensile as shown in CAEPIPE material input)
Note: Starting Version 7.50 of CAEPIPE, the value of “ff” is no longer input in the
material properties table. Instead, the value of “f” which is calculated as min(Rp0.2t/1.5;
Rm/2.4) is input for each temperature.
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If a stress model created using an earlier version of CAEPIPE is read into Version 7.50 of
CAEPIPE, then in the 7.50 model file, the material properties should be updated
appropriately.
Sustained plus Occasional Stress

The stress (𝜎2 ) due to sustained and occasional loads is calculated from equation (12.3.3-1)
as the sum of stress due to sustained loads such as due to pressure, weight and other
sustained mechanical loads and stress due to occasional loads such as earthquake or wind.
Wind and earthquake are not considered concurrently

2 

PDo 0.75iM A 0.75iM B


 kf f
4en
Z
Z

where
𝑀𝐵 = resultant bending moment due to occasional load
𝑘=1.2 if the occasional load is acting less than 1% in any 24 hour operating period. In
CAEPIPE 𝑘=1.2; user can change this input in Layout window > Options > Analysis >
Code > EN13480.
Expansion Stress

The stress (𝜎3 ) due to thermal expansion is calculated from equation (12.3.4-1)
𝜎3 =

𝑖𝑀𝐶
≤ 𝑓𝑎
𝑍

where
𝑀𝐶 = resultant moment due to thermal expansion and alternating loads
Z = un-corroded section modulus; for reduced outlets / branch connections, effective
section modulus

f a  U (1.25 f C  0.25 f h )

Eh
as per Equation (12.1.3 - 1)
Ec

U = cyclic stress range reduction factor taken from Table 12.1.3-1
𝐸𝐶 = modulus of elasticity at the minimum metal temperature consistent with the loading
under consideration
𝐸ℎ = modulus of elasticity at the maximum metal temperature consistent with the loading
under consideration
𝑓𝑐 = min(Rm/3; f), where f = min(Rp0.2t/1.5 ; Rm/2.4) at room temperature (Tref) as per
Equation (12.1.3-2)
𝑓ℎ = basic allowable stress at maximum metal temperature consistent with the loading under
consideration = min(fc; f; fcr) as per Equation 12.1.3-3, with fc determined at minimum
metal temperature consistent with the loading under consideration and f determined at
maximum metal temperature consistent with the loading under consideration.
For example, for the thermal range (T1-T2), with T1 = 3000 C, T2 = 1000 C and Tref =
210C,Ec is determined at T2 = 1000C and Eh is determined at T1 =3000C
fc as per Equation (12.1.3-2) listed above is determined at Tref = 210C, the value of fc
used in calculating fh is determined at T2 = 1000C the value of f used in calculating fh is
determined at T1 = 300 0C andthe value of fcr is taken at T1 = 3000C (if available)
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If the above condition in equation (12.3.4-1) is not met, equation (12.3.4-2) may be used.
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Additional Conditions for the Creep Range

For piping operating within the creep range, the stress, (𝜎3 ), due to sustained, thermal and
alternating loadings shall satisfy the equation (12.3.5-1) below.
𝜎5 =
where

𝑃 𝐷𝑜 0.75𝑖𝑀𝐴 0.75𝑖𝑀𝐶
+
+
≤ 𝑓𝑐𝑟
4𝑒
𝑍
3𝑍

f cr = design stress in creep range at max(T1 through T10)
Stresses due to single non-repeated Support Movement (settlement)

The stress (𝜎6 ) due to a single non-repeated support movement (settlement) is calculated
from equation (12.3.6-1)
𝜎6 =
where

𝑖𝑀𝐷
≤ 𝜎6𝑎
3𝑍

𝑀𝐷 = resultant moment from a single non-repeated anchor movement (settlement)
𝜎6𝑎 = allowable stress = min(2Rp0.2t; Rm)
Since only f and Rm are input into CAEPIPE, the above allowable stress criterion can be
rewritten as follows.
𝜎6𝑎 = 3f, if [f < (Rm/2.4)]; otherwise
𝜎6𝑎 = Rm ,if [f = (Rm/2.4)]
where
f = allowable stress @ Reference Temperature (Tref) entered in CAEPIPE.
Stresses on Buried Piping as per EN 13480-6 (2017)

The axial stress (𝑆𝐿 ) due to combined pressure and temperature change effects is calculated
from equation 1 of Clause 5.2.4 of EN 13480-6 (2017).
𝑆𝐿 = η𝑆𝑃 − Eα(∆ 𝑇 ) ≤ 0.9𝑆𝑦
where
𝑆𝑃 = circumferential stress due to maximum of CAEPIPE input pressures [i.e., max(P1
through P10)]
η= Poisson’s ratio
∆ 𝑇 = maximum temperature range
𝑆𝑦 = Yield Strength = 1.5 x f
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SIFs for Reducer and Weldsare computed as per Table H.1 as given below.
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SIFs for Flanges and Threaded Joints are computed as given below.
Sl.
No.
1
2
3
4
5
6
7
8

Designation

Flexibility
factor

Weld Neck Flange
Double Welded Slip on Flange
Single Welded Slip on Flange
Fillet Welded Flange
Socket Welded Flange
Lap Joint Flange
Threaded Flange
Threaded Joint

1
1
1
1
1
1
1
1

Stress
intensification
factor i
1.0
1.2
1.3
1.3
1.3
1.6
2.3
2.3

Note:
In-plane and out-of-plane SIF values are the same for Reducers, Welds, Flanges and
Threaded Joints (computed as per Table H.1 as well as the Table provided above).
CAEPIPE internally incorporates the SIF values and Flexibility factors as given by the above
three (3) Tables in any stress model.
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[Superseded by SS EN 13480-3:2017]

Allowable Pressure

The allowable pressure for straight pipes is calculated from equation 6.1-1 or 6.1-3
depending on the ratio between inner and outer diameter.
For 𝐷𝑜 /𝐷𝑖 ≤ 1.7
𝑃=

2𝑓𝑧𝑒
𝐷𝑜 − 𝑒

For 𝐷𝑜 /𝐷𝑖 > 1.7
𝑃 = 𝑓𝑧

(1 − 𝑎2 )
(1 + 𝑎2 )

where
𝑃 = allowable pressure
𝑓 = allowable stress
𝑧 = joint factor (input as material property in CAEPIPE)
𝑒 = nominal pipe thickness × (1 – mill tolerance %/100 – corrosion allowance)“c”
(Any additional thickness required for threading, grooving, erosion, corrosion, etc. should be
included in corrosion allowance in CAEPIPE)
𝐷𝑜 = outer diameter
𝐷𝑖 = inner diameter
2𝑒
𝑎 =1−𝐷
𝑜

For pipe bends the maximum allowable pressure is calculated using the equivalent pipe wall thickness

e𝑒𝑞𝑢𝑖−
𝑒𝑒𝑞𝑢𝑖 =

𝑒
𝑡𝑓

where
𝑅/𝐷−0.25

tf

= (

)

𝑅

= radius on bend

𝑅/𝐷−0.50

For closely spaced miter bends, the allowable pressure is calculated from equations 6.3.4-1
and 6.3.4-2.
𝑃 = 𝑚𝑖𝑛 [

𝑓𝑧𝑒 2

𝑓𝑧𝑒(𝑅𝑠 − 𝑟)
] 𝑤𝑖𝑡ℎ 𝜃 ≤ 22.5
𝑟(𝑒 + 0.643 𝑡𝑎𝑛 𝜃 √𝑟𝑒) 𝑟(𝑅𝑠 − 𝑟/2)
,
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For widely spaced miter bends, the allowable pressure is calculated from equations 6.3.4-1,
6.3.4-2 and 6.3.5-1
𝑃 = 𝑚𝑖𝑛 [

𝑓𝑧𝑒 2

𝑓𝑧𝑒(𝑅𝑠 − 𝑟)
] 𝑤𝑖𝑡ℎ 𝜃 ≤ 22.5
𝑟(𝑒 + 0.643 𝑡𝑎𝑛 𝜃 √𝑟𝑒) 𝑟(𝑅𝑠 − 𝑟/2)

𝑃=

,

𝑓𝑧𝑒 2
𝑟(𝑒 + 1.25 𝑡𝑎𝑛 𝜃 √𝑟𝑒)

𝑤𝑖𝑡ℎ𝜃 ≤ 22.5

where
𝑟 = mean radius of pipe = (𝐷 − t)/2
𝑅𝑆 = effective bend radius of the miter
θ = miter half angle
Sustained Stress

The stress (  1 ) due to sustained loads (pressure, weight and other sustained mechanical
loads) is calculated from Equation (12.3.2-1)

1 

PDo 0.75iM A

 ff
4en
Z

where
P = maximum of CAEPIPE input pressures [i.e., max(P1 through P10)]
Do = outside diameter
en = nominal pipe thickness

i  stress intensification factor; the product of 0.75ishall not be less than 1.0
M A  resulting bending moment due to sustained loads

Z = un-corroded section modulus; for reduced outlets / branch connections, effective
section modulus
ff = min(f; fcr) = design stress for flexibility analysis at the maximum operating temperature
under consideration [i.e., max(T1 through T10)], where
f = min(Rp0.2t/1.5 ; Rm/2.4)
fcr = design stress in creep range at max(T1 through T10)
Rp0.2t = minimum 0.2% proof strength at max(T1 through T10)
Rm = Tensile Strength (= Tensile as shown in CAEPIPE material input)
Note: Starting Version 7.50 of CAEPIPE, the value of “ff” is no longer input in the
material properties table. Instead, the value of “f” which is calculated as min(Rp0.2t/1.5;
Rm/2.4) is input for each temperature.
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If a stress model created using an earlier version of CAEPIPE is read into Version 7.50 of
CAEPIPE, then in the 7.50 model file, the material properties should be updated
appropriately.
Sustained plus Occasional Stress

The stress (𝜎2 ) due to sustained and occasional loads is calculated from equation (12.3.3-1)
as the sum of stress due to sustained loads such as due to pressure, weight and other
sustained mechanical loads and stress due to occasional loads such as earthquake or wind.
Wind and earthquake are not considered concurrently
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where
𝑀𝐵 = resultant bending moment due to occasional load
𝑘=1.2 if the occasional load is acting less than 1% in any 24 hour operating period. In
CAEPIPE𝑘=1.2; user can change this input in Layout window> Options > Analysis > Code
>EN13480.
Expansion Stress

The stress (𝜎3 ) due to thermal expansion is calculated from equation (12.3.4-1)
𝜎3 =

𝑖𝑀𝐶
≤ 𝑓𝑎
𝑍

where
𝑀𝐶 = resultant moment due to thermal expansion and alternating loads
Z = un-corroded section modulus; for reduced outlets / branch connections, effective
section modulus

f a  U (1.25 f C  0.25 f h )

Eh
as per Equation (12.1.3 - 1)
Ec

U = cyclic stress range reduction factor taken from Table 12.1.3-1
𝐸𝐶 = modulus of elasticity at the minimum metal temperature consistent with the loading
under consideration
𝐸ℎ = modulus of elasticity at the maximum metal temperature consistent with the loading
under consideration
𝑓𝑐 = min(Rm/3; f), where f = min(Rp0.2t/1.5 ; Rm/2.4) at room temperature (Tref) as per
Equation (12.1.3-2)
𝑓ℎ = basic allowable stress at maximum metal temperature consistent with the loading under
consideration = min(fc; f; fcr) as per Equation 12.1.3-3, with fc determined at minimum
metal temperature consistent with the loading under consideration and f determined at
maximum metal temperature consistent with the loading under consideration.
For example, for the thermal range (T1-T2), with T1 = 3000 C, T2 = 1000 C and Tref =
210C,Ec is determined at T2 = 1000C and Eh is determined at T1 =3000C
fc as per Equation (12.1.3-2) listed above is determined at Tref = 210C, the value of fc
used in calculating fh is determined at T2 = 1000C the value of f used in calculating fh is
determined at T1 = 300 0C andthe value of fcr is taken at T1 = 3000C (if available)
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If the above condition in equation (12.3.4-1) is not met, equation (12.3.4-2) may be used.
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Additional Conditions for the Creep Range

For piping operating within the creep range, the stress, (𝜎3 ), due to sustained, thermal and
alternating loadings shall satisfy the equation (12.3.5-1) below.
𝜎5 =
where

𝑃 𝐷𝑜 0.75𝑖𝑀𝐴 0.75𝑖𝑀𝐶
+
+
≤ 𝑓𝑐𝑟
4𝑒
𝑍
3𝑍

f cr = design stress in creep range at max(T1 through T10)
Stresses due to single non-repeated Support Movement (settlement)

Settlement evaluation as per Equation (12.3.6-1) of EN 13480-3 (2012) is not yet
implemented in CAEPIPE.
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Norwegian (1983)
Allowable Pressure

The allowable pressure for straight pipes and bends is calculated from Equation 6.3.
𝑝=

where
𝑝 =
𝑓 =
𝑧𝐿 =
𝑇𝑒𝑓𝑓 =
𝐷 =
𝑑 =
𝑚 =
=
=

2𝑓𝑧𝐿 𝑇𝑒𝑓𝑓
𝐷𝑚 − 𝑇𝑒𝑓𝑓

allowable pressure
allowable stress
joint efficiency of longitudinal weld (input as material property)
nominal pipe thickness × (1 – mill tolerance/100) – corrosion allowance
outside diameter
inside diameter
pressure coefficient
1.0 for 𝐷/d<1.6
0.25(𝐷/d)+0.6 for 1.6 ≤ 𝐷/d≤2.0

Sustained Stress

Stress (𝑆𝐿 ) due to sustained loads (pressure, weight and other sustained mechanical loads) is
calculated from Equation 9.32.
𝑆𝐿 =

where
𝑝 =
𝑧𝐶 =
𝑘1 =
𝑀𝐴 =
𝑊 =
𝑓2 =

𝑝𝐷
0.75𝑘1 𝑀𝐴
+
≤ 𝑓2
4𝑇𝑒𝑓𝑓 𝑧𝐶
𝑊

maximum pressure
joint efficiency of circumferential weld (input as material property)
stress intensification factor. The product 0.75𝑘1 shall not be less than 1.0
resultant bending moment due to sustained loads
section modulus, for reduced outlets, effective section modulus
hot allowable stress

Occasional Stress

The stress (𝑆𝐿𝑂 ) is calculated as the sum of the stress due to sustained loads (𝑆𝐿 ) and the
stress (𝑆𝑂 ) due to occasional loads such as earthquake or wind from Equation 9.33. Wind
and earthquake are not considered concurrently.
𝑆𝐿𝑂 =

𝑝𝐷
0.75𝑘1 (𝑀𝐴 + 𝑀𝐵 )
+
≤ 1.2𝑓2
4𝑇𝑒𝑓𝑓 𝑧𝐶
𝑊

where
𝑀𝐵 = resultant bending moment due to occasional loads
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Expansion Stress

The stress (𝑆𝐸 ) due to thermal expansion is calculated from Equation 9.34.
𝑆𝐸 =

𝑘1 𝑀𝐶
≤ 𝑆𝑟
𝑊

Alternatively, Equation 9.35 may be used.
𝑆𝐿 + 𝑆𝐸 ≤ 𝑓2 + 𝑆𝑟

where
𝑀𝐶 = resultant bending moment due to thermal expansion.
𝑆𝑟 = 𝑓𝑟 (1.17𝑅1 + 0.17𝑅2 )
𝑓𝑟 = stress range reduction factor taken from Table 9.1.
𝑅1 = smaller of 𝑓1 and 0.267𝑅m
𝑅2 = smaller of 𝑓2 and 0.367𝑅m
𝑓1 = allowable stress at cold condition
𝑓2 = allowable stress at hot condition
𝑅m = tensile strength at room temperature
At moderate temperatures (up to 370º C) for carbon steel, low alloy steel and chromium steel
(specified as CS material type) and up to 425º C for austenitic stainless steel (specified as AS
material type), the limits 0.267𝑅m and 0.367𝑅m are disregarded and𝑆𝑟 is selected as smaller
of 𝑆𝑟′ and 𝑆𝑟′′ ,
where
𝑆𝑟′ = 1.17𝑓1 + 0.20𝑓2
𝑆𝑟′′ = 290𝑓r − 𝑓2
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Norwegian (1990)
Allowable Pressure

The allowable pressure for straight pipes and bends is calculated from Equation 6.3.
𝑝=

where
𝑝 =
𝑓 =
𝑧𝐿 =
𝑇𝑒𝑓𝑓 =
𝐷 =
𝑑 =
𝑚 =
=
=

2𝑓𝑧𝐿 𝑇𝑒𝑓𝑓
𝐷𝑚 − 𝑇𝑒𝑓𝑓

allowable pressure
allowable stress
joint efficiency of longitudinal weld (input as material property)
nominal pipe thickness × (1 – mill tolerance/100) – corrosion allowance
outside diameter
inside diameter
pressure coefficient
1.0 for 𝐷/d<1.6
0.25(𝐷/d)+0.6 for 1.6 ≤ 𝐷/d≤2.0

Sustained Stress

Stress (𝑆𝐿 ) due to sustained loads (pressure, weight and other sustained mechanical loads) is
calculated from Equation 10.7.
𝑆𝐿 =

where
𝑝 =
𝑧𝐶 =
𝑘1 =
𝑀𝐴 =
𝑊 =
𝑓2 =

𝑝𝐷
0.75𝑘1 𝑀𝐴
+
≤ 𝑓2
4𝑇𝑒𝑓𝑓 𝑧𝐶
𝑊

maximum pressure
joint efficiency of circumferential weld (input as material property)
stress intensification factor. The product 0.75𝑘1 shall not be less than 1.0
resultant bending moment due to sustained loads
section modulus, for reduced outlets, effective section modulus
hot allowable stress

Occasional Stress

The stress (𝑆𝐿𝑂 ) is calculated as the sum of the stress due to sustained loads (𝑆𝐿 ) and the
stress (𝑆𝑂 ) due to occasional loads such as earthquake or wind from Equation 10.8. Wind
and earthquake are not considered concurrently.
𝑆𝐿𝑂 =

𝑝𝐷
0.75𝑘1 (𝑀𝐴 + 𝑀𝐵 )
+
≤ 1.2𝑓2
4𝑇𝑒𝑓𝑓 𝑧𝐶
𝑊

where
𝑀𝐵 = resultant bending moment due to occasional loads
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Expansion Stress

The stress (𝑆E ) due to thermal expansion is calculated from Equation 10.9.
𝑆𝐸 =

𝑘1 𝑀𝐶
≤ 𝑆𝑟
𝑊

Alternatively, Equation 10.10 may be used.
𝑆𝐿 + 𝑆𝐸 ≤ 𝑓2 + 𝑆𝑟

where
𝑀𝐶 =
𝑆𝑟 =
𝑆𝑟′ =
𝑆𝑟′′ =
𝑓𝑟 =
𝑓1 =
𝑓2 =
𝑅𝑠 =

resultant bending moment due to thermal expansion.
smaller of 𝑆𝑟′ and 𝑆𝑟′′
1.25𝑓1 + 0.25𝑓2
𝑓𝑟 𝑅𝑠 − 𝑓2
stress range reduction factor
allowable stress at cold condition
allowable stress at hot condition
permissible extent of stress for 7000 load cycles for different materials
𝑅𝑠 is determined by material type as follows:
Material
Carbon and low alloy steel
Austenitic stainless steel
Copper alloys, annealed
Copper alloys, cold worked
Aluminum
Titanium

Type
CS
AS
CA
CC
AL
TI

RS
290
400
150
100
130
200

The stress range reduction factor 𝑓𝑟 depends on the number of thermal cycles (NE). For
moderate high temperatures (≤ 370º C for carbon, low alloy and chromium steel and ≤ 425º
C for austenitic stainless steel), 𝑓𝑟 is calculated from
𝑓𝑟 = (7000/𝑁𝐸 )0.2 𝑁𝐸 > 100 (𝑖. 𝑒. , 𝑓𝑟 ≤ 2.34)

At higher temperatures, 𝑆𝑟 shall not be greater than 𝑓𝑟 (1.25𝑅1 + 0.25𝑅2 ) and 𝑓𝑟 shall not
be greater than 1.0.
where
𝑅1 = smaller of 𝑓1 and 0.25𝑅𝑚
𝑅2 = smaller of 𝑓2 and 0.25𝑅𝑚
𝑅𝑚 = tensile strength at room temperature
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RCC-M (1985)
Allowable Pressure

The allowable pressure for straight pipes and bends is calculated from Equation 2 of C
3641.1.
𝑃=

where
𝑃 =
𝑆 =
𝐸 =
𝑡𝑚 =
=
𝑡 =
𝐷 =
𝑑 =
𝑌 =
=
=

2𝑆𝐸𝑡𝑚
𝐷 − 2𝑌𝑡𝑚

allowable pressure
allowable stress
joint factor (input as material property)
minimum required thickness, including mechanical and corrosion allowance
𝑡 ×(1 – mill tolerance/100) – corrosion allowance
nominal pipe thickness
outside diameter
inside diameter
pressure coefficient
0.4 for 𝑡 < 𝐷/6
𝑑/(𝐷 + 𝑑 ) for 𝑡 ≥ 𝐷/6

Sustained Stress

The stress (𝑆𝐿 ) due to sustained loads (pressure, weight and other sustained mechanical
loads) is calculated from Equation 6 of C 3652.
𝑆𝐿 =

where
𝑃 =
𝐷 =
𝑡 =
𝑖 =
𝑀𝐴 =
𝑍 =
𝑆ℎ =

𝑃𝐷 0.75𝑖𝑀𝐴
+
≤ 𝑆ℎ
4𝑡
𝑍

maximum pressure
outside diameter
nominal wall thickness
stress intensification factor. The product 0.75𝑖, shall not be less than 1.0
resultant bending moment due to sustained loads = √𝑀𝑋2 + 𝑀𝑌2 + 𝑀𝑍2
section modulus, for reduced outlets, effective section modulus
hot allowable stress

Occasional Stress

The stress (𝑆𝐿𝑂 ) is calculated as the sum of stress due to sustained loads (𝑆𝐿 ) and stress due
to occasional loads (𝑆𝑂 ), such as earthquake or wind from Equation 10 of C 3654. Wind and
earthquake are not considered concurrently.
𝑆𝐿𝑂 = 𝑆𝐿 +

0.75𝑖𝑀𝐵
≤ 1.2𝑆ℎ
𝑍

where
𝑀𝐵 = resultant moment due to occasional loads
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Expansion Stress

The stress (SE) due to thermal expansion is calculated from Equation 7 of C 3653.2.
𝑆𝐸 =

𝑖𝑀𝐶
≤ 𝑆𝐴
𝑍

where
𝑀𝐶 = resultant moment due to thermal expansion
𝑆𝐴 = 𝑓 (1.25𝑆𝑐 + 0.25𝑆ℎ )
𝑆𝑐 = allowable stress at cold temperature
𝑓 = stress range reduction factor from Table C 3653.3
The stress due to pressure, weight, other sustained loads and thermal expansion is calculated
from Equation 8 of C 3653.2.
𝑆𝑇𝐸 = 𝑆𝐿 + 𝑆𝐸 ≤ 𝑆ℎ + 𝑆𝐴
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CODETI (2013)
Allowable Pressure

For straight pipes and bends, the allowable pressure is calculated using Eq. (C2.2.2-2) for
straight pipes and Eq. (C2.3.2-1) for bends from paras. C2.2.2. and C2.3.2.respectively
𝑃=

2𝑓𝑧𝑒
𝐷−𝑒

where
𝑃
𝑓
𝑧
e

=
=
=
=

allowable pressure
allowable stress
joint factor (input as material property in CAEPIPE)
nominal pipe thickness× (1 – mill tolerance/100) – corrosion allowance “c”

(Any additional thickness required for threading, grooving, erosion, corrosion, etc. shouldbe
included in corrosion allowance in CAEPIPE)
𝐷 = outside diameter
For pipe bends the maximum allowable pressure is calculated using the equivalent pipe wall
thickness 𝑒𝑒𝑞𝑢𝑖

𝑒𝑒𝑞𝑢𝑖 =

𝑒
𝑡𝑓

where

𝑡𝑓 = [

𝑅/𝐷𝑜 − 0.25
𝑅/𝐷𝑜 − 0.50

]

For closely spaced miter bends, the allowable pressure is calculated from
2𝑓𝑧𝑒
𝑒
2𝑓𝑧𝑒 𝑅 − 0.5𝐷𝑚
𝑃 = min [(
.
),(
.
)] with 𝜃 ≤ 22.5
𝐷𝑚 𝑒 + 0.643 tan 𝜃√0.5𝐷𝑚 𝑒
𝐷𝑚 𝑅 − 0.25𝐷𝑚

For widely spaced miter bends, the allowable pressure is calculated from
2𝑓𝑧𝑒
𝑒
2𝑓𝑧𝑒 𝑅 − 0.5𝐷𝑚
𝑃 = min [(
.
),(
.
)] with 𝜃 ≤ 22.5
𝐷𝑚 𝑒 + 0.643 tan 𝜃√0.5𝐷𝑚 𝑒
𝐷𝑚 𝑅 − 0.25𝐷𝑚

𝑃=(

2𝑓𝑧𝑒
𝐷𝑚

.

𝑒
𝑒 + 1.25 tan 𝜃√0.5𝐷𝑚 𝑒

where
𝐷𝑚 = mean diameter of pipe = D-tn
𝑅 = effective bend radius of the miter
𝜃 = miter half angle
𝑡𝑛 = nominal thickness
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Sustained Stress

The stress (𝜎1 ) due to sustained loads (pressure, weight and other sustained mechanical
loads) is calculated using Eq. (C10.3.2) from para. C10.3.2.
𝜎1 =

𝑃𝐷𝑜 0.75𝑖𝑀𝐴
+
≤ 𝑓ℎ
4𝑒
𝑍

Where
maximum of CAEPIPE input pressures P1 through P10
outside diameter
nominal pipe thickness x [1 - mill tolerance%/100] - corrosion allowance “c”
stress intensification factor from Table C10.2.6-1; the product of 0.75i shall not be
less than 1.0
𝑀𝐴 = resulting bending moment due to sustained loads
𝑍 = un-corroded section modulus; for reduced outlets / branch connections, effective
section modulus
𝑓ℎ = hot allowable stress
𝑃
𝐷𝑜
𝑒
𝑖

=
=
=
=

Sustained plus Occasional Stress

The stress (𝜎2 ) due to sustained and occasional loads is calculated as the sum of stress due
to sustained loads such as due to pressure, weight and other sustained mechanical loads and
stress due to occasional loads such as earthquake or wind. Wind and earthquake are not
considered concurrently (see para. C10.3.3)
𝑃𝐷𝑜 0.75𝑖𝑀𝐴 0.75𝑖𝑀𝐵
𝜎2 =
+
+
≤ 𝑘𝑓ℎ
4𝑒
𝑍
𝑍
where,
𝑃
𝐷𝑜
𝑀𝐵
𝑘
𝑒

=
=
=
=

maximum of CAEPIPE input pressures P1 through P10
outside diameter
resultant bending moment due to occasional load
1.2 if the occasional load is acting less than 1% in any 24 hour operating period. In
CAEPIPE k =1.2 is used for occasional loading.
= nominal pipe thickness x [1 - mill tolerance%/100] - corrosion allowance “c”

Expansion Stress

The stress (𝜎3 ) due to thermal expansion is calculated from Eq. C10.3.4-1from para.
C10.3.4.
𝜎3 =
where,

𝑖𝑀𝐶
+≤ 𝑓𝑎
𝑍

𝑀𝐶 = range of resultant moments due to displacement cycle between two thermal states
inclusive of thermal anchor movements
346

CODETI (2013)
𝑍
𝑓𝑎
𝑖
𝑈

= un-corroded section modulus; for reduced outlets / branch connections, effective
section modulus
𝐸
= 𝑈(1.25𝑓𝐶 + 0.25𝑓ℎ ) ℎ Eq. (C10.2.4.2-1) of para. C10.2.4.2.
𝐸𝑐

= stress intensification factor from Table C10.2.6-1; the product of 0.75i shall not be
less than 1.0
= cyclic stress range reduction factor from Table C10.2.4.3 and are mentioned below.
Number of cycle
𝑓𝑎 <= 7000
7001 to 140000
14001 to 220000
22001 to 0.7
45001 to 100000
100001 to 2000000

𝑓𝐶
𝑓ℎ
𝐸𝐶
𝐸ℎ

Stress range reduction factor 𝑈
1.0
0.9
0.8
0.7
0.6
0.5

= basic allowable stress as minimum metal temperature expected during the
displacement cycle under analysis
= basic allowable stress as maximum metal temperature expected during the
displacement cycle under analysis
= elastic modulus at cold temperature
= elastic modulus at hot temperature

Sustained + Expansion Stress

The stress due to pressure, weight, other sustained loads and thermal expansion is calculated
from Equation C10.3.4-2 of para. C10.3.4.
𝜎4 =
where,
𝑃 =
𝐷𝑜 =
𝑒 =
𝑀𝐴 =
𝑀𝐶 =
𝑍
𝑖
𝑓𝑎
𝑓𝐶
𝑓ℎ
𝐸𝐶

𝑃𝐷𝑜 0.75𝑖𝑀𝐴 𝑖𝑀𝐶
+
+
≤ 𝑓𝐻 + 𝑓𝑎
4𝑒
𝑍
𝑍

maximum of CAEPIPE input pressures P1 through P10
outside diameter
nominal pipe thickness x [1 - mill tolerance%/100] - corrosion allowance “c”
resulting bending moment due to sustained loads
range of resultant moments due to displacement cycle between two thermal states
inclusive of thermal anchor movements
= un-corroded section modulus; for reduced outlets / branch connections, effective
section modulus
= stress intensification factor from Table C10.2.6-1; the product of 0.75i shall not be
less than 1.0
𝐸
= 𝑈(1.25𝑓𝐶 + 0.25𝑓ℎ ) 𝐸ℎ Eq. (C10.2.4.2-1) of para. C10.2.4.2.
𝑐

= basic allowable stress as minimum metal temperature expected during the
displacement cycle under analysis
= basic allowable stress as maximum metal temperature expected during the
displacement cycle under analysis
= elastic modulus at cold temperature
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𝐸ℎ = elastic modulus at hot temperature
𝑓𝐻 = allowable stress at Maximum of CAEPIPE input temperatures T1 through T10
Additional Conditions for the Creep Range

For piping operating within the creep range, the stress, (𝜎5 ), due to sustained, thermal and
alternating loadings shall satisfy the Eq. C10.3.4-3 of para. C10.3.4.
𝜎5 =

𝑃𝐷𝑜 0.75𝑖𝑀𝐴 0.75𝑖𝑀𝐶
+
+
≤ 𝑓𝑐𝑟
4𝑒
𝑍
3𝑍

where,
𝑃
𝐷𝑜
𝑒
𝑀𝐴
𝑀𝐶
𝑍
𝑖
𝑓𝑐𝑟

=
=
=
=
=

maximum of CAEPIPE input pressures P1 through P10
outside diameter
nominal pipe thickness x [1 - mill tolerance%/100] - corrosion allowance “c”
resulting bending moment due to sustained loads
range of resultant moments due to displacement cycle between two thermal states
inclusive of thermal anchor movements
= un-corroded section modulus; for reduced outlets / branch connections, effective
section modulus
= stress intensification factor from Table C10.2.6-1; the product of 0.75i shall not be
less than 1.0
= allowable creep stress value
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CODETI (2006)
[Superseded by CODETI (2013)]

Allowable Pressure

The allowable pressure for straight pipes and bends is calculated from
𝑃=

2𝑓𝑧𝑒
𝐷−𝑒

where
𝑃
𝑓
𝑧
e

=
=
=
=

allowable pressure
allowable stress
joint factor (input as material property in CAEPIPE)
nominal pipe thickness× (1 – mill tolerance/100) – corrosion allowance “c”

(Any additional thickness required for threading, grooving, erosion, corrosion, etc. shouldbe
included in corrosion allowance in CAEPIPE)
𝐷=outside diameter
For pipe bends the maximum allowable pressure is calculated using the equivalent pipe wall
thickness𝑒𝑒𝑞𝑢𝑖

𝑒𝑒𝑞𝑢𝑖 =

𝑒
𝑡𝑓

Where

𝑡𝑓 = [

𝑅/𝐷 − 0.25
𝑅/𝐷 − 0.50

]

For closely spaced miter bends, the allowable pressure is calculated from
2𝑓𝑧𝑒
𝑒
2𝑓𝑧𝑒 𝑅 − 0.5𝐷𝑚
𝑃 = min [(
.
),(
.
)] with 𝜃 ≤ 22.5
𝐷𝑚 𝑒 + 0.643 tan 𝜃√0.5𝐷𝑚 𝑒
𝐷𝑚 𝑅 − 0.25𝐷𝑚

For widely spaced miter bends, the allowable pressure is calculated from
2𝑓𝑧𝑒
𝑒
2𝑓𝑧𝑒 𝑅 − 0.5𝐷𝑚
𝑃 = min [(
.
),(
.
)] with 𝜃 ≤ 22.5
𝐷𝑚 𝑒 + 0.643 tan 𝜃√0.5𝐷𝑚 𝑒
𝐷𝑚 𝑅 − 0.25𝐷𝑚

𝑃=(

2𝑓𝑧𝑒
𝐷𝑚

.

𝑒
𝑒 + 1.25 tan 𝜃√0.5𝐷𝑚 𝑒

Where
𝐷𝑚 = mean diameter of pipe = D-tn
𝑅 = effective bend radius of the miter
𝜃 = miter half angle
𝑡𝑛 = nominal thickness
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Sustained Stress

The stress (𝜎1 ) due to sustained loads (pressure, weight and other sustained mechanical
loads) iscalculated from
𝜎1 =

𝑃𝐷𝑜 0.75𝑖𝑀𝐴
+
≤ 𝑓ℎ
4𝑒
𝑍

Where
𝑃
𝐷𝑜
𝑒
𝑖
𝑀𝐴
𝑍
𝑓ℎ

=
=
=
=
=
=

maximum of CAEPIPE input pressures P1, P2 and P3
outside diameter
nominal pipe thickness x [1 - mill tolerance%/100] - corrosion allowance “c”
stress intensification factor; the product of 0.75i shall not be less than 1.0
resulting bending moment due to sustained loads
un-corroded section modulus; for reduced outlets / branch connections, effective
section modulus
= hot allowable stress

Sustained plus Occasional Stress

The stress (𝜎2 ) due to sustained and occasional loads is calculated as the sum of stress due
to sustained loads such as due to pressure, weight and other sustained mechanical loads and
stress due to occasional loads such as earthquake or wind. Wind and earthquake are not
considered concurrently
𝑃𝐷𝑜 0.75𝑖𝑀𝐴 0.75𝑖𝑀𝐵
𝜎2 =
+
+
≤ 𝑘𝑓ℎ
4𝑒
𝑍
𝑍
𝑀𝐵 = resultant bending moment due to occasional load
𝑘 = 1.2 if the occasional load is acting less than 1% in any 24 hour operating period. In
CAEPIPE k =1.2 is used for occasional loading.
Expansion Stress

The stress (𝜎3 ) due to thermal expansion is calculated from
𝜎3 =

𝑖𝑀𝐶
+≤ 𝑓𝑎
𝑍

𝑓𝑎

= un-corroded section modulus; for reduced outlets / branch connections, effective
section modulus
𝐸
= 𝑈(1.25𝑓𝐶 + 0.25𝑓ℎ ) ℎ

𝑈

= cyclic stress range reduction factor as mentioned below

𝑍

𝐸𝑐
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Number of cycle
𝑓𝑎 <= 7000
7001 to 140000
14001 to 220000
22001 to 0.7
45001 to 100000
100001 to 2000000
𝑓𝐶
𝑓𝐶
𝐸𝐶
𝐸ℎ

=
=
=
=

Stress range reduction factor 𝑈
1.0
0.9
0.8
0.7
0.6
0.5

allowable stress at cold temperature
allowable stress at hot temperature
elastic modulus at cold temperature
elastic modulus at hot temperature
𝜎4 =

𝑃𝐷𝑜 0.75𝑖𝑀𝐴 𝑖𝑀𝐶
+
+
≤ 𝑓ℎ + 𝑓𝑎
4𝑒
𝑍
𝑍

Additional Conditions for the Creep Range

For piping operating within the creep range, the stress, (𝜎5 ), due to sustained, thermal and
alternating loadings shall satisfy the equation below.
𝜎5 =

𝑃𝐷𝑜 0.75𝑖𝑀𝐴 0.75𝑖𝑀𝐶
+
+
≤ 𝑓𝑐𝑟
4𝑒
𝑍
3𝑍

Where
𝑓𝑐𝑟 = allowable creep stress value
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Stoomwezen (1989)
Sustained Stress

The stress (𝑆𝐿 ) due to sustained loads (pressure, weight and other sustained mechanical
loads) is calculated from
𝑆𝐿 =

where
𝑃 =
𝐷 =
𝑡 =
𝑖 =
𝑀𝐴 =
𝑍 =
𝑆ℎ =

𝑃 (𝐷 − 𝑡) 0.75𝑖𝑀𝐴
+
≤ 𝑆ℎ
4𝑡
𝑍

maximum pressure
outside diameter
nominal wall thickness
stress intensification factor. The product 0.75𝑖, shall not be less than 1.0
resultant bending moment due to sustained loads = √𝑀𝑋2 + 𝑀𝑌2 + 𝑀𝑍2
section modulus, for reduced outlets, effective section modulus
hot allowable stress: smaller of:
0.67 yield stress at temperature
0.44 tensile strength at 20º C
0.67 rupture stress (after 100,000 hours at temperature)

Occasional Stress

The stress (𝑆𝐿𝑂 ) is calculated as the sum of stress due to sustained loads (𝑆𝐿 ) and stress due
to occasionalloads (𝑆𝑂 ),such as earthquake or wind. Wind and earthquake are not considered
concurrently.
𝑆𝐿𝑂 = 𝑆𝐿 +

0.75𝑖𝑀𝐵
≤ 1.2𝑆ℎ
𝑍

where
𝑀𝐵 = resultant moment due to occasional loads
Expansion Stress

The stress (𝑆𝐸 ) due to thermal expansion is calculated from
𝑆𝐸 =

𝑖𝑀𝐶
≤ 𝑆𝐴
𝑍

where
𝑀𝐶 = resultant moment due to thermal expansion
𝑆𝐴 = smaller of:
𝐶𝑓 (0.8 yield strength at 20º C + 0.13 hot yield strength)
𝐶𝑓 (0.8 yield strength at 20º C + 0.2 x 0.67 rupture stress)
𝐶𝑓 = stress range reduction factor
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Allowable Pressure

The allowable pressure for straight pipes and bends is calculated from Equation 6.3.
𝑝=

where
𝑝 =
𝜎𝑡𝑛 =
𝑧𝐿 =
𝑠𝑒𝑓𝑓 =
𝐷𝑦 =
𝐷𝑖 =
𝑚 =
=
=

2𝜎𝑡𝑛 𝑧𝐿 𝑠𝑒𝑓𝑓
𝐷𝑦 𝑚 − 𝑠𝑒𝑓𝑓

allowable pressure
allowable stress
joint efficiency of longitudinal weld (input as material property)
nominal pipe thickness × (1 – mill tolerance/100) – corrosion allowance
outside diameter
inside diameter= 𝐷𝑦 − 𝑠𝑒𝑓𝑓
pressure coefficient
1.0 for 𝐷𝑦 /𝐷𝑖 <1.6
0.25(𝐷𝑦 /𝐷𝑖 )+0.6 for 1.6≤𝐷𝑦 /𝐷𝑖 ≤2.0

Sustained Stress

Stress (𝑆𝐿 ) due to sustained loads (pressure, weight and other sustained mechanical loads) is
calculated from Equation 9.37.
𝑆𝐿 =

where
𝑝𝑚𝑎𝑥
𝑧𝐶
𝑘1
𝑀𝐴
𝑊𝑦
𝜎𝑡𝑛2

=
=
=
=
=
=

𝑝𝑚𝑎𝑥 𝐷𝑦 0.75𝑘1 𝑀𝐴
+
≤ 𝜎𝑡𝑛2
4𝑠𝑒𝑓𝑓 𝑧𝐶
𝑊𝑦

maximum pressure
joint efficiency of circumferential weld (input as material property)
stress intensification factor. The product 0.75𝑘1shall not be less than 1.0
resultant bending moment due to sustained loads
section modulus, for reduced outlets, effective section modulus
hot allowable stress

Occasional Stress

The stress (𝑆𝐿𝑂 ) is calculated as the sum of the stress due to sustained loads (𝑆𝐿 ) and the
stress (𝑆𝑂 ) due to occasional loads such as earthquake or wind from Equation 9.38. Wind
and earthquake are not considered concurrently.
𝑆𝐿𝑂 =

𝑝𝑚𝑎𝑥 𝐷𝑦 0.75𝑘1 (𝑀𝐴 + 𝑀𝐵 )
+
≤ 1.2𝜎𝑡𝑛2
4𝑠𝑒𝑓𝑓 𝑧𝐶
𝑊𝑦

where
𝑀𝐵 = resultant bending moment due to occasional loads
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Expansion Stress

The stress (𝑆𝐸 ) due to thermal expansion is calculated from Equation 9.39.
𝑆𝐸 =

𝑘1 𝑀𝐶
≤ 𝑆𝑟
𝑊𝑦

where
𝑀𝐶 = resultant bending moment due to thermal expansion
𝑆𝑟 = 𝑓 (1.17𝜎1 + 0.17𝜎2 ) from Equation 9.43
𝑓 = stress range reduction factor taken from Table 9.1
𝜎1 = smaller of 𝜎𝑡𝑛1 and 0.267𝑅𝑚
𝜎2 = smaller of 𝜎𝑡𝑛2 and 0.367𝑅𝑚
𝜎𝑡𝑛1 = allowable stress at cold condition
𝜎𝑡𝑛2 = allowable stress at hot condition
𝑅𝑚 = tensile strength at room temperature
At moderate temperatures (up to 370º C) for carbon steel, low alloy steel and chromium steel
(specified as CS material type) and up to 425º C for austenitic stainless steel (specified as AS
material type), the limits 0.267𝑅𝑚 and 0.367𝑅𝑚 are disregarded and 𝑆𝑟 is selected as smaller
of 𝑆𝑟′ and 𝑆𝑟′′ ,
where
𝑆𝑟′ = 1.17𝜎𝑡𝑛1 + 0.20𝜎𝑡𝑛2
𝑆𝑟′′ = 290𝑓 − 𝜎𝑡𝑛2
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Allowable Pressure

The allowable pressure is calculated from 5.3.2.1.
𝑃 = 2𝑆𝑡𝐹𝐿𝐽𝑇/D

where
𝑃 =
𝑆 =
𝑡 =
=
𝐹 =
𝐿 =
𝐽 =
𝑇 =
𝐷 =

allowable pressure
specified minimum yield strength
minimum wall thickness
nominal wall thickness × (1 − mill tolerance/100) − corrosion allowance
design factor = 0.8 for steel pipe (from 5.2.3)
location factor (from Table 5.1)
joint factor (from Table 5.2), input as material property
temperature derating factor for steel pipe (from Table 5.3)
outside diameter

Sustained Stress

The stress (𝑆𝐿 ) due to sustained loads (pressure, weight and other sustained mechanical
loads) and wind loads, is calculated from (5.6.3.5)
𝑆𝐿 =

where
𝑃 =
𝐷 =
𝑡 =
𝑖 =
𝑀 =
𝑍 =
𝑆 =
𝐹 =
𝐿 =
𝐽 =
𝑇 =

𝑃𝐷
𝑀
+ 𝑖 ≤ 𝑆𝐹𝐿𝐽𝑇
4𝑡
𝑍

maximum pressure
outside diameter
minimum wall thickness
stress intensification factor
resultant bending moment due to sustained loads
corroded section modulus
specified minimum yield strength
design factor
location factor
joint factor
temperature derating factor

Occasional Stress

The stress (𝑆𝐿𝑂 ) is calculated as the sum of stress due to sustained and wind loads (𝑆𝐿 ) and
stress due to occasional loads (𝑆𝑂 ), such as earthquake. The allowable stress for occasional
stress is not given in the code, therefore it is conservatively taken the same as the sustained
stress allowable.
𝑆𝐿𝑂 = 𝑆𝐿 + 𝑖

𝑀
≤ 𝑆𝐹𝐿𝐽𝑇
𝑍

where
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𝑀 = resultant bending moment due to occasional loads
Expansion Stress

The stress (𝑆𝐸 ) due to thermal expansion is calculated from (5.6.3.3).
𝑆𝐸 = √𝑆𝑏2 + 4𝑆𝑡2 ≤ 0.72𝑆𝑇

where
𝑆𝑏 =
𝑆𝑡 =
𝑀𝑏 =
𝑀𝑡 =
Z =

resultant bending stress= 𝑖𝑀𝑏 /Z
torsional stress = 𝑀𝑡 /2Z
resultant bending moment due to expansion loads
torsional moment due to expansion loads
un-corroded section modulus
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Allowable Pressure

The allowable pressure is calculated from 5.4.2.1.
𝑃 = 2𝑆𝑡𝐹𝐿𝐽𝑇/D

where
𝑃 =
𝑆 =
𝑡 =
=
𝐹 =
𝐿 =
𝐽 =
𝑇 =
𝐷 =

allowable pressure
specified minimum yield strength
minimum wall thickness
nominal wall thickness × (1 − mill tolerance/100) − corrosion allowance
design factor = 0.8 for steel pipe (from 5.2.3)
location factor (from Table 5.1)
joint factor (from Table 5.2), input as material property
temperature derating factor for steel pipe (from Table 5.3)
outside diameter

Sustained Stress

The stress (𝑆𝐿 ) due to sustained loads (pressure, weight and other sustained mechanical
loads) and wind loads, is calculated from (5.19.3.5)
𝑆𝐿 =

where
𝑃 =
𝐷 =
𝑡 =
𝑖 =
𝑀 =
𝑍 =
𝑆 =
𝐹 =
𝐿 =
𝐽 =
𝑇 =

𝑃𝐷
𝑀
+ 𝑖 ≤ 𝑆𝐹𝐿𝐽𝑇
4𝑡
𝑍

maximum pressure
outside diameter
minimum wall thickness
stress intensification factor
resultant bending moment due to sustained loads
corroded section modulus
specified minimum yield strength
design factor
location factor
joint factor
temperature derating factor

Occasional Stress

The stress (𝑆𝐿𝑂 ) is calculated as the sum of stress due to sustained and wind loads (𝑆𝐿 ) and
stress due to occasional loads (𝑆𝑂 ), such as earthquake. The allowable stress for occasional
stress is not given in the code, therefore it is conservatively taken the same as the sustained
stress allowable.
𝑆𝐿𝑂 = 𝑆𝐿 + 𝑖

𝑀
≤ 𝑆𝐹𝐿𝐽𝑇
𝑍

where
𝑀 = resultant bending moment due to occasional loads
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Expansion Stress

The stress (𝑆𝐸 ) due to thermal expansion is calculated from (5.6.3.3).
𝑆𝐸 = √𝑆𝑏2 + 4𝑆𝑡2 ≤ 0.72𝑆𝑇

where
𝑆𝑏 =
𝑆𝑡 =
𝑀𝑏 =
𝑀𝑡 =
Z =

resultant bending stress= 𝑖𝑀𝑏 /Z
torsional stress = 𝑀𝑡 /2Z
resultant bending moment due to expansion loads
torsional moment due to expansion loads
un-corroded section modulus
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Allowable Pressure

For straight pipe, the allowable pressure for a given wall thickness shall be determined by the
following formula from Clause 4.3.5.1.
𝑃 = 𝐹𝐿𝐽𝑇 (

2𝑆𝑡
)
𝐷

where
𝑃 = allowable pressure
𝑆 = specified minimum yield strength, input as material property in CAEPIPE
𝑡 = minimum wall thickness = nominal wall thickness × (1 − mill tolerance/100) −
corrosion allowance (see Note below)
𝐹 = design factor = 0.8 as per Clause 4.3.6.
𝐿 = location factor (from Table 4.2), input into CAEPIPE analysis option
𝐽 = joint factor (from Table 4.3), input as material property in CAEPIPE
𝑇 = temperature factor for steel pipe (from Table 4.4), determined based on Design
Temperature input into CAEPIPE
𝐷 = outside diameter
Note:
Corrosion allowance input into CAEPIPE should include corrosion/erosion allowance and
allowance for grooving and threading.
Sustained + Occasional Stress (Unrestrained Piping = Un-buried Piping)

The sum of longitudinal pressure stress and the total bending stress due to sustained force
(pressure, weight and other sustained mechanical loads) and occasional loads (such as wind,
seismic, etc.) shall be limited in accordance with the following formula from Clause 4.8.5.
0.5𝑆ℎ + 𝑠𝐵 ≤ 𝑆𝐹𝐿𝑇

where
𝑃𝐷
𝑆ℎ = hoop stress due to pressure P, as computed using formula given in Clause 4.6.5 = 2𝑡
𝑆𝐵 = absolute value of beam bending stresses resulting from sustained and occasional loads
𝑖𝑀
= 𝑍𝐵
𝐶

𝑃 = maximum of CAEPIPE input pressures P1 through P10
𝐷 = outside diameter of pipe
𝑡 = minimum wall thickness = nominal wall thickness × (1 − mill tolerance/100) −
corrosion allowance (see Note above for corrosion allowance)
𝑖 = stress intensification factor (from Table 4.8)
𝑀𝐵 = resultant bending moment due to sustained and occasional loads
𝑍𝐶 = corroded section modulus computed using corroded wall thickness = Nominal wall
thickness – corrosion allowance, in which mill tolerance is not deducted.
𝑆 = specified minimum yield strength
𝐹 = design factor = 0.8 as per Clause 4.3.6
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𝐿 = location factor (from Table 4.2)
𝑇 = temperature factor for steel pipe (from Table 4.4) determined based on Maximum
Temperature input into CAEPIPE (T1 through T10)
Expansion Stress (Unrestrained Piping = Un-buried Piping)

The thermal expansion stress range (𝑆𝐸 ) for those portions of pipeline systems shall be
limited in accordance with the formulae given in Clauses 4.8.3 and 4.8.4.
𝑆𝐸 = √𝑆𝑏2 + 4𝑆𝑡2 ≤ 0.72𝑆𝑇

where
𝑆𝑏 = resultant bending stress= 𝑖𝑀𝑏 /Z
𝑆𝑡 = torsional stress = 𝑀𝑡 /(2Z)
𝑀𝑏 = resultant bending moment due to expansion loads
𝑀𝑡 = torsional moment due to expansion loads
𝑍 = un-corroded section modulus
𝑖 = stress intensification factor (from Table 4.8)
𝑆 = specified minimum yield strength
𝑇 = temperature factor for steel pipe (from Table 4.4), determined at Thot.
𝑇ℎ𝑜𝑡 = maximum(𝑇𝑜𝑝𝑟 , 𝑇𝑟𝑒𝑓 ) (see Note 3 below)
Combined Stress (Restrained Piping = Buried Piping)

For those portions of restrained pipelines, the combined stress shall be limited in accordance
with the formula given in Clause 4.7.2.1.
𝑆ℎ − 𝑆𝐿 + 𝑠𝐵 ≤ 𝑆𝑇

where
𝑃𝐷
𝑆ℎ = hoop stress due to pressure P, as determined using formula given in Clause 4.6.5 = 2𝑡
𝑆𝐿 = longitudinal compressive stress as determined using the formula given in Clause 4.7.1
= 𝑆𝐿 = 𝜗𝑆ℎ − 𝐸𝑐 𝛼(𝑇𝑜𝑝𝑟 − 𝑇𝑟𝑒𝑓 ) (see Notes below)
𝑆𝐵 = absolute value of beam bending stresses resulting from sustained and occasional loads
𝑖𝑀
= 𝑍𝐵
𝐶

𝑃 = maximum of CAEPIPE input pressures P1 through P10
𝐷 = outside diameter of pipe
𝑡 = minimum wall thickness
= nominal wall thickness × (1 − mill tolerance/100) − corrosion allowance (see Note
above)
𝑖 = stress intensification factor (from Table 4.8)
𝑀𝐵 = resultant bending moment due to sustained and occasional loads
𝑍𝐶 = corroded section modulus computed using corroded wall thickness = Nominal wall
thickness – corrosion allowance, in which mill tolerance is not deducted.
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𝜗 = Poisson’s ratio, input as material property in CAEPIPE
𝑇𝑜𝑝𝑟 = operating temperature under consideration. See Note 2 below.
𝑇𝑟𝑒𝑓 = ambient temperature at the time of restraint = Reference temperature in CAEPIPE
𝐸𝑐 = modulus of elasticity of steel at 𝑇𝑟𝑒𝑓
𝛼 = coefficient of thermal expansion at 𝑇𝑜𝑝𝑟 defined above
𝑆 = specified minimum yield strength
𝑇 = temperature factor for steel pipe (from Table 4.4), determined at Thot.
𝑇ℎ𝑜𝑡 = maximum(𝑇𝑜𝑝𝑟 , 𝑇𝑟𝑒𝑓 ) (see Note 3 below)
Note:
1. Evaluation as per Clause 4.7.2.1 (listed above) for Restrained Piping shall be
performed in CAEPIPE only when the value of SL computed as listed above is
negative (compressive).
2. If there are more than one thermal load defined in CAEPIPE, for example T1 and
T2, then CAEPIPE calculates longitudinal stress (SL) due to
Thermal expansion range from 𝑇𝑟𝑒𝑓 to T1 as
𝐸𝑐 𝛼(𝑇𝑜𝑝𝑟 − 𝑇𝑟𝑒𝑓 ) = 𝐸𝑐 𝛼 𝑇1 (𝑇1 − 𝑇𝑟𝑒𝑓 )
Thermal expansion range from 𝑇𝑟𝑒𝑓 to T2 as
𝐸𝑐 𝛼(𝑇𝑜𝑝𝑟 − 𝑇𝑟𝑒𝑓 ) = 𝐸𝑐 𝛼 𝑇2 (𝑇2 − 𝑇𝑟𝑒𝑓 )
Thermal expansion range from T1 to T2 as
𝐸𝑐 𝛼(𝑇𝑛 − 𝑇𝑚 ) = 𝐸𝑐 𝛼𝑛 (𝑇𝑛 − 𝑇𝑟𝑒𝑓 ) − 𝐸𝑐 𝛼𝑚 (𝑇𝑚 − 𝑇𝑟𝑒𝑓 ), where n = 1 and m = 2
3. If there are more than one thermal load defined in CAEPIPE, for example T1 and
T2, then CAEPIPE determines Temperature factor (T) as given below.
Thermal expansion range from 𝑇𝑟𝑒𝑓 to 𝑇1 as maximum(𝑇1 , 𝑇𝑟𝑒𝑓 )
Thermal expansion range from 𝑇𝑟𝑒𝑓 to 𝑇2 as maximum(𝑇2 , 𝑇𝑟𝑒𝑓 )
Thermal expansion range from 𝑻𝟏 to 𝑻𝟐 as maximum(𝑻𝟏 , 𝑻𝟐 )
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Allowable Pressure

For straight pipe, the allowable pressure for a given wall thickness shall be determined by the
following formula from Clause 4.3.5.1.
𝑃 = 𝐹𝐿𝐽𝑇 (

2𝑆𝑡
)
𝐷

where
𝑃 = allowable pressure
𝑆 = specified minimum yield strength, input as material property in CAEPIPE
𝑡 = minimum wall thickness = nominal wall thickness × (1 − mill tolerance/100) −
corrosion allowance (see Note below)
𝐹 = design factor = 0.8 as per Clause 4.3.6.
𝐿 = location factor (from Table 4.2), input into CAEPIPE analysis option
𝐽 = joint factor (from Table 4.3), input as material property in CAEPIPE
𝑇 = temperature factor for steel pipe (from Table 4.4), determined based on Design
Temperature input into CAEPIPE
𝐷 = outside diameter
Note:
Corrosion allowance input into CAEPIPE should include corrosion/erosion allowance and
allowance for grooving and threading.
Sustained + Occasional Stress (Unrestrained Piping = Un-buried Piping)

The sum of longitudinal pressure stress and the total bending stress due to sustained force
(pressure, weight and other sustained mechanical loads) and occasional loads (such as wind,
seismic, etc.) shall be limited in accordance with the following formula from Clause 4.8.5.
0.5𝑆ℎ + 𝑠𝐵 ≤ 𝑆𝐹𝐿𝑇

where
𝑃𝐷
𝑆ℎ = hoop stress due to pressure P, as computed using formula given in Clause 4.6.5 = 2𝑡
𝑆𝐵 = absolute value of beam bending stresses resulting from sustained and occasional loads
𝑖𝑀
= 𝑍𝐵
𝐶

𝑃 = maximum of CAEPIPE input pressures P1 through P10
𝐷 = outside diameter of pipe
𝑡 = minimum wall thickness = nominal wall thickness × (1 − mill tolerance/100) −
corrosion allowance (see Note above for corrosion allowance)
𝑖 = stress intensification factor (from Table 4.8)
𝑀𝐵 = resultant bending moment due to sustained and occasional loads
𝑍𝐶 = corroded section modulus computed using corroded wall thickness = Nominal wall
thickness – corrosion allowance, in which mill tolerance is not deducted.
𝑆 = specified minimum yield strength
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𝐹 = design factor = 0.8 as per Clause 4.3.6
𝐿 = location factor (from Table 4.2)
𝑇 = temperature factor for steel pipe (from Table 4.4) determined based on Maximum
Temperature input into CAEPIPE (T1 through T10)
Expansion Stress (Unrestrained Piping = Un-buried Piping)

The thermal expansion stress range (𝑆𝐸 ) for those portions of pipeline systems shall be
limited in accordance with the formulae given in Clauses 4.8.3 and 4.8.4.
𝑆𝐸 = √𝑆𝑏2 + 4𝑆𝑡2 ≤ 0.72𝑆𝑇

where
𝑆𝑏 = resultant bending stress= 𝑖𝑀𝑏 /Z
𝑆𝑡 = torsional stress = 𝑀𝑡 /(2Z)
𝑀𝑏 = resultant bending moment due to expansion loads
𝑀𝑡 = torsional moment due to expansion loads
𝑍 = un-corroded section modulus
𝑖 = stress intensification factor (from Table 4.8)
𝑆 = specified minimum yield strength
𝑇 = temperature factor for steel pipe (from Table 4.4), determined at Thot.
𝑇ℎ𝑜𝑡 = maximum(𝑇𝑜𝑝𝑟 , 𝑇𝑟𝑒𝑓 ) (see Note 3 below)
Combined Stress (Restrained Piping = Buried Piping)

For those portions of restrained pipelines, the combined stress shall be limited in accordance
with the formula given in Clause 4.7.2.1.
𝑆ℎ − 𝑆𝐿 + 𝑠𝐵 ≤ 𝑆𝑇

where
𝑃𝐷
𝑆ℎ = hoop stress due to pressure P, as determined using formula given in Clause 4.6.5 = 2𝑡
𝑆𝐿 = longitudinal compressive stress as determined using the formula given in Clause 4.7.1
= 𝑆𝐿 = 𝜗𝑆ℎ − 𝐸𝑐 𝛼(𝑇𝑜𝑝𝑟 − 𝑇𝑟𝑒𝑓 ) (see Notes below)
𝑆𝐵 = absolute value of beam bending stresses resulting from sustained and occasional loads
𝑖𝑀
= 𝑍𝐵
𝐶

𝑃 = maximum of CAEPIPE input pressures P1 through P10
𝐷 = outside diameter of pipe
𝑡 = minimum wall thickness
= nominal wall thickness × (1 − mill tolerance/100) − corrosion allowance (see Note
above)
𝑖 = stress intensification factor (from Table 4.8)
𝑀𝐵 = resultant bending moment due to sustained and occasional loads
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𝑍𝐶 = corroded section modulus computed using corroded wall thickness = Nominal wall
thickness – corrosion allowance, in which mill tolerance is not deducted.
𝜗 = Poisson’s ratio, input as material property in CAEPIPE
𝑇𝑜𝑝𝑟 = operating temperature under consideration. See Note 2 below.
𝑇𝑟𝑒𝑓 = ambient temperature at the time of restraint = Reference temperature in CAEPIPE
𝐸𝑐 = modulus of elasticity of steel at 𝑇𝑟𝑒𝑓
𝛼 = coefficient of thermal expansion at 𝑇𝑜𝑝𝑟 defined above
𝑆 = specified minimum yield strength
𝑇 = temperature factor for steel pipe (from Table 4.4), determined at Thot.
𝑇ℎ𝑜𝑡 = maximum(𝑇𝑜𝑝𝑟 , 𝑇𝑟𝑒𝑓 ) (see Note 3 below)
Note:
1. Evaluation as per Clause 4.7.2.1 (listed above) for Restrained Piping shall be
performed in CAEPIPE only when the value of S L computed as listed above is
negative (compressive).
2. If there are more than one thermal load defined in CAEPIPE, for example T1 and
T2, then CAEPIPE calculates longitudinal stress (SL) due to
Thermal expansion range from 𝑇𝑟𝑒𝑓 to T1 as
𝐸𝑐 𝛼(𝑇𝑜𝑝𝑟 − 𝑇𝑟𝑒𝑓 ) = 𝐸𝑐 𝛼 𝑇1 (𝑇1 − 𝑇𝑟𝑒𝑓 )
Thermal expansion range from 𝑇𝑟𝑒𝑓 to T2 as
𝐸𝑐 𝛼(𝑇𝑜𝑝𝑟 − 𝑇𝑟𝑒𝑓 ) = 𝐸𝑐 𝛼 𝑇2 (𝑇2 − 𝑇𝑟𝑒𝑓 )
Thermal expansion range from T1 to T2 as
𝐸𝑐 𝛼(𝑇𝑛 − 𝑇𝑚 ) = 𝐸𝑐 𝛼𝑛 (𝑇𝑛 − 𝑇𝑟𝑒𝑓 ) − 𝐸𝑐 𝛼𝑚 (𝑇𝑚 − 𝑇𝑟𝑒𝑓 ), where n = 1 and m = 2
3. If there are more than one thermal load defined in CAEPIPE, for example T1 and
T2, then CAEPIPE determines Temperature factor (T) as given below.
Thermal expansion range from 𝑇𝑟𝑒𝑓 to 𝑇1 as maximum(𝑇1 , 𝑇𝑟𝑒𝑓 )
Thermal expansion range from 𝑇𝑟𝑒𝑓 to 𝑇2 as maximum(𝑇2 , 𝑇𝑟𝑒𝑓 )
Thermal expansion range from 𝑇1 to 𝑇2 as maximum(𝑇1 , 𝑇2 )
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FRP Stress
Fiber Reinforced Plastic Pipe Stress
𝑃𝐷

Hoop stress: 𝑆𝐻 = 2𝑡

𝑚

𝑃𝐷

𝐹

Axial stress: 𝑆𝐴 = 4𝑡 + 𝐴
𝑚

Bending stress: 𝑆𝐵 =

√(𝑖𝑖 𝑀𝑖 )2 +(𝑖𝑜 𝑀𝑜 )2

Torsional stress: 𝑆𝑇 =

𝑍
𝑀𝑡
2𝑍

Longitudinal maximum = Axial + Bending = SA + SB
Longitudinal Minimum = Axial – Bending = SA - SB
where
𝑃 =
𝐷 =
𝑡𝑚 =
=
𝑖𝑖 =
𝑖𝑜 =
𝑀𝑖 =
𝑀𝑜 =
𝑀𝑡 =
𝑍 =
𝐹 =
𝐴 =

pressure
outside diameter
minimum thickness
nominal thickness x (1 – mill tolerance/100) – corrosion allowance
in-plane stress intensification factor
out of plane stress intensification factor
in plane bending moment
out of plane bending moment
torque
section modulus
axial force
cross-section area
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Von Mises Stress and Maximum & Minimum Principal Stresses
𝑃𝐷

Hoop stress: 𝑆𝐻 = 2𝑡

𝑚

Axial stress: 𝑆𝐴 =

𝑃𝐷
4t

Bending stress: 𝑆𝐵 =

𝐹

+𝐴
√(𝑖𝑖 𝑀𝑖 )2 +(𝑖𝑜 𝑀𝑜 )2
𝑍
𝑀

Torsional stress: 𝑆𝑇 = 2𝑍𝑡
(a) At one Extreme Surface of Pipe

T1 =

𝑆𝐻 −𝑆𝐴 −𝑆𝐵
2

U1 = √𝑇12 + (𝑆𝑇 )2
Sigma l =𝜎1 =
Sigma 2 =𝜎2 =

𝑆𝐻 +𝑆𝐴 +𝑆𝐵
2
𝑆𝐻 +𝑆𝐴 +𝑆𝐵
2

+ U1
- U1

VonMises_t = √(𝝈𝟏 )𝟐 − 𝝈𝟏 𝝈𝟐 + (𝝈𝟐 )𝟐
Max_t = 𝝈𝟏
Min_t = 𝝈𝟐
(b) At the other Extreme Surface of Pipe

T2 =

𝑆𝐻 −𝑆𝐴 +𝑆𝐵
2

U2 = √𝑇22 + (𝑆𝑇 )2
Sigma l =𝜎1 =
Sigma 2 =𝜎2 =

𝑆𝐻 +𝑆𝐴 −𝑆𝐵
2
𝑆𝐻 +𝑆𝐴 −𝑆𝐵
2

+ U2
– U2

VonMises_b = √(𝝈𝟏 )𝟐 − 𝝈𝟏 𝝈𝟐 + (𝝈𝟐 )𝟐
Max_b = 𝝈𝟏
Min_b = 𝝈𝟐
(c) For the entire Pipe Cross-section at a Node

VonMises Stress = Max(VonMises_t, VonMises_b)
Maximum Principal Stress = Max(Max_t, Max_b)
Minimum Principal Stress = Min(Min_t, Min_b)
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where
𝑃 =
𝐷 =
t =
𝑡𝑚 =
𝑖𝑖 =
𝑖𝑜 =
𝑀𝑖 =
𝑀𝑜 =
𝑀𝑡 =
𝑍 =
𝐹 =
𝐴 =

pressure
outside diameter
nominal thickness
minimum thickness = t x (1 – mill tolerance/100) – corrosion allowance
in-plane stress intensification factor
out-of-plane stress intensification factor
in-plane bending moment
out-of-plane bending moment
torque
section modulus
axial force
cross-section area

Stress Intensification Factors (SIFs)
CAEPIPE computes Stress Intensification Factors (SIFs) for “None” code as per SIF
equations provided in ASME B31.3 as given below.
For “Piping code = None” and a non-FRP material, the in-plane and out-of-plane Stress
Intensification Factors (SIF) for a 90° bend/elbow are taken to be the same as those
computed using Appendix D of ASME B31.3 (appended below for reference).
For a bend with bend angle less than 90°, the in-plane and out-of-plane SIFsarecomputed
using the procedure given in ASME/BPVC Section III, Division1, Case N-319-2 “Alternate
Procedure for Evaluation of Stresses in Butt Welding Elbows in Class 1 Piping.”
For better clarity, when piping code = None, the SIF for a bend of other than 90 deg is as
follows:
The SIF for curved pipe of arc lengths between 0 and 180 deg can be estimated by
multiplying the SIF for 90 deg bend as given by ASME B31.3 code by a scalar
multiplier. This scalar multiplier is arrived at by taking the ratio of the involved Bending
stress index C(2z) values as given below.
Scalar multiplier = [C(2z) value for the required angle bend / C(2z) value for 90 deg bend] ,
where the C(2z) values are taken from ASME/BPVC Section III, Division 1, Code Case N319-2 document titled "Alternate Procedure for Evaluation of Stresses in Butt Welding
Elbows in Class 1 Piping", which are listed below.
C(2z) = 1.95/h^(2/3) for bend angles of 90 deg or greater
C(2z) = 1.75/h^(0.56) for a bend angle of 45 deg
C(2z) = 1.0 for a bend angle of 0 deg (straight pipe)
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For other bend angles, the C(2z) values can be interpolated between the above C(2z) values.
As an example, a 45 deg bend SIF could be reasonably estimated to be {SIF for B31 90 deg
bend} x [C(2z) for a 45 deg bend / C(2z) for a 90 deg bend]. You may note that the Scalar
multiplier is 1.0 for bend angles greater than 90 deg.
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Piping Code=NONE

400

Piping Code = NONE
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Operating Stress for NDE / Impact Test
This function is available to users who wish to inspect or examine high stress areas (NonDestructive Evaluation, NDE) where piping has high “operating stresses” or examine stress
areas that are higher than 35% of the allowable stress for Impact Testing as per para. 523.2.2
(f)(4) of ASME B31.5 (2017) code
While piping codes do not consider the operating condition (W+P+T) as a required load case for code
compliance, you may, however, evaluate this load case the same way as you would do for other
code compliance cases such as Sustained (W+P) and Expansion (T). CAEPIPE will show
columns displaying Operating Stress (Sopr) and Allowable stress (Sall) alongside the code
required stresses even though the Operating Stress is not a code requirement.
To display these columns, you will have to turn them on first:(mouse right click) > Show
Operating Stress for NDE for all codes excepting ASME B31.5. For ASME B31.5 Code, this
option will change as “Show Operating Stress for Impact Test”.
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Operating Stress for NDE / Impact Test

This allowable stress is NOT specified nor recommended by piping codes but, as mentioned
above, may aid you in identifying regions of high combined stress in your piping system,
which may warrant a closer examination in your engineering judgment.
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Operating Stress for NDE / Impact Test

Allowable stress for Impact Test is specified for the materials given in Table 502.3.1 of
ASME B31.5 (2016) Code. Accordingly, “Sall” is computed and shown above.
The equation used to calculate the operating stresses is modeled along the lines of a piping
code specified stress equation. The three components of the equation are:
1. Axial stress combined with the longitudinal pressure stress,
2. Bending stress from in-plane and out-of-plane bending moments, and
3. A torsional stress from the torsion term.
The allowable stress for this case is simply a combination of the sustained and the thermal
allowable stresses.
Note that the Operating Stress is calculated and shown only for the first Operating case (W+P1+T1).
Details follow.
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Operating Stress for NDE / Impact Test
The stress (Sopr) due to operating loads (pressure, weight and thermal load T 1) is calculated as
𝑆𝑜𝑝𝑟 = 𝑆𝑎 + √(𝑆𝑎 )2 + (2𝑆𝑡 )2 ≤ 𝑆𝑎𝑙𝑙
where
𝑃𝐷
𝐹
𝑆𝑎 = ⌊ 4 + 𝐴⌋
𝑡

𝑆𝑏 = ⌊

𝑂𝑝𝑒𝑟𝑎𝑡𝑖𝑛𝑔1

√(𝑖𝑖 𝑀𝑖 )2 +(𝑖𝑜 𝑀𝑜 )2
𝑍

⌋
𝑂𝑝𝑒𝑟𝑎𝑡𝑖𝑛𝑔1

𝑀

𝑆𝑡 = ⌊2𝑍𝑡 ⌋

𝑂𝑝𝑒𝑟𝑎𝑡𝑖𝑛𝑔1

maximum of CAEPIPE input pressures P1 through P10
outside diameter
nominal wall thickness
un-corroded cross-sectional area of the pipe
longitudinal force
in-plane stress intensification factor according to analysis code selected in
CAEPIPE
𝑖𝑜
= out-of-plane stress intensification factor according to analysis code selected in
CAEPIPE
Note: If the analysis code selected provides only the stress intensification i, then 𝑖𝑖 = 𝑖𝑜 = 𝑖.
𝑀𝑖 = in-plane bending moment
𝑀𝑜 = factor for loose type flanges (from Fig. 2-7.5)
𝑀𝑡 = factor for loose type flanges (from Fig. 2-7.4)
𝑍
= un-corroded section modulus; for reduced outlets / branch connections, effective
section modulus
𝑆𝑎𝑙𝑙 = 𝑓 (1.25𝑆𝑐𝑜𝑙𝑑 + 0.25𝑆ℎ𝑜𝑡 ) + 𝑆ℎ𝑜𝑡 for all codes excepting ASME B31.5. For ASME
B31.5, it is calculated as 0.35 Shot.
𝑓
= stress range reduction factor = 6/N0.2
𝑁
= Number of equivalent full-range thermal cycles
𝑆𝑐𝑜𝑙𝑑 = basic allowable stress at Tref
𝑆ℎ𝑜𝑡 = basic allowable stress at CAEPIPE input temperature T1
𝑃
𝐷
𝑡
𝐴
𝐹
𝑖𝑖

=
=
=
=
=
=
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Particulars

Allowable Pressure

Pipe Weight

Sustained Stress

Nominal
Thk.
x
(1-mill
tolerance/100) –
Corrosion
allowance

Nominal Thickness

Nominal Thickness

Expansion Stress

Occasional Stress

ASME B31.1
Pipe
used

Thickness

Section Modulus
used

-

-

-

Nominal Thickness

Un-corroded Section Modulus;
For Branch, effective section
modulus

Un-corroded Section Modulus;
For Branch, effective section modulus

Un-corroded Section Modulus;
For Branch, effective section
modulus

Nominal Thickness - Corrosion
allowance

-

Nominal Thickness – Corrosion
allowance

Corroded Section Modulus;
For Branch, effective section
modulus

Un-corroded Section Modulus;
For Branch, effective section modulus

Corroded Section Modulus;
For Branch, effective section
modulus

ASME B31.3
Pipe
used

Thickness

Section Modulus
used

Nominal
Thk.
x
(1-mill
tolerance/100) –
Corrosion
allowance

Nominal Thickness

-

-

Nominal
Thk.
x
(1-mill
tolerance/100) –
Corrosion
allowance

Nominal Thickness

-

-

ASME B31.4
Pipe
used

Thickness

Section Modulus
used

Nominal Thickness

-

Nominal Thickness

Un-corroded Section Modulus;
For Branch, effective section
modulus

Un-corroded Section Modulus;
For Branch, effective section modulus

Un-corroded Section Modulus;
For Branch effective section
modulus

Nominal Thickness – Corrosion
allowance

-

Nominal Thickness – Corrosion
allowance

ASME B31.5
Pipe
used

Thickness

Nominal
Thk.
x
(1-mill
tolerance/100) –
Corrosion
allowance

Nominal Thickness
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Particulars

Allowable Pressure

Section Modulus
used

-

Pipe Weight
-

Sustained Stress

Expansion Stress

Occasional Stress

Corroded Section Modulus;
For Branch, effective section
modulus

Un-corroded Section Modulus;
For Branch, effective section modulus

Corroded Section Modulus;
For Branch, effective section
modulus

ASME B31.8
Pipe
used

Thickness
Nominal Thk.

Section Modulus
used

Nominal Thickness

-

-

Nominal Thickness
Un-corroded Section Modulus;
For Branch, effective section
modulus

-

Un-corroded Section Modulus;
For Branch, effective section modulus

Nominal Thickness
Un-corroded Section Modulus;
For Branch, effective section
modulus

ASME B31.9
Pipe
used

Thickness

Section Modulus
used

Nominal
Thk.
x
(1-mill
tolerance/100) –
Corrosion
allowance
-

Nominal Thickness

-

Nominal Thickness
Un-corroded Section Modulus;
For Branch, effective section
modulus

-

Un-corroded Section Modulus;
For Branch, effective section modulus

Nominal Thickness
Un-corroded Section Modulus;
For Branch, effective section
modulus

ASME B31.12
Pipe
used

Thickness

Section Modulus
used

Nominal
Thk.
x
(1-mill
tolerance/100) –
Corrosion
allowance
-

Nominal Thickness

-

Nominal Thickness
Un-corroded Section Modulus;
For Branch, effective section
modulus

Note:
1. Corrosion allowance includes thickness required for threading, grooving, erosion, corrosion etc.
2. Un-corroded section modulus = section modulus calculated using the nominal thickness.
3. Corroded section modulus = section modulus calculated using the “corroded thickness”
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-

Un-corroded Section Modulus;
For Branch, effective section modulus

Nominal Thickness
Un-corroded Section Modulus;
For Branch, effective section
modulus

Thickness and Section Modulus used in Weight, Pressure and Stress Calculations for ANSI B31.x Codes
corroded thickness = nominal thickness – corrosion allowance
4. Effective section modulus = section modulus calculated using effective branch thickness, which is lesser of i itb or th
where, tb = branch nominal thickness, th = header nominal thickness, ii = in-plane SIF at branch
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Rotating Equipment Qualification

API 610 (11th Edition, 2010) / ISO 13709:2009
API 610 (11th Edition, 2010) / ISO 13709:2009 for Pumps

The allowable nozzle forces and moments for pumps are taken from Table 4 of the eleventh
edition of API Standard 610 / ISO 13709.

411

API 610 (11th Edition, 2010) / ISO 13709:2009

412

API 610 (11th Edition, 2010) / ISO 13709:2009
The coordinate systems and nozzle orientations for various pump configurations are shown
next.

413

API 610 (11th Edition, 2010) / ISO 13709:2009

414

API 610 (11th Edition, 2010) / ISO 13709:2009
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API 610 (11th Edition, 2010) / ISO 13709:2009

416

API 610 (11th Edition, 2010) / ISO 13709:2009
Criteria for Piping Design

The criteria for piping design are taken from Appendix F of the API 610.

417

API 610 (11th Edition, 2010) / ISO 13709:2009

418

API 610 (11th Edition, 2010) / ISO 13709:2009

419

API 610 (11th Edition, 2010) / ISO 13709:2009
Verification of API 610 Pump Compliance
Implementation of API 610 Pump Compliance in CAEPIPE is verified using the sample
provided in API Standard 610, 11th Edition and presented in this section.

CAEPIPE model corresponding to the above API Publication sample

420

API 610 (11th Edition, 2010) / ISO 13709:2009

421

API 610 (11th Edition, 2010) / ISO 13709:2009
Results from API 610, 11th Edition

422

API 610 (11th Edition, 2010) / ISO 13709:2009

Results from CAEPIPE Rotating Equipment Report
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Coordinate System for ASME B73.1, B73.3 and B73.5M horizontal end suction
pumps

Figure 1 – Coordinate system for ASME B73.1, B73.3 and B73.5M horizontal end suction
pumps
A1.0 Definitions (refer to Figure above)

Fxs = applied force on X-axis on suction nozzle, to be assessed using equation sets 1-5
Fys = applied force on Y-axis on suction nozzle, to be assessed using equation sets 1-5
Fzs = applied force on Z-axis on suction nozzle, to be assessed using equation sets 1-5
Mxs = applied moment about X-axis on suction nozzle, to be assessed using equation sets 1-5
Mys = applied moment about Y-axis on suction nozzle, to be assessed using equation sets 1-5
Mzs = applied moment about Z-axis on suction nozzle, to be assessed using equation sets 1-5
Fxd = applied force on X-axis on discharge nozzle, to be assessed using equation sets 1-5
Fyd = applied force on Y-axis on discharge nozzle, to be assessed using equation sets 1-5
Fzd = applied force on Z-axis on discharge nozzle, to be assessed using equation sets 1-5
Mxd = applied moment about X-axis on discharge nozzle, to be assessed using equation sets
1-5
Myd = applied moment about Y-axis on discharge nozzle, to be assessed using equation sets
1-5
Mzd = applied moment about Z-axis on discharge nozzle, to be assessed using equation sets
1-5
Fxs max = maximum value of force on X-axis on suction nozzle, to be used with equation sets
1-5
Fys max = maximum value of force on Y-axis on suction nozzle, to be used with equation sets
1-5
Fzs max = maximum value of force on Z-axis on suction nozzle, to be used with equation sets
1-5
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Mxs max = maximum value of moment about X-axis on suction nozzle, to be used with
equation sets 1-5
Mys max = maximum value of moment about Y-axis on suction nozzle, to be used with
equation sets 1-5
Mzs max = maximum value of moment about Z-axis on suction nozzle, to be used with
equation sets 1-5
Fxd max = maximum value of force on X-axis on discharge nozzle, to be used with equation
sets 1-5
Fyd max = maximum value of force on Y-axis on discharge nozzle, to be used with equation
sets 1-5
Fzd max = maximum value of force on Z-axis on discharge nozzle, to be used with equation
sets 1-5
Mxd max = maximum value of moment about X-axis on discharge nozzle, to be used with
equation sets 1-5
Myd max = maximum value of moment about Y-axis on discharge nozzle, to be used with
equation sets 1-5
Mzd max = maximum value of moment about Z-axis on discharge nozzle, to be used with
equation sets 1-5
Group 1 is defined as ASME B73.1, B73.3 and B73.5M sizes AA and AB. Two/four-pole, 60
cycle speed and up to 20/10 hp, respectively.
Group 2 is defined as ASME B73.1, B73.3 and B73.5M sizes A05, A10, A20, A30, A40, A50,
A60, A70 and A80. Two/four-pole, 60-cycle speed and up to 130/65 hp, respectively.
Group 3 is defined as ASME B73.1, B73.3 and B73.5M sizes A90, A100, A110 and A120.
Four/six-pole, 60-cycle speed and up to 220/146 hp, respectively.
A1.1 ASME B73.1 pump assessment of applied nozzle loads

Loads given in Tables B through E are applicable for ASME B73.1 pumps constructed of
ASTM A351/A351M – Grade CF8M (Type 316SS) operated between 20 and 1000 F and
mounted on a grouted metal baseplate with anchor bolts.
For an individual force or moment, pumps must be capable of satisfactory operation when
subjected to loads shown in Table B while meeting the criteria of equation set 1 provided in
Table A below.
For a combination of more than one force and/or moment, pumps must be capable of
satisfactory operation when subjected to the loads in Tables C through E while meeting the
criteria of equation sets 2 – 5 of Table A given below. When combining loads, the absolute
value of any individual load must not exceed the value given in Table B.
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Adjustment of the tabulated maximum forces and moments are performed if any of the
following occur.
a. Temperature is above 1000 F.
b. The pump material construction is not ASTM A351/A351M – Grade CF8M.
c. The base is not a fully grouted metal baseplate with anchor bolts.
Table A – Equation sets 1 through 5 (using the maximum forces and moments of
the referenced tables, applied loads shall satisfy the criteria defined by these
equations)
Set

1

Equation
|

𝐹𝑋𝑆
𝐹𝑌𝑆
𝐹𝑍𝑆
𝑀𝑋𝑆
𝑀𝑌𝑆
𝑀𝑍𝑆
| ≤ 1.0, |
| ≤ 1.0, |
| ≤ 1.0, |
| ≤ 1.0, |
| ≤ 1.0, |
| ≤ 1.0
𝐹𝑋𝑆𝑚𝑎𝑥
𝐹𝑌𝑆𝑚𝑎𝑥
𝐹𝑍𝑆𝑚𝑎𝑥
𝑀𝑋𝑆𝑚𝑎𝑥
𝑀𝑌𝑆𝑚𝑎𝑥
𝑀𝑍𝑆𝑚𝑎𝑥

𝐹𝑋𝑑
𝐹𝑌𝑑
𝐹𝑍𝑑
𝑀𝑋𝑑
𝑀𝑌𝑑
𝑀𝑍𝑑
| ≤ 1.0, |
| ≤ 1.0, |
| ≤ 1.0, |
| ≤ 1.0, |
| ≤ 1.0, |
| ≤ 1.0
𝐹𝑋𝑑𝑚𝑎𝑥
𝐹𝑌𝑑𝑚𝑎𝑥
𝐹𝑍𝑑𝑚𝑎𝑥
𝑀𝑋𝑑𝑚𝑎𝑥
𝑀𝑌𝑑𝑚𝑎𝑥
𝑀𝑍𝑑𝑚𝑎𝑥
𝐹𝑋𝑆
𝐹𝑌𝑆
𝐹𝑍𝑆
𝑀𝑋𝑆
𝑀𝑌𝑆
𝑀𝑍𝑆
|
|+ |
|+|
|+ |
|+ |
|+|
|+
1
𝐹
𝐹𝑌𝑆𝑚𝑎𝑥
𝐹𝑍𝑆𝑚𝑎𝑥
𝑀𝑋𝑆𝑚𝑎𝑥
𝑀𝑌𝑆𝑚𝑎𝑥
𝑀𝑍𝑆𝑚𝑎𝑥
𝑥 𝑋𝑆𝑚𝑎𝑥
≤ 1.0
𝐹𝑋𝑑
𝐹𝑌𝑑
𝐹𝑍𝑑
𝑀𝑋𝑑
𝑀𝑌𝑑
𝑀𝑍𝑑
2
|
|+ |
|+|
|+|
|+|
|+ |
|
[ 𝐹𝑋𝑆𝑚𝑎𝑥
]
𝐹𝑌𝑆𝑚𝑎𝑥
𝐹𝑍𝑆𝑚𝑎𝑥
𝑀𝑋𝑑𝑚𝑎𝑥
𝑀𝑌𝑑𝑚𝑎𝑥
𝑀𝑍𝑑𝑚𝑎𝑥

Reference

Remarks

Table B

Individual
loading

Table C

Nozzle
stress,
holddown bolt
stress,
pumps
slippage
y-axis
movement

|

2

3
4

𝐹𝑌𝑆
𝑀𝑋𝑆
𝑀𝑌𝑆
𝑀𝑍𝑆
𝐹𝑌𝑑
+
+
+
+
𝐹𝑌𝑆 𝑚𝑎𝑥 𝑀𝑋𝑆 𝑚𝑎𝑥 𝑀𝑌𝑆 𝑚𝑎𝑥 𝑀𝑍𝑆 𝑚𝑎𝑥 𝐹𝑌𝑑 𝑚𝑎𝑥
𝑀𝑋𝑑
𝑀𝑌𝑑
𝑀𝑍𝑑
+
+
+
≤ 1.0
𝑀𝑋𝑑 𝑚𝑎𝑥 𝑀𝑌𝑑 𝑚𝑎𝑥 𝑀𝑍𝑑 𝑚𝑎𝑥
𝐹𝑋𝑆
𝐹𝑍𝑆
𝑀𝑋𝑆
𝑀𝑌𝑆
𝑀𝑍𝑆
−1.0 ≤ 𝑏 =
+
+
+
+
+
𝐹𝑋𝑆 𝑚𝑎𝑥 𝐹𝑍𝑆 𝑚𝑎𝑥 𝑀𝑋𝑆 𝑚𝑎𝑥 𝑀𝑌𝑆 𝑚𝑎𝑥 𝑀𝑍𝑆 𝑚𝑎𝑥
−1.0 ≤ 𝑎 =

Table D
Table E

z-axis
movement

Equation
sets 3 and 4

Combined
axis
movement

𝐹𝑋𝑑
𝐹𝑌𝑑
𝐹𝑍𝑑
𝑀𝑋𝑑
𝑀𝑌𝑑
𝑀𝑍𝑑
+
+
+
+
+
≤ 1.0
𝐹𝑋𝑑 𝑚𝑎𝑥 𝐹𝑌𝑑 𝑚𝑎𝑥 𝐹𝑍𝑑 𝑚𝑎𝑥 𝑀𝑋𝑑 𝑚𝑎𝑥 𝑀𝑌𝑑 𝑚𝑎𝑥 𝑀𝑍𝑑 𝑚𝑎𝑥

5

√𝑎2 + 𝑏2 ≤ 1.0
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Table B – Maximum forces and moments for use with equation set 1 to assess
applied loads
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Table C- Maximum forces and moments for use with equation set 2 to assess
applied loads

Table D – Maximum forces and moments for use with equation set 3 to assess
applied loads
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Table E – Maximum forces and moments for use with equation set 4 to assess
applied loads

A1.2 Nozzle loads and adjustment factors

The loads in the tables are multiplied by adjustment factors when applicable. The lowest
correction factor is applied when more than one adjustment factor is involved. For instance,
if the pump is an ASME B73.5 pump (90% reduction factor) mounted on a fully grouted
nonmetallic baseplate (80% reduction factor), then the reduction factor for Tables B through
E is 80%
A1.2.1 Alternate pump mounting

For alternate mounting conditions, the pump must be mounted on a base that can, as a
minimum, withstand the applied nozzle loads combined with normal operating loads.
A1.2.1.1 Still-mounted metal baseplate

100% of the values in Table C and 90% of values in Table D and Table E are used. If after
adjusting the value for a particular load in Tables D and E, the absolute value of any adjusted
value is lower than the corresponding load in Table B, then the lower value is substituted
into Table B.
A1.2.1.2 Ungrouted metal baseplate that is anchored down

100% of the values in Table C and 80% of the values in Tables D and E are used. If after
adjusting the value for a particular load in Tables D and E, the absolute value of any adjusted
value is lower than the corresponding load in Table B, then the lower value is substituted
into Table B.
A1.2.1.3 Grouted nonmetal baseplate with anchor bolts

80% of the values in Tables B through E are used.
A1.2.1.4 Ungrouted nonmetal baseplate that is anchored down

70% of the values in Tables B through E are used.
A1.2.2 Temperature and material adjustment factors for ASME B73.1 and ASME
B73.3 pumps
A1.2.2.1 Adjustment factors

For temperatures above 1000 F and/or the use of a material other than ASTM A351/351M –
Grade CF8M, the loads in Table C are reduced by multiplying the proper adjustment factor
from Table A1.2.2b.
If after adjusting the value for a particular load in Table C, any adjusted value is lower than
the corresponding load in Table B, then the lower value is substituted in Table B.
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Material group numbers used in Table A1.2.2b are defined in Table A1.2.2.a
Table A1.2.2a – List of material specifications as used in Table B

Table A1.2.2b – ASME B73.1 metallic pump temperature and material adjustment
values used on Table C values
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Coordinate System for ASME B73.2 vertical in-line pumps

Figure 2 – Coordinate system for ASME B73.2 vertical in-line pumps
A2.0 Definitions (refer to Figure above)

Fxs = applied force on X-axis on suction nozzle, to be assessed using equation set 6
Fys = applied force on Y-axis on suction nozzle, to be assessed using equation set 6
Fzs = applied force on Z-axis on suction nozzle, to be assessed using equation set 6
Mxs = applied moment about X-axis on suction nozzle, to be assessed using equation set 6
Mys = applied moment about Y-axis on suction nozzle, to be assessed using equation set 6
Mzs = applied moment about Z-axis on suction nozzle, to be assessed using equation set 6
Fxd = applied force on X-axis on discharge nozzle, to be assessed using equation set 6
Fyd = applied force on Y-axis on discharge nozzle, to be assessed using equation set 6
Fzd = applied force on Z-axis on discharge nozzle, to be assessed using equation set 6
Mxd = applied moment about X-axis on discharge nozzle, to be assessed using equation set 6
Myd = applied moment about Y-axis on discharge nozzle, to be assessed using equation set 6
Mzd = applied moment about Z-axis on discharge nozzle, to be assessed using equation set 6
Fx max = maximum value of force on X-axis on suction or discharge nozzles, to be used with
equation set 6
Fy max = maximum value of force on Y-axis on suction or discharge nozzles, to be used with
equation set 6
Fz max = maximum value of force on Z-axis on suction or discharge nozzles, to be used with
equation set 6
Mx max = maximum value of moment about X-axis on either nozzle, to be used with equation
set 6
My max = maximum value of moment about Y-axis on either nozzle, to be used with equation
set 6
Mz max = maximum value of moment about Z-axis on either nozzle, to be used with equation
set 6
A2.1 ANSI/ASME B73.2 pump assessment of applied nozzle loads

Loads given in Table B above are applicable for ASME B73.2 pumps constructed of ASTM
A351/A351M – Grade CF8M (Type 316SS) operated between -20 and 1000 F.
For an individual force or moment or for a combination of more than one force and/or
moment, pumps should be capable of satisfactory operation when subjected to loads shown
in Table A2.1b (adjusted if applicable) while meeting the criteria of equation set 6 in Table
A2.1a.
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Table A2.1a – Equation set 6
Set

6

Equation
𝐹𝑋𝑆
𝐹𝑌𝑆
𝐹𝑍𝑆
𝑀𝑋𝑆
𝑀𝑌𝑆
𝑀𝑍𝑆
|
| ≤ 1.0, |
| ≤ 1.0, |
| ≤ 1.0, |
| ≤ 1.0, |
| ≤ 1.0, |
| ≤ 1.0
𝐹𝑋𝑚𝑎𝑥
𝐹𝑌𝑚𝑎𝑥
𝐹𝑍𝑚𝑎𝑥
𝑀𝑋𝑚𝑎𝑥
𝑀𝑌𝑚𝑎𝑥
𝑀𝑍𝑚𝑎𝑥
|

Reference

-

Remarks

Individual
loading

𝐹𝑋𝑑
𝐹𝑌𝑑
𝐹𝑍𝑑
𝑀𝑋𝑑
𝑀𝑌𝑑
𝑀𝑍𝑑
| ≤ 1.0, |
| ≤ 1.0, |
| ≤ 1.0, |
| ≤ 1.0, |
| ≤ 1.0, |
| ≤ 1.0
𝐹𝑋𝑚𝑎𝑥
𝐹𝑌𝑚𝑎𝑥
𝐹𝑍𝑚𝑎𝑥
𝑀𝑋 𝑚𝑎𝑥
𝑀𝑌𝑚𝑎𝑥
𝑀𝑍𝑚𝑎𝑥

Table A2.1b – Maximum forces and moments for use with equation set 6 to assess
applied loads

A2.1.1 Temperature and material adjustment factors

Adjustments of allowable load values are performed when any of the following occurs:
a. Temperature is above 1000 F
b. The pump material construction is not ASTM A351/A351M – Grade CF8M
A2.1.2 Adjustment factors

For temperatures above 1000 F and/or the use of a material other than ASTM A351/A351M
– Grade CF8M, the loads in Table A2.1b are reduced by multiplying them by the proper
adjustment factor from Table A2.1d. Material group numbers used in Table A2.1d are
defined in Table A2.1c.
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Table A2.1c – List of materials specifications as used in Table A2.1d

Table A2.1d – ASME B73.2 metallic pump temperature and material adjustment
values used
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Coordinate System for Axial split case pumps (single-stage double suction and
two-stage single suction)

Figure 3 – Coordinate system for axial split case pumps
A3.0 Definitions (refer to Figure above)

Fxs = applied force on X-axis on suction nozzle, to be assessed using equation 1
Fys = applied force on Y-axis on suction nozzle, to be assessed using equation 1
Fzs = applied force on Z-axis on suction nozzle, to be assessed using equation 1
Mxs = applied moment about X-axis on suction nozzle, to be assessed using equation 1
Mys = applied moment about Y-axis on suction nozzle, to be assessed using equation 1
Mzs = applied moment about Z-axis on suction nozzle, to be assessed using equation 1
Fxd = applied force on X-axis on discharge nozzle, to be assessed using equation 1
Fyd = applied force on Y-axis on discharge nozzle, to be assessed using equation 1
Fzd = applied force on Z-axis on discharge nozzle, to be assessed using equation 1
Mxd = applied moment about X-axis on discharge nozzle, to be assessed using equation 1
Myd = applied moment about Y-axis on discharge nozzle, to be assessed using equation 1
Mzd = applied moment about Z-axis on discharge nozzle, to be assessed using equation 1
Fx max = maximum value of force on X-axis on either nozzle, to be used with equation1
Fy max = maximum value of force on Y-axis on either nozzle, to be used with equation 1
Fz max = maximum value of force on Z-axis on either nozzle, to be used with equation 1
Mx max = maximum value of moment about X-axis on either nozzle, to be used with equation
1
My max = maximum value of moment about Y-axis on either nozzle, to be used with equation
1
Mz max = maximum value of moment about Z-axis on on either nozzle, to be used with
equation 1

434

Rotodynamic Pumps - ANSI/HI 9.6.2 - 2011
A3.1 Axial split case pumps assessment of applied loads

The lowest values of maximum forces and moments from Tables A3.1a and A3.1b are used.
The combined applied loads should satisfy the criteria defined by equation 1 below.

Table A3.1a – Maximum forces and moments for use with equation 1 to assess
applied loads based on the hold-down bolts

Table A3.1b – Maximum forces and moments for use with equation 1 to assess
applied loads based on the nozzle stress
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Coordinate System for Vertical turbine short set pumps
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A4.0 Definitions

fx, fy and fz are the actual applied nozzle forces in their respective coordinate direction
mx, my and mz are actual applied nozzle moments in their respective coordinate direction
Fx, Fy and Fz are tabulated maximum permissible nozzle forces in their respective
coordinate direction
Mx, My and Mz are tabulated maximum permissible nozzle moments in their respective
coordinate direction
A4.1 Vertical turbine short set pumps assessment of applied loads

The tables above show maximum permissible forces and moments for each coordinate
direction of each flange. Each value in the tables represents the maximum allowable load in a
particular direction acting alone. For cases in which more than one load is applied
simultaneously, the following formula should be satisfied.
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NEMA SM-23 (1991) for Turbines

There are two types of allowables.
1. Allowables for each nozzle and
2. Combined allowables for each turbine.
1. Allowables for each Nozzle

The resultant force and the resultant moment at any connection must not exceed
3𝐹𝑅 + 𝑀𝑅 ≤ 500𝐷𝑒

where
𝐹𝑅 =
𝑀𝑅 =
𝐷𝑒 =
=

resultant force at the nozzle (lb)
resultant moment at the nozzle (ft.-lb)
nominal pipe size (inches) of the connection up to 8” in diameter
(16 + 𝐷𝑛𝑜𝑚 )/3 If the size is greater than 8”

2. Combined Allowables for the Turbine

The combined resultants of the forces and moments at the inlet, exhaust and extraction
nozzles resolved at the centerline of the exhaust nozzle must not exceed the following two
conditions:
(a) These resultant should not exceed:
2𝐹𝐶 + 𝑀𝐶 ≤ 250𝐷𝐶

where
𝐹𝐶 = combined resultant of inlet, exhaust and extraction forces (lb)
𝑀𝐶 = combined resultant of inlet, exhaust and extraction moments (ft.-lb.)
𝐷𝐶 = diameter (in inches) of a circular opening equal to the total areas of the inlet, exhaust
and extraction nozzles up to a value of 9” in diameter
= (18 + Equivalent diameter) / 3 (in.) For values > 9”
(b) The components of these resultants shall not exceed:
𝐹𝑋 = 50𝐷𝐶 𝑀𝑋 = 250𝐷𝐶
𝐹𝑌 = 125𝐷𝐶 𝑀𝑌 = 125𝐷𝐶
𝐹𝑍 = 100𝐷𝐶 𝑀𝑍 = 125𝐷𝐶

where
𝐹𝑋 =
𝐹𝑌 =
𝐹𝑍 =
𝑀𝑋 =
𝑀𝑌 =
𝑀𝑍 =

horizontal component of 𝐹𝑅 parallel to the turbine shaft
vertical component of 𝐹𝑅
horizontal component of 𝐹𝑅 at right angles to the turbine shaft
horizontal component of 𝑀𝑅 parallel to the turbine shaft
vertical component of 𝑀𝑅
horizontal component of 𝑀𝑅 at right angles to the turbine shaft
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API 617 (Seventh edition, June 2003) for Compressors
1. Allowables for each Nozzle

The total resultant force and resultant moment imposed on the compressor at any
connection should not exceed
Where
𝐹𝑟 =
𝑀𝑟 =
𝐷𝑒 =
=

3𝐹𝑟 + 𝑀𝑟 ≤ 927𝐷𝑒
resultant force at the Nozzle (lb)
resultant moment at the Nozzle (ft.-lb)
nominal pipe size (inches) of the connection up to 8” in diameter
(16 + Dnom )/3 If the size is greater than 8”

2. Combined Allowables for Compressors

The combined resultants of the forces and moments of the inlet, sidestream, and discharge
connections resolved at the centerlines of the largest connection should not exceed the
following two conditions:
(a) The resultant should not exceed:
2𝐹𝑐 + 𝑀𝑐 ≤ 462𝐷𝑐
Where
𝐹𝑐 = combined resultant of inlet, sidestream, and discharge forces (lb)
𝑀𝑐 = combined resultant of inlet, sidestream, and discharge moments, and moments
resulting from forces (ft.-lb)
𝐷𝑐 = diameter of one circular opening equal to the total areas of the inlet, sidestream, and
discharge openings. If the equivalent nozzle diameter is greater than 9”, use a value
of Dc equal to (18 + Equivalent Diameter) / 3
(b) The components of these resultants shall not exceed:

Where
𝐹𝑥 =
𝐹𝑦 =
𝐹𝑧 =
𝑀𝑥 =
𝑀𝑦 =
𝑀𝑧 =

𝐹𝑥 = 92𝐷𝑐

𝑀𝑥 = 462𝐷𝑐

𝐹𝑦 = 231𝐷𝑐

𝑀𝑦 = 231𝐷𝑐

𝐹𝑧 = 185𝐷𝑐

𝑀𝑧 = 231𝐷𝑐

horizontal component of Fc parallel to the compressor shaft (lb)
vertical component of Fc (lb)
horizontal component of Fc at right angles to be compressor shaft (lb)
component of Mc around the horizontal axis (ft-lb)
component of Mc around the vertical axis (ft-lb)
component of Mc around the horizontal axis at right angles to the compressor (ft-lb)
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Z: Perpendicular to compressor shaft

X: Parallel to compressor shaft
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Flange Qualification
Notation based on ASME Section VIII, Division 1, Appendix 2 (2013)

The symbols described below are used in the formulas for the design of flanges
𝐴 = outside diameter of flange
𝐴𝑏 = cross-sectional area of the bolts using the root diameter of the thread
𝐴𝑚 = total required cross-sectional area of bolts taken as greater of 𝐴𝑚1 and 𝐴𝑚2
𝐴𝑚1 = total cross-sectional area of bolts at root of thread or section of least diameter under
stress, required for the operating conditions
𝑊𝑚1
𝑆𝑏
𝐴𝑚2 = total cross-sectional area of bolts at root of thread or section of least diameter under
stress
𝑊𝑚2
=
𝑆𝑎
𝐵 = inside diameter of flange
𝐵′ = inside diameter of reverse flange
𝑏
= effective gasket or joint-contact-surface seating width
𝑏0 = basic gasket seating width (from Table 2-5.2)
𝐶 = bolt-circle diameter
𝑐
= basic dimension used for the minimum sizing of welds
𝐹
𝑒
= factor =
=

ℎ𝑜
𝑈

𝑑

= factor = 𝑉 ℎ𝑜 𝑔02 for integral type flanges

𝑑

= factor =𝑉 ℎ𝑜 𝑔02 for loose type flanges

𝑒

= factor =ℎ for integral type flanges

𝑐

𝑈

𝐿

𝐹

𝑜

𝐹𝐿

= factor =ℎ for loose type flanges
𝑜

= factor for integral type flanges (from Fig. 2-7.2)
𝐹𝐿 = factor for loose type flanges (from Fig. 2-7.4)
𝑓 = hub stress correction for integral flanges from Fig. 2-7.6 (when greater than one, this
is the ratio of the stress in the small end of hub to the stress in the large end), (for
values below limit of figure, use f = 1.)
𝐺 = diameter at location of gasket load reaction
𝑔0 = thickness of hub at small end
𝑔1 = thickness of hub at back of flange
𝐻 = total hydrostatic end force = 0.785𝐺 2 𝑃
𝐻𝐷 = hydrostatic end force on area inside of flange =0.785𝐵2 𝑃
𝐻𝐺 = gasket load (difference between flange design bolt load and total hydrostatic end
force) = W – H
𝐻𝑃 = total joint-contact surface compression load = 2b x 3.14 𝐺𝑚 𝑃
𝐻𝑇 = difference between total hydrostatic end force and the hydrostatic end force on area
inside of flange = 𝐻 − 𝐻𝐷
ℎ = hub length
𝐹
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ℎ𝐷 = radial distance from the bolt circle, to the circle on which HD acts, as prescribed in
Table 2-6
𝐶−𝐺
ℎ𝐺 = radial distance from gasket load reaction to the bolt circle =
2

ℎ𝑂 = factor = √𝐵𝑔0
ℎ 𝑇 = distance from the bolt circle, to the circle on which 𝐻𝑇 acts, as prescribed in Table
2-6
𝐾 = ratio of outside diameter of flange to inside diameter of flange = A / B
𝐿
𝑀𝐷
𝑀𝐺
𝑀𝑇
𝑀𝑂

=
=
=
=
=

(𝑡 +1)

𝑡3

factor = 𝑒𝑇 + 𝑑
component of moment due to 𝐻𝐷 = 𝐻𝐷 ℎ𝐷
component of moment due to 𝐻𝐺 = 𝐻𝐺 ℎ𝐺
component of moment due to 𝐻𝑇 = 𝐻𝑇 ℎ 𝑇
total moment acting upon the flange for the operating conditions or gasket seating as
may apply
(𝐶−𝐺)

𝑀𝑂 = 𝑊 2 for gasket seating condition
𝑀𝑂 = 𝐻𝐷 ℎ𝐷 + 𝐻𝐺 ℎ𝐺 + 𝐻𝑇 ℎ 𝑇 for operating condition
𝑁 = width used to determine the basic gasket seating with 𝑏0 , based upon the possible
contact width of the gasket (see Table 2-5.2)
𝑃 = internal design pressure
𝑅 = radial distance from bolt circle to point of intersection of hub and back of flange. For
integral and hub flanges, R = (C-B / 2) – g1
𝑆𝑎 = allowable bolt stress at reference temperature
𝑆𝑏 = allowable bolt stress at design temperature
𝑆𝑓 = allowable stress for material of flange at design temperature (operating condition)
𝑆𝐻 = calculated longitudinal stress in hub
𝑆𝑅 = calculated radial stress in flange
𝑆𝑇 = calculated tangential stress in flange
𝑇 = factor involving K (from Fig. 2-7.1)
𝑡 = flange thickness
𝑈 = factor involving K (from Fig. 2-7.1)
𝑉 = factor for integral type flanges (from Fig. 2-7.3)
𝑉𝐿 = factor for loose type flanges (from Fig. 2-7.5)
𝑊 = flange design bolt load, for the operating condition or gasket seating
= 𝑊𝑚1 for operating condition
(𝐴 +𝐴 )𝑆

= 𝑚 2 𝑏 𝑎 for gasket seating condition
𝑊𝑚1 = minimum required bolt load for the operating conditions
𝑊𝑚1 = minimum required bolt load for gasket seating
𝑤 = nubbin width used to determine the basic gasket seating width 𝑏0 , based on contact
width between the flange and the gasket (see Table 2-5.2)11
𝑌 = factor involving K (from Fig. 2-7.1)
𝑦 = gasket or joint-contact-surface unit seating load
𝑍 = factor involving K (from Fig. 2-7.1)
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Calculation of Flange Stresses

The stresses in the flange shall be determined for both the operating conditions and gasket
seating condition, in accordance with the following formulas:
(1) Integral type flanges
𝑓𝑀

Longitudinal hub stress 𝑆𝐻 = 𝐿𝑔2𝑂𝐵 < 1.5𝑆𝑓
1

Radial flange stress 𝑆𝑅 =

(1.33𝑡𝑒+1)𝑀𝑂
𝐿𝑡 2 𝐵

Tangential flange stress 𝑆𝑇 =

𝑌𝑀𝑂
𝑡2𝐵

< 𝑆𝑓

− 𝑍𝑆𝑅 < 𝑆𝑓

Combined stress
𝑆𝐻 +𝑆𝑅
< 𝑆𝑓 and
2
𝑆𝐻 + 𝑆𝑇
< 𝑆𝑓
2
(2) Loose type flanges with hubs
𝑓𝑀

Longitudinal hub stress 𝑆𝐻 = 𝐿𝑔2𝑂𝐵 < 1.5𝑆𝑓
1

Radial flange stress 𝑆𝑅 =

(1.33𝑡𝑒+1)𝑀𝑂
𝐿𝑡 2 𝐵

< 𝑆𝑓

𝑌𝑀

Tangential flange stress 𝑆𝑇 = 𝑡 2 𝐵𝑂 − 𝑍𝑆𝑅 < 𝑆𝑓
Combined stress
𝑆𝐻 +𝑆𝑅
2
𝑆𝐻 +

2

< 𝑆𝑓 and
𝑆𝑇
< 𝑆𝑓

where,
(𝑡𝑒+1)

𝑡3

𝐿

= factor =

𝑑

= factor = 𝑉 ℎ𝑜 𝑔02 for integral type flanges

𝑒

𝑇

+

𝑑

𝑈

𝐿

𝐹𝐿

= factor =ℎ

𝑜

𝑉𝐿 = factor for loose type flanges (from Fig. 2-7.5)
𝐹𝐿 = factor for loose type flanges (from Fig. 2-7.4)
(3) Loose type flanges without hubs
Longitudinal hub stress 𝑆𝐻 = 0
Radial flange stress 𝑆𝑅 = 0
𝑌𝑀
Tangential flange stress 𝑆𝑇 = 𝑡 2 𝐵𝑂 < 𝑆𝑓
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Combined stress
𝑆𝐻 +𝑆𝑅
2

< 𝑆𝑓 and

𝑆𝐻 + 𝑆𝑇
< 𝑆𝑓
2
where,

𝐿

(te  1) t 3

d
= factor = T

𝑑

= factor =

U
h0 g 02
VL

𝑒

= factor =

FL
ho

𝑉𝐿 = factor for loose type flanges (from Fig. 2-7.5)
𝐹𝐿 = factor for loose type flanges (from Fig. 2-7.4)
(4) Optional type flanges (calculated as loose flanges without hubs)
Longitudinal hub stress 𝑆𝐻 = 0
Radial flange stress 𝑆𝑅 = 0
𝑌𝑀
Tangential flange stress 𝑆𝑇 = 𝑡 2 𝐵𝑂 < 𝑆𝑓
Combined stress
𝑆𝐻 +𝑆𝑅
2

< 𝑆𝑓 and

𝑆𝐻 + 𝑆𝑇
< 𝑆𝑓
2
where,

𝐿

(te  1) t 3

d
= factor = T

𝑑

= factor =

U
h0 g 02
VL

𝑒

= factor =

FL
ho

𝑉𝐿 = factor for loose type flanges (from Fig. 2-7.5)
𝐹𝐿 = factor for loose type flanges (from Fig. 2-7.4)
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(5) Reverse type flanges
Longitudinal hub stress 𝑆𝐻 = 𝐿

𝑓𝑀𝑂

2
𝑟 𝑔1 𝐵′

Radial flange stress 𝑆𝑅 =

< 1.5𝑆𝑓

(1.33𝑡𝑒𝑟 +1)𝑀𝑂
𝐿𝑟 𝑡 2 𝐵′
𝑌𝑀

< 𝑆𝑓
0.67𝑡𝑒 +1

Tangential flange stress 𝑆𝑟 = 𝑡 2 𝐵𝑂 − 𝑍𝑆𝑅 1.33𝑡𝑒𝑟 +1 < 𝑆𝑓
𝑟

Combined stress
𝑆𝐻 +𝑆𝑅
2
𝑆𝐻 +

2

< 𝑆𝑓 and
𝑆𝑇
< 𝑆𝑓

where,
𝐿𝑟 = factor =

(𝑡𝑒𝑟 +1)

𝑑𝑟 = factor =

𝑈𝑟

𝑇

𝑡3

+𝑑

𝑟

ℎ 𝑔2
𝑉 𝑜 0
𝐹

𝑒𝑟 = factor = ℎ

𝑜

ℎ𝑜 = factor =√𝐴𝑔0
𝛼𝑟 =

1+0.668

(𝐾+1)
𝑌

𝐾2
𝑍+0.3

𝑇𝑟 = 𝑍−0.3 𝛼𝑟 𝑇
𝑈𝑟 = 𝛼𝑌 𝑈
𝑌𝑟 = 𝛼𝑌 𝑌
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Problem 1:

(Example from “Taylor Forge & Pipe Works, 1961”)
Flange Details:
Flange Type : Loose Flanges with Hubs
Flange Outside Diameter [A] = 40.375 (inch)
Flange Inside Diameter [B] = 33.25 (inch)
Inside Diameter of Reverse Flange [B'] = 20 (inch)
Flange Thickness [t] = 2.125 (inch)
Small End Hub Thickness [g0] = 0.875 (inch)
Large End Hub Thickness [g1] = 1.125 (inch)
Hub Length [h] = 2.5 (inch)
All. Stress @ Design Temp [sf] = 17500 (psi)
All. Stress @ Ref. Temp [sfa] = 17500 (psi)
Modulus @ Design Temp [E] = 2.7E+7 (psi)
Modulus @ Ref. Temp [Ea] = 2.92E+7 (psi)
Bolting Information:
Bolt Circle Diameter = 38.25 (inch)
Number of Bolts = 44
Bolt Diameter = 1 (inch)
All. Stress @ Ref. Temp [sa] = 20000 (psi)
All. Stress @ Design Temp [sb] = 20000 (psi)
Gasket Information:
Gasket Outside Diameter = 35.75 (inch)
Gasket Inner Diameter = 34.25 (inch)
Leak Pressure Ratio [m] = 2.75
Gasket Seating Stress [y] = 3700 (psi)
Facing Sketch = 1
Facing Column = 1
Load Data:
Design Pressure = 400 (psi)
Design Temperature = 500 (F)
Axial Force = 1000 (lb)
Bending Moment = 200 (ft-lb)
Allowable Pressure = 665 (psi)
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Comparison of Results:
Flange Stresses
Operating condition
Longitudinal Hub (SH)
Radial Flange (SR)
Tangential Flange (ST)
0.5(SH + SR)
0.5(SH + ST)
Gasket Seating Condition
Longitudinal Hub (SH)
Radial Flange (SR)
Tangential Flange (ST)
0.5(SH + SR)
0.5(SH + ST)

Text Book Results CAEPIPE
(psi)
(psi)

CAESAR II
(psi)

20800
11100
13800
15950
17300

21153
11110
13826
16132
17489

21214
11155
13797
16185
17506

14400
7660
9500
11030
11950

14623
7681
9558
11152
12091

15095
7938
9818
11517
12457

Problem 2:
(Example 10.5 on page 209 Chapter 10 on “CASTI Guidebook to ASME Section VIII Div.1
– Pressure Vessels – Third Edition”)
Flange Details:
Flange Type : Reverse Flanges
Flange Outside Diameter [A] = 49 (inch)
Flange Inside Diameter [B] = 48.25 (inch)
Inside Diameter of Reverse Flange [B'] = 20.25 (inch)
Flange Thickness [t] = 5.25 (inch)
Small End Hub Thickness [g0] = 0.375 (inch)
Large End Hub Thickness [g1] = 1.375 (inch)
Hub Length [h] = 6 (inch)
All. Stress @ Design Temp [sf] = 12000 (psi)
All. Stress @ Ref. Temp [sfa] = 20000 (psi)
Modulus @ Design Temp [E] = 2.7E+7 (psi)
Modulus @ Ref. Temp [Ea] = 2.92E+7 (psi)
Bolting Information:
Bolt Circle Diameter = 44 (inch)
Number of Bolts = 32
Bolt Diameter = 1.25 (inch)
All. Stress @ Ref. Temp [sa] = 25000 (psi)
All. Stress @ Design Temp [sb] = 21000 (psi)
Gasket Information:
Gasket Outside Diameter = 24 (inch)
Gasket Inner Diameter = 22 (inch)
Leak Pressure Ratio [m] = 2.50
Gasket Seating Stress [y] = 10000 (psi)
Facing Sketch = 1
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Facing Column = 1
Load Data:
Design Pressure = 150 (psi)
Design Temperature = 800 (F)
Axial Force = 1000 (lb)
Bending Moment = 200 (ft-lb)
Allowable Pressure = 665 (psi)
Comparison of Results:
Flange Stresses
Operating condition
Longitudinal Hub (SH)
Radial Flange (SR)
Tangential Flange (ST)
0.5(SH + SR)
0.5(SH + ST)
Gasket Seating Condition
Longitudinal Hub (SH)
Radial Flange (SR)
Tangential Flange (ST)
0.5(SH + SR)
0.5(SH + ST)

Text Book Results CAEPIPE
(psi)
(psi)

CAESAR II
(psi)

2060
280
1340
1170
1700

2257
307
1314
1282
1785

2055
280
1336
1168
1695

9220
1260
6000
5240
7610

10082
1372
7004
5727
8543

9220
1257
5997
5239
8703

Problem 3:
(Example from KEDKEP CONSULTING, INC. dated May 27, 2008)
Flange Details:
Flange Type : Loose Flanges without Hubs / Optional Flanges
Flange Outside Diameter [A] = 38.4 (inch)
Flange Inside Diameter [B] = 32 (inch)
Inside Diameter of Reverse Flange [B'] = 32 (inch)
Flange Thickness [t] = 4 (inch)
Small End Hub Thickness [g0] = 0.001 (inch)
Large End Hub Thickness [g1] = 0.001 (inch)
Hub Length [h] = 0.001 (inch)
All. Stress @ Design Temp [sf] = 20000 (psi)
All. Stress @ Ref. Temp [sfa] = 20000 (psi)
Modulus @ Design Temp [E] = 2.7E+7 (psi)
Modulus @ Ref. Temp [Ea] = 2.92E+7 (psi)
Bolting Information:
Bolt Circle Diameter = 36 (inch)
Number of Bolts = 28
Bolt Diameter = 1 (inch)
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All. Stress @ Ref. Temp [sa] = 25000 (psi)
All. Stress @ Design Temp [sb] = 25000 (psi)
Gasket Information:
Gasket Outside Diameter = 32.75 (inch)
Gasket Inner Diameter = 32 (inch)
Leak Pressure Ratio [m] = 0.50
Gasket Seating Stress [y] = 0 (psi)
Facing Sketch = 2
Facing Column = 2
Load Data:
Design Pressure = 300 (psi)
Design Temperature = 295 (F)
Axial Force = 1000 (lb)
Bending Moment = 200 (ft-lb)
Allowable Pressure = 665 (psi)
Comparison of Results:
Flange Stresses
Operating Condition
Longitudinal Hub (SH)
Radial Flange (SR)
Tangential Flange (ST)
0.5(SH + SR)
0.5(SH + ST)
Bolt Stress
Gasket Seating Condition
Longitudinal Hub (SH)
Radial Flange (SR)
Tangential Flange (ST)
0.5(SH + SR)
0.5(SH + ST)
Bolt Stress

Text Book Results
(psi)

CAEPIPE
(psi)

CAESAR
II
(psi)

0
0
10577
0
0
16378

0
0
10569
0
0
16371

3
0
10618
1.5
5310.5
16445

0
0
12147
0
0
0

0
0
11987
0
0
0

3
0
12166
1.5
6085
124
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Pressure Design of Pipe & Pipe Fittings
as per EN 13480-3 (2017)

Pressure Design of Pipe & Pipe fittings according to SS EN 13480-3 (2017)
Internal pressure according to SS EN 13480-3 (2017)
Straight Pipes

The minimum required wall thickness for a straight pipe without allowances and tolerances,
ep, is calculated from equation 6.1-1 and 6.1-3 depending on the ratio between inner and
outer diameter as follows:
For Do/Di<= 1.7
ep =

Pc D0
2fz + Pc

For Do/Di> 1.7
ep =

Do
fz − pc
[1 − √
]
2
fz + pc

where,
Do = outside diameter of pipe
Di = inside diameter of pipe = Do – 2 x en
en = nominal wall thickness of pipe
f = Allowable stress for material at maximum temperature
z = weld efficiency factor = 1.0
pc = maximum internal pressure = maximum of CAEPIPE input pressures P1 through P10
ep = minimum required wall thickness

Elbows

The minimum required wall thickness of the intrados and the extrados of the elbow without
allowances and tolerances, ep1 / ep2, is calculated from equation B.4.1-3
ep1 = ep2 = e.B
D0 R
D0 R 2
R D0
√
B=
− + [ − ] +2 −
2e e
2e e
e 2e
where
Do = outside diameter of elbow
e = minimum required wall thickness of corresponding straight pipe computed as per Eq.
6.1-1 or 6.1-3
R = radius of the elbow
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ep1 = ep2 = minimum required wall thickness of the elbow
Bends (formed by cold bending of straight pipes)

Wall thickness of the intrados of the bend
The minimum required wall thickness of the intrados of the bend without allowances and
tolerances, ep1, is calculated from equation B.4.1-1
ep1 = e .Bint

Bint =

D0 r
Do r
+ − [ + − 1] √
2e e
2e e

r 2

D

(e) − ( 2eo)
r 2

D

2

D

(e) − 2eo ( 2eo − 1)

r/e is calculated from
2

r
1 Do 2
R 2
1 Do 2
R 2
Do Do
R 2
√
=
{( ) + ( ) } + √ (( ) + ( ) ) −
( − 1) ( )
e
2 2e
e
4 2e
e
2e 2e
e
where
Do = outside diameter of bend
Di = inside diameter of bend = Do – 2 x en
e = minimum required wall thickness of corresponding straight pipe computed as per Eq.
6.1-1 or 6.1-3
R = radius of the bend
ep1 = minimum required wall thickness of the intrados
Wall thickness of the extrados of the bend
The minimum required wall thickness of the extrados of the bend without allowances and
tolerances, ep2, is calculated from equation B.4.1-8
ep2 = e .Bext
r 2

Bext =

D

(e) − ( 2eo)

2

D0 r
Do r
− − [ − − 1] √ 2
r
D
D
2e e
2e e
(e) − 2eo ( 2eo − 1)

r/e is calculated from
2

r
1 Do 2
R 2
1 Do 2
R 2
Do Do
R 2
√
=
{( ) + ( ) } + √ (( ) + ( ) ) −
( − 1) ( )
e
2 2e
e
4 2e
e
2e 2e
e
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where
Do = outside diameter of bend
Di = inside diameter of bend = Do – 2 x en
e = minimum required wall thickness of corresponding straight pipe computed as per Eq.
6.1-1 or 6.1-3
R = radius of the bend
ep2 = minimum required wall thickness of the extrados
Reducers

Junction between the large end of a cone and a cylinder without a knuckle
The minimum required wall thickness (e1) of the larger cylinder adjacent to the junction is
calculated from Subsection 6.4.6.2 as the greater of ecyl and ej where ej is determined from
1 Dc tan ∝
β= √
− 0.15
3 ej 1 + 1

(Eq. 6.4.6 − 2)

√cos∝

ej =

pcβDc
2f

(Eq. 6.4.6 − 1)

The value of ej is acceptable, if the value given by Eq. 6.4.6-1 is not less than that assumed in
Eq. 6.4.6-2
econ =

pc De
1
2fZ + pc COS(α)

(Eq. 6.4.4 − 2)

p D

c 01
ecyl = 2fZ+p

c

e1 = thickness of larger cylinder = max(ej , ecyl )
e3 = thickness of cone shell = max(ej , econ )
where
De = outside diameter of the cone
D01 = outside diameter of the larger cylinder
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D02 = outside diameter of the small cylinder
Dc = mean diameter of the larger cylinder at the junction with the cone = D 01 - en
en = nominal wall thickness of the larger cylinder at the junction with the cone
∝ = cone angle
e1 = minimum required wall thickness for larger cylinder adjacent to the junction.
e3 = minimum required wall thickness at cone.
f = Allowable stress for material at maximum temperature
pc = maximum internal pressure = maximum of CAEPIPE input pressures P1 through P10
Z = weld efficiency factor = 1.0
Junction between the small end of a cone and a cylinder without a knuckle
The minimum required wall thickness (e2) of the small cylinder adjacent to the junction is
calculated according to Subsection 6.4.8.2 as follows.
s=

e3
ej2

With e3 already determined in the earlier section, assume value of ej2 and calculate the values
of s, τ and βH
When s < 1.0, then
τ = s√

s
1 + s2
+√
cos ∝
2

When s >= 1.0, then
τ = 1 + √s

Dc tan ∝
βH = 0.4√
+ 0.5
ej2 τ
ej2 =

pc Dc βH
2fZ

1 + s2
2cos ∝

(Eq. 6.4.8 − 4)

(Eq. 6.4.8 − 5)
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The value of ej2 is acceptable, if the value given by Eq. 6.4.8-5 is not less than that assumed
for Eq. 6.4.8-4
ecyl =

pc D02
2fZ + pc

e2 = max(ej2 , ecyl )
where
D02 = outside diameter of the small cylinder at the junction with the cone
Dc = mean diameter of the small cylinder at the junction with the cone = D 02 - en
en = nominal wall thickness of the small cylinder at the junction with the cone
∝ = cone angle
e2 = minimum required wall thickness of the small cylinder at the junction with the cone
f = Allowable stress for material at maximum temperature
pc = maximum internal pressure = maximum of CAEPIPE input pressures P1 through P10
Z = weld efficiency factor = 1.0
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External Pressure Design according to SS EN 13480-3 (2017)
Pipes, Elbows, Mitre Bends and Reducers

Interstiffener collapse
The thickness of the pipe within the unstiffened length L shall not be less than that
determined by the following.
Pr ≥ k. Pc
Py =
Pm =

ε=

1
2
𝑛𝑐𝑦𝑙
−1+

1
Z2
2

{

(

2
𝑛𝑐𝑦𝑙
Z2

Sea
Rm

Et ea ε
Rm

2+

+ 1)

ea2
12R m2(1−v2)

2
(𝑛𝑐𝑦𝑙
− 1 + Z2 )

2

}

Z=

πR m
L

using the calculated value of Pm/Py, Pr/Py is determined from Table 9.3.2.1 of Subsection
9.3.2
where
ncyl = integer >= 2 to minimize the value of Pm.
CAEPIPE goes through an iterative routine by increasing the value of ncyl from 2 and above
until the minimum collapse pressure (pm) is reached.
Rm = mean radius of the pipe
L = length between the stiffener, is calculated from CAEPIPE input as follows
for Pipe, L = length of pipe (= distance between the “From” and “To” node of CAEPIPE)
for Elbow and Miter bend, L = arc length measured on extrados of elbow and miter bend
for Reducer, L = Length of the reducer
Et = Young’s modulus of material at design temperature (max of CAEPIPE Temperature T1
through T10)
ea = analysis thickness of reducer at smaller end = en – corr.all – mill tolerance
en = nominal thickness of reducer at smaller end
k = factor = 1.5
Pc = external pressure = maximum negative CAEPIPE input pressures P1 through P10
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S = elastic stress limits for pipe and stiffener for External Pressure Design
= “Rp0.2t” for non-austenitic steels
= “Rp0.2t/1.25” for austenitic steels
Note:
Generally, allowable stress is (2/3) x Yield. So, for Piping code = EN 13480-3, the value of
Rp0.2t is computed as “Rp0.2t = f x 1.5”
For all other Piping Codes, the value of Rp0.2t is computed as “Rp0.2t = allowable stress x
1.5”.
Additional check for Reducers

In addition to the above, as stated in Subsection 9.4.2 of EN 13480-3, the moment of inertia,
Ix taken parallel to the axis of the cylinder, of the part of the cone and cylinder with a
distance of √Deq . e on either side of the junction is not less than:
Ix = 0.18Deq LD2s

pc
≤ Ixa
Et

where
Deq = equivalent diameter =

D1+D2
2

cos(α)

D1 = outside diameter of larger end of reducer
D2 = outside diameter of smaller end of reducer
α =cone angle of reducer input in CAEPIPE
Ixa = moment of inertia of reducer at smaller end
Ds = diameter of the centroid of the moment of inertia of the stiffening cross section
calculated as shown below
Icone

Dmcon 2
Dmcon 2
(
)
= (√Deq e1 . e1 ) (
) = Acone (
)
2
2

ICyl = (√Deq e2 . e2 ) (

Istiff

Dmcyl 2
Dmcyl 2
) = (Acyl ) (
)
2
2

Ds 2
= (Acone + Acyl ) ( )
2

From the above,
Icone + ICyl = Istiff
and
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Istiff
Ds = 2√
(Acone + Acyl )

e1 = analysis thickness of reducer at larger end = en1 – corr.all – mill tolerance
e2 = analysis thickness of reducer at smaller end = en2 – corr.all – mill tolerance
en1& en2 = nominal thickness of reducer at larger end and smaller end respectively
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Rectangular Cross-section Welded Attachments

The notations described below are used in the formulas for the design.
𝐿1=half length of attachment in circumferential direction of the run pipe
𝐿2= half length of attachment in longitudinal direction of the run pipe
𝑅= mean pipe radius
𝐷𝑜 =outside diameter of run pipe

𝑇= nominal run pipe wall thickness
𝐿𝑎 = lesser of L2 and T
𝐿𝑏 = lesser of L1 and T
𝐿𝑐 = lesser of L1 and L2
𝐿𝑑 = greater of L1 and L2
𝐴 𝑇 = 4. 𝐿1 . 𝐿2 = cross-sectional area of the rectangular attachment
4
𝑍𝑡𝐿 = ( ) . 𝐿1 . 𝐿2 2
3
4
𝑍𝑡𝑁 = ( ) . 𝐿1 2 . 𝐿2
3
𝐿1
𝛽1 =
𝑅
𝐿2
𝛽2 =
𝑅
𝑅
𝛾=
𝑇
Limits of Applicability

𝜷𝟏 ≤ 𝟎. 𝟓
𝜷𝟐 ≤ 𝟎. 𝟓
𝜷𝟏 . 𝜷𝟐 ≤ 𝟎. 𝟕𝟓

𝑀𝐿 = bending moment applied to the attachment as shown in figure above
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𝑀𝑁
𝑀𝑇
𝑄1
𝑄2
W

= bending moment applied to the attachment as shown in figure above
= torsional moment applied to the attachment as shown in figure above
= shear load applied to the attachment as shown in figure above.
= shear load applied to the attachment as shown in figure above
= thrust load applied to the attachment as shown in figure above

ML, MN, MT, Q1, Q2 and W are determined at the surface of the pipe. The values of
attachment loads used in the stress calculation are based on the loads used in the different
code equations.
ML**, MN**, MT**, Q1**, Q2** and W** are absolute values of maximum loads occurring
simultaneously under all service loading conditions.
Calculate 𝜼, 𝑿𝟏 𝒂𝒏𝒅 𝒀𝟏 using the factors listed in Table below.
Load
Thrust (W)
Longitudinal Moment (ML)
Circumferential Moment (MN)

Index
CW
CL
CN

Ao
2.2
2.0
1.8

𝜃
400
500
400

𝑋𝑜
0
-0.45
-0.75

𝑌𝑜
0.05
-0.55
-0.60

𝑋1 = 𝑋𝑜 + 𝑙𝑜𝑔10 𝛽1
𝑌1 = 𝑌𝑜 + 𝑙𝑜𝑔10 𝛽2
𝜂 = −(𝑋1 𝐶𝑜𝑠𝜃 + 𝑌1 𝑆𝑖𝑛𝜃) −

1
(𝑋 𝑆𝑖𝑛𝜃 − 𝑌1 𝐶𝑜𝑠𝜃)2
𝐴𝑜 1

𝐶𝑊 = 3.82(𝛾)1.64 𝛽1 𝛽2 𝜂1.54 but not less than 1.0
𝐶𝐿 = 0.26(𝛾)1.74 𝛽1 𝛽2 2 𝜂4.74 but not less than 1.0
𝐶𝑁 = 0.38(𝛾)1.90 𝛽1 2 𝛽2 𝜂3.40 but not less than 1.0
= (2/3) CL but not less than 1.0
= (2/3) CN but not less than 1.0
= (2/3) CW but not less than 1.0
= 2.0 for full penetration weldsandfillet or partial penetration welds welded on 4 sides
= 3.6 for fillet or partial penetration welds welded on 2 or 3 sides
SA= f(1.25Sc+0.25Sh) as defined in NC/ND-3611.2 (lesser of pipe or attachment material allowable)
Sc= allowable stress at ambient temperature (lesser of pipe or attachment material allowable)
Sh= allowable stress at Max. Temperature (lesser of pipe or attachment material allowable)
Sy= yield stress (lesser of pipe or attachment material yield stress)
𝐵𝐿
𝐵𝑁
𝐵𝑊
𝐾𝑇

(A) Calculate Pipe Stress SMTS due to Sustained Loads on Attachment
𝑀𝑇𝑆
𝑀𝑇𝑆
)
𝑀𝑇𝑇𝑆 = 𝑚𝑎𝑥 (
;
𝐿𝑐
𝐿
𝐿𝑐 𝐿𝑑 𝑇 [1 + (𝐿 )] [0.8 + 0.05 ( 𝐿𝑑 )] 𝐿𝑐 2 𝐿𝑑
𝑐

𝑑

𝑆𝑀𝑇𝑆 =

𝐵𝑊 𝑊𝑆 𝐵𝑁 𝑀𝑁𝑆 𝐵𝐿 𝑀𝐿𝑆
𝑄1𝑆
𝑄2𝑆
+
+
+
+
+ 𝑀𝑇𝑇𝑆
𝐴𝑇
𝑍𝑡𝑁
𝑍𝑡𝐿
2𝐿1 𝐿𝑎 2𝐿2 𝐿𝑏
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where
WS, Q1S and Q2S are the thrust load and shear forces applied at the attachment due to Weight
and Other Sustained Loads
MTS, MLS and MNS are the torsional moment and bending moments applied at the attachment
due to Weight and Other Sustained Loads
Note: Absolute values of Forces and Moments are used while calculating SMTS
Stresses.
(B) Calculate PipeStress SMTO due to Occasional Loads on Attachment
𝑀𝑇𝑂
𝑀𝑇𝑂
)
𝑀𝑇𝑇𝑂 = 𝑚𝑎𝑥 (
;
𝐿𝑐
𝐿
𝐿𝑐 𝐿𝑑 𝑇 [1 + (𝐿 )] [0.8 + 0.05 ( 𝐿𝑑 )] 𝐿𝑐 2 𝐿𝑑
𝑐

𝑑

𝑆𝑀𝑇𝑂 =

𝐵𝑊 𝑊𝑜 𝐵𝑁 𝑀𝑁𝑂 𝐵𝐿 𝑀𝐿𝑂
𝑄1𝑂
𝑄2𝑂
+
+
+
+
+ 𝑀𝑇𝑇𝑂
𝐴𝑇
𝑍𝑡𝑁
𝑍𝑡𝐿
2𝐿1 𝐿𝑎 2𝐿2 𝐿𝑏

where
WO, Q1O and Q2O are the thrust load and shear forces applied at the attachment due to
Occasional Loads such as Wind or Seismic
MTO, MLO and MNO are the torsional moment and bending moments applied at the
attachment due to Occasional Loads such as Wind or Seismic
Note: Absolute values of Forces and Moments are used while calculating SMTO
Stresses.
(C) Calculate PipeStresses SNTE and SPTE due to Thermal Loads on Attachment
𝑀𝑇𝐸
𝑀𝑇𝐸
)
𝑀𝑇𝑇𝐸 = 𝑚𝑎𝑥 (
;
𝐿
𝐿
𝐿𝑐 𝐿𝑑 𝑇 [1 + (𝐿 𝑐 )] [0.8 + 0.05 ( 𝐿𝑑 )] 𝐿𝑐 2 𝐿𝑑
𝑐

𝑑

𝑆𝑁𝑇𝐸 =

𝐶𝑊 𝑊𝐸 𝐶𝑁 𝑀𝑁𝐸 𝐶𝐿 𝑀𝐿𝐸
𝑄1𝐸
𝑄2𝐸
+
+
+
+
+ 𝑀𝑇𝑇𝐸
𝐴𝑇
𝑍𝑡𝑁
𝑍𝑡𝐿
2𝐿1 𝐿𝑎 2𝐿2 𝐿𝑏

𝑆𝑃𝑇𝐸 = 𝐾𝑇 . 𝑆𝑁𝑇𝐸
where
WE, Q1E and Q2E are the thrust load and shear forces applied at the attachment due to
Thermal Loads
MTE, MLE and MNE are the torsional moment and bending moments applied at the
attachment due to Thermal Loads
Note: Absolute values of Forces and Moments are used while calculating SNTE
Stresses.
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(D) Calculate PipeStresses SNTD and SPTD due to Settlement Loads on Attachment
𝑀𝑇𝐷
𝑀𝑇𝐷
)
𝑀𝑇𝑇𝐷 = 𝑚𝑎𝑥 (
;
𝐿𝑐
𝐿
𝐿𝑐 𝐿𝑑 𝑇 [1 + (𝐿 )] [0.8 + 0.05 ( 𝐿𝑑 )] 𝐿𝑐 2 𝐿𝑑
𝑐

𝑑

𝑆𝑁𝑇𝐷 =

𝐶𝑊 𝑊𝐷 𝐶𝑁 𝑀𝑁𝐷 𝐶𝐿 𝑀𝐿𝐷
𝑄1𝐷
𝑄2𝐷
+
+
+
+
+ 𝑀𝑇𝑇𝐷
𝐴𝑇
𝑍𝑡𝑁
𝑍𝑡𝐿
2𝐿1 𝐿𝑎 2𝐿2 𝐿𝑏

𝑆𝑃𝑇𝐷 = 𝐾𝑇 . 𝑆𝑁𝑇𝐷
where
WD, Q1D and Q2D are the thrust load and shear forces applied at the attachment due to
Settlement Loads
MTD, MLD and MND are the torsional moment and bending moments applied at the
attachment due to Settlement Loads
Note: Absolute values of Forces and Moments are used while calculating SNTD
Stresses.
(E) Calculate PipeStresses SMTR and SPTR due to Sustained + Thermal Loads
SMTR = Stress SMTS calculated in Subsection A above
SPTR = Stress SPTE calculated in Subsection C above
(F) Calculate Attachment Stresses: SNT** due to Abs. Max. Loads
𝑀𝑇𝑇

∗∗

𝑀𝑇 ∗∗

𝑀𝑇 ∗∗

)
= 𝑚𝑎𝑥 (
;
𝐿
𝐿
𝐿𝑐 𝐿𝑑 𝑇 [1 + (𝐿 𝑐 )] [0.8 + 0.05 ( 𝐿𝑑 )] 𝐿𝑐 2 𝐿𝑑
𝑐

𝑑

𝑆𝑁𝑇 ∗∗ =

𝐶𝑊 𝑊 ∗∗ 𝐶𝑁 𝑀𝑁 ∗∗ 𝐶𝐿 𝑀𝐿 ∗∗
𝑄1 ∗∗
𝑄2 ∗∗
+
+
+
+
+ 𝑀𝑇𝑇 ∗∗
𝐴𝑇
𝑍𝑡𝑁
𝑍𝑡𝐿
2𝐿1 𝐿𝑎 2𝐿2 𝐿𝑏

Analysis of Attachment Welded to Pipe with a Full Penetration Weld

Sustained Stress (SSL) = SL + SMTS≤ 1.5Sh
Occasional Stress (SSO) = SLO + SMTS + SMTO≤k.Sy
Thermal Stress (SSE) = SE + (SPTE / 2.0) ≤ SA
Settlement Stress (SSD) = SD + (SPTD / 2.0) ≤ 3.0Sh
Sustained + Thermal Stress (SSR) = STE + SMTR + (SPTR / 2.0) ≤ (Sh + SA)
Additional Check
SNT** ≤ 2.Sy
𝑄1 ∗∗
𝑄2 ∗∗
|
+
+ 𝑀𝑇𝑇 ∗∗ | ≤ 𝑆𝑌
2𝐿1 𝐿𝑎 2𝐿2 𝐿𝑏
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Analysis of Attachment Welded to Pipe with a Fillet or Partial Penetration Weld

Sustained Stress (SSL) = SL + SMTS≤ 1.5Sh
Occasional Stress (SSO) = SLO + SMTS + SMTO≤k.Sy
Thermal Stress (SSE) = SE + (SPTE / 2.0) ≤ SA
Settlement Stress (SSD) = SD + (SPTD / 2.0) ≤ 3.0Sh
Sustained + Thermal Stress (SSR) = STE + SMTR + (SPTR / 2.0) ≤ (Sh + SA)
Additional Check
|SNT**|≤ 2.Sy
𝑄1 ∗∗
𝑄2 ∗∗
|
+
+ 𝑀𝑇𝑇 ∗∗ | ≤ 𝑆𝑌
2𝐿1 𝐿𝑎 2𝐿2 𝐿𝑏
Note: Additional compliance check as per Eq. 7 and Eq. 8 of Y-3420 (b) are not
performed in CAEPIPE at this time
where,
k = 1.5 for Level A& B loadings, 1.8 for Level C loadings and 2.0 for Level D loadings
SL = Sustained Stress on Run Pipe as per NC-3652 Eq. (8)
SLO = Sustained + Occasional Stress on Run Pipe as per NC-3653.1 Eq. (9)
SE = Thermal Stress on Run Pipe as per NC-3653.2 Eq. (10)
SD = Settlement Stress on Run Pipe as per NC-3653.2 Eq. (10a)
STE = Sustained + Thermal Stress on Run Pipe as per NC-3653.2 Eq. (11)
SMTS = Pipe Stress SMTS computed in Subsection A above
SMTO = Pipe Stress SMTO computed in Subsection B above
SPTE = Pipe Stress SPTE computed in Subsection C above
SPTD = Pipe Stress SPTD computed in Subsection D above
SMTR = Pipe Stress SMTR computed in Subsection E above
SPTR = Pipe Stress SPTR computed in Subsection E above
SNT**= Pipe Stress SNT** computed in Subsection F above
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HollowCircular Cross-section Welded Attachments

The notations described below are used in the formulas for the design.
𝑅= mean run pipe radius
𝑅𝑜 = run pipe outside radius
𝑟𝑜 = attachment outside radius
𝑟𝑖 = attachment inside radius
𝐷𝑜 = outside diameter of run pipe
𝑑𝑜

= outside diameter of attachment

𝑇= nominal run pipe wall thickness
𝑡= nominal attachment wall thickness
𝐴 𝑇 = 𝜋(𝑟𝑜 2 − 𝑟𝑖 2 )= cross-sectional area of the circular attachment
𝜋
𝐼𝑇 = (𝑟𝑜 4 − 𝑟𝑖 4 )
4
𝐼𝑇
𝑍𝑇 =
𝑟𝑜
𝐽 = min(𝜋𝑟𝑜 2 𝑇, 𝑍𝑇 )
𝑅𝑜
𝑇
𝑑𝑜
𝛽=
𝐷𝑜
𝑡
𝜏=
𝑇
𝛾=

Limits of Applicability

𝟒. 𝟎 ≤ 𝜸 ≤ 𝟓𝟎

0.2 ≤ 𝜏 ≤ 1.0
0.3 ≤ 𝛽 ≤ 1.0
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𝑀𝐿
𝑀𝑁
𝑀𝑇
𝑄1
𝑄2
W

= bending moment applied to the attachment as shown in figure above
= bending moment applied to the attachment as shown in figure above
= torsional moment applied to the attachment as shown in figure above
= shear load applied to the attachment as shown in figure above.
= shear load applied to the attachment as shown in figure above
= thrust load applied to the attachment as shown in figure above

ML, MN, MT, Q1, Q2 and W are determined at the surface of the pipe. The values of
attachment loads used in the stress calculation are based on the loads used in the different
code equations.
ML**, MN**, MT**, Q1**, Q2** and W** are absolute values of maximum loads occurring
simultaneously under all service loading conditions.
𝐶 = 𝐴𝑜 (2𝛾)𝑛1 𝛽 𝑛2 𝜏 𝑛3 but not less than 1.0
Equation for C is used to determine CW, CL and CN based on the following Table. Maximum
values of CW, CL and CNamong the values calculated for the pipe and the attachment are used
subsequently.
Load
Thrust (W)

Index
CW

Part
Pipe
Attachment
Pipe
Attachment
Pipe
Attachment
Pipe
Attachment

Longitudinal
CL
Moment (ML)
Circumferential
CN
Moment (MN)
Circumferential
CN
Moment (MN)
3
(a) - Replace 𝛽 𝑛2 with 𝑒 −1.2𝛽
3
(b) - Replace 𝛽 𝑛2 with 𝑒 −1.35𝛽

𝛽 range
0.3 to1.0
0.3 to1.0
0.3 to1.0
0.3 to1.0
0.3 to 0.55
0.3 to 0.55
>0.55 to 1.0
>0.55 to 1.0

Ao
1.40
4.00
0.46
1.10
0.51
0.84
0.23
0.44

n1
0.81
0.55
0.60
0.23
1.01
0.85
1.01
0.85

n2
(a)
(b)
-0.04
-0.38
0.79
0.80
-0.62
-0.28

n3
1.33
1.00
0.86
0.38
0.89
0.54
0.89
0.54

𝐶𝑇 = 1.0 for 𝛽<= 0.55
= CN for 𝛽 = 1.0, but not less than 1.0;
CT should be linearly interpolated for 0.55 <= 𝛽< 1.0, but not less than 1.0
𝐵𝑊
𝐵𝐿
𝐵𝑁
𝐵𝑇
𝐾𝑇
SA
Sc
Sh
Sy

= 0.5 CW but not less than 1.0
= 0.5 CL but not less than 1.0
= 0.5 CN but not less than 1.0
= 0.5 CT but not less than 1.0
= 1.8 for full penetration welds
= 2.0 for fillet or partial penetration welds
= f(1.25Sc + 0.25Sh) as defined in NC/ND-3611.2 (lesser of pipe or attachment material allowable)
= allowable stress at ambient temperature (lesser of pipe or attachment material allowable)
= allowable stress at maximum temperature (lesser of pipe or attachment material allowable)
= yield stress (lesser of pipe or attachment material yield stress)
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ML, MN, MT, Q1, Q2 and W are determined at the surface of the pipe. The values of
attachment loads used in the stress calculation are based on the loads used in the different
code equations.
ML**, MN**, MT**, Q1**, Q2** and W** are absolute values of maximum loads occurring
simultaneously under all service loading conditions.
(A) Calculate PipeStress SMTS due to Sustained Loads on Attachment
𝑆𝑀𝑇𝑆 =

𝐵𝑊 𝑊𝑆 𝐵𝑁 𝑀𝑁𝑆 𝐵𝐿 𝑀𝐿𝑆 2𝑄1𝑆 2𝑄2𝑆 𝐵𝑇 𝑀𝑇𝑆
+
+
+
+
+
𝐴𝑇
𝑍𝑇
𝑍𝑇
𝐴𝑇
𝐴𝑇
𝐽

where
WS, Q1S and Q2S are the thrust load and shear forces applied at the attachment due to Weight
and Other Sustained Loads
MTS, MLS and MNS are the torsional moment and bending moments applied at the attachment
due to Weight and Other Sustained Loads
Note: Absolute values of Forces and Moments are used while calculating SMTS
Stresses.
(B) Calculate PipeStress SMTO due to Occasional Loads on Attachment
𝑆𝑀𝑇𝑂 =

𝐵𝑊 𝑊𝑂 𝐵𝑁 𝑀𝑁𝑂 𝐵𝐿 𝑀𝐿𝑂 2𝑄1𝑂 2𝑄2𝑂 𝐵𝑇 𝑀𝑇𝑂
+
+
+
+
+
𝐴𝑇
𝑍𝑇
𝑍𝑇
𝐴𝑇
𝐴𝑇
𝐽

where
WO, Q1O and Q2O are the thrust load and shear forces applied at the attachment due to
Occasional Loads such as Wind or Seismic
MTO, MLO and MNO are the torsional moment and bending moments applied at the
attachment due to Occasional Loads such as Wind or Seismic
Note: Absolute values of Forces and Moments are used while calculating SMTO
Stresses.
(C) Calculate PipeStresses SNTE and SPTE due to Thermal Loads on Attachment
𝑆𝑁𝑇𝐸 =

𝐶𝑊 𝑊𝐸 𝐶𝑁 𝑀𝑁𝐸 𝐶𝐿 𝑀𝐿𝐸 2𝑄1𝐸 2𝑄2𝐸 𝐶𝑇 𝑀𝑇𝐸
+
+
+
+
+
𝐴𝑇
𝑍𝑇
𝑍𝑇
𝐴𝑇
𝐴𝑇
𝐽

𝑆𝑃𝑇𝐸 = 𝐾𝑇 . 𝑆𝑁𝑇𝐸
where
WE, Q1E and Q2E are the thrust load and shear forces applied at the attachment due to
Thermal Loads
MTE, MLE and MNE are the torsional moment and bending moments applied at the
attachment due to Thermal Loads
Note: Absolute values of Forces and Moments are used while calculating SNTE
Stresses.
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(D) Calculate PipeStresses SNTD and SPTD due to Settlement Loads on Attachment
𝑆𝑁𝑇𝐷 =

𝐶𝑊 𝑊𝐷 𝐶𝑁 𝑀𝑁𝐷 𝐶𝐿 𝑀𝐿𝐷 2𝑄1𝐷 2𝑄2𝐷 𝐶𝑇 𝑀𝑇𝐷
+
+
+
+
+
𝐴𝑇
𝑍𝑇
𝑍𝑇
𝐴𝑇
𝐴𝑇
𝐽

𝑆𝑃𝑇𝐷 = 𝐾𝑇 . 𝑆𝑁𝑇𝐷
where
WD, Q1D and Q2D are the thrust load and shear forces applied at the attachment due to
Settlement Loads
MTD, MLD and MND are the torsional moment and bending moments applied at the
attachment due to SettlementLoads
Note: Absolute values of Forces and Moments are used while calculating SNTD
Stresses.
(E) Calculate PipeStresses SMTR and SPTR due to Sustained + Thermal Loads on
Attachment
SMTR = Stress SMTS calculated in Subsection A above
SPTR = Stress SPTE calculated in Subsection C above
(F) Calculate Attachment Stresses: SNT** due to Abs. Max. Loads
𝑆𝑁𝑇

∗∗

𝐶𝑊 𝑊 ∗∗ 𝐶𝑁 𝑀𝑁 ∗∗ 𝐶𝐿 𝑀𝐿 ∗∗ 2𝑄1 ∗∗ 2𝑄2 ∗∗ 𝐶𝑇 𝑀𝑇 ∗∗
=
+
+
+
+
+
𝐴𝑇
𝑍𝑇
𝑍𝑇
𝐴𝑇
𝐴𝑇
𝐽

Analysis of Attachment Welded to Pipe with a Full Penetration Weld

Sustained Stress (SSL) = SL + SMTS≤ 1.5Sh
Occasional Stress (SSO) = SLO + SMTS + SMTO≤k.Sy
Thermal Stress (SSE) = SE + (SPTE / 2.0) ≤ SA
Settlement Stress (SSD) = SD + (SPTD / 2.0) ≤ 3.0Sh
Sustained + Thermal Stress (SSR) = STE + SMTR + (SPTR / 2.0) ≤ (Sh + SA)
Additional Check
|SNT**|≤ 2.Sy
2𝑄1 ∗∗ 2𝑄2 ∗∗ 𝑀𝑇 ∗∗
|
| ≤ 𝑆𝑌
+
+
𝐴𝑇
𝐴𝑇
𝐽
Analysis of Attachment Welded to Pipe with a Fillet or Partial Penetration Weld

Sustained Stress (SSL) = SL + SMTS≤ 1.5Sh
Occasional Stress (SSO) = SLO + SMTS + SMTO≤k.Sy
Thermal Stress (SSE) = SE + (SPTE / 2.0) ≤ SA
Settlement Stress (SSD) = SD + (SPTD / 2.0) ≤ 3.0Sh
Sustained + Thermal Stress (SSR) = STE + SMTR + (SPTR / 2.0) ≤ (Sh + SA)
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Additional Check
|SNT**|≤ 2.Sy
2𝑄1 ∗∗ 2𝑄2 ∗∗ 𝑀𝑇 ∗∗
|
| ≤ 𝑆𝑌
+
+
𝐴𝑇
𝐴𝑇
𝐽
Note: Additional compliance checks as per Eq. 7 and Eq. 8 of Y-5420 (b) are not
performed in CAEPIPE at this time
where,
k = 1.5 for Level A& B Loadings, 1.8 for Level C loadings and 2.0 for Level D loadings
SL = Sustained Stress on Run Pipe as per NC-3652 Eq. (8)
SLO = Sustained + Occasional Stress on Run Pipe as per NC-3653.1 Eq. (9)
SE = Thermal Stress on Run Pipe as per NC-3653.2 Eq. (10)
SD = Settlement Stress on Run Pipe as per NC-3653.2 Eq. (10a)
STE = Sustained + Thermal Stress on Run Pipe as per NC-3653.2 Eq. (11)
SMTS = Pipe Stress SMTS computed in Subsection A above
SMTO = Pipe Stress SMTO computed in Subsection B above
SPTE = Pipe Stress SPTE computed in Subsection C above
SPTD = Pipe Stress SPTD computed in Subsection D above
SMTR = Pipe Stress SMTR computed in Subsection E above
SPTR = Pipe Stress SPTR computed in Subsection E above
SNT**= Pipe Stress SNT** computed in Subsection F above
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Rectangular Cross-section Welded Attachments

The notations described below are used in the formulas for the design.
𝐿1= half length of attachment in circumferential direction of the run pipe
𝐿2= half length of attachment in longitudinal direction of the run pipe
𝑅= mean pipe radius
𝐷𝑜 = outside diameter of run pipe

𝑇= nominal run pipe wall thickness
𝐿𝑎 = lesser of L2 and T
𝐿𝑏 = lesser of L1 and T
𝐿𝑐 = lesser of L1 and L2
𝐿𝑑 = greater of L1 and L2
𝐴 𝑇 = 4. 𝐿1 . 𝐿2 = cross-sectional area of the rectangular attachment
4
𝑍𝑡𝐿 = ( ) . 𝐿1 . 𝐿2 2
3
4
𝑍𝑡𝑁 = ( ) . 𝐿1 2 . 𝐿2
3
𝐿1
𝛽1 =
𝑅
𝐿2
𝛽2 =
𝑅
𝑅
𝛾=
𝑇
Limits of Applicability

𝜷𝟏 ≤ 𝟎. 𝟓
𝜷𝟐 ≤ 𝟎. 𝟓
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𝜷𝟏 . 𝜷𝟐 ≤ 𝟎. 𝟕𝟓

𝑀𝐿
𝑀𝑁
𝑀𝑇
𝑄1
𝑄2
W

= bending moment applied to the attachment as shown in figure above
= bending moment applied to the attachment as shown in figure above
= torsional moment applied to the attachment as shown in figure above
= shear load applied to the attachment as shown in figure above.
= shear load applied to the attachment as shown in figure above
= thrust load applied to the attachment as shown in figure above

ML, MN, MT, Q1, Q2 and W are determined at the surface of the pipe. The values of
attachment loads used in the stress calculation are based on the loads used in the different
code equations.
ML**, MN**, MT**, Q1**, Q2** and W** are absolute values of maximum loads occurring
simultaneously under all service loading conditions.
Calculate 𝜼, 𝑿𝟏 𝒂𝒏𝒅 𝒀𝟏 using the factors listed in Table below.
Load
Thrust (W)
Longitudinal Moment (ML)
Circumferential Moment (MN)

Index
CW
CL
CN

Ao
2.2
2.0
1.8

𝜃
400
500
400

𝑋𝑜
0
-0.45
-0.75

𝑌𝑜
0.05
-0.55
-0.60

𝑋1 = 𝑋𝑜 + 𝑙𝑜𝑔10 𝛽1
𝑌1 = 𝑌𝑜 + 𝑙𝑜𝑔10 𝛽2
𝜂 = −(𝑋1 𝐶𝑜𝑠𝜃 + 𝑌1 𝑆𝑖𝑛𝜃) −

1
(𝑋 𝑆𝑖𝑛𝜃 − 𝑌1 𝐶𝑜𝑠𝜃)2
𝐴𝑜 1

𝐶𝑊 = 3.82(𝛾)1.64 𝛽1 𝛽2 𝜂1.54 but not less than 1.0
𝐶𝐿 = 0.26(𝛾)1.74 𝛽1 𝛽2 2 𝜂4.74 but not less than 1.0
𝐶𝑁 = 0.38(𝛾)1.90 𝛽1 2 𝛽2 𝜂3.40 but not less than 1.0
𝐵𝐿
𝐵𝑁
𝐵𝑊
𝐾𝑇
fa
Sc
fh
fcr
ReHt

= (2/3) CL but not less than 1.0
= (2/3) CN but not less than 1.0
= (2/3) CW but not less than 1.0
= 2.0 for full penetration welds and fillet or partial penetration welds welded on 4 sides
= 3.6 for fillet or partial penetration welds welded on 2 or 3 sides
= allowable stress range as defined in Clause 12.1.3 of EN 13480-3 (2017)
= allowable stress at ambient temperature
= allowable stress at max temperature as provided in Clause 12.1.3 of EN 13480-3 (2017)
= design stress in the creep range as defined in Clause 5.3 of EN 13480-3 (2017)
= yield stress

Pipe Stresses are calculated using the equations 11.5.3-1, 11.5.3-2, 11.5.3-3 and 11.5.3-4
provided in Clause 11.5.3.
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(A) Calculate PipeStress SMTS due to Sustained Loads on Attachment
𝑀𝑇𝑆
𝑀𝑇𝑆
)
𝑀𝑇𝑇𝑆 = 𝑚𝑎𝑥 (
;
𝐿𝑐
𝐿
𝐿𝑐 𝐿𝑑 𝑇 [1 + (𝐿 )] [0.8 + 0.05 ( 𝐿𝑑 )] 𝐿𝑐 2 𝐿𝑑
𝑐

𝑑

𝑆𝑀𝑇𝑆 =

𝐵𝑊 𝑊𝑆 𝐵𝑁 𝑀𝑁𝑆 𝐵𝐿 𝑀𝐿𝑆
𝑄1𝑆
𝑄2𝑆
+
+
+
+
+ 𝑀𝑇𝑇𝑆
𝐴𝑇
𝑍𝑡𝑁
𝑍𝑡𝐿
2𝐿1 𝐿𝑎 2𝐿2 𝐿𝑏

where
WS, Q1S and Q2S are the thrust load and shear forces applied at the attachment due to Weight
and Other Sustained Loads
MTS, MLS and MNS are the torsional moment and bending moments applied at the attachment
due to Weight and Other Sustained Loads
Note: Absolute values of Forces and Moments are used while calculating SMTS
Stresses.
(B) Calculate PipeStress SMTO due to Occasional Loads on Attachment
𝑀𝑇𝑂
𝑀𝑇𝑂
)
𝑀𝑇𝑇𝑂 = 𝑚𝑎𝑥 (
;
𝐿𝑐
𝐿
𝐿𝑐 𝐿𝑑 𝑇 [1 + (𝐿 )] [0.8 + 0.05 ( 𝐿𝑑 )] 𝐿𝑐 2 𝐿𝑑
𝑐

𝑑

𝑆𝑀𝑇𝑂 =

𝐵𝑊 𝑊𝑜 𝐵𝑁 𝑀𝑁𝑂 𝐵𝐿 𝑀𝐿𝑂
𝑄1𝑂
𝑄2𝑂
+
+
+
+
+ 𝑀𝑇𝑇𝑂
𝐴𝑇
𝑍𝑡𝑁
𝑍𝑡𝐿
2𝐿1 𝐿𝑎 2𝐿2 𝐿𝑏

where
WO, Q1O and Q2O are the thrust load and shear forces applied at the attachment due to
Occasional Loads such as Wind or Seismic
MTO, MLO and MNO are the torsional moment and bending moments applied at the
attachment due to Occasional Loads such as Wind or Seismic
Note: Absolute values of Forces and Moments are used while calculating SMTO
Stresses.
(C) Calculate Attachment Stresses: SNTE and SPTE due to Thermal Loads
𝑀𝑇𝐸
𝑀𝑇𝐸
)
𝑀𝑇𝑇𝐸 = 𝑚𝑎𝑥 (
;
𝐿
𝐿
𝐿𝑐 𝐿𝑑 𝑇 [1 + (𝐿 𝑐 )] [0.8 + 0.05 ( 𝐿𝑑 )] 𝐿𝑐 2 𝐿𝑑
𝑐

𝑑

𝑆𝑁𝑇𝐸 =

𝐶𝑊 𝑊𝐸 𝐶𝑁 𝑀𝑁𝐸 𝐶𝐿 𝑀𝐿𝐸
𝑄1𝐸
𝑄2𝐸
+
+
+
+
+ 𝑀𝑇𝑇𝐸
𝐴𝑇
𝑍𝑡𝑁
𝑍𝑡𝐿
2𝐿1 𝐿𝑎 2𝐿2 𝐿𝑏

𝑆𝑃𝑇𝐸 = 𝐾𝑇 . 𝑆𝑁𝑇𝐸
where
WE, Q1E and Q2E are the thrust load and shear forces applied at the attachment due to
Thermal Loads
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MTE, MLE and MNE are the torsional moment and bending moments applied at the
attachment due to Thermal Loads
Note: Absolute values of Forces and Moments are used while calculating SNTE
Stresses.
(D) Calculate PipeStresses SMTR and SPTR due to Sustained + Thermal Loads on
Attachment
SMTR = additional stress resulting from sustained loads = S MTS calculated in Subsection A
above
SPTR = additional stress resulting from restrained thermal loads = S PTE calculated in
Subsection C above
(E) Calculate PipeStresses SMTC and SPTC due to Creep on Attachment
SMTC = additional stress resulting from sustained loads = S MTS calculated in Subsection A
above
SPTC = additional stress resulting from restrained thermal loads = S PTE calculated in
Subsection C above
(F) Calculate PipeStress SNT** due to Abs. Max. Loads
𝑀𝑇𝑇

∗∗

𝑀𝑇 ∗∗

𝑀𝑇 ∗∗

)
= 𝑚𝑎𝑥 (
;
𝐿
𝐿
𝐿𝑐 𝐿𝑑 𝑇 [1 + (𝐿 𝑐 )] [0.8 + 0.05 ( 𝐿𝑑 )] 𝐿𝑐 2 𝐿𝑑
𝑐

𝑑

𝑆𝑁𝑇 ∗∗ =

𝐶𝑊 𝑊
𝐴𝑇

∗∗

∗∗

+

𝐶𝑁 𝑀𝑁
𝐶𝐿 𝑀𝐿
+
𝑍𝑇
𝑍𝑇

∗∗

∗∗

+

𝑄1
𝑄2 ∗∗
+
+ 𝑀𝑇𝑇 ∗∗
2𝐿1 𝐿𝑎 2𝐿2 𝐿𝑏

Analysis of Attachment Welded to Pipe with a Full Penetration Weld

Sustained Stress (SSL) = S1 + SMTS≤ 1.5fh
Occasional Stress (SSO) = S2 + SMTS + SMTO≤1.8fh
Thermal Stress (SSE) = S3 + (SPTE / 2.0) ≤fa
Sustained + Thermal Stress (SSR) = S4 + SMTR + (SPTR / 2.0) ≤ (fh + fa)
Creep Stress (SSC) = S4 + SMTC + (SPTC / 2.0) ≤ 1.25fcr
Additional Check
SNT** ≤2ReHt
𝑄1 ∗∗
𝑄2 ∗∗
|
+
+ 𝑀𝑇𝑇 ∗∗ | ≤ R 𝑒𝐻𝑡
2𝐿1 𝐿𝑎 2𝐿2 𝐿𝑏
Analysis of Attachment Welded to Pipe with a Fillet or Partial Penetration Weld

Sustained Stress (SSL) = S1 + SMTS≤ 1.5fh
Occasional Stress (SSO) = S2 + SMTS + SMTO≤1.8fh
Thermal Stress (SSE) = S3 + (SPTE / 2.0) ≤fa
Sustained + Thermal Stress (SSR) = S4 + SMTR + (SPTR / 2.0) ≤ (fh + fa)
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Creep Stress (SSC) = S4 + SMTC + (SPTC / 2.0) ≤ 1.25fcr
Additional Check
SNT** ≤2ReHt
𝑄1 ∗∗
𝑄2 ∗∗
|
+
+ 𝑀𝑇𝑇 ∗∗ | ≤ R 𝑒𝐻𝑡
2𝐿1 𝐿𝑎 2𝐿2 𝐿𝑏
Note: Additional compliance checks as per Eq. 11.5.4-1 and Eq. 11.5.4-2 of Clause
11.5.4 are not performed in CAEPIPE at this time.
where,
S1 = Sustained Stress on Run Pipe as per 12.3.2-1 of EN 13480-3 (2017)
S2 = Sustained + Occasional Stress on Run Pipe as per 12.3.3-1 of EN 13480-3 (2017)
S3 = Thermal Stress on Run Pipe as per 12.3.4-1 of EN 13480-3 (2017)
S4 = Sustained + Thermal Stress on Run Pipe as per 12.3.4-2 of EN 13480-3 (2017)
S5 = Settlement Stress on Run Pipe as per 12.3.5-1 of EN 13480-3 (2017)
SMTS = Pipe Stress SMTS computed in Subsection A above
SMTO = Pipe Stress SMTO computed in Subsection B above
SPTE = Pipe Stress SPTE computed in Subsection C above
SMTR = Pipe Stress SMTR computed in Subsection D above
SPTR = Pipe Stress SPTR computed in Subsection D above
SMTC = Pipe Stress SMTR computed in Subsection E above
SPTC = Pipe Stress SPTR computed in Subsection E above
SNT**= Pipe Stress SNT** computed in Subsection F above
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HollowCircular Cross-section Welded Attachments

The symbols described below are used in the formulas for the design.
𝑅= mean run pipe radius
𝑅𝑜 = run pipe outside diameter
𝑟𝑜 = attachment outside radius
𝑟𝑖 = attachment inside radius
𝐷𝑜 = outside diameter of run pipe
𝑑𝑜

= outside diameter of attachment

𝑇= nominal run pipe wall thickness
𝑡= nominal attachment wall thickness
𝐴 𝑇 = 𝜋(𝑟𝑜 2 − 𝑟𝑖 2 )= cross-sectional area of the circular attachment
𝜋
𝐼𝑇 = (𝑟𝑜 4 − 𝑟𝑖 4 )
4
𝐼𝑇
𝑍𝑇 =
𝑟𝑜
𝐽 = min(𝜋𝑟𝑜 2 𝑇, 𝑍𝑇 )
𝑅𝑜
𝛾=
𝑇
𝑑𝑜
𝛽=
𝐷𝑜
𝑡
𝜏=
𝑇
Limits of Applicability

𝟒. 𝟎 ≤ 𝜸 ≤ 𝟓𝟎

0.2 ≤ 𝜏 ≤ 1.0
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0.3 ≤ 𝛽 ≤ 1.0
𝑀𝐿
𝑀𝑁
𝑀𝑇
𝑄1
𝑄2
W

= bending moment applied to the attachment as shown in figure above
= bending moment applied to the attachment as shown in figure above
= torsional moment applied to the attachment as shown in figure above
= shear load applied to the attachment as shown in figure above.
= shear load applied to the attachment as shown in figure above
= thrust load applied to the attachment as shown in figure above

ML, MN, MT, Q1, Q2 and W are determined at the surface of the pipe. The values of
attachment loads used in the stress calculation are based on the loads used in the different
code equations.
ML**, MN**, MT**, Q1**, Q2** and W** are absolute values of maximum loads occurring
simultaneously under all service loading conditions.
𝐶 = 𝐴𝑜 (2𝛾)𝑛1 𝛽 𝑛2 𝜏 𝑛3 but not less than 1.0
Equation for C is used to determine CW, CL and CN based on the following Table. Maximum
values of CW, CL and CN among the values calculated for the pipe and the attachment are
used subsequently.
Load
Thrust (W)

Index
CW

Part
Pipe
Attachment
Pipe
Attachment
Pipe
Attachment
Pipe
Attachment

Longitudinal
CL
Moment (ML)
Circumferential
CN
Moment (MN)
Circumferential
CN
Moment (MN)
3
(a) - Replace 𝛽 𝑛2 with 𝑒 −1.2𝛽
3
(b) - Replace 𝛽 𝑛2 with 𝑒 −1.35𝛽

𝛽 range
0.3 to1.0
0.3 to1.0
0.3 to1.0
0.3 to1.0
0.3 to 0.55
0.3 to 0.55
>0.55 to 1.0
>0.55 to 1.0

Ao
1.40
4.00
0.46
1.10
0.51
0.84
0.23
0.44

n1
0.81
0.55
0.60
0.23
1.01
0.85
1.01
0.85

n2
(a)
(b)
-0.04
-0.38
0.79
0.80
-0.62
-0.28

n3
1.33
1.00
0.86
0.38
0.89
0.54
0.89
0.54

𝐶𝑇 = 1.0 for 𝛽<= 0.55
= CN for 𝛽 = 1.0, but not less than 1.0;
CT should be linearly interpolated for 0.55 <= 𝛽< 1.0, but not less than 1.0
𝐵𝑊
𝐵𝐿
𝐵𝑁
𝐵𝑇
𝐾𝑇
fa
Sc
fh
fcr

= 0.5 CW but not less than 1.0
= 0.5 CL but not less than 1.0
= 0.5 CN but not less than 1.0
= 0.5 CT but not less than 1.0
= 1.8 for full penetration welds
= 2.0 for fillet or partial penetration welds
= allowable stress range as defined in Clause 12.1.3 of EN 13480-3 (2017)
= allowable stress at ambient temperature
= allowable stress at max temperature as provided in Clause 12.1.3 of EN 13480-3 (2017)
= design stress in the creep range as defined in Clause 5.3 of EN 13480-3 (2017)
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ReHt = yield stress
(A) Calculate PipeStress SMTS due to Sustained Loads on Attachment
𝑆𝑀𝑇𝑆 =

𝐵𝑊 𝑊𝑆 𝐵𝑁 𝑀𝑁𝑆 𝐵𝐿 𝑀𝐿𝑆 2𝑄1𝑆 2𝑄2𝑆 𝐵𝑇 𝑀𝑇𝑆
+
+
+
+
+
𝐴𝑇
𝑍𝑇
𝑍𝑇
𝐴𝑇
𝐴𝑇
𝐽

where
WS, Q1S and Q2S are the thrust load and shear forces applied at the attachment due to Weight
and Other Sustained Loads
MTS, MLS and MNS are the torsional moment and bending moments applied at the attachment
due to Weight and Other Sustained Loads
Note: Absolute values of Forces and Moments are used while calculating SMTS
Stresses.
(B) Calculate Pipe Stress SMTO due to Occasional Loads on Attachment
𝑆𝑀𝑇𝑂 =

𝐵𝑊 𝑊𝑂 𝐵𝑁 𝑀𝑁𝑂 𝐵𝐿 𝑀𝐿𝑂 2𝑄1𝑂 2𝑄2𝑂 𝐵𝑇 𝑀𝑇𝑂
+
+
+
+
+
𝐴𝑇
𝑍𝑇
𝑍𝑇
𝐴𝑇
𝐴𝑇
𝐽

where
WO, Q1O and Q2O are the thrust load and shear forces applied at the attachment due to
Occasional Loads such as Wind or Seismic
MTO, MLO and MNO are the torsional moment and bending moments applied at the
attachment due to Occasional Loads such as Wind or Seismic
Note: Absolute values of Forces and Moments are used while calculating SMTO
Stresses.
(C) Calculate PipeStresses SNTE and SPTE due to Thermal Loads on Attachment
𝑆𝑁𝑇𝐸 =

𝐶𝑊 𝑊𝐸 𝐶𝑁 𝑀𝑁𝐸 𝐶𝐿 𝑀𝐿𝐸 2𝑄1𝐸 2𝑄2𝐸 𝐶𝑇 𝑀𝑇𝐸
+
+
+
+
+
𝐴𝑇
𝑍𝑇
𝑍𝑇
𝐴𝑇
𝐴𝑇
𝐽

𝑆𝑃𝑇𝐸 = 𝐾𝑇 . 𝑆𝑁𝑇𝐸
where
WE, Q1E and Q2E are the thrust load and shear forces applied at the attachment due to
Thermal Loads
MTE, MLE and MNE are the torsional moment and bending moments applied at the
attachment due to Thermal Loads
Note: Absolute values of Forces and Moments are used while calculating SNTE
Stresses.
(D) Calculate PipeStresses SMTR and SPTR due to Sustained + Thermal Loads on
Attachment
SMTR = Stress SMTS calculated in Subsection A above
SPTR = Stress SPTE calculated in Subsection C above
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(E) Calculate PipeStresses SMTC and SPTCdue to Creep on Attachment
SMTC = Stress SMTS calculated in Subsection A above
SPTC = Stress SPTE calculated in Subsection C above
(F) Calculate PipeStress SNT** due to Abs. Max. Loads on Attachment
𝑆𝑁𝑇 ∗∗ =

𝐶𝑊 𝑊 ∗∗ 𝐶𝑁 𝑀𝑁 ∗∗ 𝐶𝐿 𝑀𝐿 ∗∗ 2𝑄1 ∗∗ 2𝑄2 ∗∗ 𝐶𝑇 𝑀𝑇 ∗∗
+
+
+
+
+
𝐴𝑇
𝑍𝑇
𝑍𝑇
𝐴𝑇
𝐴𝑇
𝐽

Analysis of Attachment Welded to Pipe with a Full Penetration Weld

Sustained Stress (SSL) = S1 + SMTS≤ 1.5fh
Occasional Stress (SSO) = S2 + SMTS + SMTO≤1.8fh
Thermal Stress (SSE) = S3 + (SPTE / 2.0) ≤fa
Sustained + Thermal Stress (SSR) = S4 + SMTR + (SPTR / 2.0) ≤ (fh + fa)
Creep Stress (SSC) = S4 + SMTC + (SPTC / 2.0) ≤ 1.25fcr
Additional Check
|SNT**|≤ 2.ReHt
2𝑄1 ∗∗ 2𝑄2 ∗∗ 𝑀𝑇 ∗∗
|
| ≤ 𝑅𝑒𝐻𝑡
+
+
𝐴𝑇
𝐴𝑇
𝐽
Analysis of Attachment Welded to Pipe with a Fillet or Partial Penetration Weld

Sustained Stress (SSL) = S1 + SMTS≤ 1.5fh
Occasional Stress (SSO) = S2 + SMTS + SMTO≤1.8fh
Thermal Stress (SSE) = S3 + (SPTE / 2.0) ≤fa
Sustained + Thermal Stress (SSR) = S4 + SMTR + (SPTR / 2.0) ≤ (fh + fa)
Creep Stress (SSC) = S4 + SMTC + (SPTC / 2.0) ≤ 1.25fcr
Additional Check
|SNT**|≤ 2.ReHt
2𝑄1 ∗∗ 2𝑄2 ∗∗ 𝑀𝑇 ∗∗
|
| ≤ 𝑅𝑒𝐻𝑡
+
+
𝐴𝑇
𝐴𝑇
𝐽
Note: Additional compliance checks as perEq. 11.4.4-1 and Eq. 11.4.4-2 of Clause
11.4.4 are not performed in CAEPIPE at this time
where,
S1 = Sustained Stress on Run Pipe as per 12.3.2-1 of EN 13480-3 (2017)
S2 = Sustained + Occasional Stress on Run Pipe as per 12.3.3-1 of EN 13480-3 (2017)
S3 = Thermal Stress on Run Pipe as per 12.3.4-1 of EN 13480-3 (2017)
S4 = Sustained + Thermal Stress on Run Pipe as per 12.3.4-2 of EN 13480-3 (2017)
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S5 = Settlement Stress on Run Pipe as per 12.3.5-1 of EN 13480-3 (2017)
SMTS = Pipe Stress SMTS computed in Subsection A above
SMTO = Pipe Stress SMTO computed in Subsection B above
SPTE = Pipe Stress SPTE computed in Subsection C above
SMTR = Pipe Stress SMTR computed in Subsection D above
SPTR = Pipe Stress SPTR computed in Subsection D above
SMTC = Pipe Stress SMTR computed in Subsection E above
SPTC = Pipe Stress SPTR computed in Subsection E above
SNT**= Pipe Stress SNT** computed in Subsection F above
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EN 13445-3:2014/A8:2019
Local Loads on nozzles in spherical shells

Conditions of applicability
𝑎) 0.001 ≤ 𝑒𝑎 /𝑅 ≤ 0.1
b) distances to any other local load in any direction shall be not less than √𝑅. 𝑒𝑐
c) nozzle thickness shall be maintained over a distance of 𝐿 ≥ √𝑑. 𝑒𝑏
where,
e = nominal shell thickness
ea = analysis shell thickness = e – corrosion allowance
eb = nozzle thickness
ec = analysis thickness of the combined shell and reinforcing plate
= ea + e2 . min(f2/f;1) when a reinforcing plate is fitted
= ea when no reinforcing plate is fitted
R = mean shell radius at the nozzle
e2 = reinforcing pad thickness
f2 = allowable design stress of reinforcing pad plate
f = allowable design stress of shell material
Maximum allowable individual loads

Allowable axial nozzle load
Allowable axial nozzle load Fz.max is computed using Eq. (16.4-7)
𝐹𝑧.𝑚𝑎𝑥 = 𝑓. 𝑒𝑐2 (1.82 + 2.4√1 + 𝑘. 𝜆𝑠 + 0.91. 𝑘. 𝜆2𝑠 )
where
k = min (
𝜆𝑠 =

2𝑓𝑏 𝑒𝑏
𝑓𝑒𝑐

𝑒

√ 𝑑𝑏 ; 1.0)

𝑑
√𝑅𝑒𝑐

d = mean nozzle diameter
fb = allowable design stress of nozzle material
Allowable bending moment
Allowable bending moment MB.max is computed using Eq. (16.4-8)
𝑑
𝑀𝐵.𝑚𝑎𝑥 = 𝑓. 𝑒𝑐2 (4.90 + 2.0√1 + 𝑘. 𝜆𝑠 + 0.91. 𝑘. 𝜆2𝑠 )
4
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Local Loads on nozzles in cylindrical shells

Conditions of applicability
𝑎) 0.001 ≤ 𝑒𝑎 /𝐷 ≤ 0.1
b) 𝜆𝐶 =

𝑑
√𝐷𝑒𝑐

b) distances to any other local load in any direction shall be not less than √𝐷. 𝑒𝑐
c) nozzle thickness shall be maintained over a distance of 𝐿 ≥ √𝑑. 𝑒𝑏
where,
e = nominal shell thickness
ea = analysis shell thickness = e – corrosion allowance
eb = nozzle thickness
ec = analysis thickness of the combined shell and reinforcing plate
= ea + e2 . min(f2/f;1) when a reinforcing plate is fitted
= ea when no reinforcing plate is fitted
D = mean shell diameter at the opening
e2 = reinforcing pad thickness
f2 = allowable design stress of reinforcing pad plate
f = allowable design stress of shell material
Maximum allowable individual loads

Allowable axial nozzle load
Allowable axial nozzle load Fz.max is computed using Eq. (16.5-3)
𝐹𝑧.𝑚𝑎𝑥 = 𝑓. 𝑒𝑐2 . 𝐶1
where
𝐶1 = 𝑚𝑎𝑥[(𝑎𝑜 + 𝑎1 . 𝜆𝐶 + 𝑎2 . 𝜆2𝐶 + 𝑎3 . 𝜆3𝐶 + 𝑎4 . 𝜆4𝐶 ); 1.81] as per Eq. (16.5-4)

𝜆𝐶 =

𝑑
√𝐷𝑒𝑐
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Allowable circumferential moment
Allowable bending moment MX.max is computed using Eq. (16.5-5)
𝑑
𝑀𝑋.𝑚𝑎𝑥 = 𝑓. 𝑒𝑐2 𝐶2
4
where,
𝐶2 = 𝑚𝑎𝑥[(𝑎𝑜 + 𝑎1 . 𝜆𝐶 + 𝑎2 . 𝜆2𝐶 + 𝑎3 . 𝜆3𝐶 + 𝑎4 . 𝜆4𝐶 ); 4.90] as per Eq. (16.5-6)

Allowable longitudinal moment
Allowable longitudinal moment MY.max is computed using Eq. (16.5-7)
𝑑
𝑀𝑌.𝑚𝑎𝑥 = 𝑓. 𝑒𝑐2 𝐶3
4
where,
𝐶3 = 𝑚𝑎𝑥[(𝑎𝑜 + 𝑎1 . 𝜆𝐶 + 𝑎2 . 𝜆2𝐶 + 𝑎3 . 𝜆3𝐶 + 𝑎4 . 𝜆4𝐶 ); 4.90] as per Eq. (16.5-8)

WRC Bulletin 537 (2013)
General

CAEPIPE computes Local Shell Stresses at Nozzles as per WRC Bulletin 537 (2013) and
performs Stress Compliance as per ASME Section VIII Division 2 (2017).
As stated in ASME Section VIII Division 2 (2017) code, shell stresses computed for primary
loads of Sustained and Sustained + Occasional should exclude the Radial and Tangential
Bending Stresses. On the other hand, for Operating load which includes secondary loads due
to temperature change and thermal anchor movements, Radial and Tangential Bending
Stresses should be included for compliance as per ASME Section VIII Division 2 (2017).
Refer to the extract from ASME Section VIII Division 2 (2017) provided at the end of this
section for details on the implementation of Stress Compliance in CAEPIPE.
Local Stresses in Spherical Shells at Hollow Circular Attachments

As per Section 3.5.1 of WRC Bulletin 537, the below procedure provides one with a tool to
compute stresses in the shell, but not in the nozzle. In some instances, stresses will be higher
in the nozzle wall than they are in the vessel wall. This possibility is most likely if the nozzle
opening is not reinforced, or if the reinforcement is placed on the vessel wall and not on the
nozzle.

WRC Bulletin 537 (2013)

WRC Bulletin 537 (2013)

WRC Bulletin 537 (2013)
Local Stresses in Cylindrical Shells at Solid Circular Attachments

As per Section 4.5.3 of WRC Bulletin 537, the below procedure provides one with a tool to
compute stresses in the shell, but not in the attachment. Under certain conditions, stresses
may be higher in the attachment than they are in the vessel. For example, in the case of a
nozzle, it is likely that the stresses will be higher in the nozzle wall than they are in the vessel
wall if the nozzle opening is unreinforced or if the reinforcement is placed on the vessel wall
and not on the nozzle.

WRC Bulletin 537 (2013)

See Note 2 below

See Note 3 below

Note:
1. Original Curves are referred for all figures. For example, 3C-Original is referred to
read the parameters required for calculating Circumferential Membrane Stress due to
P.
2. Figure 2C-1 – Original is referred to calculate Circumferential Bending Stress due to
P at Points AU, AL, BU and BL. Similarly, Figure 1C is referred to calculate
Circumferential Bending Stress due to P at Points CU, CL, DU and DL.
3. Figure 1C-1 – Original is referred to calculate Longitudinal Bending Stress due to P
at Points AU, AL, BU and BL. Similarly, Figure 2C is referred to calculate Longitudinal
Bending Stress due to P at Points CU, CL, DU and DL.

WRC Bulletin 537 (2013)
Stress Compliance of Local Shell Stresses at Nozzles
[Extract from ASME Section VIII Division 2 (2017)]

WRC Bulletin 537 (2013)

WRC Bulletin 537 (2013)

ASCE/SEI 7
Minimum Design Loads for Buildings
and
Other Structures

ASCE/SEI 7-16
The Design Earthquake Load – ASCE/SEI 7-16

Chapter 13 titled “Seismic Design Requirements for Nonstructural Components” from
ASCE/SEI 7-16 provides Seismic Design requirements for architectural, mechanical and
electrical components including specific references to ASME boiler, pressure vessels and
piping as detailed below.
Site Coefficients and Risk-Targeted Maximum Considered Earthquake (MCE)
Spectral Response Acceleration Parameters
The MCE spectral response acceleration parameter for Site Class effects shall be determined
by Eq. 11.4-1.
𝑆𝑀𝑆 = 𝐹𝑎 𝑆𝑆
where,
Fa = Site Coefficient defined in Table 11.4-1.
SS = the mapped MCE spectral response acceleration parameter at short periods as
determined in accordance with Section 11.4.1. The value of Ss can be retrieved from the
USGS website http://earthquake.usgs.gov/designmaps.

Note: Site specific analysis is required for Site Class E with Ss>= 1.0 and Site Class F,
Design Spectral Acceleration Parameters
Design earthquake spectral response acceleration parameter at short period, SDS shall be
determined from Eq. 11.4-3.
2
𝑆𝐷𝑆 = ( ) 𝑆𝑀𝑆
3
Seismic Design Force
The horizontal seismic design force (Fp) shall be applied at the component’s center of
gravity and distributed relative to the component’s mass distribution and shall be determined
in accordance with Eq. 13.3-1 of para. 13.3.1.
𝐹𝑝 =

0.4𝑎𝑝 𝑆𝐷𝑆 𝑊𝑝
𝑅

( 𝐼 𝑝)
𝑝

𝑧
(1 + 2 )
ℎ

ASCE/SEI 7-16
Fp is not required to be taken as greater than
𝐹𝑝 = 1.6𝑆𝐷𝑆 𝐼𝑝 𝑊𝑝
Fp shall not be taken as less than
𝐹𝑝 = 0.3𝑆𝐷𝑆 𝐼𝑝 𝑊𝑝
where,
Fp = seismic design force
SDS = spectral acceleration, short period, as determined above
SMS = maximum MCE spectral acceleration at short periods
ap = component amplification factor that varies from 1.00 to 2.50(see Table 13.6-1 below)
Ip = component importance factor that varies from 1.00 to 1.50 (see Section 13.1.3)
Wp = component operating weight
Rp = component response modification factor that varies from 1.00 to 12 (see Table 13.6-1 below)
z = height in structure of point of attachment of component with respect to the base. For items at or
below the base, z shall be taken as 0. The value of z/h need not exceed 1.0.
h = average roof height of structure with respect to the base
Note:
As per 13.1.8, the earthquake loads determined in accordance with Section 13.3.1 shall be
multiplied by a factor 0.7. This can be performed in CAEPIPE by entering the value as 0.70
for “All. Stress Factor ADS(a)” through “ASCE/SEI 7-16” Seismic parameter input dialog.
Vertical Seismic Force
As per para. 13.3.1, Vertical Seismic Force shall be computed as
𝑉𝑝 = 0.2𝑆𝐷𝑆 𝑊𝑝
where,
SDS and Wp are as defined above.

ASCE/SEI 7-16

ASCE/SEI 7-16
The Design Wind Load – ASCE/SEI 7-16

Chapter 26 titled “Wind Load: Generic Requirements” is used to determine basic parameters
for determining wind loads and Chapter 29 titled “Wind Load on Other Structures and
Building Appurtenances – MWFRS” of ASCE/SEI 7-16 provides a directional wind force
determination procedure for building appurtenances and other structures. Details referred
from these two (2) chapters for implementation in CAEPIPE are detailed below.
Type of Element Classification
Type of Element Classification = Other Structures
Figure 26.1-1 directs the ASCE 7 user to the appropriate method to determine wind forces
for the particular building or structure the user is concerned with. The method most
appropriate for industrial plant piping of any type is detailed in Chapter 29, “Wind Loads on
Other Structures and Building Appurtenances – MWFRS”.
Wind Load Parameters
The following wind load parameters shall be determined in accordance with Chapter 26.
Basic Wind Speed (V):
The basic wind speed, V, used in the determination of design wind loads on buildings and
other structures shall be determined from Fig. 26.5-1 as follows.
Fig. 26-5-1A can be referred for Risk Category I buildings and other structures.
Fig. 26-5-1B can be referred for Risk Category II buildings and other structures
Fig. 26.5-1C can be referred for Risk Category III buildings and other structures.
Fig. 26.5-1D can be referred for Risk Category IV Buildings and Other Structures.
Wind Directionality Factor Kd:
The wind directionality factor, Kd, shall be determined from Table 26.6-1 as given below.
Exposure Categories:
As detailed in Section 26.7.3 of ASCE/SEI 7-16, Exposure Categories can be B, C or D.
Topographical Factor Kzt:
As detailed in Section 26.8.2, Wind speed-up effects shall be included in the calculation of
design wind loads by using the factor Kzt.
Figure 26.8-1 (given below) can be referred to compute the Topographical Factor Kzt.
𝐾𝑧𝑡 = (1 + 𝐾1 𝐾2 𝐾3 )2
where K1, K2 and K3 are given in Fig. 26.8-1.
If site conditions and locations of structures do not meet all the conditions specified in
Section 26.8.1 then Kzt = 1.0
Velocity Pressure Exposure Coefficient Kz
Velocity pressure exposure coefficient Kz can be determined from Table 26.10.1 provided
below.

ASCE/SEI 7-16
Velocity Pressure
Velocity pressure, qz, evaluated at height z shall be calculated by the following equation:
𝑞𝑧 = 0.00256𝐾𝑧 𝐾𝑧𝑡 𝐾𝑑 𝐾𝑒 𝑉 2 (𝑙𝑏/𝑓𝑡 2 )
where
Kd = wind directionality factor as defined above
Kzt = velocity pressure exposure coefficient as defined above
Kz = topographic factor as defined above
Ke = ground elevation factor to adjust air density permitted Ke = 1
V = basic wind speed as defined above
Design Wind Loads – Other Structures
The design wind force for other structures (chimneys, tanks, rooftop equipment for h > 60,
and similar structures, open signs, lattice frameworks, and trussed towers) shall be
determined by section 29.4, ASCE 7-16, with the following equation:
𝐹 = 𝑞𝑧 𝐶𝑓 𝐺𝐴𝑓 (𝑙𝑏)
where
qz = velocity pressure evaluated at height z as defined above of the centroid of area A f
G = gust-effect factor for a rigid building or other structure is permitted to be taken as 0.85
Cf = force coefficients from Fig. 29.4-1 given below
Af = projected area normal to the wind except where C f is specified for the actual surface
area in ft2

ASCE/SEI 7-16

ASCE/SEI 7-16
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EN 1991-1-4 (2010)

EN 1991-1-4 (2010)
General actions - Wind actions

EN 1991-1-4 (2010)
The Design Wind Load

Section 4 titled “Wind velocity and velocity pressure” is used to compute Peak Velocity
Pressure at a given elevation.
Basic Values
The fundamental value of the basic wind velocity, Vb,Q, is the characteristic 10 minutes
mean wind velocity, irrespective of wind direction and time of year, at 10m above ground
level in open country terrain with low vegetation such as grass and isolated obstacles with
separations of at least 20 obstacle heights.
The basic wind velocity shall be calculated from Expression (4.1) of EN 1991-1-4 (2010) as
given below.
𝑽𝒃, 𝑸 = 𝑪𝒅𝒊𝒓 . 𝑽𝒃 . 𝑪𝑺𝒆𝒂𝒔𝒐𝒏
where
Vb is the basic wind velocity, defined as a function of wind direction and time of year at 10m
above ground of terrain category II.
Vb,Q is the fundamental value of the basic wind velocity
Cdir is the directional factor, the recommended value is 1.0.
Cseason is the season factor, the recommended value is 1.0.
Mean Wind
The mean wind velocity Vm(z) at a height z above the terrain depends on the terrain
roughness and orography and on the basic wind velocity, V b, and is determined using
Expression (4.3) of EN 1991-1-4 (2010) as given below.
𝑽𝒎 (𝒛) = 𝑪𝒓 (𝒛). 𝑽𝒃 . 𝑪𝒐 (𝒛)
Where
Cr(z) is the terrain roughness factor. This can be computed as given below.
C0(z) is the orography factor, the recommended value is 1.0. See Section 4.3.3 of EN 1991-14 (2010) for further details.
Terrain Roughness Factor[Cr(z)]
The roughness factor, Cr(z), accounts for the variability of the mean wind velocity at the site
of the structure due to:
a. height above ground level
b. ground roughness of the terrain upwind of the structure in the wind direction
considered.
𝒛
𝑪𝒓 (𝒛) = 𝑲𝒓 . 𝑳𝒏 ( ) 𝒇𝒐𝒓 𝒛𝒎𝒊𝒏 < 𝑧 < 𝑧𝒎𝒂𝒙
𝒛𝒐
𝑪𝒓 (𝒛) = 𝑪𝒓 (𝒛𝒎𝒊𝒏 )𝒇𝒐𝒓 𝒛 < 𝑧𝒎𝒊𝒏
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where
𝑲𝒓 = 𝟎. 𝟏𝟗. (

𝒛
𝒛𝒐,𝑰𝑰

𝟎.𝟎𝟕

)

where
zO,II= 0,05 m [terrain category II, as per Table 4.1 of EN 1991-1-4 (2010)]
zmin is the minimum height defined in Table 4.1 of EN 1991-1-4 (2010)
zmax is to be taken as 200 m

Wind Turbulence
The turbulence intensity Iv(z) at height z is defined as the standard deviation of the
turbulence divided by the mean wind velocity.
𝑰 𝑽 ( 𝒛) =

𝑲𝒕
𝒛

𝑪𝒐 (𝒛). 𝐥𝐧 (𝒛 )

for 𝒛𝒎𝒊𝒏 < 𝑧 < 𝑧𝒎𝒂𝒙

𝒐

𝑰𝒗 (𝒛) = 𝑰𝒗 (𝒛𝒎𝒊𝒏 ) for

𝒛 < 𝑧𝒎𝒊𝒏

where
Kt is the turbulence factor. The value may be given in the National Annex. The
recommended value for Kt is 1.0.
C0(z) is the orography factor as explained above.
z0is the roughness length as given in Table 4.1 of EN 1991-1-4 (2010).
Peak Velocity Pressure [Qp(z)]
The peak velocity pressure Qp(z) at height z, which includes mean and short-term velocity
fluctuations, is determined using Expression (4.8) of EN 1991-1-4 (2010) as given below.
𝟏
𝑸𝒑 (𝒛) = [𝟏 + 𝟕. 𝑰𝒗 (𝒛)]. . 𝝆. 𝑽𝟐𝒎 (𝒛) = 𝑪𝒆 (𝒛). 𝑸𝒃
𝟐
where
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𝜌 is the air density, which depends on the altitude, temperature and barometric pressure to
be expected in the region during wind storms
𝐶𝑒 (𝑧)is the exposure factor =

𝑸𝒑 (𝒛)
𝑸𝒃
1

𝑄𝑏 is the basic velocity pressure = 2 . 𝜌. 𝑉𝑏2
Design Wind Loads
The design wind force is then determined as given below.
𝐹 = 𝑸𝒑 (𝒛). 𝐴𝑓
where
𝑸𝒑 (𝒛) = peak velocity pressure evaluated at height z
Af = projected area normal to the wind
Note:
In Expression 5.3, Wind Force is computed by multiplying the above Qp(z) with
CsCd and Cf. From Section 6.2(d), for chimneys with circular cross-sections (similar
to the flow around circular pipes), CsCd is specified as 1.0. So, the only factor that is
NOT yet applied in computing the design wind loads above is Cf.
From Section 7.9 for Circular Cylinders, for most piping systems, Cf should be of
between 0.7 and 1.0. Surface roughness factors (k) provided in Section 7.9.2 and endeffect factors provided in Section 7.13 (used for computing Cf) are mostly related to
structural elements. Since piping elements are connected to either adjoining pipe
elements or fittings or components or equipment, the end-effect factor for any
element in a pipe stress model should be 1.0; it is equivalent to saying that, from fluid
flow point of view, each element in a pipe stress model is behaving as an infinitely
long element. Hence, it does not cause the kind of end flow effect created by finite
length elements.
In view of the above, applying only Eq. 4.8 to compute design wind force is
conservative. Hence, in the current version of CAEPIPE, Expression 5.3 is not
implemented to calculate Design Wind Loads.
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